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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i
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https://www.oracle.com/education/
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https://community.oracle.com/customerconnect/categories/idealab-guidelines
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1  Overview

Overview of the Supply Chain Planning Common
Features Guide  
The Oracle Fusion Cloud SCM Using Supply Chain Planning Common Features guide contains topics that are applicable
to work areas for two or more modules in Oracle Fusion Cloud Supply Chain Planning.

These topics are also included in the guide for each of the products to which they're applicable.

For additional topics that are specific to only one of these products, you must refer to the applicable guide:

• Oracle Fusion Cloud SCM Using Planning Central

• Oracle Fusion Cloud SCM Using Demand Management

• Oracle Fusion Cloud SCM Using Supply Planning

• Oracle Fusion Cloud SCM Using Sales and Operations Planning

• Oracle Fusion Cloud SCM Using Order Promising

• Oracle Fusion Cloud SCM Using Replenishment Planning

For topics that provide help for end-user features that are common across Oracle Fusion Cloud Applications, refer to the
Oracle Fusion Cloud Applications Using Common Features guide.

Overview of Supply Chain Planning Work Areas  
The Oracle Fusion Cloud Supply Chain Planning solution is composed of products designed for specific supply chain
planning business processes and tasks.

You perform these processes and tasks by using work areas. Each of the Oracle Supply Chain Planning products
provides access to one or more work areas.

The Supply Chain Planning work areas that you can use are determined by these factors:

• The products that your enterprise has licensed and configured

• The security privileges assigned to your user account

To use the Supply Chain Planning work areas, you must be aware of these points:

• Navigation to work areas

• List of Supply Chain Planning work areas and the products to which they're applicable

1
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Navigation to Work Areas
You can use different paths to navigate to a specific work area including:

• From the Navigator: Click the Navigator icon to see the work areas that you have access to. The Supply Chain
Planning work areas are listed within the Supply Chain Planning heading. The work area names are links. Click a
specific work area link to access that work area.

• From the Springboard: On your home page you might have one or more springboard icons that represent
a group of work areas, such as the group of Supply Chain Planning work areas. Click on the Supply Chain
Planning springboard to access a set of icons, each of which represents a specific Supply Chain Planning work
area. Click a specific icon to access that work area.

List of Supply Chain Planning Work Areas
The following table lists the Supply Chain Planning work areas and the Oracle Fusion Cloud Supply Chain Planning
modules that are applicable to each of the work areas.

Work Area Modules

Demand Management
 

Oracle Demand Management
 

Supply Planning
 

Oracle Supply Planning
 

Demand and Supply Planning
 

Both of these products must be configured:
 

• Oracle Demand Management

• Oracle Supply Planning

Planning Central
 

Oracle Planning Central
 

Sales and Operations Planning
 

Oracle Sales and Operations Planning
 

Backlog Management
 

Oracle Backlog Management
 

Production Scheduling
 

Oracle Production Scheduling
 

Replenishment Planning
 

Oracle Replenishment Planning
 

Plan Inputs
 

Use the Plan Inputs work area to perform tasks that don't require creating or accessing a plan.
 
This work area can also be opened from other Supply Chain Planning work areas.
 

Note:  If a plan that has been created in the Planning Central work area is opened from either the Supply Planning
or the Demand and Supply Planning work area, then that plan will no longer be accessible from the Planning Central
work area.

2
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The Global Order Promising work area is bundled within the Oracle Fusion Cloud Order Management solution.

Related Topics
• Overview of the Supply Planning Work Area

• Overview of the Demand Management Work Area

• Overview of the Sales and Operations Planning Work Area

• Overview of the Order Promising Work Area

• Overview of the Replenishment Planning Work Area

Plan Options Topics for Supply Chain Planning  
This guide contains topics applicable to the work areas for two or more modules in Oracle Fusion Cloud Supply Chain
Planning.

These topics are also included in the guide for each applicable product along with other topics specific to that product.

Some of the product-specific guides share the same topic regarding the Scope tab for Plan Options page, so that is the
topic used in this guide, but a couple of guides use a product-specific variation for the topic.

• For the Plan Options topic for the Replenishment Planning work area, click on this link: Scope Plan Options for
Replenishment Plans

• For the Plan Options topic for the Sales and Operations Planning work area, click on this link: Define Scope Plan
Options for Sales and Operations Plans

• For the Plan Options topic for the Planning Central work area for demand plans, click on this link: Define Scope
Plan Options in Planning Central

For the Demand Management and Supply Planning work areas, and the Planning Central work area for supply plans,
you can use the Define Scope Plan Options topic in this guide, Define Scope Plan Options, or go to the product-specific
guide and search for the Define Scope Plan Options topic.

• Using Demand Management

• Using Supply Planning

• Using Planning Central

Access Tasks as Quick Actions on a Home Page  
Some tasks that are accessible by using the tasks panel drawer in a supply chain planning work area are also available
from the home page as quick actions.

Click the Show More link on the home page to display all of the available quick actions for which you have access. You
don't have to first navigate to a supply chain planning work area to take an action. For example, use quick actions to
create a sourcing rule to purchase components from a new supplier without having to first select a planning work area.

In addition, there are work area-specific preferences that enable you to change your default page layout without having
to first launch the work area. These preferences are useful if you configured a content-heavy default page layout that's

3
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taking too long to load. In such cases, you can change your default page to a different page layout that opens quicker
and then edit the content-heavy page layout to make it perform better.

Here's some additional information about quick actions on a home page:

• You must have the applicable privileges associated with the task to see the task as a quick action on the
home page. Each quick action is secured by its related privilege or privileges. For example, if you have the
Manage Planning Sourcing privilege, then you should see the Manage Sourcing Rules task in the tasks panel
drawer in the work area. You should also see the task as a quick action on the Supply Chain Planning or Order
Management (in the case of Global Order Promising) home pages.

• You must have access to the work area to see the associated manage preferences quick actions. For example,
you must have access to the Supply Planning work area to see the Edit Supply Planning Preferences quick
action.

• You can't navigate to any other UI or open other tabs. When you click a quick access link, the UI opens in the
page, but you aren't in a work area.

• You can only return to the Supply Chain Planning home page when you close out of a task that you initiated
from the Supply Chain Planning home page.

Manage Page Layouts in Supply Chain Planning  
You can create and manage your page layouts. Use the Manage Page Layout action to modify the properties of your
existing page layouts.

You access a plan interface page by opening a plan from the Plans section of the Tasks pane in the Planning Central
work area.

This topic discusses how to do the following:

• Create a page layout

• Edit a page layout

• Manage a page layout

• Use the Plan Summary page layout

Create a Page Layout
Page layouts are reusable across plans, simulation sets, and plan inputs. You can create page layouts or copy and then
edit a page layout to create page layouts that are tailored to specific business needs.

To create a page layout:

1. In the Navigator, click the Planning Central work area link.
2. Click the Plans panel tab.
3. In the Plans panel drawer, expand Plans list.

Open a plan for which you want to create a page layout.
4. From the Page Layout drop-down list, click Create.
5. Specify the following details and click Save and Close:

◦ Enter a page layout name and description.

4
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◦ Select the access level as Public or Private.

- Select Public to make the plan accessible for all users.
- Select Private to restrict the plan accessible to you and to a list of users that you want to provide

access.

This creates an empty pane page layout.
6. Click the Change drop-down list and select any layout.

For example, select a two pane horizontal layout.
7. Click Open and select the pane and add the content using the Open Table, Graph, or Tile Set dialog.
8. Click Save Layout.

Edit a Page Layout
You can edit an existing page layout in two ways:

• Use the Save button to save the current page layout as it's currently displayed. For example, you can change
the current page layout from a one pane layout to a two pane layout. The next time that you use this page, the
layout appears as a two pane layout.

• You can also change a page layout by using the Manage action from the page layout drop-down list.

• You can't edit the predefined page layouts. You can copy and then edit the copy.

Manage a Page Layout
Use the Manage Page Layout to perform the following:

• Edit page layouts that you created. You can move one pane to another by using Manage page layouts. However,
if you're using a public page layout where you're not the owner, then you can't make changes to the layout. You
can only set the layout to your default layout.

• Change the layout that's used as your default layout when you initially open a plan, simulation set, or plan
inputs.

• Delete layouts that you created, but are no longer needed.

Use the Plan Summary Layout
Plan Summary is a predefined page layout that contains a set of tiles and high level graphics you can use to review the
business value of a plan.

Use the Plan Summary layout to do the following:

• Measure the performance of a plan.

• Review plan information through the individual Key Performance Indicators (KPIs).

• Perform plan analysis using the contextual based navigation.

• Copy and configure the components of the Plan Summary page layout for your specific needs.

The structure of the Plan Summary layout is a predefined set of tiles, also referred to as infotiles. Use tiles to view the
key metrics of your plan. You can further drill to the predefined analytics using the following tables or graphs:

• Revenue and margin

5
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• Forecast comparison

• Shipments forecast MAPE

• Inventory turns

• Demand at risk

• Rescheduling exceptions

• Utilization percentage

• Excess and obsolescence

Related Topics
• Overview of Supply Chain Planning Work Areas

Planners for Supply Chain Planning  

How You Define Planners for Supply Chain Planning  
Planners are the people in your organization who are responsible for a set of items, their inventory levels, supply and
demand, and so forth. For example, some typical titles of planners are Material Planner, Supply Chain Planner, and
Demand Planner.

All supply chain planning products use planners. You can define a specific person as a supply chain planner for
the Oracle Fusion source system or for any other source system. You can also associate a planner to an item at the
organization level.

Use the ScpPlannersImportTemplate.xlsm import template to create the CSV file for the Load Planning Data from Files
task for planners. You can also use the Manage Planners page to define supply chain planners for each source system.
Access the Manage Planners page from a Supply Chain Planning work area. Click the Tasks panel drawer and then click
the Manage Planners link.

For Oracle Fusion source systems, associate the employee identification number with the planner name because Oracle
Purchasing requires a valid employee identification number. When a planner releases a planned order, purchasing
checks the employee identification number before creating the purchase requisition.

For external source systems, determine if the employee identification number is required when releasing planned
orders. If required, use the Manage Planners page to associate the planner with their employee identification number.
Or, you can use the ScpPlannersImportTemplate.xlsm template to associate the employee identification number with
the planner name.

Use Oracle Product Hub to assign planners at the item-organization level. During data collections, the planning
processes collect the planner-item-organization assignment. Planners can then use the planner name to search the
data on most of the demand and supply planning pages.

Update Planner Data with New Employee Information  
If a planner's employee information (such as employee number, employee name, or email) changes, then that
information can be updated in the planners table in several ways.

6
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For external source systems, the collection process looks for the employee number in the data managed by Oracle
Fusion Cloud Human Capital Management.

• If the employee number is available in the employee data managed by Oracle Fusion Cloud Human Capital
Management, then its respective details (employee name and email) are extracted and populated in the
planners table.

• If the employee number isn’t available in the employee data managed by Oracle Fusion Cloud Human Capital
Management, then the collection process populates the employee number as provided in the comma-
separated values (CSV) file in the planners table.

Employee details are updatable only once during the initial collection process. For example, in the first collection run,
123456 is provided for an employee number. If you change the employee number to 100100 on the second collection
run, then the latest employee details aren’t reflected in the planners table. To change a planner’s employee information,
you can select a different employee by using the Manage Planners UI or you can mass update planners.

There are two methods to mass update planners. They both involve removing planner data and then collecting the
planner data again with any changes.

Method A

1. In one of the Supply Chain Planning work areas, select the Manage Planners task.
2. Delete all the planners who need their employee information updated.
3. Collect the planner data again by using the Load Planning Data from Files scheduled process.

Method B

Note:  Method B will purge planner data for all planners.

1. In the Scheduled Processes work area, click Schedule New Process.
2. In the Schedule New Process dialog box, search for and select the Purge Data Repository process.
3. In the Process Details dialog box:

a. Select the Source System.
b. Set Purge Global Entities = Yes.
c. In the Reference Data tab, move Planners to Selected Entities.
d. Click Submit.

The scheduled process purges the planner data.
4. Collect the planner data again by using the Load Planning Data from Files scheduled process.

How You Reassign Item Definitions to a Different Planner  
When a planner leaves an organization and that planner's items need to be reassigned, there are two ways you can
reassign the planner’s item definitions.

• Don't change the planner code but instead reassign the existing code to a different employee on the Manage
Planners page. In this case, there’s no need to change the planner codes for the item.

• Create one or more new planner codes (or use an existing one) and then either:
◦ Manually reassign the items to those one or more new planners individually.

◦ Use the item mass changes feature in the Product Information Management work area.

7



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 1
Overview

Overview of Supply Chain Planning Plan Types  
When you create a plan, plan type is the first choice that you make. After you run a plan, you can't edit the plan type.

Oracle Fusion Cloud Supply Chain Planning provides these types of plans, which you can create, edit, run, and so on,
depending on the work area that you have access to:

Plan Type Use This Plan Type Work Areas the Plan Type is Available

Demand Plan
 

• When you want to perform collaborative
and statistical demand forecasting.

• When you want to use a demand plan as
a demand schedule for a supply plan or
replenishment plan.

Demand and Supply Planning
 
Demand Management
 
Planning Central
 
Replenishment Planning
 

Supply Plan
 

When you want to generate a supply schedule.
 

Demand and Supply Planning
 
Planning Central
 
Supply Planning
 

Demand and Supply Plan
 

For an integrated demand and supply planning.
 

Demand and Supply Planning
 
Planning Central
 

Sales and Operations Plan
 
 

For aggregate planning.
 

Sales and Operations Planning
 

Backlog Plan
 

For backlog management.
 

Backlog Management
 

Replenishment Plan
 

For replenishment planning.
 

Replenishment Planning
 

Related Topics
• Actions to Manage Your Plans

Actions to Manage Your Plans  
The Actions menu on the Manage Plans and the Edit Plan pages are integrated plan management pages for all plan
types. When you open the Edit Plan page, note that only the plan name displays in the heading.

8
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Note:  Not all action options are available on both the Manage Plans page and the Edit Plan page. For example,
the Compare action is only available when you're in an open plan on the Edit Plan page. Also, not all action options
are available for all plan types or work areas. For example, the Planning Central work area doesn't include Archive,
Compare, or Copy to Simulation Set in the Actions menu.

The following table lists the available options in the Actions menu and the description of each option.

Action Description

Approve
 

Initiate and complete the approval process for a plan.
 
When you rerun the plan, the Approved status is removed from the Approval Status column.
 

Archive
 

Archive a plan.
 

Cancel Compare
 

Cancel the comparison of plan data.
 

Close
 

Close a loaded plan from memory. This option isn't available for Demand Plan types.
 

Compare
 

Compare plan data with another plan.
 

Copy to Simulation Set
 

Open the Copy to Simulation Set dialog box to copy plan data to an existing simulation set. Plan data
includes items, resource availability, bill of resources, and so on. This option is available only for Supply
Plan and Demand and Supply Plan types.
 

Create
 

Open the Create Plan dialog box where you can define the plan options for your new plan. Depending
on your plan type, define the scope, demand, safety stock, and supply options. The Safety Stock tab
isn't available for Sales and Operations Plan types.
 

Delete
 

Delete a plan and its archive versions. This irrevocable action purges the plan from memory and the
database.
 

Duplicate
 

Create a copy of an existing plan to leverage previously defined plans or to perform what-if simulation
analysis. You can decide whether you want to copy only the plan options or copy the plan options
including plan data.
 

Edit Plan Options
 

Open the Plan Options dialog box where you can edit your plan options. Depending on your plan type,
 you can change the scope, demand, safety stock, and supply options.
 

Export
 

Export the data from the Search Results table on the Manage Plans page to a spreadsheet.
 

Export Plan Data
 

Extract all multidimensional plan data from a plan into a set of files for offline reporting and analysis.
 

Load
 

Load the plan into memory. This option is available only for Supply Plan, Sales and Operations Plan,
 and Demand and Supply Plan types.
 

Manage Tables, Graphs, and Analysis Sets
 

Open the Manage Tables, Graphs, and Analysis Sets dialog box. You can search for tables, graphs, tiles,
 tile sets, and analysis sets and manage them.
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Action Description

 

Open
 

Open the Edit Plan page for an existing plan. Note that only the plan name displays in the page
heading.
 

Publish Order Forecast
 

Starts the Publish Order Forecast job. You can publish the order forecast without saving the plan to
the database. This option is available in the Actions menu on the Items, Supplies and Demands, and
Manage Plans page. This option is available only for Supply Plan, and Demand and Supply Plan types.
 

Publish Data
 

Export measure data from a plan based on a pivot table. You can export the data available in planning
data measures at any aggregation level based on an existing pivot table to a file in a comma delimited
(CSV) file format.
 

Release
 

Release the plan from the Supply Chain Planning work area to another plan execution system. This
option is available only for Supply Plan, and Demand and Supply Plan types.
 
The Release action integrates Supply Chain Planning with other plan execution systems by publishing
approved planning recommendations to execution systems. These plan recommendations can be in
the form of new planned orders, rescheduled existing supplies, and canceled existing supplies.
 

Request Approval
 

Request approval of a plan. This option is available only for Sales and Operations Plan types.
 

Reset Approval Status
 

Reset the approval status. This option isn't available for Supply Plan types.
 

Review Plan Messages
 

Open the Review Plan Messages tab to review the warning and error messages generated by the
planning processes, such as forecast generation and supply plan generation. You can also review the
recommendations to address the warning and error conditions.
 

Run
 

Run the plan and generate data.
 
When you click Run, the Run Plan dialog box opens. In the Run Plan dialog box, you can select data
refresh options, scope options, and demand and supply plan run options to generate planning data.
 

Save Plan to Database
 

Save the plan from the memory to the database.
 
The benefit of saving a plan to the database is that you can perform plan analysis without first loading
the plan. This option is available only for Supply Plan and Demand and Supply Plan types.
 

View Status Details
 

Open the Plan Status Details dialog box to view all of the actions performed by any user for the
selected plan. You can also export status details to a spreadsheet.
 

Related Topics
• Overview of Supply Chain Planning Plan Types
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Review Plan Messages  
In Supply Chain Planning, you can view root causes for technical plan process failures and the recommendations to fix
the issues.

After running a plan, open the Review Plan Messages table to review the warning and error messages generated by the
planning processes, such as forecast generation and supply plan generation. You can also review the recommendations
to address the warning and error conditions. Access the plan messages from either the Manage Plans page or the Edit
Plan page.

Plan messages are available for all plan types (for example, Supply Plan or Sales and Operations Plan types) and are
accessible from your respective Supply Chain Planning work area. There are three message types:

• Warning: Indicates an issue that can result in a future run plan error if not resolved.

• Error: Indicates a plan failure.

• Recommendation: Indicates a recommendation to resolve a plan failure or how to achieve a better run
performance.

If you repeatedly run the plan, the same messages appear on the Review Plan Messages tab for each plan run. The
messages will have different process identifiers and submission times.

You can delete plan messages based on the submission date. On the Review Plan Messages tab, click the Purge button.
In the Purge Messages dialog box, enter a submission date with one of the operators: Equals, Before, On or before, After,
On or after, Between, or Not between.

Use the following steps to open the Review Plan Messages table from the Manage Plans page:

1. From a Supply Chain Planning work area, click the Task drawer and select Manage Plans.
2. On the Manage Plans page, search for a plan.
3. In the Search Results region, select a plan.
4. Click the Actions list and then select Review Plan Messages to access the Review Plan Messages tab.

From the Search Results region, you can export the messages to a Microsoft Excel spreadsheet.
Use the following steps to open the Review Plan Messages table from the Edit Plans page:

1. From a Supply Chain Planning work area, click the Task drawer and select Manage Plans.
2. On the Manage Plans page, search for a plan.
3. In the Search Results region, select a plan. Next, click the Actions list and then select Open.
4. On the Edit Plan page, click Open.
5. In the Open Table, Graph, or Tile Set dialog box, search for the Review Plan Messages table. Select the table and

then click OK.
6. On the Review Plan Messages tab, click the Search button.
7. In the Search Results region, view the plan messages.

From the Search Results region, you can export the messages to a Microsoft Excel spreadsheet.

Related Topics
• Actions to Manage Your Plans

• Overview of Supply Chain Planning Plan Types
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Manage Notes in Supply Chain Planning  
Use Notes in Supply Chain Planning to document and communicate important information about your plan.

You can use notes to provide reasons for any changes made to a plan or to record decisions and assumptions that led to
those changes. You can save these notes for future reference or to provide details to other users. Participants in the plan
management process can annotate the data with notes to document changes and assumptions.

The notes functionality is available in the Demand Management, Supply Planning, Planning Central, and Sales and
Operations work areas. You can create notes for the following:

• Plans

• Planning level members, such as items, organization, and customers

• Planning combinations, such as a specific item-organization-date-measure combination

• Exceptions

When you create a note, you must specify a note type. Note types enable notes to be categorized, which you can use as
search criteria. The following lists the predefined note types:

• General

• Assumption

• Decision

• Issue

• Possibility

• Risk

• Reference

• Special

You also specify whether the note is private or public. Private notes are visible only to the user who created the note.
Public notes are visible to all the users with whom the object is associated.

From the Demand Management or the Sales and Operations work area, you can access the Notes table to display
planning level members for Product hierarchies. You can create a layout to view the Notes table as part of the layout
instead of as a dialog box. The Notes table is not available for Supply Planning or Planning Central.

Notes for Plans
You can create notes for plans. When you copy a plan, any notes associated with the plan are copied into the new plan.

To create a note for a plan, do the following:

1. Open the Plan Options page for your plan, and click the Manage Notes icon.
2. In the Manage Notes dialog box, click Actions > Create.
3. In the Create Note dialog box, add your notes.
4. Click OK.
5. Click Save and Close.
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Notes for Planning Level Members
You can associate notes with planning-level members, such as items, organizations, and customers. You can create
notes at any level of the hierarchy, such as on an individual item, on a brand, or on a product category.

Notes that you create on planning level members at lower levels in the hierarchy are visible when you open Manage
Notes from an aggregate level. Notes that you create on level members aren't plan-specific. This means that a note
associated with a level member is visible from any plan that contains that member.

To create a note on a level member, select the level member, and select Create Note from the Actions menu.

To view, edit, or delete an existing note, select the level member, and select Manage Notes from the Actions menu.

Notes for Planning Combinations
You can associate notes for the planning combinations, such as a specific item, organization, date, and measure
combination. Planning combinations appear as cells within a table.

You can create a note at any level; however, they are only visible at the level at which they are created. For example, if
you create a note at a brand, month, and measure combination, you can't view that note at the item, day, and measure
level.

If you copy a plan, then any plan-specific notes on planning combinations are also copied.

To create a note for the planning combinations, do the following:

1. Select the cell in the table.
2. Select Create Note from the Actions menu.
3. Add your notes.
4. Click Save and Close.

To view, edit or delete an existing note on a planning combination, do the following:

1. Select the Note icon from the table's cell level.
2. Select Manage Notes from the Actions menu.

Note:  If you create a note on a planning combination, and the associated measure is shared across plans, then the
note isn't plan-specific. In this case, the note is visible across all plans. If you create a note on a planning combination,
and the associated measure isn't shared across plans, then the note is plan-specific. In this case, the note is visible
within the plan in which you created it.

Notes for Exceptions
You can associate notes with exceptions. Notes on exceptions persist across plan runs. If an exception still exists after
a plan is run again, then any notes associated with the exception are retained. When an exception is resolved, the
exception is removed from the application. In that case, any notes associated with the exception are also removed.

To create notes for an exception, do the following:

1. Click the Note icon on the table row of the exception.
2. Add your notes.
3. Click Save and Close.
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Assign Time Zones to Locations in Supply Chain
Planning  
You can view supplies and demands in your Supply Chain Planning work area based on the time zone of the
organization, customer site, or supplier site.

In addition, you can calculate precise in-transit time because supply chain planning considers the time zone difference
between the source and destination locations.

The following points discuss in detail how you can collect time zone details and view orders depending on the locations'
time zone:

• Update Time Zones Using Data Collections

• Assign Time Zones in Supply Network Model

• Calculate In-Transit Time

• View Time Zones in Supplies and Demands

• Release to Execution

Update Time Zones Using Data Collections
Use data collections to update organizations, customer site, or supplier site time zones. You can update the time zone in
one of following three ways:

• Collect the organization's time zone from an Oracle Fusion source system.

• Collect time zones from an external source system using the organization, customer, and supplier import
templates.

• Update the time zone on Customers and Suppliers tabs of the Maintain Supply Network Model page.

If you are collecting from an Oracle Fusion source system, then you can update the organization's time zone using the
data collections method only. You cannot manually update the organization's time zone using the Maintain Supply
Network Model page in your Supply Chain Planning work area.

Assign Time Zones in Supply Network Model
Before collecting time zones or converting time zones to a local time, you must first assign time zones to organizations,
customer sites, and supplier sites. A new time zone field is available on the Organizations, Customers, and Suppliers tab
of the Maintain Supply Network Model page in your Supply Chain Planning work area.

You cannot collect customer site and supplier site time zones from an Oracle Fusion source system. To update the
customer site or supplier site time zone, use one of the following options:

• Use the customer or supplier import template to update the customer site or supplier site time zone. You can
also use this template if you are collecting from an external source system.

• Update the customer site and supplier site time zones directly in the Maintain Supply Network Model page.

When you recollect new customer and supplier data from an Oracle Fusion source system, the existing customer site
and supplier site time zone information is preserved. If you do not collect or update the customer site or supplier site

14



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 1
Overview

time zone, then planning calculations assume that the customer site or supplier site is located in the same time zone as
the organization that is associated with the demand or supply.

When you collect the supplies and demands, collections automatically convert the associated dates from the database
server time zone (Coordinated Universal Time or UTC) to the local time zone based on where the event takes place. In
addition, when you collect shipments and booking history from the Oracle Fusion source system for use in the Demand
Management or the Demand and Supply Planning work area, collections converts the historical data from the database
server time zone (UTC) to the associated organization's time zone.

Calculate In-Transit Time
When calculating in-transit times, supply chain planning considers the time zone difference between the shipping
and receiving locations. The following example shows how supply chain planning calculates the in-transit time. In this
example, the customer site is located in Sydney (UTC+10) and the shipping organization is in Sacramento, California
(UTC-8).

1. When planning collects a sales order with a requested arrival date of 25-March-2018, 21:00 (UTC) on the
database server, the requested arrival date is offset to the customer site's time zone. The customer site's time
zone is Sydney time zone (UTC+10 hours). The requested arrival date becomes 26-March-2018, 7:00 in plan
inputs (Sydney time zone).

2. When you run the plan with the Refresh with current data option, the sales order is included in the plan and
supply chain planning uses this date to calculate the scheduled ship date.

3. Consider the in-transit time for the selected shipping method (Air Freight) is 36 hours. Supply chain planning
first calculates the scheduled ship date as 25-March-2018, 19:00 hours (Sydney time) and then converts the
date to the Sacramento time. The product is shipped from Sacramento. The time zone difference is applied
to the scheduled ship date by subtracting 18 hours. The scheduled ship date becomes 25-March-2018, 1:00
Sacramento time, which is used to generate the pegged supplies.

4. After completing the calculations, supply chain planning moves all the dates to the end of the day. All dates
have the time stamp of 23:59:00. The time stamp is not available on the UI, but you can query the time stamp
from the planning database.

Supply chain planning makes similar in-transit calculations when shipping supplies from a supplier site to an
organization, or when transferring product from one organization to another.

View Time Zones in Supplies and Demands
On the Supplies and Demands page, use the following three columns to view supplies and demands in relation to the
time zone:

• Organization Time Zone

• Source Time Zone

• Destination Time Zone

The columns aren't included in any predefined table layout. Create a user-defined table layout and include these
columns in your table.

To display supply and demand measure values within a table such as Material Plan or Build Plan, supply chain planning
assigns the measure value to the day based on the organization's local time zone. The supply and demand measure
value is not assigned to a date based on a common time zone.
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Release to Execution
When you release orders that are marked for release to Oracle Fusion Cloud execution system, the release action offsets
the date from the location's time zone to the database server time zone (UTC).

For example, when you release a planned make order, supply chain planning converts the need-by date from the
organization's time zone to UTC.
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2  Enable Supply Chain Planning Features

How to Enable the Backlog Management Work Area  
To enable the Backlog Management work area, you must perform two setup tasks.

You can perform these tasks in any order, but you must do both before a user can access the work area.

• Opt in to the Order Backlog Management feature.

• Assign a job role to the applicable users.

Opt In to the Order Backlog Management Feature
You perform this opt in one time for your overall site.

• Offering: Supply Chain Planning

• Feature: Order Backlog Management

For instructions regarding how to opt in to features, refer to the Using Functional Setup Manager guide, Offering
Configuration chapter, in the Oracle Help Center.

Assign the Applicable Job Role to the Applicable Users
Assign a job role that includes the Monitor Backlog Management Work Area
(MSC_MONITOR_BACKLOG_MANAGEMENT_WORK_AREA_PRIV) privilege to the user associated with each of your
order backlog managers.

Other privileges you might also need to include in the job role:

• Create Backlog Plan (MSC_CREATE_BACKLOG_PLAN_PRIV)

• Manage Allocation Data (MSC_MANAGE_ALLOCATION_DATA_PRIV)

• Manage Allocation Attributes (MSC_MANAGE_ALLOCATION_ATTRIBUTES_PRIV)

For more information regarding how to assign job roles to users, refer to the Securing SCM guide, Role Provisioning
chapter, in the Oracle Help Center.

Related Topics
• Overview of Configuring Offerings

• Role Provisioning and Deprovisioning

• Configure Offerings
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How to Enable the Production Scheduling Work Area  
To enable the Production Scheduling work area, you must perform two setup tasks.

You can perform these tasks in any order, but you must do both before a user can access the work area.

• Opt in to the Production Scheduling feature

• Assign a job role to the applicable users

Opt In to the Production Scheduling Feature
You perform this opt in one time for your overall site.

• Offering: Supply Chain Planning

• Feature: Production Scheduling

For more information regarding how to opt in to features, refer to the Using Functional Setup Manager guide, Offering
Configuration chapter in the Oracle Help Center.

Assign the Applicable Job Role to the Applicable Users
Assign a job role that includes the View Production Schedule (MSC_VIEW_PRODUCTION_SCHEDULE_PRIV) privilege to
the user associated with each of your production schedulers.

For more information regarding how to assign job roles to users, refer to the Securing SCM guide, Role Provisioning
chapter in the Oracle Help Center.

Related Topics
• Role Provisioning and Deprovisioning

• Overview of Configuring Offerings

How to Enable the Replenishment Planning Work Area  
To enable the Replenishment Planning work area, you must perform two setup tasks.

You can perform these tasks in any order, but you must do both before a user can access the work area.

• Opt in to the Replenishment Planning feature

• Assign a job role to the applicable users

Opt In to the Replenishment Planning Feature
You perform this opt in one time for your overall site.

• Offering: Supply Chain Planning
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• Feature: Replenishment Planning

For more information regarding how to opt in to features, refer to the Using Functional Setup Manager guide, Offering
Configuration chapter in the Oracle Help Center.

Assign the Applicable Job Role to the Applicable Users
Assign a job role to the user associated with each of your replenishment planners that includes these privileges:

• Monitor Replenishment Planning Work Area
(MSC_MONITOR_REPLENISHMENT_PLANNING_WORK_AREA_PRIV)

• Manage Segments (MSC_MANAGE_SEGMENTS_PRIV)

For more information regarding how to assign job roles to users, refer to the Securing SCM guide, Role Provisioning
chapter in the Oracle Help Center.

Related Topics
• Role Provisioning and Deprovisioning

• Overview of Configuring Offerings

How to Enable Project-Specific Supply Planning  
How you enable project-specific supply planning depends on which scenario is applicable to your enterprise:

Scenario How to Enable

Your enterprise uses Oracle Supply Chain
Execution Cloud and has already opted in
to the Project-Driven Supply Chain feature.
 

Use one of the two offerings:
 

• Manufacturing and Supply Chain Materials Management

• Supply Chain Planning

Feature to enable: Plan Project-Specific Supply
 

Your enterprise uses Oracle Supply Chain
Execution Cloud and hasn't opted in to the
Project-Driven Supply Chain feature.
 

Use one of the two offerings:
 

• Manufacturing and Supply Chain Materials Management

• Supply Chain Planning

Features to enable:
 

• Project-Driven Supply Chain

• Plan Project-Specific Supply

Note:
Perform the setups that are required for the Project-Driven Supply Chain feature. For details, refer
to the Project-Driven Supply Chain chapter in the Implementing Manufacturing and Supply Chain
Materials Management guide.
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Scenario How to Enable

Your enterprise doesn't use Oracle Supply
Chain Execution Cloud.
 

Use the offering: Supply Chain Planning
 
Features to enable:
 

• Project-Driven Supply Chain

• Plan Project-Specific Supply

For detailed instructions on how to enable a feature, refer to the Configure Offerings topic in the Using Functional Setup
Manager guide.

Related Topics
• Configure Offerings

• How You Set Up Project-Driven Supply Chain
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3  Tables, Graphs, Analysis Sets, Tiles, and Tile
Sets

Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile
Sets  
You can configure the entities for tables, graphs, analysis sets, tiles (also referred to as infotiles), or tile sets by using the
Selector Tool.

You can also create and manage groups on the Selector Tool page and associate your tables and graphs with the group.
Navigate to the Selector Tool from an open plan or from the Actions menu on a table or graph toolbar.

To create a table, graph, analysis set, tile set, or tile, open the Selector Tool:

1. From an open plan, click Actions and then select Manage Tables, Graphs, and Analysis Sets.
2. In the Manage Tables, Graphs, and Analysis Sets dialog box, click Actions and then select Create.
3. Select one of the following to open the Selector Tool:

◦ Table

◦ Graph

◦ Analysis Set

◦ Tile Set

◦ Tile

4. Depending on your selection, the Selector Tool dialog box opens with the following tabs:

Tab Table Graph Analysis Set Tile

Measures
 

Yes
 

Yes
 

Yes
 

Yes
 

Hierarchies
 

Yes
 

Yes
 

No
 

Yes
 

Members
 

Yes
 

Yes
 

Yes
 

Yes
 

Measure Filters
 

Yes
 

Yes
 

No
 

Yes
 

Layout
 

Yes
 

Yes
 

No
 

Yes
 

Comparison Options
 

Yes
 

Yes
 

No
 

No
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Tab Table Graph Analysis Set Tile

Details
 

No
 

No
 

Yes
 

No
 

Note:  In the Selector Tool, the member values displayed are based on what's configured in the Member Identifier to
Display column on the Configure Planning Analytics page, Levels and Attributes tab. For example, for item, you can
configure your tables and graphs to show the item description instead of the item name, which is what also appears
when you're in the Selector Tool.

Measures
Use the Measures tab to select measures for a table or graph by moving measures from the Available Measures pane to
the Selected Measures pane. The measures that you select determine the content of the other tabs. The dimensions of
the measures determine the dimensions available on the Hierarchies tab and the dimension members on the Members
tab. For example, if a measure has the Product, Organization, and Time dimensions, those dimensions and their
hierarchies are visible on the other tabs. You can display the available measures by measure group or alphabetically by
using the Tree View or List View icon.

A measure is usually a named time series of values that represent the following at a particular intersection of the
Customer, Organization, Product, Supplier, and Resource dimensions:

• Historical performance (Bookings History). This measure isn't applicable for supply planning.

• Future projections (Shipments Forecast)

• A key performance indicator (KPI), such as Gross Margin Percentage, or a derived calculation, such as Projected
Available Balance

The planning process aggregates measure data from lower levels to higher levels or computes KPIs and derives
calculations from other values at the same level as needed. The planning process can also allocate or spread updates
made at an aggregate level to the affected cells at lower levels. Measures can be expressed in different units of measure,
such as inches, dollars, kilos, or liters. Depending on the context, you can display, update, or compare measures that are
in different units. The planning process can convert values among different units and among different currencies (for
monetary values).

When plans are archived, you can retrieve measures from the archived time periods and show them on a plan table. See
the View Planning Measures from Archived Time Periods topic to learn more. However, for Demand and Supply Plans,
the Demand History Buckets option determines whether the archived period is shown or not.

Note:  Text-based measures aren't supported in graphs and aren't displayed in the Available Measures pane on the
Measures tab of the Selector Tool during the configuration of graphs.

Hierarchies
Use the Hierarchies tab to select the dimensions, hierarchies, and levels to include or exclude in the table or graph.

For each dimension, select the hierarchies and levels that you want to include in the graph or table. Checking the
box in the Display column includes that dimension in the table or graph. Expand the dimension to view the available
hierarchies. Expand the hierarchy to view the levels of the hierarchy. Checking a level includes it in the table or graph. If
multiple levels are checked, the top level is displayed in the table or graph by default. Each level in the table or graph can
be expanded until all checked levels are visible. The Show Unassociated check box determines whether the measure
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values that aren't associated with a specific dimension in the table or graph are hidden or displayed. For example, a
table could include Shipments Forecast and Net Resource Availability. Shipments Forecast has product, organization,
and time as dimensions. Net Resource Availability has resource, organization, and time as dimensions. With the check
box selected, the Resource column displays the word Unassociated when you view Shipments Forecast rows.

For a demand plan that uses a hybrid time hierarchy, only the hierarchy that was selected as the planning calendar on
the Scope tab on the Plan Options page is displayed for the Time dimension along with the other, corresponding hybrid
time hierarchies that were created when the Create Hybrid Time Hierarchies scheduled process was run.

You can select the levels of only one hybrid time hierarchy.

Members
You use the Members tab to manually select dimension members by moving members from the Available Members
pane to the Selected Members pane. If no selections are made on this tab for a dimension, the graph or table displays
the dimension starting at the top level checked on the Hierarchies tab. For example, if you selected the Gregorian
Calendar hierarchy with Quarter and Month on the Hierarchies tab, the graph or table displays all quarters; each quarter
has an icon to drill to its months.

Measure Filters
Use the Measure Filters tab to filter results based on measure values across dimension member combinations that meet
the criteria that you specify. You can filter your measure data to return only multidimensional combinations that meet
the measure criteria for selected dimensions of the measure.

Note:  The measures listed are those that are of data type number, currency, or percent that aren't dimensioned by
time. Measures that are time dimensioned and of data types date and text are excluded from the list. If the table
contains any configure-to-order (CTO) measures, then the Measure Filters tab is disabled.

When you create or edit a table or graph, make your selections on the Measures, Hierarchies, and Members tabs. Next,
on the Measure Filters tab, specify the measure criteria to apply across combinations of your dimension selections, such
as Item and Customer. The table or graph displays only the combinations that meet your specified measure criteria.

You can compare measures to fixed values or to other measures, and you can apply multiple measure conditions:

• Multiple AND conditions are allowed

• Multiple OR conditions are allowed

• Combinations of AND and OR conditions aren't allowed.

You can apply the measure filters in a table or graph to a linked table or graph in the Manage Links dialog box. On the To
Table, Graph, or Layout tab, select the Include measure filters check box. This check box is enabled after you select the
Pass user-specified parameters check box.

Layout
Use the Layout tab to format tables, graphs, or tiles. The following are the key layout options for tables, graphs, and
tiles:

• Tables: Use table layout options to drag and drop dimensions to change the table layout and configure drill
settings.

• Graphs: Use the graph layout options to select the graph type and the formatting options for the graph type
that you select. In the Filters section, you can specify the filter criteria that you want displayed in the graph.
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• Tiles: Use the tile layout options to select the graph type and add tables and graphs to the content area of the
tile you're creating.

Comparison Options
The Comparison Options tab is applicable only for tables and graphs. On the Comparison Options tab, you can compare
your current plan with an archived version or an alternate plan. Use this tab to compare how specific measures have
varied over time. The Comparison Options tab contains three sections: Waterfall Analysis, Trend Analysis, and Plan
Comparison.

Note:   The Comparison Options tab isn't available in the Oracle Planning Central work area.

• In the Waterfall Analysis section, you can compare selected measures in a table or a graph with an archived
plan.

Select the Use MAPE calculations check box if you have scheduled your plan archival process. Mean absolute
percentage error (MAPE) calculations use the system administrator archive and not an on-demand archive.

In the Measure Archives to Use list, select one or more archives to reference. The number of weeks refers to
how long ago the archive was created. The planning process uses the following logic for when to use an archive:

◦ Match the exact dates. If multiple versions of an archive are within the waterfall time frame, use the
closest, most current version.

◦ If no match is found on the exact date, use the match closest inside the range, which is +3/-3 days of a
selected weekly waterfall time frame, or +15/-15 days for a monthly archive.

◦ If no match is found within +3/-3 days of a selected weekly waterfall time frame, or +15/-15 days for a
monthly archive, then nothing is returned.

For example, if you select 4 weeks ago, the planning process searches for the archive 4 weeks prior to today's
date, for instance, March 6. If your archives are stored at the month level and nothing is found on February 5,
the planning process searches for the most recent archive within +15/-15 days.

• In the Trend Analysis section, you can provide the number of archives that you want to reference. The planning
process selects the latest archives. For example, you have five archives, where number five is the latest archive
and you have selected 3 in the Number of Previous Versions to Include field. The planning process selects
archive number five, four, and three for the comparison. The difference between Waterfall Analysis and Trend
Analysis is that in Waterfall Analysis you can choose an archive created within each selected time frame that
you want to compare. In Trend Analysis, you can select the number of archives that you want to compare, and
only the latest archives are used for comparison.

• The Plan Comparison section pertains to both archived plans and alternate plans that you consider for
comparison. You can select the type of difference to display in tables or graphs for comparison. For example,
you can choose to view the difference in percentage or absolute percentage.

Related Topics
• Use Advanced Options in the Selector Tool

• Use Table Drilling

• Create a Tile in Supply Chain Planning

• Create a Tile Set in Supply Chain Planning

• How You Use Levels and Attributes in Supply Chain Planning
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Use Advanced Options in the Selector Tool  
You can use the Advanced Filter dialog box to filter data and select specific members that fulfill some criteria.

Click the Advanced Filter icon on the Members tab to open the Advanced Filter dialog box. You can use the following
filter criteria tools:

• Levels: Select by level. Select the members in a level such as Customer Site for the Customer dimension, or
Period for the Time dimension.

• Family: Select parent or child of a dimension member. Select members based on a parent or child relationship,
such as selecting the Days in a Week.

• Attributes: Select based on name. For example, select members based on items whose name contains
Economy.

• Measure Criteria: Select based on meeting measure criteria. Select members that meet the criteria, such as
Products for which the gross margin is greater than a particular value.

• Time Range: Select a range of dates. Select time periods based on a range, a start date, or today's date.

The advanced filter criteria tools are used in conjunction with action keywords to refine selections. The following four
actions determine how to apply the criteria:

• Replace with: Replace the current selection, if any, with members meeting the criteria.

• Add: Add members meeting the criteria to the current selection.

• Keep: Keep only the members in the current selection that meet the criteria.

• Remove: Remove the members from the current selection that meet the criteria.

You can apply filter criteria tools sequentially to refine your selection. For example, select all the items for a category,
and then keep the top 10 items based on sales.

Click the Show Results button to see the filtered list of members based on the criteria. Removed members are shown
below the filtered list. You have the option of accepting the results or resetting to the previous members.

When you accept the results, the criteria used to retrieve the accepted members appear in the Criteria Steps section on
the tab. These criteria are evaluated when the table or graph is displayed. You can remove criteria steps.

Note:  Ensure that the criteria steps defined for each dimension are needed and relevant. Remove all unwanted or
unnecessary criteria steps so that your table or graph displays the correct information.

• To remove a step, click the Remove icon in a row.

• To view the result of removing a criteria, click Show Criteria Change.

• To accept the Show Criteria Change results, click Accept and then OK.

• To make the change permanent, click Save or Save and Close.

• To view the results without making the change permanent, click Apply and Close.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets
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Create an Analysis Set  
An analysis set is a named set of criteria that can contain selected measures, dimension members, or both measures
and dimension members.

Use the Apply Analysis Set and Save as Analysis Set buttons to apply previously made selections or to save the
selections made in the Selector Tool.

Applying an existing analysis set to a table or graph is a quick way to select the measures and dimension members that
you frequently use.

You have the option to save measures and dimension members. You can save the dimension members as a list or as
a script. For example, you can select the top 10 items based on sales for January. If saved as a list, the same 10 items
would always be displayed in the table or graph, regardless of the current month. However, as sales data changes over
time, you would want to see the top items in the current month in your table or graph. To accomplish this, save the
dimension members in a script that would evaluate the criteria whenever the table or graph is displayed.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Create a Tile in Supply Chain Planning  
A tile is a component used to present a graphical summary of the data. A tile is also referred to as an infotile in Oracle
Fusion Cloud Supply Chain Planning.

Each tile has one or more related tables or graphs with predefined drill-to actions to display additional information
about that key performance indicator (KPI).

To create a tile:

1. In a Supply Chain Planning work area, open a plan.
2. Click Actions > Manage Tables, Graphs, and Analysis Sets.
3. In the Manage Tables, Graphs, and Analysis Sets dialog box, in the Search Results region, click Actions and then

select Create > Tile.
4. In the Selector Tool - Create Tile dialog box, on the Measures tab, select the required measures and move them

from the Available Measures pane to the Selected Measures pane.
5. On the Hierarchies tab, select the dimensions, hierarchies, and levels to include or exclude in the tile.
6. On the Members tab, select the required dimension members and move them from the Available Members

pane to the Selected Members pane. If you don't select a dimension member, the tile displays the dimension
starting at the top level selected in the Hierarchies tab.

7. On the Layout tab, do the following:

◦ Select the graph type for the infotile.

◦ Expand the Content Area panel, and then click the Add Row button. You can add up to four tables or
graphs to display them in the content area for that tile.

8. Click Save and Close.
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Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Create a Tile Set in Supply Chain Planning

Set Measure Targets for Use in Tiles  
You can enter or update goals for a measure to track performance against the goals. Set targets by editing a measure
and updating the measure goal. When the plan summary displays the measure, the goal or target for that measure is
visible.

You can define goals only for measures that are of data type currency, number, or percent.

For global goals, you can provide a low range or a high range. The ranges are displayed on the user interface when you
view a measure in comparison with its goal. Global goals are measure level parameters and aren't defined specifically for
a data population.

To enter or update measure target goals, follow these steps:

1. Open the Manage Planning Measures page:

a. In a Supply Chain Planning work area, open a plan.
b. On the Edit Plan page, click the Tasks panel tab.
c. In the Tasks panel drawer, click the Manage Planning Measures link.

2. On the Manage Planning Measures page, select the measure and click the Edit icon.
3. On the Edit Measure page, navigate to the Advanced tab, Goals subtab.
4. In the Goals subtab, select whether low values or high values are better.

For example, high values are better for Gross Margin, but low values are better for Demand at Risk.
5. In the Global Goals section, provide a low range or a high range.
6. Click Save and Close.

Create a Tile Set in Supply Chain Planning  
You can create a tile set to group individual tiles.

Tiles are also referred to as infotiles in Oracle Supply Chain Planning. Creating tile sets can be useful in cases where you
want to track various metrics on a single page. You can add tile sets to a pane in a page layout.

Tip:  Before you create a tile set, check whether you need to create the tiles that you will be adding to the tile set.

To create a tile set:

1. In a Supply Chain Planning work area, open a plan.
2. Click Actions > Manage Table, Graphs, and Analysis Sets.
3. On the Search table toolbar, from the Actions menu, select Create > Tile Set.
4. In the Selector Tool - Create Tile Set dialog box, specify these details:
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◦ Enter a name and description for the tile set.

◦ Select a group for the tile set.

5. From the Available Tiles pane, select the tiles to include in the tile set and move them to the Selected Tiles pane.
6. Click Save and Close.

Related Topics
• Create a Tile in Supply Chain Planning

Use Table Drilling  
After you create a table, use drilling in the table to expand and collapse the levels within the hierarchy by which you can
view different levels of aggregation.

When viewing a table or graph, the dimensions and hierarchies selected on the Hierarchies tab are visible. The top
selected level is visible; use drilling to view lower levels.

To drill across hierarchies or dimensions, the levels must be adjacent. Drilling is automatically available for the levels
within the predefined hierarchies, but you can also configure drill pairs to drill across hierarchies or dimensions.

To display a table showing Final Shipments History with the ability to drill from customer to item, the columns Customer
and Item must be adjacent:

1. On the Layout tab, use the View menu to select Configure Drill Settings.
2. Click the Add Row  icon to add a new drill pair.
3. In the Drill From column, select Customer. In the Drill To column, select Item.

With this configuration, you can view the shipments history values by item for each customer in the table.

Note:  Drilling is only active between the adjacent levels in the table.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Use Advanced Options in the Selector Tool

• Use Table Linking

Use Table Linking  
You can link a table or graph to another table or graph or a page layout by selecting Manage Links from the Actions
menu on the toolbar.

The links enable you to pass the context of a table or graph to another table or graph or a page layout.

In the Manage Links dialog box, you can use these tabs:

• To Table, Graph, or Page Layout: Create a link to another table or graph or to a page layout.
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• From Table or Graph: Link to the open table or graph from another table or graph.

Use the Add Row icon to add a link.

• Enable dynamic linking: Select this check box to enable dynamic linking. If selected, then the target table or
graph is refreshed when the selections in the source table or graph change.

• Pass highlighted selections and selected members: If you select this option, then whatever you highlight in
the current table or graph is passed as the context along with the filters in the Selector Tool to the target table,
graph, or page layout.

• Pass user-specified parameters: If you select this option, then you can select the level and context of the source
table or graph to pass as link parameters to the target table, graph, or page layout.

• Include measure filters: Select this check box to apply measure filters that you defined on the Measure Filters
tab in the Selector Tool to a linked table or graph. This check box is enabled:

◦ After you select the Pass user-specified parameters option.

◦ If the From Table contains measure filters.

Note:  If you're linking a summary table that lists configure-to-order (CTO) items to a detail table that lists the CTO
items along with their option classes and options, select the Pass highlighted selections and selected members
option.

After you define the link, use the Drill icon on the toolbar to drill to the linked table, graph, or page layout.

Dynamic linking is supported only from a pivot table displaying measures to another pivot table or graph displaying
measures. It's not supported from the entity tables such as items, item structures, and so on.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Use Advanced Options in the Selector Tool

• Use Table Drilling

Link to External Systems  

Overview of Linking to External Systems with Context  
You can link a table or graph in your Oracle Fusion Cloud Supply Chain Planning module to supporting information in an
external system to gain a deep understanding of your data and aid your decision making.

Note:  You can create links to external systems from only pivot tables and not regular tables.

When you're analyzing data in a table or graph in the Demand Management, Demand and Supply Planning, Planning
Central, Replenishment Planning, Sales and Operations Planning, or Supply Planning work area, you might need to view
additional information that resides in an external system. Using this functionality, you can link your table or graph to an
object in the external system. For example, you can link your table or graph to a predefined or user-defined analysis or
report in Oracle Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher.
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While specifying the link, you can pass dimensions, levels, and level members in your table or graph along with the link
so that it opens the external system object with the context of the data in your table or graph. You can also pass the plan
name or ID along with the link to restrict the displayed data in OTBI, Analytics Cloud, or Analytics Publisher.

How You Set Up Links to External Systems
To set up links to an external system, you must do the following:

1. Set up the application integration for the external system.
2. Configure a table or graph with a link to the external system.

Additional Points About Links to External Systems
Note these additional points about links to external systems:

• Any link that you create from a table or graph to an external system is tied to that table or graph and your user
credentials.

When you log on to an Oracle Supply Chain Planning module, you can use the link in the table or graph from
all plans that include the table or graph. Others with the required role and privileges can also use the link in the
table or graph from all plans that include the table or graph.

However, you can edit or delete the link only if you created it.

• During data migration, when you export a table that contains a link to an external system and subsequently
import the table, the link is available in the table.

• When you duplicate the table or graph, you can choose to include the links to the external system in the copy.

Related Topics
• Structure of a Link to an External System

• Set Up the Application Integration for an External System

• Create a Link to an External System

• Use a Link to an External System

Structure of a Link to an External System  
This topic explains the structure of a link to an external system from a table or graph in an Oracle Fusion Cloud Supply
Chain Planning module. The topic also provides examples of such links.

A link to an external system consists of these parts:

• Base URL: You supply this part of the link in the Full URL field on the Create Application Integration page. The
link must include the host information and can also include the port details. This part is displayed in the Base
URL field in the Create Link to External System dialog box and can't be modified.

For example, the base URL could be as follows: https://...oracle.com
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• Page or report path: You supply this part of the link in the Page Path field in the Create Link to External System
dialog box. This path is appended to the base URL and contains details about the page or report in the external
system to which you're creating the link.

Along with the page path, you can also pass the name or ID of the Oracle Supply Chain Planning plan you're
in to restrict the displayed information in the linked, predefined or user-defined analysis or report in Oracle
Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher.

An example of the report path without the plan context is as follows: /analytics/saw.dll?
Dashboard&PortalPath=%2Fshared%2FCustom%2FSCP%2FSalesOrders_Booking_Rpt
%2FSO_Bookings_Rpt4&Page=page%201&Action=Navigate, where SO_Bookings_Rpt4 is the name of the
report.

An example of the report path with the plan context is as follows: /analytics/saw.dll?Dashboard&PortalPath=
%2Fshared%2FCustom%2FSCP%2FPL_OTBI_report2%2FDM_Plan_Details&Page=page
%201&Action=Navigate&col3=%22Plan%22.%22Plan%20Name%22&val3=#PlanName#

You must provide the plan context only when the page or report in the external system has a filter for the plan
context, and you want to review the information by plans. For example, a link to an external web page doesn't
require plan context.

• Linking parameters: You supply this part of the link in the Linking Parameters section on the To External
System tab in the Manage Links dialog box. The linking parameters contain details about the dimensions,
levels, and level members in the table or graph. This information is appended to a combination of a base URL
and page or report path and opens the external system object with the context of the data in your table or
graph.

For example, the linking parameters could be as follows: "Distributed Order Orchestration - Fulfillment Lines
Real Time"."Order Header Detail"."Ordered Date"&op1=bet&val1=timestamp '#StartDate# 00:00:00' timestamp
'#EndDate# 23:59:00'

After the link is encoded, when it's accessed from a table or graph, and the runtime values for the contextual
parameters are passed, the linking parameters would look as follows: &col1=%22Distributed%20Order
%20Orchestration%20-%20Fulfillment%20Lines%20Real%20Time%22.%22Order%20Header%20Detail%22.
%22Ordered%20Date%22&op1=bet&val1=%22timestamp%20%272022-06-01%2000%3A00%3A00%27%22+
%22timestamp%20%272022-06-30%2000%3A00%3A00%27%22

The resulting, concatenated link opens the external system object with the context of the selected data in your table or
graph.

Example of a Link to an OTBI or Analytics Cloud Report or Analysis
You must meet these requirements while creating a link from a table or graph to a report or analysis in OTBI or Analytics
Cloud:

• In the Parameter field on the To External System tab in the Manage Links dialog box, enter the names in the
col<number> format. For example, the parameter names could be col1, col2, col3, and so on.

• In the Value field on the To External System tab, enter the names for the subject areas and columns to which
you're passing tokens, and enclose this information in quotation marks.

Then, enter the tokens in the val<number> =<token name> format. The token names mustn't be within double
quotation marks.

If required, include operators, which you must preface in the op<number> format (for example, op2=bet).
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This example depicts how the linking parameters would look before the link is encoded:

col1="Submitted Date (Booked Date) - UTC"."Submitted Date"&val1=timestamp '#MemberName# 00:00:00'

col2="Fulfillment Line Details"."Demand Class Meaning"&val2=#MemberName#

col3="Product"."Product Number"&val3=#MemberName#

col4="Planning Date 1"."Period Start Date"&op4=bet&val4=#StartDate# #EndDate#

After the link is encoded, the linking parameters would look as follows: &col1=%22Submitted+Date+%28Booked
+Date%29+-+UTC%22.%22Submitted+Date%22&val1=%22timestamp+%27<date from selection context>
+00%3A00%3A00%27%22&col2=%22Fulfillment+Line+Details%22.%22Demand+Class+Meaning%22&val2=
%22<member name from selection context>%22&col3=%22Product%22.%22Product+Number%22&val3=
%22<member name from selection context>%22&col4=%22Planning%20Date%201%22.%22Period%20Start%20Date
%22&op4=bet&val4=%22<start date from selection context>%22+%22<end date from selection context>%22

Note:  Ensure that the numbers for the parameter, value, and operator names are the same for a combination of a
parameter and value.

Example of a Link to an Analytics Publisher Report
You must meet these requirements while creating a link from a table or graph to a report in Analytics Publisher:

• In the Parameter field on the To External System tab in the Manage Links dialog box, enter the access
parameters for Analytics Publisher.

Some examples of access parameters are as follows:

◦ _paramsp_itemname

◦ _paramsp_fromdate

◦ _paramsp_todate

◦ _paramsp_customer

• In the Value field on the To External System tab, enter the token names.

Match the access parameters for Analytics Publisher to the available token names for links to external systems.

This example depicts how the linking parameters would look before the link is encoded:

_paramsp_itemname=#MemberName#

_paramsp_fromdate=#StartDate#

_paramsp_todate=#EndDate#

_paramsp_customer=#MemberName#

After the link is encoded, the linking parameters would look as follows: &_paramsp_itemname=<member name from
selection context>&_paramsp_fromdate=<start date from selection context>&_paramsp_todate=<end date from
selection context>&_paramsp_customer=<member name from selection context>
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Related Topics
• Overview of Linking to External Systems with Context

• Set Up the Application Integration for an External System

• Create a Link to an External System

• Use a Link to an External System

Set Up the Application Integration for an External System  
You must specify the application integration for an external system before you can link to it from a table or graph in your
Oracle Fusion Cloud Supply Chain Planning module. You must have administrator privileges to perform this procedure.

1. In the Setup and Maintenance work area, on the Tasks panel tab, select Manage Setup Content.
The Manage Setup Content page opens.

2. Under Topology Definition, select Manage Integration of Additional Applications.
The Manage Integration of Additional Applications page opens.

3. Click Actions > Create.
The Create Application Integration page opens.

4. In Application Name, enter the name of the external system.

Note:  The name must start with "SCP_EXT_LINK_". Otherwise, you can't select the application integration in the
Application Name field in the Create Link to External System dialog box.

5. In Full URL, enter the base portion of the URL to the external system. The URL must include the host information
and can also include the port details. The page path and linking parameters are appended as context to this URL.
For example, you can enter "https://...oracle.com" in the field.
When you create the link for the table or graph, this URL is displayed in the Base URL field in the Create Link to
External System dialog box and can't be modified. The information you specify in the Page Path field in the dialog
box and on the To External System tab in the Manage Links dialog box is appended to this base URL.

6. In Partner Name, enter any value you require.
7. In Security Policy, ensure that None is selected.
8. Click Save and Close.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Edit the Application Integration for an External System

• Create a Link to an External System

33



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 3
Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Edit the Application Integration for an External System  
You can edit or delete the application integration for an external system to which you're linking tables or graphs from
your Oracle Fusion Cloud Supply Chain Planning module. You must have administrator privileges to perform this
procedure.

1. In the Setup and Maintenance work area, on the Tasks panel tab, select Manage Setup Content.
The Manage Setup Content page opens.

2. Under Topology Definition, select Manage Integration of Additional Applications.
The Manage Integration of Additional Applications page opens.

3. Search for your application integration, and select it.
4. Do one of the following:

◦ To edit the application integration, follow these steps:
i. Click Actions > Edit.

The Edit Application Integration page opens.

You can't edit the application and partner names.
ii. Edit the value in the Full URL field.

The URL must include the host information and can also include the port details.
iii. In Security Policy, ensure that None is selected.
iv. Click Save and Close.

◦ To delete the application integration, follow these steps:
i. Click Actions > Delete.

A dialog box is displayed.
ii. Click Yes.

What to do next
After editing or deleting the application integration, you must modify the external links that use the application
integration. Otherwise, the external links won't work.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Set Up the Application Integration for an External System

• Create a Link to an External System

• Edit a Link to an External System

Create a Link to an External System  
After specifying an external system's application integration, you can create a link to the system from a table or graph in
your Oracle Fusion Cloud Supply Chain Planning module by supplying the page path and linking parameters.
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Tip:  To create a link to a page or report in an external system, examine the target URL. Then, enter the required
information for the base URL, page or report path, and linking parameters so that the rendered link meets the external
system's requirements. Use supported tokens instead of actual values in the linking parameters to pass contextual
values during runtime.

1. In your table or graph in the Demand Management, Demand and Supply Planning, Planning Central, Replenishment
Planning, Sales and Operations Planning, or Supply Planning work area, click Actions > Manage Links.
The Manage Links dialog box opens.

Note:  You can create links to external systems from only pivot tables and not regular tables.

2. On the To External System tab, click the Create icon.
The Create Link to External System dialog box opens.

3. In Name, enter a unique name for the combination of the application integration and page path for which you're
creating the link.
This name is displayed when you click Actions > Drill To > External Links in the table or graph.

4. In Description, enter the link description.
5. In Application Name, select the application integration that was previously specified on the Create Application

Integration page.
The base URL that you entered on the page is displayed in the Base URL field and can't be changed.

Tip:  You can reuse the same application integration in links to external systems so long as you don't need to
change the base URL.

6. In Page Path, enter the path to the page or report in the external system.

To restrict the displayed data to the current plan in the linked, predefined or user-defined analysis or report in Oracle
Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher, specify these
tokens:

◦ #PlanName#: Append this token to the page path to pass the name of the current plan in the Oracle Supply
Chain Planning work area.

◦ #PlanId#: Append this token to the page path to pass the ID of the current plan in the Oracle Supply Chain
Planning work area.

Ensure that the path doesn't contain the host or port details because they're derived from the application
integration.

7. Click OK.
The link is displayed on the To External System tab in the Manage Links dialog box.

8. With the link name selected, in the Linking Parameters section, click the Add Row icon.
A blank row appears in the Linking Parameters section.
You can save the link only when it has at least one valid combination of a parameter and value.

9. In Dimension, select a dimension that you want to pass along with the link to the external system.
The available dimensions are those selected for the table or graph on the Hierarchies tab in the Selector Tool.
The Level field becomes available.

If you selected the Time dimension, the Date Format field is enabled.

10.Select a level that you want to pass along with the link to the external system.
The available levels are those selected for the table or graph on the Hierarchies tab in the Selector Tool.

35



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 3
Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

11. In Parameter, enter a unique name for the parameter through which you want to pass the dimension, level, and
value to the external system page or report.
Ensure that the name meets the external system's nomenclature rules for parameters.

12. In Value, enter a token for passing the selected level member in the table or graph. The information in this field
should be in the decoded format for URLs.
You can specify these tokens:

◦ #MemberName#: Use this token to pass the member name. For example, the token can contain the name
of the item, organization, customer, week, or month.

◦ #MemberId#: Use this token to pass the internal ID of the member.

◦ #StartDate#: Use this token to pass the start date of the time bucket for your selection in the table or
graph.

◦ #EndDate#: Use this token to pass the end date of the time bucket for your selection in the table or graph.

When you use the link, the tokens are replaced by the actual values for your selection in the table or graph.

13. In Date Format, select the format in which the value for the Time dimension must be passed to the external system
page or report.

14.Configure additional parameters by repeating Steps 8 through 13.
15. Click Save and Close.

The link is added to the External Links group that's available when you click Actions > Drill To > External Links for
the table or graph.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Edit a Link to an External System

• Set Up the Application Integration for an External System

Edit a Link to an External System  
You can edit or delete a link to an external system from a report or graph in your Oracle Fusion Cloud Supply Chain
Planning module.

Before you start
You can edit or delete the link only if you created it.

Here's what to do

1. In your table or graph in the Demand Management, Demand or Supply Planning, Planning Central, Replenishment
Planning, Sales and Operations Planning, or Supply Planning work area, click Actions > Manage Links.
The Manage Links dialog box opens.

2. On the To External System tab, select the link that you want to edit.
The linking parameters for the link are displayed.
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3. To edit the link, follow these steps:
a. Click the Edit icon on the toolbar above the link name.

The Edit Link to External System dialog box opens.
b. Change the name, description, application integration, and page path.

Ensure that the link name is unique.
The value in the Base URL field is populated according to the selected application integration and can't be
changed.

Ensure that the page path doesn't contain the host or port details because they're derived from the
application integration.

c. Click OK.
4. To edit the linking parameters, follow these steps:

◦ To add a parameter, click the Add Row icon for the linking parameters.

In the new row that appears, specify the dimension, level, parameter name, value, and date format.

Ensure that the parameter name is unique.

◦ To modify a parameter, click it, and change the values for the dimension, level, parameter name, value, and
date format.

Ensure that the parameter name is unique.

◦ To delete a parameter, select it, and click the Delete icon for the linking parameters.

You can delete the parameter only if at least one valid combination of a parameter and value remains for
the link.

5. To delete the link, follow these steps:
a. Click the Delete icon on the toolbar above the link name.
b. Click Yes in the displayed dialog box.

6. Click Save and Close.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Create a Link to an External System

• Set Up the Application Integration for an External System

Use a Link to an External System  
This topic explains how you can use a link to an external system from a table or graph in your Oracle Fusion Cloud
Supply Chain Planning module.
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Prerequisites for Using Links to an External System
You can use the link to an external system if these conditions are met:

• You must have the privileges to view the data in the external system.

Otherwise, you can't view the data in the external system when you click the link.

• The application integration for the external link must exist.

• You can open the link only if it has at least one valid combination of a parameter and value.

After the link is configured, if the underlying table or graph is edited, and dimensions are removed, the affected
combinations of parameters and values are automatically deleted. Consequently, the link might become invalid.

• You must select a cell, column, or row of the table or an area of the graph before clicking the link.

• You must select values for the levels that have been configured in the link.

Otherwise, an error message is displayed.

Tip:  To identify the required levels, examine the configuration of the link on the To External System tab in the
Manage Links dialog box.

• You must select a value that's associated with or assigned to a level and then click the link.

• You can select multiple values only if they're contiguous.

1. In the Demand Management, Demand and Supply Planning, Planning Central, Replenishment Planning, Sales and
Operations Planning, or Supply Planning work area, open your table or graph.

2. Make a selection.
3. Click Actions > Drill To > External Links, and select a link.

The external link opens on a new tab of your web browser.

What to do next
Note these additional points while using links to external systems:

• Every time you click the link to the external system, it opens on a new tab of your web browser.

• After clicking the link, if you change the selection in your table or graph, the data on the page or report in the
external system isn't refreshed.

You must click the link anew to view the external system data on a new tab of your web browser according to
the changed context in your table or graph.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Set Up the Application Integration for an External System

• Create a Link to an External System
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Graph Layout Options  
The graph layout option is available in the Selector Tool dialog box, on the Layout tab when you create or edit a graph
using the Manage Tables, Graphs, and Analysis Sets option.

In the Graph Layout Options section, you can define the type of graph and configure layouts and the dimension of axes.
In the Filters section you can specify the filter criteria that you want displayed in the graph.

The layout options vary according to the type of graph. For example, a bar graph has X and Y-axis layout options
whereas a Pie chart doesn't have any X or Y axis. General Options is common for all layout options and includes generic
information for a graph such as title, font, and position of the graph. You can also preview a graph from the Layout
tab before you save the graph. In the preview mode, you can format measures, change the layout, and modify the drill
settings.

The following types of graphs are available:

• X and Y axes graphs

◦ Vertical bar

◦ Horizontal bar

◦ Line graph

• X and Y axes graphs with additional parameters

◦ Area graph

◦ Combination graph

◦ Bubble graph

• Pie graph

• Sunburst graph and Treemap graph

• Funnel graph and Radar graph

• Gauge graph

For graphs with an X, Y, or dual Y axes, you can select up to three entities in total: measures are mandatory, and you can
select one or two dimension hierarchies. A dual Y-axis graph requires the measures on the Y axis. You must select one
measure for the Y2 axis in the Y2 -Axis panel. Axis title and tick label rotation options are available for all axes. Tick label
options are also available for the X-axis. For example, skip a certain number of labels for legibility. The Formatting panel
contains visual effect options for the graph, such as 2 dimension or 3 dimension, and bar or line style.

Here's additional information about some of the graphs:

Graph Type Comments

Combination
 

A Combination graph includes an area, bar, and line. The measures represented by each of these
options are specified in the Formatting panel.
 

Bubble
 

A Bubble graph requires selections for the bubble component of the graph in addition to the X and Y
axes options. Select the hierarchy and the bubble sizing measure in the Bubble panel.
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Graph Type Comments

Sunburst
 

A Sunburst graph is comprised of rings. Select the number of rings to display. Each ring represents
a level of the hierarchy. The rings are divided into sectors for each member of the level. The size and
color of the sector is determined by the measures selected for those options.
 

Treemap
 

A Treemap graph is comprised of rectangles. Select the depth of the rectangles for a hierarchy. The
rectangles for a level of the hierarchy are nested within the parent level rectangle. The size and color of
the rectangles are determined by the measures selected for those options.
 

Funnel and Radar
 

Funnel and Radar graphs require only a hierarchy and measure selection.
 

Gauge
 

Gauge graphs, which are used in infotiles, require measures with goals defined.
 

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Configure Filters for Graphs  
You can configure graphs that specify filter criteria that enables you to page through data in the graph by one or more
hierarchy levels. For example, you might want to filter for product category when analyzing your plan.

After you analyze one product category, you can select another product category to review from the filter bar above the
graph. Specify the filter criteria in the Selector Tool dialog box, Layout tab, Filters section.

The hierarchy levels that you selected on the Hierarchies tab are available to select as filters. You can select one or more
levels of a hierarchy for a filter. However, if you also selected the hierarchy for the X-axis or Y-axis, then you can't select
all of the hierarchy levels for filters. At least one hierarchy level must be used for the X-axis or Y-axis.

The members of the levels that you select are used to filter the data shown in your graph. You can select the level
member value of interest from a set of values in the filter bar above the graph.

Let's work through an example of setting up filters for a graph:

1. In the Selector Tool dialog box, on the Hierarchies tab, select the Time, Product, Organization, and Customer
dimensions.

All levels are selected by default. The levels that you select for the dimensions become visible in the Filters
section.

2. On the Layout tab, in the X-Axis section, select Gregorian Calendar.
3. In the Y-Axis section select the Product hierarchy and Measures.
4. In the Filters section, select to filter on Quarter and Zone.
5. Click Apply and Close.

When you display the graph, you can see the Quarter and Zone filters above the graph. Months are on the X-Axis and
items are on the Y-Axis. The months shown are determined by the selected quarter, based on the Gregorian calendar.
So, for Quarter 1, the graph displays January, February, and March on the X-Axis. Levels not selected on the axes or in
the Filters section, such as Organization, aren't included in the graph.
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For the X-axis and Y-axis, if one or more levels are selected on the Hierarchies tab, such as Year, Quarter, and Month,
the graph displays with the highest level. You can drill to lower levels that aren't selected in the Filters section.

Note:  Filters for graphs are similar to filters for tables. However, you can't drag and drop filters onto the X-axis or Y-
axis of the graph.

Set Your Axis Scale  
Use Axis Scale Options to refine your scale.

• Axis Scale Options applies to the Y axis and Y2 axis and you can use it only for bar, line, area, or combination
graphs.

• Minimum is the starting point of the axis.

• Maximum is the ending point of the axis.

• Increment is the increase in values between maximum and minimum.

Specify the behavior.

• Automatic. Promising automatically adjusts the scale for the Y axis and the Y2 axis.

• Manual. You have to manually specify the scale for the Y axis and the Y2 axis.

Assume you set Minimum to 3, Maximum to 10, and Increment to 2. The graph will display 3 as the lowest value, 10 as
the highest value, and 5, 7, and 9 as incremental values for the Y axis or the Y2 axis.

Format How Measures Are Displayed in Tables and
Graphs  
You can make measure formatting changes to tables and graphs to reflect your individual preferences or requirements
for how you want the tables or graphs to display.

For example, you can override the name of a measure and its measure of unit. When you format measures in a planning
table or graph, your measure formatting can't be overridden by another user. Any formatting changes done by other
users, including the owner of the table or graph, don't take precedence over your changes. To make user-specific
measure formatting changes, open a table or graph and select View > Format Measures to open the Format Measures
dialog box.

If you're the owner of the table or graph, then your formatting changes are visible to you and to other users who haven't
defined their own formatting. These changes can include overriding the measure label, applying conditional formatting,
or changing the unit of measure that you want displayed in your table or graph. Formatting changes made by others
won't impact your specific measure formatting.

If you're not the owner of the table or graph, then any measure formatting you define takes precedence over the
owner's measure formatting and is visible only to you. For example, if you change decimal positions to 0 (zero) for all
measures in a table, you're the only user that sees those changes. When you save your measure formatting, you'll no
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longer see future formatting changes made by the table or graph owner. For example, if you save measure formatting
and then the table owner adds conditional formatting on a measure, you won't see that conditional formatting.

Use the Reset to Default button in the Format Measures dialog box to remove your user-specific measure formatting.

• If you're the owner of the table or graph, then your measure formatting is removed. Any measure formatting by
non-owners won't be impacted.

• If you're not the owner of the table or graph, then all of your measure formatting is removed. The table or graph
displays all existing measure formatting saved by the owner of the table or graph.

If you duplicate a measure, the duplicated measure is added as the last measure in the table. For example, you can
duplicate a measure with a different currency or unit of measure. If you're the owner of the table, the duplicated
measure is visible to you and to other users who haven't defined their own formatting. If you're not the owner of the
table, the duplicated measure is visible only to you. You can reorder the duplicated measures, but you must save your
layout to preserve the measure order.

You can make user-specific measure formatting changes in the following work areas:

• Demand Management

• Demand and Supply Planning

• Planning Central

• Replenishment Planning

• Sales and Operations Planning

• Supply Planning

Configure Color by Measure to Display in Graphs  
You can configure the color by measure and then use that color for every graph that the measure appears in. For
example, always show Final Shipments Forecast in blue and Final Sales Forecast in green.

This functionality is helpful when viewing a specific measure in several graphs in one layout. You can also specify the
color to display for a measure in a specific graph.

The configure color by measure to display in graphs functionality is available in the following Supply Chain Planning
work areas:

• Demand Management

• Demand and Supply Planning

• Planning Central

• Replenishment Planning

• Sales and Operations Planning

• Supply Planning

Configure Color by Measure for All Graphs
When you configure graphs, you can have a consistent color for a specific measure in your graphs. For example, you
have multiple graphs that display the forecast. You can quickly identify the forecast measure by using the same color for
the measure in all of your graphs.
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To configure a graph color for a specific measure to use in all graphs, select the graph color for the measure in the Edit
Measure dialog box.

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel drawer, click the Manage Planning Measures link in the Configuration section.
3. On the Manage Planning Measures page, select a measure, click Actions, and then select Edit.
4. In the Edit Measure dialog box, click the Advanced tab.
5. In the Properties subtab, click the Graph Color drop down arrow and select a color to use for the measure in all

graphs.

Configure Color by Measure for a Specific Graph
You can configure a color for a measure in a specific graph, which overrides the color configured for the measure in the
Edit Measure dialog box.

To configure a graph color for a specific measure for a specific graph, select the graph color for the measure in the
Format Measures dialog box.

1. In an open table or graph, click View and then select Format Measures.
2. In the Format Measures dialog box, in the Graph Color column, click the drop down arrow and select a color to

use.

Automatically Assign Graph Color
If a graph color is already configured for a measure for all graphs, but you want the graph color assigned automatically
for that measure for a specific graph, then select the Assign Graph Color Automatically check box on the Format
Measures page.

1. In an open table or graph, click View and then select Format Measures.
2. In the Format Measures dialog box, in the Assign Graph Color Automatically column, click the check box in

the row for the measure.

Tips and Considerations for Assigning Graph Colors to Measures
The following is additional information about the configure color by measure to display in graphs functionality:

• Duplicate Colors: You might have a situation where you have two measures with the same color in a graph.
If the color you configure for a measure is the same color as one of the colors automatically assigned to a
measure in a specific graph, then you must select a different color for the measure you're configuring.

• Predefined measures: By default, predefined measures initially don't have a graph color selected on the
Manage Planning Measures page. In this case, when used in a graph the planning process automatically
assigns a color for the measure.

• Bar, line, and radar graphs: Only measures located in the Y-axis display the graph color settings. This is only in
case the measures aren't combined with one or more hierarchies in the Y-axis. Automatically-assigned colors
are used in this case.

• Plan Comparison: When comparing plans, the configured measure color in the graph is honored only for the
measure itself. The measures that represent the compared plans get an automatically-assigned color, selected
randomly by the planning process.

• Archive Plan: When archiving a plan and using Waterfall Analysis or Trend Analysis graphs, the configured
measure color is honored only for the measure itself. The measures that represent the archive get an
automatically-assigned color, selected randomly by the planning process.
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• Export and Import: When exporting and importing measure settings from one environment to another, the
export and import keeps the graph color settings in Manage Planning Measures and Format Measures.

• Graph Types: The graph color functionality isn't available for the following graph types:

◦ Pie

◦ Sunburst

◦ Treemap

◦ Gauge

◦ Funnel

◦ Bubble

Related Topics
• How You Manage Planning Measures

• Predefined Measures in Supply Chain Planning

How You Can Edit Measures at an Aggregate Time Level 

This topic explains how you can edit measures at an aggregate time level in tables in demand, demand and supply,
replenishment, sales and operations, and supply plans.

You can edit a measure with an edit range that's set to only the future at an aggregate time level in only those table cells
that don't contain time periods for the past. For example, if the current date is Wednesday, August 11, 2021, and you're
viewing the data at a weekly level, you can't edit the forecast for the week starting August 09 or any aggregate level
such as the year 2021. Instead, you can edit the forecasts for the days of August 11 and later as well as the weeks starting
August 16 and later.

You can edit a measure with an edit range that's set to only the history at an aggregate time level in only those table
cells that don't contain time periods for the future. For example, if the current date is Wednesday, August 11, 2021, and
you're viewing the data at a weekly level, you can't edit the history for the year 2021. Instead, you can edit the history for
the days before August 11 and the weeks starting August 02 and earlier.

The same behavior applies when you summarize data across time in tables. For example, the Adjusted Shipments
Forecast measure has an edit range that's set to only the future. If you summarize the measure by time in a table, the
summarized value is editable only if all the included values are editable. If the current month is August 2021, you can't
edit the summary for 2021, but you can edit the summary for 2022.

The same behavior also applies to plans with aggregate planning time levels. For example, if the planning time level
is week, and the current month is August 2021, you can't edit measures at aggregate time levels such as quarter and
year if the underlying weeks aren't editable. Instead, you can view the data at the weekly level to update the values for
editable weeks.

The edit ranges of measures are enforced at the Hybrid time level in demand plans. For example, for the week starting
Monday, December 31, 2029, there are two Hybrid time level members, one starting on Monday, December 31, 2029,
and the other starting on Tuesday, January 01, 2030. If the forecasting time level is set to week, and the plan is run on
Wednesday, January 02, the forecast would begin on Monday, December 31. But, the first Hybrid time level member is
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before the plan run date and considered as history. Therefore, any measure with an edit range that's set to the future,
such as Adjusted Shipments Forecast, isn't editable for the first Hybrid time level member.

Thus, data integrity is ensured because you can't make changes to the values of measures outside of their configured
edit ranges.

How Time Periods Are Calculated and Displayed in
Tables, Graphs, and the Selector Tool  
This topic explains how time periods are calculated and displayed in tables, graphs, and the Selector Tool in the Demand
Management, Demand and Supply Planning, Planning Central, Replenishment Planning, and Sales and Operations
Planning work areas.

Settings That Affect the Calculation and Display of Time Periods
The following settings affect the calculation and display of time periods in tables and graphs for a demand, demand and
supply, replenishment planning, or sales and operations plan:

• The value in the Demand History Days field in the Demand: Advanced Options dialog box that you open from
the Demand tab on the Plan Options page

• The selection on the Time Range tab of the Advanced Filter dialog box that's available on the Members tab in
the Selector Tool

• The selected members for the Time dimension on the Members tab in the Selector Tool

• Shared measures

The following settings affect the calculation and display of available members for the Time dimension on the Members
tab in the Selector Tool for the plan:

• The value in the Demand History Days field

• The planning horizon

The default value for the Demand History Days field is 182 days.

Note:  If data isn't available, blank rows are displayed for the time periods included in tables and graphs. Also, the
amount of historical data that's considered for the forecast depends on the value in the Historical Buckets field on
the Demand tab on the Plan Options page.

How Time Periods Are Calculated and Displayed
Time periods are calculated and displayed in a table or graph as follows:

• If you select members of the Time dimension on the Members tab in the Selector Tool, they're displayed in the
table or graph.

• If you don't select members of the Time dimension on the Members tab in the Selector Tool, time periods are
displayed as follows:
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◦ If the table or graph has shared measures, time periods are displayed for the combination of the demand
history days and planning horizon.

◦ If the table or graph doesn't have shared measures, time periods are displayed for the planning horizon.

The display of available members for the Time dimension on the Members tab in the Selector Tool is for the
combination of the demand history days and planning horizon.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Manage Measure Data in Tables  

Features You Use to Edit Measure Data  
While working in one of the Supply Chain Planning work areas, you might be editing measure data in a table.

The following table provides a list of some features you can use when doing so, and where each feature is located:

Feature Location

Configure Summaries
 

View menu
 

Data Calculation Options
 

Table toolbar
 

Lock and Unlock Cells
 

If at least one summary is configured:
 
Action menu, table toolbar, right-click in cell
 

Related Topics
• Manage Data Calculations When Editing Measure Data in a Supply Chain Planning Table

• How You Lock Cells While Editing Measure Data or Allocating Values in a Table

Copy and Paste Values in Tables  
Use the Copy and Paste options in the Actions menu for a table to copy cell values and paste them in editable cells. You
can also copy values from one table to another within the same plan.

Pasting overwrites any existing values, and any measures that are dependent on the overwritten measures are
recalculated.
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If your data is in an external application such as Microsoft Excel, you can use the following procedure to copy and paste
your data:

1. Copy your data from the external application.
2. In your work area table, click the first editable cell from which you want the data to be pasted, and select

Actions > Paste from Clipboard. The Paste from Clipboard dialog box opens.
3. Press Ctrl+V to paste your content in the dialog box. You can further edit your data in the dialog box.
4. Click Paste and Close. The copied content is pasted into the editable cells of the table.

Alternatively, you can export your table data to Microsoft Excel using the Export icon, work with your data in that
application, copy your data, and bring it back into your table by using the Paste from Clipboard option. To copy data
between plans, export the table data to Microsoft Excel from one plan, and use the Paste from Clipboard option to
copy data into the other plan.

Note:  You can paste values in only those cells that fall within your plan horizon. The number and orientation of the
cells from which data is copied and the cells into which data is pasted must match. Only numeric data can be copied
and pasted. Non-editable cells that are within a range of editable cells are skipped when data is pasted, and a warning
is displayed to this effect.

Related Topics
• How can I highlight editable cells in a table?

Data Calculation Options  
When you are working in a Supply Chain Planning work area, you might be editing measure data in tables that include
dependent measures.

You can use the Data Calculation Options menu to determine when calculations are performed. You access the Data
Calculation Options menu from the table toolbar for the table you are editing.

The Data Calculation Options choices are:

• Enable Automatic Calculations

• Calculate Now

Enable Automatic Calculations
When you edit data with this option selected, each time you edit a value, calculations are performed for any applicable
summaries or other measures that include an expression. The Enable Automatic Calculations choice is the default
selection.

Calculate Now
To choose when calculations are performed, you must first deselect Enable Automatic Calculations. When you make
edits with the Enable Automatic Calculations choice deselected, you must click the Calculate Now choice when you want
calculations to be performed. Calculations will be performed for all edits made since the last time calculations were
performed.

If you save a table after making edits, any needed calculations will be performed, but you must refresh the table to see
the results.
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How You Lock Cells While Editing Measure Data or Allocating
Values in a Table  
When you are working in a Supply Chain Planning work area, you might be editing measure data in a table.

When you have locked cells, edits, including those that spread allocations to other cells, do not change locked cells.

Note:  You must configure at least one summary to enable the Lock and Unlock actions.

Lock cells by performing one of the following:

• Click the Lock action in the Actions menu.

• Click the Lock icon on the table toolbar.

• Right-click in an editable cell.

Related Topics
• How do I enable the Lock and Unlock actions for a table while editing measure data in a Supply Chain Planning

table?

• Can I unlock all cells at once while editing measure data in a Supply Chain Planning table?

How do I enable the Lock and Unlock actions for a table when
editing measure data?  
Configure at least one summary to enable the Lock and Unlock actions. Use the View menu for the table to configure
summaries.

Can I unlock all cells at once when editing measure data in a table?
 
Yes, you can unlock all cells at once by using the Unlock All action from the Actions menu. This action is available in the
Actions menu only if you have configured summaries.

How can I highlight editable cells in a table?  
In the View menu for a table, select Highlight Editable Cells to provide a background color for cells that contain editable
measures.
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Do note that any conditional formatting that has been applied to an editable measure or a table takes precedence over
the highlight color. You can choose to save your page layout with this setting.
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4  Planning Exceptions

Exceptions in Plans  

Overview of Plan Exceptions  
Exceptions are a key element to evaluate and improve your plan in Oracle Fusion Cloud Supply Chain Planning.

After you run a plan, view the exceptions to understand the quality of the plan and to get visibility of key problem areas.
You can focus on key exceptions to understand their root causes. From the exceptions tables, you can drill down to
other plan views for more details into the problem areas. After taking actions to resolve exceptions, run the plan again
to evaluate whether the plan is now acceptable.

Oracle provides several predefined exceptions that the Oracle Supply Chain Planning processes compute after you run
a plan. View these exceptions to identify problem areas in the plan that might need your attention. To view a list of the
exceptions, open your plan and then open the Exceptions table.

The exception types and their calculation logic are predefined. However, to ensure that only significant deviations
are highlighted, you can edit the conditions under which the exceptions are generated. You control which exceptions
to calculate for a plan by specifying an exception set on the Plan Options page. View the metrics associated with
exceptions, such as by count or by quantity, in tables or graphs at different hierarchical levels.

You can also create user-defined exceptions based on specific conditions in the supply chain that you want to identify.
Base these user-defined exceptions on your business requirements and focus on specific areas to improve your supply
chain planning capabilities. Use the Configure Exception task to create a user-defined exception.

Note:  You can't create user-defined exceptions in the Planning Central work area. Also, there are no predefined
exceptions for Replenishment Planning.

Plan Exception Types
From within your plan, you can open the Exceptions table to view the exceptions grouped within the following folders:

Exception Folder Accessible from these work areas:

Demand Planning Exceptions
 

Demand Management
 
Planning Central
 
Sales and Operations Planning
 

Replenishment Planning Exceptions
 

Replenishment Planning (user-defined exceptions only)
 

Sales and Operations Planning Exceptions
 

Sales and Operations Planning
 

Supply Planning Exceptions
 

Supply Planning
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Exception Folder Accessible from these work areas:

Planning Central
 

Views for Multiple Exceptions
 

Supply Planning
 
Planning Central
 

Exception Categories
There are two categories of exceptions:

• Measure-based exceptions

• Order-based exceptions

Oracle provides several predefined exceptions for most Supply Chain Planning modules. You can also create user-
defined exceptions from most Supply Chain Planning work areas. The following table lists the Supply Chain Planning
modules, the type of exception, whether the product has predefined exceptions, and whether you can create user-
defined exceptions.

Module Type of Exception Predefined Exceptions User-Defined Exceptions

Oracle Demand Management
 

Measure-based exceptions
 

Yes
 

Yes
 

Oracle Planning Central
 

Measure-based exceptions
 

Yes
 

No
 

Oracle Replenishment Planning
 

Measure-based exceptions
 

No
 

Yes
 

Oracle Sales and Operations
Planning
 

Measure-based exceptions
 

Yes
 

Yes
 

Oracle Supply Planning
(constrained and unconstrained)
 

Order-based exceptions
 
Measure-based exceptions
 

Yes
 

Yes
 

View Exceptions for Your Plan
When you open the exceptions table, the number of exception records generated are shown after the exception name,
in parentheses. Clicking the exception name displays a table with details of the exception. From the Exceptions tab, you
can:

• Search for exceptions for a specific item and organization within a specified date range

• Search for measure-based exceptions based on various attributes such as Planner, Planner Description,
Catalog, and Category. If a measure-based exception is created at the category level, categories specific to the
catalog selected in the hierarchy parameter appear in search results. If a measure-based exception is created
at the Item level, then you can filter the records based on Item, Catalog, and Category Level attributes. If a
measure-based exception is created with no product dimension, then you can filter the records based on other
attributes except Item and Category level
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• Save the search criteria for future searches

• Export the table to a spreadsheet, rearrange columns, and perform other standard table actions on the table

Predefined views within the Views for Multiple Exceptions folder enable you to view all exceptions for an item, resource,
or supplier within the same table. The folder is available only in the Supply Planning and Planning Central work areas.

From tables that show exception data, you can navigate in context to other plan data. This navigation capability is useful
when, for example, you view exceptions for an item and you also want to see its supply or resource availability.

Related Topics
• How You Edit Exceptions

• Configure Exception Thresholds

• Overview of Exceptions and Exception Sets

• Overview of Predefined Planning Exceptions

• Overview of User-Defined Exceptions

Configure Exception Thresholds  
You can control the number of exceptions that your plan generates by changing the levels at which an exception is
computed and its threshold value. A higher threshold value typically results in fewer exceptions.

To configure exception thresholds, do the following:

1. From a Supply Chain Planning work area, select the Configure Exceptions task.
2. On the Configure Exceptions page, select an exception.
3. Click Actions and then select Edit.

Demand planning, replenishment planning, and sales and operations planning exceptions are measure-based
exceptions. A base measure forms the foundation for these exceptions.

In the Planning Central work area, you can't change the base measure, but you can edit the level at which the exception
is computed and its threshold value.

Most supply planning exception calculations are for a specific order and aren't associated with a base measure. For
these types of exceptions, select the fact associated with the exception and modify the condition that specifies when to
generate the exception. Think of a fact as an attribute of the exception. Typical facts are quantity and value.

Related Topics
• How You Edit Exceptions

• Overview of Plan Exceptions

• Overview of User-Defined Exceptions

Create Tables and Graphs for Exceptions  
Create a table or graph for plan exceptions based on their measures, such as number of exceptions generated and the
quantity associated with the exception.
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Create a Table for Exceptions

1. In a Supply Chain Planning work area, open a plan.
2. Click the Actions button and select Manage Tables, Graphs, and Analysis Sets from the list.
3. In the Manage Tables, Graphs, Analysis Sets dialog box, click Actions. Next, select Create and then select Table.
4. On the Create Table page, do the following:

◦ Enter a name for your table.

◦ Select a group.

◦ Enter a description.

◦ Select the type of access (public or private).

5. On the Measures tab, do the following:
a. In the Available Measures section, expand the Overall Plan Health folder.

The Overall Plan Health folder contains the measures associated with exceptions.
b. Select the exception facts that you want to view in the table.

6. On the Hierarchies tab, include the Exception Type hierarchy.
7. On the Members tab, select the exception types to display in the table.
8. Click Save and Close.

Create a Graph for Exceptions

1. In a Supply Chain Planning work area, open a plan.
2. Click the Actions button and select Manage Tables, Graphs, and Analysis Sets from the list.
3. In the Manage Tables, Graphs, Analysis Sets dialog box, click Actions. Next, select Create and then select

Graph.
4. On the Create Graph page, do the following:

◦ Enter a name for your graph.

◦ Select a group.

◦ Enter a description.

◦ Select the type of access (public or private).

5. On the Measures tab, do the following:
a. In the Available Measures section, expand the Overall Plan Health folder.

The Overall Plan Health folder contains the measures associated with exceptions.
b. Select the exception facts that you want to view in the graph.

6. On the Hierarchies tab, include the Exception Type hierarchy.
7. On the Members tab, select the exception types to display in the graph.
8. On the Layout tab, do the following:

a. In the Graph Layout Options section, select a type of graph.
b. Configure your graph in the horizontal panels below the Graph Layout Options.

The horizontal panels below the Graph Layout Options section vary, depending on the type of graph that
you select. For example, if you select Pie Graph for your graph type, the horizontal panels include General
Options, Pie Slice, and Formatting.

54



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 4
Planning Exceptions

9. Click Save and Close.

Related Topics
• How You Edit Exceptions

• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Overview of Plan Exceptions

How Exceptions are Calculated in Supply Plans That Use
Telescoping Time Buckets  
When you use telescoping buckets in your supply plan, the planning process handles exception messages based on
what you specify for Planning Time Buckets in plan options.

This table explains how the planning process calculates exceptions when you use time buckets larger than days.

Exception Type Calculation Logic

• Orders To Be Rescheduled In

• Orders To Be Rescheduled Out

The planning process generates reschedule exceptions only if the supply orders get rescheduled
across planning time buckets.
 
Any reschedules of the order due dates within a planning time bucket doesn't trigger reschedule
exceptions.
 

• Late Supply Pegged to Sales Order

• Late Supply Pegged to Forecast

• Late Replenishment for Sales Order

• Late Replenishment for Forecast

The planning process generates late supply or late replenishment exceptions only if the supply and
demand dates are in different planning time buckets.
 
For example, a sales order suggested due date is in the middle of a week. The suggested due date of
the supply is the last working day of the week. In this case, the planning process doesn't generate a
Late Supply Pegged to Sales Order or Late Replenishment for Sales Order exception.
 
However, suppose you have a sales order suggested due date in the middle of a week. The suggested
due date of the supply is the first working day of the following week. In this case, the planning process
generates an exception.
 

• Items with a Shortage

• Items Below Safety Stock

The planning process creates an exception only if the available quantity is less than the required
quantity at the planning time bucket level. The planning process evaluates item shortages by using the
projected available balance on the last day of the planning time bucket.
 
The planning process ignores daily fluctuations within a planning time bucket.
 

• Items with Excess Inventory The planning process creates an exception only if the available quantity is greater than the required
quantity at the planning time bucket level. The planning process evaluates item excesses by using the
projected available balance on the last day of the planning time bucket.
 
The planning process ignores daily fluctuations within a planning time bucket.
 

• Resource Overloaded

• Supplier Capacity Overloaded

The planning process creates an exception only if the available capacity is less than the required
capacity at the planning time bucket level.
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Exception Type Calculation Logic

For example, in a weekly bucket, a resource can have some overloads within the week on a few days. As
long as the available capacity at the week level is more than the required capacity, the planning process
doesn't generate a resource overload exception.
 
The planning process ignores daily fluctuations within a planning time bucket.
 

Exceptions and Exception Sets  

Overview of Exceptions and Exception Sets  
On the Configure Exceptions page, you can select an exception and edit the thresholds for reporting. You can configure
only those exceptions that are relevant to your Supply Chain Planning work area.

On the Configure Exception Sets page, you can restrict the exceptions that are computed as part of the plan run. You
can also control the organizations, item categories, time period, and so on for which to compute exceptions.

A defined exception set is associated with a plan. The plan evaluates the exceptions using the filters associated with the
exception set. Select the exception set to use during the plan run on the Plan Options page, Scope tab.

Related Topics
• How You Edit Exceptions

• Configure Exception Sets

• Set Filters on Planning Dimensions for Exceptions

• Define Scope Plan Options

• Overview of User-Defined Exceptions

How You Edit Exceptions  
To edit exception parameters, select an exception on the Configure Exceptions page. You can configure only those
exceptions that are relevant to your Supply Chain Planning work area.

In the Edit Exception dialog box, there is an area for General Properties and Exception Detail. Depending on the Supply
Chain Planning work area that you're in, you can see the following tabs in the Exception Detail section:

• Demand Management work area: Level, Threshold, and Notification

• Planning Central work area: Level and Threshold

• Replenishment Planning work area: Level, Threshold, and Notification

• Sales and Operations work area: Level, Threshold, and Notification

• Supply Planning work area: Level, Threshold, and Notification
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You can edit Level and Threshold only for those exceptions whose basis is Measure. For exceptions whose basis is
Order, you can edit only the Threshold.

Level Tab
On the Level tab, the dimensions for the exception are derived from the base measure. You can edit the default values
for hierarchy and level. You can also enable and disable each of the available dimensions to control the level that the
exception is evaluated at.

Note:  Ensure that the selected hierarchy is in the dimension catalog for the plan. The Configure Exceptions task is
outside of the plan context. It's possible to select a product hierarchy that's not used in the plan's dimension catalog,
in which case the plan exceptions output won't display data for items.

Threshold Tab
On the Threshold tab, the base measure used in the exception is compared to either a value or another measure. If
the threshold is specified in terms of a value, the value is interpreted in terms of the data type of the base measure. To
ensure that exceptions return meaningful values, set the threshold to an appropriately high or low value.

Notifications Tab
On the Notification tab, set up notification rules for exceptions. Configure exceptions to trigger notifications to specific
users or roles. In the Details section specify the entity and condition for notifications. Notifications are automatically
sent at the end of the plan run.

Related Topics
• Configure Exception Sets

• Set Filters on Planning Dimensions for Exceptions

• Overview of Predefined Planning Exceptions

• Overview of User-Defined Exceptions

• Overview of Plan Exceptions

Configure Exception Sets  
Use the Configure Exception Sets page to create, modify, or copy an exception set.

The set of exceptions and their scope that's calculated by the plan is configured on the Create or Edit Exception Set
page. When creating an exception set, you must first specify the exceptions to include in the set, which can include
user-defined exceptions. User-defined exceptions aren't available in Planning Central.

The exception set also enables you to restrict the generation of exceptions for specific organizations, categories,
suppliers, and customers. You can then point to the exception set on the Plan Options page for a plan.

When you create a constrained supply plan in Supply Planning, the Exception Set plan option defaults to the
Constrained Supply Planning Default exception set.

Use the following steps to configure exception sets:

1. In a Supply Chain Planning work area, click the Tasks panel drawer and click Configure Exception Sets.
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2. On the Configure Exception Sets page, select an existing exception set. Next, click Actions and select
Duplicate.

3. In the Create Exception Sets dialog box:

a. Expand the group of exceptions in the Available Exceptions section. For example, expand Supply
Planning Exceptions.

b. Select the exception from the Available Exceptions section and move it to the Selected Exceptions
section.

4. Click Save and Close to return to your plan.

Note:  To generate exceptions, you must include the exception set in the plan options for your plan.

Related Topics
• How You Edit Exceptions

• Set Filters on Planning Dimensions for Exceptions

• Overview of Plan Exceptions

• Overview of Predefined Planning Exceptions

• Overview of User-Defined Exceptions

Set Filters on Planning Dimensions for Exceptions  
After selecting available exceptions for an exception set to use in a plan, you can add filters on some of the key planning
dimensions. The levels on which you can define filters are organizations, categories, suppliers, and customers.

On the Configure Exception Sets page, Filters tab, select one or more organizations, suppliers, categories, and
customers in each of the tables for which to generate exceptions. If you don't specify a filter for a level, you will generate
exceptions for all records in that level. For example, if you don't specify an organization, exceptions will be generated for
all planning organizations when you run the plan. If any of the organizations, categories, suppliers, or customers in the
exception set aren't available in the plan, they will be ignored.

In the Exception Cutoff Days field, specify the number of calendar days, starting from the plan start date, from which
to generate the exceptions. If this field is blank, exceptions will be generated for the full planning horizon.

Related Topics
• Configure Exception Sets

• How You Edit Exceptions

• Overview of Plan Exceptions
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Predefined Planning Exceptions  

Overview of Predefined Planning Exceptions  
The planning process computes several predefined exceptions after you run a plan.

View these exceptions to obtain quick visibility of problem areas in the plan that might need your attention. To view a
list of the exceptions, from a Supply Chain Planning work area, open a plan and then open the Exceptions table.

The Exceptions table is grouped into different folders, depending on the plan type:

• Demand Planning Exceptions

• Sales and Operations Planning Exceptions

• Supply Planning Exceptions

• Views for Multiple Exceptions: View exceptions for an item, resource, or supplier within the same table. (This
folder is available only in the Supply Planning and Planning Central work areas.)

Note:  There are no predefined exceptions for Replenishment Planning, only user-defined exceptions that reside in
the Replenishment Planning Exceptions folder.

Related Topics
• Overview of Plan Exceptions

• How You Edit Exceptions

• Predefined Demand Planning Exceptions

• Predefined Sales and Operations Planning Exceptions

• Predefined Supply Planning Exceptions

Predefined Demand Planning Exceptions  
The basis for all predefined demand planning exceptions is Measure.

The following table lists the predefined demand planning exceptions, their descriptions, the base measure used for the
exception, the intersection of levels that the condition is evaluated for, the threshold to base measure, and the relevant
exception set.

Demand Planning
Exception Name

Description Base Measure Levels Threshold to Base
Measure

Exception Set

Bookings MAPE
Exceeds Threshold
 

The Bookings Forecast
MAPE is greater than
the specified threshold
value.
 

Bookings Forecast
MAPE
 

Item
 
Organization
 

Greater than 0.4
 

Default
 
Demand Management
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Demand Planning
Exception Name

Description Base Measure Levels Threshold to Base
Measure

Exception Set

Shipment MAPE
Exceeds Threshold
 

The Shipments
Forecast MAPE is
greater than the
specified threshold
value.
 

Shipments Forecast
MAPE
 

Item
 
Organization
 

Greater than 0.4
 

Default
 
Demand Management
 

Significant Deviation
between Actual
Sales and Consensus
Forecast
 

The deviation between
the Actual Sales
and the Consensus
Forecast is significant.
 

Deviation between
Shipment History
Shipped Items by
Requested Date and
Consensus Forecast
 

Item
 
Organization
 
Customer
 
Week
 

Greater than 20
percent
 

Demand Management
 

Significant Deviation
between Bookings
History and Final
Bookings Forecast
 

The deviation between
the Bookings History
and the Final Bookings
Forecast is significant.
 

Deviation between
Bookings History
Booked Items by
Requested Date and
Final Bookings
 

Item
 
Organization
 
week
 

Greater than 20
percent
 

Demand Management
 

Significant Deviation
between Budget
and Final Shipments
Forecast
 

The deviation between
the Budget and the
Final Shipments
Forecast is significant.
 

Deviation between
Budget Value and
Final Shipments
Forecast Value
 

Category
 
Organization
 
Period
 

Greater than 0.2
 

Demand Management
 

Significant Deviation
between Marketing
Forecast and
Consensus Forecast
 

The deviation between
the Marketing
Forecast and the
Consensus Forecast is
significant.
 

Deviation between
Final Marketing
Forecast and
Consensus Forecast
 

Item
 
Customer
 
Period
 

Greater than 20
percent
 

Demand Management
 

Significant Deviation
between Sales
Forecast and
Consensus Forecast
 

The deviation between
the Sales Forecast
and the Consensus
Forecast is significant.
 

Deviation between
Final Sales Forecast
and Consensus
Forecast
 

Item
 
Customer
 
Period
 

Greater than 20
percent
 

Default
 
Demand Management
 

Significant Deviation
between Sales
Forecast and Final
Shipments Forecast
 

The deviation between
the Sales Forecast and
the Final Shipments
Forecast is significant.
 

Deviation between
Final Sales Forecast
and Final Shipments
Forecast
 

Item
 
Organization
 
Week
 

Greater than 20
percent
 

Default
 
Demand Management
 

Significant Deviation
between Sales Orders
and Final Shipments
Forecast
 

The deviation between
the Sales Orders and
the Final Shipments
Forecast is significant.
 

Deviation between
Sales Orders by
Request Date and
Final Shipments
Forecast
 

Item
 
Organization
 
Week
 

Greater than 20
percent
 

Default
 
Demand Management
 

Significant Deviation
between Shipments
History and Final
Shipments Forecast

The deviation between
the Shipments
History and the Final

Deviation between
Shipment History
Shipped Items by
Requested Date and

Item
 
Organization
 

Greater than 20
percent
 

Demand Management
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Demand Planning
Exception Name

Description Base Measure Levels Threshold to Base
Measure

Exception Set

 Shipments Forecast is
significant.
 

Final Shipments
Forecast
 

Week
 

Significant Deviation
in Year on Year Sales
 

The difference
between the current
year's sales and the
past year's sales
exceeds a specified
percentage.
 

Deviation in Sales Year
over Year
 

Item
 
Organization
 
Customer
 
Period
 

Greater than 20
percent
 

Default
 
Demand Management
 

Predefined Supply Planning Exceptions  
The basis for all predefined supply planning exceptions is Order. The following table lists the predefined supply planning
exception reports, their descriptions, and if the exception is available for constrained and unconstrained supply plans.

Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

Demand Quantity Not
Satisfied
 

No supply is available.
The planning process
finds demand pegged
to supplies and the
supply quantities are
less than the demand
quantity. The planning
process issues this
exception for demands
at all levels of the
supply chain bill of
materials.
 
This exception
typically occurs
due to inconsistent
setups. For example, a
configured item can't
be sourced because
too many option-
specific exclusions
prevent any source
from being used.
 

When Pegged
Quantity < Order
Quantity for all supply
orders pegged to a
demand order
 
For order types of
Sales order, Forecast,
 and Manual demand.
 

No
 

Yes
 

Default
 

Demand at Risk Due to
Insufficient Lead Time
 

A demand is pegged
to a supply that's
scheduled with
insufficient lead
times. The sales
order or forecast is
planned on time even
though the lead time
required to meet it on

All three of these
conditions must
be met before the
planning process
generates the
exception:
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
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Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

time is insufficient.
The exception then
traverses up the
supply chain and
determines all of the
supplies that would
be short on lead time
if the demand were
to be met on time.
The planning process
reports one exception
for every supply that
doesn't have sufficient
lead time.
 

• Contributes
to Demand
Lateness = YES

• Reschedule
Days for existing
supply is
less than 0
(Reschedule in
Recommendations).

• Firm Status is set
to Not Firm

(For order types of
Sales order, Forecast,
 and Manual demand.)
 

Demand at Risk Due to
Resource Shortage
 

A demand is pegged
to a resource with a
resource overload
exception. The sales
order or forecast is
still planned on time
even in the absence of
resource availability.
This exception details
the end demands that
are at risk because
they're pegged
against suppliers with
insufficient capacity.
 

When Resource
Availability < Resource
Requirements
 
(For order types of
Sales order, Forecast,
 and Manual demand)
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 
Default
 
Constrained Supply
Planning Default
 

Demand at Risk Due
to Supplier Capacity
Shortage
 

A demand is pegged
to a supply where the
supplier capacity is
constrained. The sales
order or forecast is
still planned on time
even in the absence
of supplier capacity.
This exception details
the end demands that
are at risk because
they're pegged
against suppliers with
insufficient capacity.
 

When Supplier
Capacity Availability
< Supplier Capacity
Required
 
(For order types
of Sales order and
Forecast)
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

Items Below Safety
Stock
 

The projected
available balance for
a planning bucket is
below the specified
safety stock level for
the planning bucket.
 
If the exception
extends over several
days, the planning
process reports one
exception with the
start and end dates to

When Projected
Available Balance
< Safety Stock in a
bucket for an item,
 organization
 

No
 

Yes
 

Default
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Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

reflect the duration.
If the magnitude
of the exception
worsens, the planning
process creates a new
exception.
 

Items with Excess
Inventory
 

The projected
available balance is
higher than the safety
stock level.
 

When Projected
Available Balance
> Safety Stock in a
bucket for an item,
 organization
 

No
 

Yes
 

Default
 

Items with Expired
Lots
 

The planning process
detects a potential
expired lot. A potential
expired lot:
 

• Has a lot
expiration date
during the
planning horizon.

• isn't pegged to
a demand that
results in its use
before its lot
expiration date.

This exception occurs
against items under
full lot control. The
calculation for lot
expiration date is Lot
Receipt Date + Shelf
Life Days.
 
In addition to
reporting this
exception, the
planning process
plans for you to
flush the inventory
on its lot expiration
date. This process
prevents you from
using the lot after its
lot expiration date to
satisfy demands.
 

When order attribute
Order Type = Expired
lot
 

No
 

Yes
 

Default
 

Items with a Shortage
 

The item has negative
on hand at the end
of the day. If the
exception extends
over several days,
 the planning process
reports one exception
with the start and
end dates to reflect
the duration. If the

When Projected
Available Balance < 0
in a bucket for an item,
 organization
 

No
 

Yes
 

Default
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Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

magnitude of the
exception worsens,
 the planning process
creates a new
exception.
 

Items with a Shortage
in a Project Task
 

The item has negative
on hand at the end
of the day for an
item in a project
task. If the exception
extends over several
days, the planning
process reports one
exception with the
start and end dates to
reflect the duration.
If the magnitude
of the exception
worsens, the planning
process creates a new
exception.
 

When Projected
Available Balance <
0 in a bucket for an
item, project task,
 organization
 

No
 

Yes
 

Default
 

Late Replenishment
for Forecast
 

The planning process
detects that the
supplies for a forecast
are due later than
the forecast's due
date. This exception
typically occurs
because planning time
fences are enabled.
 

When order attribute
Days Late > 0
 
(For order type of
Forecast)
 

No
 

Yes
 

Default
 

Late Replenishment
for Sales Order
 

The planning process
detects that the
supplies for a sales
order line are due
later than the sales
order line's scheduled
date. This exception
typically occurs
because planning time
fences are enabled
or when a reserved
supply is firmed late.
 

When order attribute
Days Late > 0
 
(For order type of
Sales Order)
 

No
 

Yes
 

Default
 

Late Supply Pegged
for Forecast
 

The planning process
detects supplies
that peg against
independent forecast
demand that's

When component
supply attribute Days
Late > 0
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
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Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

satisfied late. Through
this exception, you can
quickly detect which
supplies are pegged
against a late forecast.
 

Note:
For Manual
Demand, the Late
Supply Pegged to
Forecast is also
generated when the
Days Late > 0
 

(For order types of
Forecast and Manual
Demand)
 

Late Supply Pegged
for Forecast
 

The planning process
detects supplies
that peg against
independent forecast
demand that's
satisfied late. Through
this exception, you can
quickly detect which
supplies are pegged
against a late forecast.
 

When component
supply attribute Days
Late > 0
 

Note:
For Manual
Demand, the Late
Supply Pegged to
Forecast is also
generated when the
Days Late > 0
 

(For order types of
Forecast and Manual
Demand)
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

Late Supply Pegged
for Forecast
 

The planning process
detects supplies
that peg against
independent forecast
demand that's
satisfied late. Through
this exception, you can
quickly detect which
supplies are pegged
against a late forecast.
 

When component
supply attribute Days
Late > 0
 

Note:
For Manual
Demand, the Late
Supply Pegged to
Forecast is also
generated when the
Days Late > 0
 

(For order types of
Forecast and Manual
Demand)
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

Late Supply Pegged to
Sales Order
 

The planning process
detects supplies
that peg sales order
demand that's
satisfied late. Through
this exception, you can
quickly detect which
supplies are pegged

When component
supply attribute Days
Late > 0
 
(For order type of
Sales Order)
 

Yes
 

Yes
 

Default
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Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

against a late sales
order.
 

Late Supply Pegged to
Sales Order
 

The planning process
detects supplies
that peg sales order
demand that's
satisfied late. Through
this exception, you can
quickly detect which
supplies are pegged
against a late sales
order.
 

When component
supply attribute Days
Late > 0
 
(For order type of
Sales order)
 

Yes
 

Yes
 

Constrained Supply
Planning Default
 

Order Sourced from
Alternate Facility
 

The order is sourced
from an alternate
facility due to the
material, resource, or
lead time constraints.
 

When order attribute
Alternate Facility Used
= True
 

Yes
 

No
 

Default
 
Constrained Supply
Planning Default
 

Order Sourced from
Alternate Supplier
 

The order is sourced
from an alternate
supplier (Rank 2
supplier and higher)
due to the supplier
capacity constraints.
 

When order attribute
Alternate Supplier
Used = True
 

Yes
 

No
 

Constrained Supply
Planning Default
 

Orders To Be Canceled
 

The planning process
detects a supply
order that's not
firm for which you
don't need to satisfy
demand or safety
stock requirements.
The planning process:
 

• Suggests that
you cancel the
supply order.

• Continues to
plan lower
item structure
levels as if you
accepted the
suggestion.

When order attribute
Disposition Status
Type = Canceled
 
(Not Displayed)
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

Orders To Be
Rescheduled In
 

The planning process
detects a supply order
that's not firm with
an original due date
that's later than the
suggested due date.
The planning process:
 

• Suggests that
you reschedule

When order attributes
Rescheduled Days < 0,
 and
 
Old Due Date > 0
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
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Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

the supply order
to an earlier date.

• Continues to
plan lower
item structure
levels as if you
accepted the
suggestion.

Orders To Be
Rescheduled Out
 

The planning process
detects a supply order
that's not firm with
an original due date
that's earlier than the
suggested due date.
The planning process:
 

• Suggests that
you reschedule
the supply order
to a later date.

• Continues to
plan lower
item structure
levels as if you
accepted the
suggestion.

When order attribute
Rescheduled Days > 0
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

Orders with
Insufficient Lead Time
 

The planning process
detects that a supply
order must be
completed in less time
than its minimum
processing time to
meet demand. If the
planning process plans
the order according
to its lead time, it
would start before the
planning horizon start
date.
 
To report compression
days, the planning
process calculates the
order start date by
using the item lead
times and backward
scheduling. The
planning process
considers all calendars
associated with the
supply chain model.
 

All three of these
conditions must
be met before the
planning process
generates the
exception:
 

• Compression
Days is greater
than zero

• Reschedule
Days for existing
supply is
less than 0
(Reschedule in
Recommendations)

• Firm Status is set
to Not Firm

(For supply order
types)
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

Past Due Orders
 

The planning process
detects purchase
orders, transfers, or
work orders that have
order due dates before

When order attributes:
 
Days Past Due > 0
 

No
 

Yes
 

Default
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Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

the plan horizon start
date.
 

Old Due Date isn't
NULL (Old Due Date
for planned order is
NULL)
 
Action = Is not
Canceled
 
(For supply order
types)
 

Past Due Sales Orders
 

The planning process
detects the scheduled
date of the sales order
is earlier than the plan
horizon start date.
 

When order attribute
Days Past Due > 0
 
(For order type of
Sales order)
 

No
 

Yes
 

Default
 

Planned Order Uses
Alternate Work
Definition
 

The planned order has
used an alternate work
definition due to the
material, resource, or
lead time constraints.
 

TBD
 

No
 

Yes
 

Constrained Supply
Planning Default
 

Planned Order Uses
Alternate Resource
 

The planned order
has used an alternate
resource due to the
capacity constraints.
 

When order attribute
Alternate Resource
Used = True
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

Planned Order Uses
Substitute Component
 

The order has used a
substitute component.
The scenarios where
this exception is
generated are:
 

• The primary
component lead
time is long,
 which causes
demand lateness
(Lead Time
Constraint).

• The supplier
capacity of
the primary
component
isn't sufficient,
 which causes
lateness (Supplier
Capacity
Constant).

• The resource
capacity
for making
the primary
component isn't
sufficient, which
causes lateness

When order attribute
Substitute Component
Used = True
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
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Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

(Resource
Constraint).

• The Create
Supply plan
option is set
to No for
the primary
component and
there's enough
on hand or
capacity available
on the substitute
component.

Resource Overloaded
 

Exception occurs
when, in a planning
time bucket, the
resource required
capacity is more
than the resource
available capacity. In
unconstrained plans,
 resources can be
overloaded to meet
demand requirements
on time.
 
If the exception
extends over several
days, the exception
displays the start
and end dates to
reflect the duration
of the exception.
If the magnitude
of the exception
worsens, the planning
process reports a new
exception.
 

When Resource
Utilization Percentage
> 100 in a bucket for a
resource, organization
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

Supplier Capacity
Overloaded
 

Exception occurs
when, in a planning
time bucket, the
supplier required
capacity is more than
the supplier available
capacity.
 
If the exception
extends over several
days, the exception
displays the start
and end dates to
reflect the duration
of the exception.
If the magnitude
of the exception
worsens, the planning
process reports a new
exception.

When Supplier
Capacity Utilization
Percentage > 100 in
a bucket for an item,
 supplier site
 

Yes
 

Yes
 

Default
 
Constrained Supply
Planning Default
 

69



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 4
Planning Exceptions

Supply Planning
Exception Name

Description Calculation Constrained Unconstrained Exception Set

 

Predefined Sales and Operations Planning Exceptions  
The basis for all predefined sales and operations planning exceptions is Measure. The following table lists the
predefined sales and operations planning exception reports, their descriptions, the base measure used for the
exception, and the levels.

Sales and Operations Planning
Exception Name

Description Base Measure Levels

Demand Quantity Not Satisfied
 

The satisfied demand (Constrained
Forecast measure) is less than the
required demand (Net Demand
measure) for a planning time
bucket. This exception can occur if
lead times are enforced or capacity
constraints are considered. When
this occurs, demand is backordered
(Backorder measure).
 

Unmet Demand
 

Month
 
Organization
 
Item
 

Items Below Safety Stock
 

The projected available balance
(Projected Available Balance
measure) is below the specified
safety stock (Safety Stock measure)
level for a planning time bucket.
If the exception extends beyond
one time bucket then the planning
process reports one exception with
the start and end dates to reflect
the duration.
 

Projected Available Balance
 

Month
 
Organization
 
Item
 

Items with a Shortage
 

The projected available balance
(Projected Available Balance
measure) has a negative value for
a planning time bucket. It's unlikely
for this exception to occur in a
sales and operations plan.
 

Projected Available Balance
 

Month
 
Organization
 
Item
 

Resource Overloaded
 

The resource utilization (Resource
Utilization Percentage measure)
exceeds 100 percent for a planning
time bucket. If the exception
extends beyond one time bucket
then the planning process reports
one exception with the start and
end dates to reflect the duration.
In a sales and operations plan that
considers work center capacity
constraints, it's still possible for

Resource Utilization Percentage
 

Month
 
Organization
 
Resource
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Sales and Operations Planning
Exception Name

Description Base Measure Levels

resources in a work center to be
overloaded.
 

Work Center Overloaded
 

The work center utilization
(Resource Utilization Percentage
measure) is greater than or equal
to 100 percent for a planning time
bucket. If the exception extends
beyond one time bucket then
the planning process reports one
exception with the start and end
dates to reflect the duration. In
a sales and operations plan that
considers work center capacity
constraints, it's still possible
for resources in a constrained
work center to be overloaded.
Additionally, only the capacity
for Constrained Work Center
Level Members are considered,
 whereas other work centers are
unconstrained and can exceed 100
percent.
 

Resource Utilization Percentage
 

Month
 
Organization
 
Work Center
 

Supplier Capacity Overloaded
 

The supplier item capacity
utilization (Supplier Capacity
Utilization Percentage measure)
exceeds 100 percent for a planning
time bucket. If the exception
extends beyond one time bucket
then the planning process reports
one exception with the start and
end dates to reflect the duration.
In a sales and operations plan
that considers supplier capacity
constraints, it's still possible for
supplier items in a category to be
overloaded.
 

Supplier Capacity Utilization
Percentage
 

Month
 
Supplier Site
 
Item
 

Supplier Category Capacity
Overloaded
 

The supplier category capacity
utilization (Supplier Capacity
Utilization Percentage measure)
is greater than or equal to 100
percent for a planning time bucket.
If the exception extends beyond
one time bucket then the planning
process reports one exception
with the start and end dates to
reflect the duration. In a sales and
operations plan that considers
supplier capacity constraints, it's
still possible for supplier items in a
category to be overloaded.
 

Supplier Capacity Utilization
Percentage
 

Month
 
Supplier Site
 
Category 1
 

Lead Time Compression
 

This exception can occur for
a planning time bucket when
purchasing and transfer lead
time compression is allowed.

Lead Time Compression
 

Month
 
Supplier Site
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Sales and Operations Planning
Exception Name

Description Base Measure Levels

The exception quantity is the
number of time buckets that
have been compressed. For
example, if a supplier item has a
3-month lead time and the item
is required in 2 months, then the
exception quantity is 1. If the Allow
purchasing and transfer lead time
compression plan option isn't
selected, then a Demand Quantity
not Satisfied exception can occur.
 

Organization
 
Item
 

Consensus MAPE Exceeds
Threshold
 

The mean absolute percentage
error (MAPE) value for the
consensus forecast exceeds
20 percent for an item in an
organization.
 

Consensus Forecast MAPE
 

Organization
 
Item
 

Significant Deviation between Final
Sales Forecast and Consensus
Forecast
 

The deviation between the Final
Sales Forecast quantity and the
Consensus Forecast quantity
exceeds 20 percent for a planning
time bucket.
 

Deviation Between Final Sales
Forecast and Consensus Forecast
 

Month
 
Zone
 
Organization
 
Item
 

Significant Deviation between Final
Marketing Forecast and Consensus
Forecast
 

The deviation between the Final
Marketing Forecast quantity and
the Consensus Forecast quantity
exceeds 20 percent for a planning
time bucket.
 

Deviation Between Final Marketing
Forecast and Consensus Forecast
 

Month
 
Item
 

Significant Deviation between
Shipments History and Consensus
Forecast
 

The deviation between the
Shipments History quantity and
the Consensus Forecast quantity
exceeds 20 percent for a planning
time bucket.
 

Deviation Between Shipment
History Shipped Items by
Requested Date and Consensus
Forecast
 

Month
 
Zone
 
Organization
 
Item
 

Significant Deviation between
Financial Forecast and Operating
Plan Value
 

The deviation between the
Financial Forecast Value and the
Operating Plan Value exceeds 20
percent for a planning time bucket.
 

Deviation Between Financial
Forecast and Operating Plan Value
 

Month
 
Organization
 
Item
 

Significant Deviation between
Financial Forecast and
Unconstrained Operating Plan
Value
 

The deviation between the
Financial Forecast Value and the
Unconstrained Operating Plan
Value exceeds 20 percent for a
planning time bucket.
 

Deviation Between Financial
Forecast and Unconstrained
Operating Plan Value
 

Month
 
Organization
 
Item
 

Significant Deviation between Last
Year Shipments and Operating
Plan Value

The deviation between the
Shipments History Value 1 Year
Ago and the Operating Plan Value

Deviation Between Last Year
Shipments and Operating Plan
Value

Month
 
Zone
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Sales and Operations Planning
Exception Name

Description Base Measure Levels

 exceeds 20 percent for a planning
time bucket.
 

  
Organization
 
Item
 

Significant Deviation between
Current and Prior Consensus
Forecast Value
 

The deviation between the
Consensus Forecast Value and the
archived Consensus Forecast Value
exceeds 20 percent for a planning
time bucket.
 

Deviation Between Current and
Prior Consensus Forecast Value
 

Month
 
Zone
 
Organization
 
Item
 

Significant Deviation between
Current and Prior Operating Plan
Value
 

The deviation between the
Operating Plan Value and the
archived Operating Plan Value
exceeds 20 percent for a planning
time bucket.
 

Deviation Between Current and
Prior Operating Plan Value
 

Month
 
Zone
 
Organization
 
Item
 

User-Defined Exceptions  

Overview of User-Defined Exceptions  
You can create your own exceptions to improve supply planning capabilities using specific conditions in the supply
chain.

Use the Configure Exception task to create a user-defined exception.

You can create and use exceptions for these modules:

Module Exception Type

Oracle Demand Management
 

Measure-based exceptions
 

Oracle Replenishment Planning
 

Measure-based exceptions
 

Oracle Sales and Operations Planning
 

Measure-based exceptions
 

Supply Planning (constrained and
unconstrained)
 

Order-based exceptions
 
Measure-based exceptions
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Note:  User-defined exceptions aren't available for Oracle Planning Central.

For user-defined exceptions that are measure based, the measure forms the foundation for that exception. After you
select a measure, you can specify the dimension hierarchy and level for that measure, and the threshold value or
measure to generate the exception. You can create an exception based on the following thresholds:

• Value: Set the value and the specific operation, such as less than, equal, and larger than, against the base
measure.

• Measure: Select the measure based on your business requirement and select the specific operation that meets
the condition against the base measure.

For example, you can create a date-type, measure-based exception such as launch date or discontinuation date. You
then can set the threshold value with date and select a date-type measure from the Measure parameter.

Consider the Forecast Start Date before Launch Date date-type exception. You can define the parameters as:

• Base Measure = Forecast Start Date

• Operation = Before (Available values for date type exceptions are: After, Before, Equals, On or after, and On or
before)

• Threshold Measure = Product Launch Date

Related Topics
• Configure Measure-Based Exceptions

Configure Order-Based Exceptions for Constrained Supply Plans  
You can configure order-based exceptions as user-defined exceptions for constrained supply plans. In this topic, we
discuss the predefined order-based exceptions that are available for unconstrained supply plans, but aren't available as
predefined exceptions for constrained supply plans.

Configure Exceptions That Are Order Based
Use these general steps to configure exceptions for constrained supply plans that are order based.

1. Open a constrained supply plan and access the Supplies and Demands table.
2. In the Search section, click the Advanced button.
3. Click the Add Fields button and select an order attribute from the list of values.
4. Define a condition and value for the order attribute.
5. To save the search, click the Save button.

a. In the Create Save Search dialog box, enter a name.
b. Click OK.

6. In the Supplies and Demands table, click Search.

The Supplies and Demands table displays the records that conform to the defined condition.

The following sections provide specific details for some user-defined exceptions that you can configure for constrained
supply plans.
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Past Due Sales Orders
In an unconstrained supply plan, the planning process generates the Past Due Sales Orders exception when it detects
that the scheduled date of the sales order is earlier than the plan horizon start date. A past due sales order line is a sales
order line with a scheduled date earlier than the plan horizon start date.

To see demand where quantity isn't met in your constrained supply plan, follow these steps:

1. Open the Supplies and Demands table.
2. In the Search section, click the Advanced button.
3. Click the Add Fields button and select Days Past Due.
4. In the Order Type field:

a. Set the operation to Equals
b. For the value, select Sales order

5. In the Days Past Due field:

a. Set the operation to Greater than
b. Set the value to 0 (zero)

6. Click the Search button.

All past due sales orders appear in the Search Results section in the Supplies and Demands table.

Late Replenishment for Forecast
The planning process generates the Late Replenishment for Forecast exception when it detects supplies that peg
against independent forecast demand that's satisfied late. Through this exception, you can quickly detect which
supplies are pegged against a late forecast.

A sales order becomes past due when it hasn't been satisfied by the time you run the plan. In other words, the Original
Due Date of the sales order falls before the Plan Start Date. This exception usually occurs because of a material
constraint, resource constraint, or a planning time fence.

Let's work through an example to see all late replenishments for forecasts in your constrained supply plan using the
following criteria:

• Component C feeds end item F.

• There's a forecast for end item F with a due date of Day 17.

• Due to manufacturing constraints, the component is available on Day 16. As a result, the Material Available Date
for end item F is Day 20.
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In this example, the availability of material is late with respect to the due date. As a result, the planning process
generates a Late Replenishment for Forecast exception for end item F.

To see all late replenishments for forecasts in your constrained supply plan, follow these steps:

1. Open the Supplies and Demands table.
2. In the Search section, click the Advanced button.
3. Click the Add Fields button and select Days Late.
4. In the Order Type field:

a. Set the operation to Equals
b. For the value, select Forecast

5. In the Days Late field:

a. Set the operation to Greater than
b. Set the value to 0 (zero)

6. Click the Search button.

All late replenishments for forecasts appear in the Supplies and Demands table.

Late Replenishment for Sales Orders
The planning process generates a Late Replenishment for Sales Order exception when it detects that the supplies for
a sales order line are due later than the sales order line's scheduled date. In other words, the Material Available Date is
after its Suggested Due Date. This exception typically occurs due to any of these issues:

• There's a resource constraint

• Planning time fences are enabled

• A reserved supply is firmed late

Let's work through an example to see all late replenishments for sales orders in your constrained supply plan using the
following criteria:

• Component A feeds end item B

• End item B planning time fence is Day 20

• There's a sales order for end item B with a due date of Day 10
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• Due to the item B planning time fence, item B can't be planned before Day 20. As a result, the Material Available
Date for the end item B is Day 20.

In this example, the availability of material is late with respect to the due date. As a result, a Late Replenishment for
Sales Order exception is generated for the end item B.

To see all late replenishment for sales orders in your constrained supply plan, follow these steps:

1. Open the Supplies and Demands table.
2. In the Search section, click the Advanced button.
3. Click the Add Fields button and select Days Late.
4. In the Order Type field:

a. Set the operation to Equals
b. For the value, select Sales order

5. In the Days Late field:

a. Set the operation to Greater than
b. Set the value to 0 (zero)

6. Click the Search button.

All late replenishments for sales orders appear in the Supplies and Demands table.

Past Due Orders
The planning process generates the Past Due Orders exception when it detects purchase orders, transfer orders, or work
orders that have order due dates before the plan horizon start date. If the order is firm, the planning process retains the
order's firmed duration as it schedules all of its operations beyond the planning horizon start date. For supply orders
that aren't firm, the planning process also issues an Orders to be rescheduled out exception message.
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The calculation for the Days Past Due exception is:

Plan Start Date - Order Original Due Date, when Plan Start Date is after the Order Original Due Date

To see past due orders in a constrained supply plan, follow these steps:

1. Open the Supplies and Demands table.
2. In the Search section, click the Advanced button.
3. Click the Add Fields button to add the following attributes to the search section:

◦ Old Due Date

◦ Days Past Due

◦ Action

4. Set the operations and values for the following fields in the Search section:

Field Operation Value Note

Order Type
 

Equals
 

All supplies
 

N/A
 

Old Due Date
 

Is not
 

NULL
 

Planned order is NULL
 

Days Past Due
 

Greater than
 

0 (zero)
 

N/A
 

Action
 

Is not
 

Canceled
 

You must select all values except
Cancel
 

5. Click the Search button.

All past due orders are displayed in the Supplies and Demands table.

Items with Expired Lots
The planning process generates an Items with Expired Lots exception when it detects a potential expired lot. Item lots
can satisfy demands before their expiration dates. A potential expired lot:

• Has a lot expiration date during the planning horizon.

• Isn't pegged to a demand that results in its use before its lot expiration date.

This exception occurs against items under full lot control.

In addition to reporting this exception, the planning process plans for you to flush the inventory on its lot expiration
date. This process prevents you from using the lot after its lot expiration date to satisfy demands.

The calculation for Items with Expired Lots is: Lot Receipt Date + Shelf Life Days

In the following example, lot A001 of item A can only satisfy sales order 1 with a due date before the lot A001 expiration
date.
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To see all items with expired lots in your constrained supply plan, follow these steps:

1. Open the Supplies and Demands table.
2. In the Order Type field in the Search section:

a. Set the operation to Equals
b. For the value, select Expired lot

3. Click the Search button.

All items with expired lots appear in the Search Results section in the Supplies and Demands table.

Demand Quantity Not Satisfied
The planning process generates a Demand Quantity Not Satisfied exception when there isn't enough supply available.
The planning process finds demand pegged to supplies and the supply quantities are less than the demand quantity.
The planning process issues this exception for demands at all levels of the supply chain bill of materials.

This exception typically occurs due to inconsistent setups. For example, a configured item can't be sourced because too
many option-specific exclusions prevent any source from being used.

To see demand where quantity isn't met in your constrained supply plan, follow these steps:

1. Open the Supplies and Demands table.
2. In the search section, click the Advanced button.
3. Click the Add Fields button and select Unmet Demand Quantity.
4. In the Unmet Demand Quantity field:

a. Set the operation to Greater than.
b. Set the value to 0 (zero).

5. Click the Search button.

All demand quantities that aren't satisfied appear in the Search section in the Supplies and Demands table.

Configure Measure-Based Exceptions  
This topic covers how to configure measure-based exceptions in Supply Planning, Sales and Operations Planning,
Demand Management, and Replenishment Planning.

You can create measure-based exceptions where the measure forms the foundation for that exception. After you select
a measure, you can specify the dimension hierarchy and level for that measure, and the threshold value or measure
to generate the exception. For example, you can create an exception to identify resource overloads when the resource
utilization percentage is greater than 110%.
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Configure Exceptions That Are Measure Based
Use the following general steps to configure a user-defined exception that's measure based.

1. In a Supply Chain Planning work area, click the Tasks panel drawer and click Configure Exceptions.
2. On the Configure Exceptions page, click Actions and then select Create.
3. In the Create Exception dialog box, General Properties section, specify or enter information for the following

fields:

a. Exception
b. Display Name
c. Exception Group
d. Base Measure

4. In the Exception Detail section, on the Level tab, select the dimension and its corresponding hierarchy and level
to use for your exception

What you select for levels determines the combination at which the exception condition is evaluated. For
example, if you select levels Item and Organization, then the exception criteria is evaluated for each unique
combination of Item and Organization.

Note:  Configure Exceptions is a task defined outside of plan context. When configuring exceptions for
measure-based plans, ensure the selected hierarchy is in the plan's dimension catalog in plan options.
Otherwise item level exceptions might be blank after running a plan.

5. On the Threshold tab:

a. Select an operation.
b. Define a threshold for the base measure, which can be defined based on a value or another measure.

6. On the Notification tab, define the notification attributes.
7. When done, click Save and Close.

Exception Detail Section
In the Create Exception dialog box, the Level tab in the Exception Detail section is populated based on the base
measure. The Level tab consists of dimension, hierarchy, and level.

For example, for the user-defined exception Fill Rate Shortfall Percentage, the details are populated based on the base
measure Fill Rate Shortfall Percentage. As defined on the Threshold tab, the planning process generates this exception
when the Fill Rate Shortfall percentage is greater than 10%.

For this exception, the populated dimensions are Organization and Product. You can select dimensions and their
corresponding hierarchy and levels. In this example for the Product dimension, you can select either Item or Category as
the level.

If you select the Item level, the planning process generates this exception for any item with the Fill Rate Shortfall
Percentage of greater than 10% as defined in the Threshold tab. This case enables you to analyze the plan output in
more detail. At the same time, the number of exceptions could be large enough that analyzing each exception might not
be possible.

On the other hand, if you select the Category level, the planning process generates this exception for any category with
the Fill Rate Shortfall Percentage of greater than 10%. In this case, the number of exceptions is lower than the item level
scenario. But, potentially some issues that exists at the item level aren't visible since the planning process generates an
exception only when the specified criterion holds at the category level.

80



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 4
Planning Exceptions

Related Topics
• Overview of User-Defined Exceptions

• Overview of Plan Exceptions

Configure Measure-Based Exceptions for Constrained Supply
Plans  
This topic covers predefined measure-based exceptions that are available in unconstrained Supply Planning but aren't
available as predefined exceptions in constraint-based Oracle Supply Planning. You can configure these exceptions as
user-defined exceptions in constraint-based Supply Planning.

Items Below Safety Stock
The planning process generates the Items Below Safety Stock exception when the projected available balance for a
planning bucket is below the specified safety stock level for the planning bucket. Safety stock is maintained to mitigate
risk of stockouts caused by uncertainties in supply and demand. When the projected material balance drops below the
safety stock level, you have a potential stockout. You can increase your supply orders by creating new purchase orders
or rescheduling existing ones to bring the material balance above the safety stock level.

Use these steps to configure an Items Below Safety Stock exception for a constrained supply plan.

1. Navigate to the Tasks panel. In the Configuration section, click the Configure Exceptions link.
2. On the Manage Planning Measures page, click Actions and then select Create.
3. In the Create Exceptions dialog box, in the General Properties section, enter or select the following:

Parameter Value

Exception
 

Items Below Safety Stock
 

Display Name
 

Items Below Safety Stock
 

Exception Group
 

Supply Planning Exceptions
 

Base Measure
 

Projected Available Balance
 

4. On the Level tab, specify the dimension and its corresponding hierarchy and level.
5. On the Threshold tab, define the threshold for the base measure as Projected Available Balance Less than

Safety Stock.

◦ In the Operation field, select Less than

◦ In the Threshold field, select Measure and then select Safety Stock from the list of values.

6. Click Save and Close.
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Items with a Shortage
The planning process generates the Items with a Shortage exception when the item has a negative on hand at the end
of the day. The items with a shortage refers to the situation when the projected material balance suggests that there
is less than zero of the item or items in question. You can rectify this situation by increasing your supply orders, such
as creating new purchase orders or rescheduling existing ones. In addition you can analyze your forecast demand to
determine whether the forecasts are too optimistic and they can be lowered to remove the shortages.

Use these steps to configure an Items with a Shortage exception for a constrained supply plan.

1. Navigate to the Tasks panel. In the Configuration section, click the Configure Exceptions link.
2. On the Manage Planning Measures page, click Actions and then select Create.
3. In the Create Exceptions dialog box, in the General Properties section, enter or select the following:

Parameter Value

Exception
 

Items with a Shortage
 

Display Name
 

Items with a Shortage
 

Exception Group
 

Supply Planning Exceptions
 

Base Measure
 

Projected Available Balance
 

4. On the Level tab, specify the dimension and its corresponding hierarchy and level.
5. On the Threshold tab, define the threshold for the base measure as Projected Available Balance Less than

Safety Stock.

◦ In the Operation field, select Less than

◦ In the Threshold field, select Value and then enter 0 (zero) in the value field.

6. Click Save and Close.

Items with Excess Inventory
The planning process generates the Items with Excess Inventory exception when the projected available balance for a
planning bucket is higher than the specified safety stock level for the planning bucket. The excess inventory is a product
that hasn't yet been sold and exceeds the projected consumer demand for that product.

The Items with Excess Inventory exception usually represents some type of mismanagement of stock demand due to
factors such as over-buying, inaccurate projections, canceled orders, a bad economy, unforeseen weather changes,
unpredictable consumer demand, or late or early delivery of goods.

Use these steps to configure an Items with Excess Inventory exception for a constrained supply plan.

1. Navigate to the Tasks panel. In the Configuration section, click the Configure Exceptions link.
2. On the Manage Planning Measures page, click Actions and then select Create.
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3. In the Create Exceptions dialog box, in the General Properties section, enter or select the following:

Parameter Value

Exception
 

Items with Excess Inventory
 

Display Name
 

Items with Excess Inventory
 

Exception Group
 

Supply Planning Exceptions
 

Base Measure
 

Projected Available Balance
 

4. On the Level tab, specify the dimension and its corresponding hierarchy and level.
5. On the Threshold tab, define the threshold for the base measure as Projected Available Balance Less than

Safety Stock.

◦ In the Operation field, select Greater than

◦ In the Threshold field, select Measure and then select Safety Stock from the list of values.

6. Click Save and Close.

Configure Exceptions for Replenishment Planning  
Create user-defined exceptions in Replenishment Planning by using the same process to configure measure-based
exceptions covered in the Configure Measure-Based Exceptions topic. This topic details how to configure a specific
exception for Replenishment Planning.

Projected Fill Rate Less than 90 Percent
The fill rate is the fraction of customer demand that's met through immediate stock availability, without backorders or
lost sales. The planning process generates the Projected Fill Rate Less than 90 Percent exception when the projected fill
rate for an item and organization is below 90 percent.

Use these steps to configure a Projected Fill Rate Less than 90 Percent exception for a replenishment plan:

1. Navigate to the Tasks panel. In the Configuration section, click the Configure Exceptions link.
2. On the Configure Exceptions page, click Actions and then select Create.
3. In the Create Exceptions dialog box in the General Properties section, enter or select the following:

Parameter Value

Exception
 

Projected fill rate less than 90 percent
 

Display Name
 

Projected fill rate less than 90 percent
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Parameter Value

Exception Group
 

Replenishment Planning Exceptions
 

Base Measure
 

Projected Fill Rate
 

4. On the Level tab, specify the dimension and its corresponding hierarchy and level.
5. On the Threshold tab, define the threshold for the base measure as Projected Fill Rate Less than 90%:

◦ In the Operation field, select Less than.

◦ In the Threshold field, select Value and then enter 90.

Related Topics
• Configure Measure-Based Exceptions

• Overview of User-Defined Exceptions

• Overview of Plan Exceptions

• Configure Exception Thresholds

Configure Exceptions Based on User-Defined Measures  
You might have a scenario where you need to define a user-defined measure and then configure an exception based on
that measure.

For example, you want to identify the items that have demands with a risk of not being satisfied, and the value of these
demands are 10 percent more than their quarterly revenue.

Step 1: Configure a User-Defined Measure
In our example, the first step is to define a user-defined measure that represents the percentage value of demands at
risk. This percentage can be calculated as follows:

Demand at Risk Value Percentage = (Demand at Risk Value / Revenue) x 100

Use the following steps to configure a user-defined measure.

1. Navigate to the Tasks panel. In the Configuration section, click the Manage Planning Measures link.
2. On the Manage Planning Measures page, click Actions and then select Create.
3. In the Create Measure dialog box, enter or select the following:

Parameter Value

Measure
 

Demand at Risk Value Percentage
 

Description
 

Enter a description
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Parameter Value

Data Type
 

Percent
 

Enable in Work Area
 

Supply Planning
 

Measure Groups
 

Overall Plan Health
 

4. On the Aggregation and Disaggregation tab in the Dimension Parameters section, select the Customer and
Demand Class dimensions.

5. On the Expression tab, Functions subtab, define the Demand at Risk Value Percentage equation:

Safe_Division (Demand at Risk Value, Revenue, null) * 100.
6. Click Save and Close.

Step 2: Configure a User-Defined Exception
The next step is to configure a user-defined exception using Demand at Risk Value Percentage as the base measure.

1. Navigate to the Tasks panel. In the Configuration section, click the Configure Exceptions link.
2. On the Manage Planning Measures page, click Actions and then select Create.
3. In the Create Exceptions dialog box, in the General Properties section, enter or select the following:

Parameter Value

Exception
 

Demand at Risk Value over 10 Percent of Revenue
 

Display Name
 

Demand at Risk Value over 10 Percent of Revenue
 

Exception Group
 

Supply Planning Exceptions
 

Base Measure
 

Demand at Risk Value Percentage
 

4. In the Exception Detail section, on the Level tab, specify the dimension and its corresponding hierarchy and
level.

5. On the Threshold tab, define the threshold for the base measure as Demand at Risk Value Percentage Greater
than 10%:

Parameter Value

Base Measure
 

Demand at Risk Value Percentage
 

Description Demand at Risk Value Percentage
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Parameter Value

  

Operation
 

Greater than
 

Threshold Value
 

10%
 

6. Click Save and Close.

Calculate User-Defined, Measure-Based Exceptions  
After you modify, add, or delete one or more user-defined, measure-based exceptions in your plan’s exception set,
you can recalculate these exceptions independent of running the plan. These calculations are based on the current
definitions of the exceptions and include any changes since the plan was last run.

This calculation is based on the current definition of exceptions that includes any changes since the plan was last run.
By default, the process calculates all exceptions in the plan exception set. You can change the exception set parameters
of the process to calculate a subset of those exceptions.

Note:  The Calculate Measure-Based Exception process doesn't recalculate predefined order-based exceptions.

The Calculate Measure-Based Exception process is available from the Supply Planning, Demand Planning,
Replenishment Planning, and Sales & Operations Planning work areas.
You can recalculate user-defined, measure-based exceptions from these pages:

• Scheduled processes: By default, scheduled process recalculates all exceptions in the exception set. However,
you can also recalculate exceptions of a subset by changing the exception set parameters.

• Actions menu on the header of the open plan

• Actions menu on Manage Plans page

Note:  The Calculate Measure Based Exception process and Plan Run process cannot run simultaneously for the same
plan.
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5  Planning Analytics

Overview of Planning Analytics  
Configuring planning dimensions and hierarchies on the Configure Planning Analytics page is a key setup to use the
analytics in Supply Chain Planning work areas.

It has a unified dimensional hierarchy for various uses. Depending on your security privilege, you can also open the
Configure Planning Analytics page from the Setup and Maintenance work area by selecting the following:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Configure Planning Analytics

To run plans successfully, you must complete the following Configure Planning Analytics tasks:

• Set Up Dimension Catalogs

• Set Up Measure Catalogs

• Set Up Levels and Attributes

You can use the default hierarchies for most of the dimensions.

If the default product catalog named Product is not collected, then you must select at least one product hierarchy. If a
default product catalog is collected, then the predefined Product hierarchy is selected as a product hierarchy by default.
You can optionally add or change the product hierarchy. You must include at least one product hierarchy when creating
a dimension catalog.

On the Configure Planning Analytics page, Levels and Attributes tab, you can configure your planning table and graphs
to display descriptions instead of codes for the following entities: Items, Organizations, Resource, Work Center, and
Work Area.

Related Topics
• Considerations for Setting Up Dimension Catalogs

• Configure Planning Analytics

• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• How You Use Levels and Attributes in Supply Chain Planning

• Can I modify the default dimension catalog?

Configure Planning Analytics  
To run plans successfully, you must set up dimensions and dimension catalogs, measure catalogs, and levels and
attributes.
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You can open the Configure Planning Analytics task from one of the Supply Chain Planning work areas. Depending on
your security privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work
area.

Note:  Default Catalog is the name of the predefined dimension catalog. It contains predefined hierarchies. Oracle
recommends that you make a copy of the Default Catalog if changes are required, instead of editing the default
catalog.

To configure planning analytics:

1. In the Navigator, click one of the Supply Chain Planning work areas or click the Setup and Maintenance work
area.

◦ If you clicked one of the Supply Chain Planning work areas, do the following:

i. Click the Tasks panel tab.
ii. In the Tasks panel drawer, click the Configure Planning Analytics link.

◦ If you clicked the Setup and Maintenance work area, select the following:

- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Configure Planning Analytics

2. On the Configure Planning Analytics page, Dimension Catalogs tab, do the following:

a. Create a dimension catalog using the Add Row button, or duplicate the default dimension catalog using
the Duplicate button.

b. Specify what hierarchies to use in the dimension catalog by moving hierarchies from the Available pane
to the Selected pane.

c. Assign the dimension catalog to a plan that will use the set of hierarchies for analysis during the plan
creation from Manage Plans.

3. Each Supply Chain Planning work area has a default measure catalog. Create a new measure catalog to add or
remove measures.

a. Use the Add Row button to create a new catalog or use the Duplicate button to duplicate an existing
catalog.

b. Specify the measures for the catalog by moving the measures from the Available pane to the Selected
pane.

c. Assign the measure catalog to a plan that will use the set of measures during the plan creation from
Manage Plans.

After you create and define a measure catalog, you can select the measure catalog for a plan from the Edit Plan
Options page.

4. Click the Levels and Attributes tab and select the desired dimension and hierarchy.

a. In the Dimension list, select a dimension.
b. Optionally, in the Hierarchy list, select a hierarchy.
c. Click the Search icon button.
d. To change how the level name appears in pivot tables and graphs, select the row and enter the level

name in the Level Name to Display field.

Note:  You can't edit the Level Name to Display field for the lowest level of the hierarchy.
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e. To display a particular member identifier in your tables and graphs, select a dimension (Product,
Organization, or Resource) and level, and then select a value in the Member Identifier to Display
column:

Dimension Level Member Identifier to Display Options

Product
 

Item
 

Item Name, Item Description, Item Name
and Description, or Item Description and
Name
 

Organization
 

Organization
 

Organization Name or Organization Code
 

Resource
 

Resource
 

Resource Code, Resource Name, or
Resource Description
 

Resource
 

Work Center
 

Work Center Code, Work Center Name, or
Work Center Description
 

Resource
 

Work Area
 

Work Area Code, Work Area Name, or
Work Area Description
 

Resource
 

Organization
 

Organization Name or Organization Code
 

Time Quarter Quarter Name or Start Date
The display name you configured on
this page appears for quarter name on
the Fiscal, Manufacturing, and Hybrid
calendars.
 

Time Month Month Name or Start Date
The display name you configured on
this page appears for month name on
the Fiscal, Manufacturing, and Hybrid
calendars.
 

Tip:  The organization level in the Organization dimension and the organization level in the Resource
dimension are separate settings. Oracle recommends that you set them to use the same identifier.

f. To add an attribute for the lowest level of the hierarchy, click the Edit Page button in the Attributes
column.

i. In the Manage Attribute List dialog box, click the Add Row button.
ii. In the Attribute list, select an attribute.

iii. In the Attribute Label text box, enter a label name and click OK.
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5. On the Configure Analytics page, click the Save and Close button.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

• How You Use Levels and Attributes in Supply Chain Planning

• Overview of Planning Analytics

• How You Use Measure Catalogs in Supply Chain Planning

Dimensions and Dimension Catalogs  

How You Use Dimensions and Dimension Catalogs in Supply
Chain Planning  
Oracle Fusion Cloud Supply Chain Planning has hierarchy levels by which you can view, compare, and analyze demands
and supplies of your products over various dimensions, such as geography and organizations.

Oracle Supply Chain Planning uses a single set of dimensions and hierarchies to drive aggregation context for demand
planning, supply planning, embedded analytics, and management analytics.

Oracle Supply Chain Planning provides predefined planning dimensions. Each of those dimensions has a predefined
hierarchy. When you implement the Oracle Supply Chain Planning offering, you must decide which dimensions and
hierarchies to use for demand and supply analysis.

Each dimension catalog has a collection of hierarchies in different dimensions that is enabled for use in the plan
options. By default, all predefined hierarchies are available in Planning Analytics. You can disable certain dimensions
that are not relevant for your plans. For example:

• If you are only using demand plans, then supplier, resource, and order type dimensions may not be relevant

• If you are using sales and operations plans, then the order type dimension is not relevant

The following hierarchies are predefined in Oracle Supply Chain Planning:

• Customer

• Demand Class

• Exception Type

• Order Type

• Organization

• Plan

• Product

• Resource

• Supplier

• Source

• Time
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Access the Configure Planning Analytics page from a Supply Chain Planning work area. Depending on your security
privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work area.

• To access the Configure Planning Analytics page from a Supply Chain Planning work area:

a. Click the Tasks panel tab.
b. In the Tasks panel drawer, click the Configure Planning Analytics link

• To access the Configure Planning Analytics page from the Setup and Maintenance work area, select the
following:

◦ Offering: Oracle Supply Chain Planning

◦ Functional Area: Supply Chain Planning Configuration

◦ Task: Configure Planning Analytics

In the Dimension Catalogs tab, several hierarchies are available in various dimensions. You can specify which hierarchy
to use in a particular dimension catalog. For example, you can select an organization type hierarchy, a product type
hierarchy, or a customer hierarchy to use in plans for analysis. After you define a dimension catalog, you can assign it to
a plan that will use the set of hierarchies for analysis.

You can select one of your dimension catalogs to be used as the default dimension catalog in plans. If you do not select
a default catalog, the predefined catalog named Default Catalog is used.

Related Topics
• Considerations for Setting Up Dimension Catalogs

• How can I use dimensions in Supply Chain Planning?

• Overview of Planning Analytics

• What's a dimension in Supply Chain Planning?

• Why You Disable or Enable Dimensions for Supply Plan Measures

Considerations for Setting Up Dimension Catalogs  
Oracle Fusion Cloud Supply Chain Planning provides predefined dimensions, and those dimensions have predefined
hierarchies. The predefined hierarchies are included in the Default Catalog.

Hierarchy Selections for the Customer Dimension
The default Customer hierarchy has the Customer Site, Customer, and Customer Class levels. This default hierarchy is
defined in the Oracle Fusion Trading Community Model, and you can modify it there.

Hierarchy Selections for the Exception Type Dimension
The default Exception Type hierarchy has the Exception Type level.

Hierarchy Selections for the Order Type Dimension
The default Order Type hierarchy has the Order Type and Order Group levels.
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Hierarchy Selections for the Organization Dimension
The default Enterprise hierarchy has the Organization, Business Unit, and Legal Entity levels. This default hierarchy is
defined in Oracle Fusion Cloud HCM, and you can modify it only there. Optionally, you can enable other Organization
hierarchies (based on regions, one per country).

Hierarchy Selections for the Product Dimension
The default Product hierarchy has the Item, Category Level 1, and Category Level 2 levels. You can collect other catalogs
for the Product dimension into Oracle Supply Chain Planning and select the resulting hierarchies.

For Oracle Sales and Operations Planning, the Lifecycle Phase attribute is also included in the default hierarchy.

The Planning catalog is populated into the Product hierarchy.

You must create the Planning catalog in the Product Information Management work area as follows:

• In the Create Catalog dialog box, in the Functional Area field, select Planning.

• In the Controlled At field, select Master Level.

• Select the Assign items to leaf level categories only check box.

• Don't select the Allow multiple item category assignments check box.

• On the Edit Catalog page, on the Details tab, in the Default Category field, select a default category.

On the Edit Catalog page, on the Category Hierarchy tab, you won't be able to create a hierarchy of categories. Under the
root level, you will be able to create only one level of categories.

If you're using the file-based data import (FBDI) template named Supply Chain Planning Catalogs
(ScpCatalogImportTemplate.xlsm), do the following:

• On the Catalogs_ tab, in the Control Level column, enter 1.

• In the Default Indicator column, enter Yes.

• On the CatalogCategoryAssociation_ tab, create a hierarchy of categories if this setup meets your requirements.

• On the ItemCategories_ tab, ensure that items belong to only the lowest-level categories, and that items don't
belong to multiple categories.

If you haven't set up the Planning catalog, the predefined Product hierarchy of the Product dimension is used. The
predefined Product hierarchy has only one predefined item. In this situation, your items won't be available in the default
Product hierarchy, and your items will be available through the other hierarchies that are created for collected catalogs.

Hierarchy Selections for the Resource Dimension
The default Resource hierarchy has the Resource, Work Center, Work Area, and Organization levels. This default
hierarchy is defined in Oracle Manufacturing and you can't modify it.

Hierarchy Selections for the Source Dimension
The default Source hierarchy has the Source level.

Hierarchy Selections for the Supplier Dimension
The default Supplier hierarchy has the Supplier Site and Supplier levels.
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Hierarchy Selections for the Time Dimension
The Gregorian Calendar hierarchy has the Day, Month, Quarter, and Year levels. You can collect other hierarchies for
the Time dimension into Oracle Supply Chain Planning and select them. These hierarchies include workday calendars
of inventory organizations collected from Oracle Fusion Cloud SCM and fiscal calendars collected from Oracle Fusion
Cloud Financial Management.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• How can I use dimensions in Supply Chain Planning?

• Can I modify the default dimension catalog?

• Overview of Planning Analytics

• Why You Disable or Enable Dimensions for Supply Plan Measures

What's a dimension in Supply Chain Planning?  
A dimension is a structure that organizes data. It categorizes data to enable you to answer business questions.
Commonly used dimensions are customers, products, and time.

Related Topics
• Configure Planning Analytics

• How can I use dimensions in Supply Chain Planning?

• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

How can I use dimensions in Supply Chain Planning?  
Oracle Fusion Cloud Supply Chain Planning applications come with predefined hierarchies in the Product dimension.

These predefined hierarchies are part of the Dimension catalog structure in Oracle Product Model. Integrations with
Oracle E-Business Suite and third-party systems where the product dimensions can still be maintained and uploaded
for use by the Oracle Supply Chain Planning applications is supported.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

• What's a dimension in Supply Chain Planning?
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What's a dimension catalog in Supply Chain Planning?  
In Oracle Fusion Cloud Supply Chain Planning, a dimension catalog is a selected list of dimensions enabled for use in
plans.

In Oracle Supply Chain Planning, a dimension catalog is a selected list of hierarchies in different dimensions that is
enabled for use in plans. The Default dimension catalog appears by default, but can be changed to another dimension
catalog that has been defined.

Related Topics
• Can I modify the default dimension catalog?

• What's a dimension in Supply Chain Planning?

• Considerations for Setting Up Dimension Catalogs

• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

Can I modify the default dimension catalog?  
Yes, you can modify the Oracle Fusion Cloud Supply Chain Planning default dimension catalog. However, if you want to
make any changes, Oracle recommends that you create a duplicate of the default dimension catalog.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

• What's a dimension catalog in Supply Chain Planning?

Measure Catalogs  

How You Use Measure Catalogs in Supply Chain Planning  
The measure catalog is similar to the dimension catalog.

Each measure catalog has a collection of measures that you can use in plans in one of the Oracle Fusion Cloud Supply
Chain Planning work areas. The measure catalog can contain predefined and user-defined measures.

On the Measure Catalogs tab on the Configure Planning Analytics page, you can create a measure catalog and add or
remove measures from a measure catalog.

Note:  In the Status column, the count indicates only those plans that include the measure catalog on the Scope tab
on the Plan Options page. The count doesn't indicate the plans in which the measure catalog is used for archiving the
plans or extracting them.
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This table lists some predefined measure catalogs for Oracle Supply Chain Planning:

Work Area Predefined Measure Catalogs

Demand and Supply Planning • Default Demand and Supply Catalog

• Default Demand Management Catalog

• Default Supply Planning Catalog

• Supersession Forecasting Catalog

Demand Management • Default Demand Management Catalog

• Supersession Forecasting Catalog

Planning Central • Default Demand and Supply Catalog

• Default Demand Management Catalog

• Default Planning Central Catalog

• Default Supply Planning Catalog

Replenishment Planning • Default Replenishment Planning Archive Catalog

• Default Replenishment Planning Catalog

• Incremental Replenishment Planning Default Catalog

• Supersession Forecasting Catalog

Sales and Operations Planning • Default S&OP Archive Catalog

• Default S&OP Catalog

Supply Planning Default Supply Planning Catalog

Related Topics
• Can I modify the default measure catalog?

Can I modify the default measure catalog?  
No. Although you cannot modify the default measure catalog, you can create a measure catalog, modify the list of
measures, and assign it to plans on the Plan Options page.

Related Topics
• How You Use Measure Catalogs in Supply Chain Planning
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Levels and Attributes  

How You Use Levels and Attributes in Supply Chain Planning  
On the Levels and Attributes tab, you can enable certain item attributes (standard fields or flexfields) and organization
attributes (standard fields) to be available in Planning Analytics as filters.

For example, you can enable PLANNER_CODE to use in an analysis to group metrics and measures by that particular
attribute.

You can create a display name to use in the various pivot tables and graph configurations. For example, if the
predefined level name is Product Category 2, you can enter a display name of Laptops. You can also configure which
identifier to display in tables and graphs for selected hierarchies. For example, you can choose to display item name or
item description in your tables and graphs.

Displaying Descriptions in Tables and Graphs
You can analyze planning data in planning tables and graphs by using the description fields of selected entities in
hierarchies, such as items and organizations. You can use the description fields when their primary identifier is a difficult
to understand alphanumeric code.

For each dimension level (Item, Organization, Resource, Work Center, or Work Area) you can select only one member
identifier option to display in a planning table or graph. To see a list of the Member Identifier to Display options, refer to
the Configure Planning Analytics topic in this guide.

Tip:  The organization level in the Organization dimension and the organization level in the Resource dimension are
separate settings. Oracle recommends that you set them to use the same identifier.

Changing a member identifier can impact the advanced criteria in tables and graphs. If you use an advanced filter
criteria in a table or graph, then the criteria will be compared to the new member identifier, which can affect the search
results. The change to the member identifier can result in different or no members meeting the filter criteria. For
example, many names might start with AB, but no descriptions start with AB. After you make this change, you should
verify that any advanced filter criteria used are still valid.

Note:  In the Selector Tool, the member values displayed are based on what's configured in the Member Identifier to
Display column on the Configure Planning Analytics page, Levels and Attributes tab. For example, for item, you can
configure your tables and graphs to show item description instead of item name, which is what also appears when
you're in the Selector Tool.

Related Topics
• Overview of Planning Analytics

• Configure Planning Analytics
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User-Defined Hierarchies  

Overview of User-Defined Hierarchies  
You can create and update user-defined hierarchies for your demand, demand and supply, sales and operations, or
supply plan using the file-based data import (FBDI) template named Supply Chain Planning User-Defined Hierarchy
(ScpUser-DefinedHierarchyImportTemplate.xlsm).

You can do the following using the import template:

• Create a user-defined hierarchy for these dimensions:

◦ Customer

◦ Demand Class

◦ End Demand Organization

◦ End Demand Product

◦ Organization

◦ Product

◦ Resource

◦ Sales Organization

◦ Supplier

• Add members to or remove members from an existing level in the user-defined hierarchy.

• Modify the user-defined hierarchy by adding or deleting levels.

• Delete the user-defined hierarchy.

Note:  After creating your user-defined hierarchy, you can’t rename its levels and level members. If the hierarchy is
configured in a planning level profile with the Enabled or Ready status, you can't change the structure of the hierarchy
or delete it.

Related Topics
• Create a User-Defined Hierarchy

• Add or Remove Members

• Add or Delete Levels

• Delete a User-Defined Hierarchy

• Overview of Planning Level Profiles

Create a User-Defined Hierarchy  
You can’t create a user-defined hierarchy with only the lowest level.
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To create the user-defined hierarchy, do these steps:

1. In the Supply Chain Planning User-Defined Hierarchy import template (ScpUser-
DefinedHierarchyImportTemplate.xlsm), enter the structure of the user-defined hierarchy on the User-
DefinedHierarchyMaster_ worksheet.

The lowest level for each supported dimension is LEVEL_0, and the name for this level is predefined and can’t be
changed. The highest-possible level is LEVEL_10.

If the hierarchy is for the Product dimension, you can enter Yes in the Default Indicator column to enable the
hierarchy by default in the Selector Tool.

2. Enter the details of the level members on the User-DefinedHierarchyDetail_ worksheet.
3. Generate the .csv files for the import template, and compress them into a single file.
4. Click Navigator > Tools > File Import and Export, and import the compressed file.
5. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.

a. In the Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined

hierarchies.
6. Click Submit.

The user-defined hierarchy is created.

7. Add the user-defined hierarchy to the dimension catalog that’s used by your plan.

Note:  If you’ve created your demand, demand and supply, or supply plan in the Planning Central work area, add
the hierarchy to the Default Catalog, which is the only dimension catalog that can be used in plans that are created
in this work area.

8. Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.

Select other options as required.

9. Modify your selections on the Hierarchies and Members tabs in the Selector Tool for the affected tables and graphs.

Related Topics
• Overview of User-Defined Hierarchies

• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Add or Remove Members  
You can add members to or remove members from any level of your user-defined hierarchy.

Note these points about adding members to or deleting members from your user-defined hierarchy:

• At the lowest level (LEVEL_0), you can add only those members that have already been collected from Oracle
Fusion Cloud Applications or your third-party source system. When you delete members at the lowest level of
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your user-defined hierarchy, the deletion is restricted to the user-defined hierarchy, and the members continue
to exist in your source system.

If you're only adding or deleting members at Level_0, you must run the Load Planning Data from Flat Files
scheduled process in the Net change mode.

In the Supply Chain Planning User-Defined Hierarchy import template (ScpUser-
DefinedHierarchyImportTemplate.xlsm), you don't need to enter anything on the User-
DefinedHierarchyMaster_ worksheet or generate the .csv file for this worksheet. On the User-
DefinedHierarchyDetail_ worksheet, you can enter Yes in the Delete Indicator column for the members you're
going to delete.

• If you're only adding members to an intermediate level or the top level of your user-defined hierarchy, you must
run the Load Planning Data from Flat Files scheduled process in the Net change mode.

In the Supply Chain Planning User-Defined Hierarchy import template, you don't need to enter anything
on the User-DefinedHierarchyMaster_ worksheet or generate the .csv file for this worksheet. On the User-
DefinedHierarchyDetail_ worksheet, you need to enter only the details for the new members. If required, for the
new members at intermediate levels, you can also enter child members at lower levels.

• If you're only deleting members from an intermediate level or the top level of your user-defined hierarchy, you
must run the Load Planning Data from Flat Files scheduled process in the Targeted mode. Effectively, you're
going to delete and recreate the user-defined hierarchy.

In the Supply Chain Planning User-Defined Hierarchy import template, you must enter all the levels on the
User-DefinedHierarchyMaster_ worksheet and all the level members on the User-DefinedHierarchyDetail_
worksheet and generate the .csv files for both worksheets.

You must also delete all members for which you're deleting the parent member. Otherwise, you'll have
orphaned members in your user-defined hierarchy. You can delete the members by not including the applicable
rows on the User-DefinedHierarchyDetail_ worksheet instead of entering Yes in the Delete Indicator column.

• If your user-defined hierarchy is configured in a planning level profile, and you've used the Load Planning Data
from Flat Files scheduled process to add or delete hierarchy members for the Customer dimension, you must
manually run the Aggregate Collected Planning Data scheduled process. Then, you must manually run the
Create Trees for Dimensions scheduled process in the net change mode for the Customer dimension.

To add members to or remove members from levels of the user-defined hierarchy, do these steps:

1. If you previously imported measure values using the Supply Chain Planning Measures import template
(ScpMeasuresImportTemplate.xlsm) for existing members that you’re going to delete, delete the measure data for
these members using the same import template.

On the Measures_ worksheet, for the values that you want to delete, enter Yes in the Delete Indicator column.

2. Generate the .csv file for the import template, and compress it.
3. Click Navigator > Tools > File Import and Export, and import the compressed file.
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4. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.
a. In the Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined

hierarchies.
e. Click Submit.

Data is removed for the level members that you're going to delete.

5. In the Supply Chain Planning User-Defined Hierarchy import template, enter information as required on the User-
DefinedHierarchyMaster_ and User-DefinedHierarchyDetail_ worksheets.

6. Generate the .csv files for the import template, and compress them into a single file.
7. Click Navigator > Tools > File Import and Export, and import the compressed file.
8. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.

a. In the Process Details dialog box, in Source System, select the source system.
b. In Collection Type, make the required selection.
c. In Data File, select the compressed file.
d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined

hierarchies.
e. Click Submit.

The members are created or deleted.

9. Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.

Select other options as required.

10.Add members to or remove members from the Selected Members pane on the Members tab in the Selector Tool for
the affected tables and graphs.

Related Topics
• Overview of User-Defined Hierarchies

• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Overview of Planning Level Profiles

Add or Delete Levels  
To change the levels of an existing user-defined hierarchy, you must delete and recreate the entire hierarchy using the
Targeted collection type for the Load Planning Data from Flat Files scheduled process.

You can’t delete the lowest level (LEVEL_0) of the user-defined hierarchy.

If the user-defined hierarchy is configured in a planning level profile with the Enabled or Ready status, you can't change
the hierarchy structure.

Note:  Oracle doesn’t recommend deleting a level from the user-defined hierarchy if you’ve loaded or stored data at
that level because level deletion also requires data removal.
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To modify the user-defined hierarchy by adding or deleting levels, do these steps:

1. If your measures are storing data for a level that you’re going to delete, delete the level data in these measures using
the Supply Chain Planning Measures import template (ScpMeasuresImportTemplate.xlsm).

On the Measures_ worksheet, for the values that you want to delete, enter Yes in the Delete Indicator column.

If you previously imported measure values for an existing level that’s going to move up or down in your user-defined
hierarchy, you don’t need to reimport measure values for that level because the IDs for the level and level members
remain unchanged.

2. Generate the .csv file for the import template, and compress it.
3. Click Navigator > Tools > File Import and Export, and import the compressed file.
4. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.

a. In the Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined

hierarchies.
5. Click Submit.

Measure values are deleted.

6. In the Supply Chain Planning User-Defined Hierarchy import template (ScpUser-
DefinedHierarchyImportTemplate.xlsm), enter the levels that must be added or deleted on the User-
DefinedHierarchyMaster_ worksheet.

Consider an example in which your user-defined hierarchy structure for the Organization dimension is Organization
(LEVEL_0), District (LEVEL_1), and Region (LEVEL_2):

◦ To add a level called State that’s at the highest level, you should enter Organization (LEVEL_0), District
(LEVEL_1), Region (LEVEL_2), and State (LEVEL_3).

◦ To add a level called Borough that’s in between Organization and District, you should enter Organization
(LEVEL_0), Borough (LEVEL_1), District (LEVEL_2), and Region (LEVEL_3).

◦ To delete the District level, you should enter Organization (LEVEL_0) and Region (LEVEL_1).

If the hierarchy is for the Product dimension, you can enter Yes in the Default Indicator column to enable the
hierarchy by default in the Selector Tool.

You don’t need to enter anything on the User-DefinedHierarchyDetail_ worksheet for the deleted levels. For the
new and modified (existing) levels, you must enter the all the level members on the User-DefinedHierarchyDetail_
worksheet.

7. Generate the .csv files for the import template, and compress them into a single file.
8. Click Navigator > Tools > File Import and Export, and import the compressed file.
9. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.

a. In the Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Targeted.
c. In Data File, select the compressed file.
d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined

hierarchies.
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10.Click Submit.

The user-defined hierarchy is deleted and recreated.

11. Using the Supply Chain Planning Measures import template, import measure values for newly added levels if you
need to.

12. Generate the .csv file for the import template, and compress it.
13. Click Navigator > Tools > File Import and Export, and import the compressed file.
14. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.

a. In the Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined

hierarchies.
15. Click Submit.

Measure values are populated.

16.Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.

Select other options as required.

17. Modify your selections on the Hierarchies and Members tabs in the Selector Tool for the affected tables and graphs.

Related Topics
• Overview of User-Defined Hierarchies

• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Overview of Planning Level Profiles

Delete a User-Defined Hierarchy  
This topic explains how you can delete a user-defined hierarchy.

Across your user-defined hierarchies, the IDs of the lowest levels and their members are the same. You can't delete the
lowest levels, their members, and the measure data that's associated with these members. These members are shared
across your user-defined hierarchies.
The intermediate levels and top level of your user-defined hierarchy are specific to it. These levels and their members
have unique IDs and aren't shared. When you delete the user-defined hierarchy, the intermediate levels and top level
and their members are deleted.

If the user-defined hierarchy is configured in a planning level profile with the Enabled or Ready status, you can't delete
the hierarchy.

To delete a user-defined hierarchy, do these steps:

1. If your measures are storing data for an intermediate level or the top level that you’re going to delete, delete the data
in these measures, and reload them at an existing level of a different user-defined hierarchy using the Supply Chain
Planning Measures import template (ScpMeasuresImportTemplate.xlsm).

On the Measures_ worksheet, make the changes that you require.

2. Generate the .csv file for the import template, and compress it.
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3. Click Navigator > Tools > File Import and Export, and import the compressed file.
4. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.

a. In the Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined

hierarchies.
5. Click Submit.

Measure values are deleted or populated.

6. In the Supply Chain Planning User-Defined Hierarchy import template (ScpUser-
DefinedHierarchyImportTemplate.xlsm), on the User-DefinedHierarchyMaster_ worksheet, enter the name and level
names of the user-defined hierarchy that you want to delete.

Enter Yes in the Delete Indicator column.

You don’t need to enter anything on the User-DefinedHierarchyDetail_ worksheet or generate the .csv file for this
worksheet.

7. Generate the .csv file for the import template, and compress it.
8. Click Navigator > Tools > File Import and Export, and import the compressed file.
9. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.

a. In the Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined

hierarchies.
10.Click Submit.

The user-defined hierarchy is deleted from dimension catalogs that it exists in.

Note:  The user-defined hierarchy is still available in tables and graphs that are using it.

11. Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.

Select other options as required.

The user-defined hierarchy is removed from the tables and graphs of the plan.

12. Modify your selections on the Hierarchies and Members tabs in the Selector Tool for the affected tables and graphs.

Related Topics
• Overview of User-Defined Hierarchies

• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Overview of Planning Level Profiles
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6  Planning Measures

Predefined Measures in Supply Chain Planning  
When you use one of the Supply Chain Planning work areas, you have access to many predefined measures.

To review the details of each predefined measure, use the following:

• The Manage Planning Measures task

• A spreadsheet available at My Oracle Support

The Manage Planning Measures Task
On the Manage Planning Measures page, select a measure, and then select edit. You can review the details of the
measure on the Edit Measure page even if you can't make changes to the measure.

A Spreadsheet Available at My Oracle Support
Use Doc ID 2374816.1, Oracle Supply Chain Planning Cloud: List of Predefined Measures.

The List of Predefined Measures spreadsheet contains only the core measure attributes. You can use the Edit Measures
page to view all the attributes associated with a particular measure.

How You Manage Planning Measures  
Use the Manage Planning Measures task to review Supply Chain Planning measures.

You can edit several measures, but some measures you can only view. You use the pivot table to view the data you
edited at different aggregations. The results of the edits are stored based on definitions of a measure.

This topic discusses how you can perform these tasks:

• Update the definition of a measure

• Update aggregation parameters

• Update disaggregation parameters

• Edit data of a measure

Update the Definition of a Measure
To update the definition of a measure:

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel, click the Manage Planning Measures link.
3. Expand a measure group and scroll manually or use the search option to find all measures that match the

search criteria.
4. Select the measure that you want to modify and then click the Edit icon.
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Note:  Look for a check mark next to Allow editing at the top of the measure definition controls to confirm
that the measure is editable.

5. Click the Aggregation and Disaggregation tab to view measure definitions.

The dimensions, hierarchies, and levels at which data persists vary from measure to measure. For the
dimensions with a check mark, the measure is defined on the current dimension. For these dimensions, each
measure is defined on a single hierarchy as listed on the dialog box.

6. Click Save and Close.

Update Aggregation Parameters
Aggregation parameters control the way in which data of a measure is aggregated from the storage level to a table,
graph, or infotile. Calculation Order enables you to chose between the following options:

• Calculate and Aggregate: Calculates the measure's expression at the lowest data level and then aggregate up.

• Aggregate and Calculate: Aggregates all measures referenced in the measure's expression and then calculate
the expression.

Update Disaggregation Parameters
The disaggregation methodology is driven by the definitions of the disaggregation parameters. Disaggregation for
definitions that include time can be different from disaggregation for definitions that don't include time. For noneditable
measures there are no configuration in the disaggregation parameters.

Here are the four different allocation methods:

• Same: Indicates that all lower-level entries into which the data is being saved will receive the same value.
Service level would be a good measure to use Same Value settings as the percentage being entered should not
be allocated between different items and organizations.

• Equal: Spreads the edited value among the lower level entries into which data is being saved. Each entry
receives an equal share of the update. This could commonly be seen on the time dimension, where data may
be updated for a week or month, but there is no guidance on how it should be allocated to the common storage
level of days. It is typically set to the time dimension to equal value to support equal allocation between the
days.

• Self: Uses a measure's own pre-calculated values to allocate the data to the dimension member combinations.

For example, item-organization. The weights for each combination are calculated and stored for the measure
during plan run. These weights are used to allocate the data. For example, the forecasts for P1-Org1 and P2-
Org1 are 40 and 60 respectively. Therefore, the weights used for allocation would be 40% for P1-Org1 and 60%
for P2-Org1.

• Measure: Uses values of a different measure to allocate.

Edit Data of a Measure
To edit the data of a measure, open a table containing the measure, double-click the cell where the data is to be entered
and then enter the data. In a table, editable and noneditable cells look similar. However, when you double-click a cell of
an editable measure, the cell enables you to enter values.
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Copy Data from One Measure to Another
In a Supply Chain Planning table, you can update the value of one measure by using values from another measure. In
several cases, a measure can have other related measures that enable you to override the value of a base measure. For
example, Sales Forecast is one of those measures:

• Sales Forecast: Base measure.

• Adjusted Sales Forecast: You can override what's in Sales Forecast.

• Final Sales Forecast: The planning process takes the Adjusted Sales Forecast, if there is one, or uses the Sales
Forecast. The planning process uses the Final Sales Forecast, which takes into account any manual adjustments
that you made.

You can specify the data source whose values you want to copy to the selected range of cells in the target measure.
Using a table containing the three measures listed in our previous example, select a range of cells associated with the
Adjusted Sales Forecast measure, click Actions and then select Edit. In the Edit Measures dialog box, use the Sales
Forecast measure as the source measure for Adjusted Sales Forecast and increase it by 10 percent. If your Sales Forecast
is 200, then Adjusted Sales Forecast now reflects 220.

For a measure to appear in the list of values for Source Measure in the Edit Measures dialog box, the measure must be
included in the table. The measure must also conform to the same dimensions as the measure you're editing.

When editing a measure's value at an aggregate level, the value is allocated down to the lowest level. For example, when
editing weekly data, the value will be allocated down to the day.

You can also edit multiple measures at a time; however, you can't have circular references. In the following example,
Measure3 is used as a source measure for Measure1. But, Measure3 is also being edited at the same time to increase the
measure by 10 percent.

Measure Source Measure Action Value

Measure1
 

Measure3
 

Increase by percentage
 

10
 

Measure2
 

Measure2
 

Increase by percentage
 

10
 

Measure3
 

Measure3
 

Increase by percentage
 

10
 

In this scenario, the planning engine won't know which value of the source measure to use: the original Measure3 value,
or the value of Measure3 after increasing it by 10 percent. To avoid circular references, you must handle these edits
separately.

Related Topics
• Configure Units for a Measure

• Configure Currencies for a Measure

• Configure Conditional Formatting for a Measure

• Configure Color by Measure to Display in Graphs
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Import Measure Data Into a Planning Table  
When working with large volumes of data, you can export data from a planning pivot table to Microsoft Excel.

After you export the data, you can edit and make adjustments to any planning measure in the spreadsheet. When
you're done making changes offline in the spreadsheet, you can then import the updated planning data back into the
same table. To initiate the Upload Planning Table Data scheduled process, click the Import icon on the toolbar in the
opened table and then select the spreadsheet.

The spreadsheet that you import must have the same structure and format as the planning table. The imported
spreadsheet can be at any level of aggregation, as long as the levels match all of the levels displayed in the table. After
you select the file to import, the Upload Planning Table Data scheduled process updates the table in the background in
batch mode. While the import process uploads data in the background, you can work on other supply chain planning
tasks. When the upload process completes, the Import icon in the table displays a green check mark for the planner
who uploaded the data.

Note:  To see the uploaded data in your planning table, refresh the table after the Upload Planning Table Data
scheduled process completes.

Importing data into planning tables is available for all pivot tables in Supply Planning, Sales and Operations Planning,
Demand Management, Replenishment Planning, and Planning Central. Importing data isn't available for non-pivot
views like standard grids or other views such as the Build Plan table.

Tips for Importing Measure Data
Here are some tips to successfully import data from a spreadsheet into a planning table:

• The imported file must be a Microsoft Excel file with the .xlsx file extension.

• The import process only updates editable measures.

• The imported file must have the exact same format at the planning table. This includes the following:

◦ The uploaded file and the target table must contain the same number of rows and columns.

◦ The levels specified in the spreadsheet must match. The level names, such as Item or Organization, don't
have to appear as the header columns, but the columns and rows that represent the level must match.

◦ The members in each of the level rows and columns must be identical and in the same order. No member
can be omitted and new members can't be added.

◦ The measures column must have the same measures as the planning table for all combinations.

• The imported file must have the exact member combinations and their order listed in the column and row
headers of the table. All member names, such as item names and time periods, must be present in the same
order in the file being imported even if there are no updates for those combinations. Typically, you can achieve
the required order by exporting the table, making the edits offline, and then using the same file for import.

• All date values must be in the correct date format.

• If you update data directly in a table when the update process is still in progress, your updates can be
overwritten if they're for the same combination and measure.
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• If multiple users import files into the same table, the import process that finishes last overrides the others. For
planning tables that need frequent updates by multiple users, Oracle recommends that you create different
tables with appropriate filters.

Additional Information about the Import Process
Here's some additional information about importing data into planning tables:

• Tables with page filters aren't enabled for import. To use the table for import, remove the page filter or use
member filters in the table configuration. Filters specified as member filters in the table configuration are
respected.

• The import process evaluates and imports only the first worksheet in the workbook. If the workbook contains
other worksheets, the import process ignores them.

• The worksheet can contain native Excel comments and conditional formatting. The import process ignores
these comments and conditional formatting.

• If a cell has a formula based on another cell, the import process evaluates the formula and uses the result. The
other cell can be in the same worksheet or a different worksheet in the same workbook.

• The import process uses the data security rules assigned to the planner doing the import.

Configure Units for a Measure  
You can view a measure in several units of measure (UOM) and currencies side by side without needing separate
measures. By converting a single measure into various values and currencies, you get superior data consistency and
don't require recalculation and data synchronization.

In addition, sometimes different products and organizations have data that's loaded externally using different units of
measure. For example, vitamins sold in Europe may be shipped in bottles, while in Asia the quantities are by pill count.
By defining units, you enable these values to be converted into a cohesive value, which can be aggregated in a seamless
manner.

To configure units for a measure:

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel, click Manage Planning Measures.
3. Locate the measure for which you want to configure units and click Edit.
4. On the Advanced tab, select the Properties tab.
5. Select UOM from the list as the default value for the Base Units of Measure.

The base units of measure define the default unit of measure to which displayed data is converted. It is editable
only for numeric measures, which don't have product and organization-based levels. For measures that have
product and organization, the definition comes from the data source. When using the measure, you must
attempt to select only the relevant UOM entries for the measure to streamline the user process.

6. Select the relevant units of measure from the Display Unit of Measure.
You completed defining the unit of measure. You can view the measure using a specific table or graph.

Note:   To show the same measure with different unit of measures, you can create a copy from the original measure.
Rename the duplicated measure to use another unit of measure of your choice. You can show the same measure as
both numbers and currencies.
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To override the default unit of measure:

1. Open a table and select View, Format Measures to find the measure.
2. Click the measure you want to modify and select the value from the Unit of Measure list.
3. Click Save and Close.

Related Topics
• How You Manage Planning Measures

Configure Currencies for a Measure  
You can view a measure in several units of measure and currencies side by side without having separate measures. By
converting a single measure into various values and currencies, you get superior data consistency and don't require
recalculation and data synchronization.

To configure currencies for a measure:

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel, click the Manage Planning Measures link.
3. Locate the measure for which you want to configure currencies and click Edit.
4. On the Advanced tab, select the Properties tab.
5. Select Currency from the list as the default value for the Base Currency.

The base currency defines the default currency to which displayed data is converted and is editable only for
currency type measures.

6. Select the relevant currencies from the Display Currency.

You completed defining the currencies for a measure. You can view the measure using a specific table or graph.
The currency value is editable only if the measure type is Currency. For numeric measures, you can change the type
from Number to Currency. Select the currency that you want to use in this instance of the measure.

Note:  To show the same measure with different currencies, you can create a copy from the original measure. Rename
the duplicated measure to use another unit of measure of your choice. You can show the same measure as both
numbers and currencies.

To override the default currency:

1. Open a table and select View, Format Measures to find the measure.
2. Click the measure you want to modify and select the value from the Currency list.
3. Click Save and Close.

Related Topics
• How You Manage Planning Measures

110



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 6
Planning Measures

Configure Conditional Formatting for a Measure  
Use conditional formatting to change the background color of a cell when a specific condition occurs.

Conditional formatting is useful to draw the attention of the user for information that requires action. You define
conditions for an individual measure. A measure can have one or more formats applied. The condition is evaluated
at the table level using the configured units and currencies. Two tables with different units of measure or currencies
defined can have different cells trigger the conditional formats.

To configure global conditions:

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel, click the Manage Planning Measures link.
3. Locate the measure for which you want to apply conditions and click Edit.
4. On the Advanced tab, select the Conditional Formatting tab.
5. Click the + icon to add a row and complete the information.

Field Name Description

Measure
 

Locate the measure you want to use to evaluate. Conditional format for a measure can be based
on another measure.
 

Condition
 

Compares the selected measure to a value or another measure
 

Compare to Measure
 

Measure to which the selected measure is compared
 

Value
 

When the Compare to Measure is empty, this value is used to compare the selected measure
 

Color
 

Defines the color for the cell background when the condition is met
 

6. Click Save and Close.
To configure local overrides to conditions:

1. Open a table and select View, Format Measures.
2. Locate the measure that you want to modify and then select the Use Override Conditional Formatting check

box.
3. The Conditional Formatting section appears. Select a new conditional format to use in your table.
4. For only the Build Plan table accessed through a Supply Planning work area, the Conditional Formatting section

also includes the Apply and Name columns.
In the Apply column, select whether you want the conditional formatting to be highlighted in your Build Plan
table all the time or only when you select it from the Highlight Exceptions drop-down list.
For example, if you set up a conditional format named Resource Overload and select When selected, Resource
Overload appears in the Highlight Exceptions drop-down list in your Build Plan.

5. Click Save and Close.
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Related Topics
• How You Manage Planning Measures

Load Measures from Other Plans  

Overview of Loading Measures from Other Plans  
You can copy data from a plan in one Oracle module to another plan in a different Oracle module. You can also copy
data between measures in the same plan in an Oracle module. When you load measures, you can:

• Copy a stored measure into another stored measure across plans or within the same plan.

• Copy a calculated measure into a stored measure across plans or within the same plan.

By doing so, you can reduce the time taken for calculating and displaying the table or graph that displays the
stored measure.

• Copy a calculated measure into another calculated measure across plans.

• Take snapshots of measure values for comparison at a later time.

You've two options to load measures between plans or within a plan:

• Use the Load Measures from Other Plans task in a Sales and Operations Planning, Demand Management, or
Demand and Supply Planning work area.

This task in turn submits the parent scheduled process named Orchestrate Load Measures Processes in the
Scheduled Processes work area.

• Use the scheduled process named Orchestrate Load Measures Processes in the Scheduled Processes work
area.

The target measure is refreshed only when you run the task or scheduled process. Therefore, you should use the task
or scheduled process whenever the value of the source measure changes. Usually, you must run the task or scheduled
process after a plan run with a data refresh.

The load measures from other plans functionality provides you with visibility of data from a measure across different
planning modules. For example, you can make the constrained forecast from Oracle Sales and Operations Planning
visible to demand planners in Oracle Demand Management for reference. You can also enable further refinement of
the operations forecast. After you copy a calculated measure into a stored measure, you can perform aggregate or
disaggregate analysis of the tactical planning data.

You can load a source measure to a different target measure. For example, you can load the Constrained Forecast
source measure from a demand and supply plan to a target measure called Tactical Constrained Forecast in an
aggregate sales and operations plan. You can then compare the aggregate constrained forecast with the tactical
constrained forecast to drive effective decision-making.

Additionally, you can create measure mappings and save them to a measure copy set to reuse in subsequent scheduled
process runs. You can modify measure mappings in an existing measure copy set. By using measure copy sets, you can
quickly submit the scheduled process.
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Specify Time Range When Loading Measures from Other Plans
You can specify the time range when copying the measure data between plans. You can include either the entire or a
specific time range. You can copy the measure data for the past and future periods to support period-to-date reporting
and analysis.

The context of the copy is based on the target plan. If you copy the data between different plans, the copy time level is
the higher time level of the two plans. For example, you want to copy the measure data from a demand plan at a hybrid
time level to a sales and operations plan at a monthly time level. Here, the data is copied at the higher time level, that
is, the monthly time level. However, if you copy the measure data from a sales and operations plan at a monthly time
level into a demand plan at a daily or hybrid time level, the data is copied at the monthly time level. Once this data gets
copied, it gets disaggregated to the daily or hybrid time level.

If you copy the data in the same plan, the copy time level is the planning time level of the plan.

For example, you've the following sales and operations plan with a monthly time level and need to copy the measure
data from a calculated measure to a stored measure within the same plan. The plan start date is November 2, 2022, and
the current date is November 14, 2022.

• Suppose the source forecast measure spans both forecast and history. You must use a negative value when you
select the past time period. Specify -1 to identify the month prior to the current month, that is, October 2022.
Set the time level range end as 24 to include the entire future in the monthly range.

• If the source forecast measure spans the forecast, specify the time level range start as 1. The measure values in
the November 2022 period are copied from the plan start rather than from the current date forward.

Note:  Enter time range start and end values that are nonzero integers.

Source and Target Measure Mapping
Here's some more information about source and target measure mapping:

• When you're copying measure data between plans, if the target plan's measure catalog contains a measure
with the same name as the source measure, it's automatically selected as the target measure. If a measure
with the same name as the source measure isn't available in the target plan's measure catalog, then you must
manually select the target measure.
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• If none of the target measures is shared, only forecast data is copied. If at least one target measure is shared,
both forecast and historical data are copied.

• When you copy data from a calculated measure to a stored measure, select a calculated measure for which the
resulting value doesn't change often.

Calculated measures that use collected, historical data are good choices as source measures. Calculated
measures that change when you generate a forecast or do a manual override aren't good choices as source
measures.

• When you want to copy data from a calculated measure to a stored measure, you can duplicate the calculated
measure to create the stored measure. Remove the calculations from the copy, and retain the other settings.

• You can't use a source measure in more than one mapping row of a measure copy set. Also, you can't use a
target measure in more than one mapping row of a measure copy set.

• Source and target measures can be predefined or user-defined.

This table summarizes how the list of available target measures is determined and displayed:

When Then

The source and target plans are the same
 

• The source measure isn't available for selection because the source measure and target measure
must be different.

• No calculated measures are available for selection.

• The source and target plans are the
same

• The source and target plan types are
different

• The available target measures are of the same type as the source measure.

• The available target measures are in the measure catalog of the target plan.

• The available target measures have the same calculation order for aggregation as the source
measure.

• If the source measure is stored, then only stored or editable measures are available as the target
measures.

• If the source measure is calculated, then the available target measures are:

◦ Stored or editable

◦ Calculated and with the same dependent measures as the source measure when the source plan
and target plan types are different

In this case, the dependent measures are in the measure catalog of the target plan, and one of the
dependent measures must be stored or editable.

• The available target measures have at least one hierarchy level in common with the source
measure.

• If the source measure contains the Day level of the Time dimension, then the available target
measures must also contain the Day level of the Time dimension.

• The available target measures can be shared.

• If the planning time level of the target plan is higher than a day, then the available target
measures can be shared.

If the planning time level of the target plan is a day, then the available target measures can't be
shared.

• The available target measures aren't archived.
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Source and Target Plan Type Mapping
When the planning time level of the source plan is Day, the target plan can have any planning calendar and planning
time level.

When the planning time level of the source plan isn't Day, the target plan is selected as follows:

• If the planning time level of the target plan is Day, the planning calendar can be anything.

• If the planning time level of the target plan isn't Day, the planning calendar of the target plan and source plan
must be the same.

You can copy measure data between a demand plan with a hybrid time hierarchy and a sales and operations plan with
an aggregate time level. The planning calendar for each available sales and operations plan is one of the calendars on
the basis of which the hybrid time hierarchy for the demand plan is created. The planning calendar and planning time
level of the sales and operations plan determine the level at which measure data is copied.

For example, if you copy measure data from a demand plan for which the planning calendar is a Gregorian hybrid
hierarchy to a sales and operations plan that's defined at the Gregorian month, measure data gets copied at the
Gregorian month level. If you copy measure data from a sales and operations plan defined at the fiscal Quarter level to a
demand plan with a fiscal hybrid hierarchy, measure data gets copied at the fiscal Quarter level and disaggregated to the
Hybrid time level.

You can't load measures between plans if either the source plan or target plan uses a planning level profile. Such
plans aren't available for selection on the Load Measures from Other Plans page or for the scheduled process named
Orchestrate Load Measures Processes.

This table summarizes how you can copy measure data from work areas and between plan types:

From Work Area Source Plan Type Target Plan Type

Demand Management
 
Demand and Supply Planning
 

Demand plan
 

Demand plan
 
The source and target plans are the same.
 

Demand and Supply Planning
 
Sales and Operations Planning
 

Demand and supply plan
 

Sales and operations plan
 

Demand and Supply Planning
 

Demand and supply plan
 

Demand and supply plan
 
The source and target plans are the same.
 

Demand Management
 
Demand and Supply Planning
 

Sales and operations plan
 

Demand plan
 

Demand and Supply Planning
 
Sales and Operations Planning
 

Sales and operations plan
 

Demand and supply plan
 

Sales and Operations Planning
 

Sales and operations plan
 

Sales and operations plan
 
The source and target plans are the same.
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From Work Area Source Plan Type Target Plan Type

 

Sales and Operations Planning
 

Demand plan
 

Sales and operations plan
 

Sales and Operations Planning
 

Supply plan
 

Sales and operations plan
 

Related Topics
• Load Measures from Other Plans

• Orchestrate Load Measures Processes

• Overview of Combining Calendars in Demand Plans with Aggregate Time Levels

• Overview of Planning Level Profiles

Load Measures from Other Plans  
This topic provides steps to load measures from one plan to another or within a plan.

Note:  Before you copy the measure data, ensure that the source and target plans have run without any errors.

1. Navigate to the Load Measures from Other Plans page:

a. In the Navigator, click one of the following work area links, and then open a plan:

- Sales and Operations Planning
- Demand Management
- Demand and Supply Planning

b. On the Tasks panel tab, click the Load Measures from Other Plans link.
2. On the Load Measures from Other Plans page, select a source plan and a target plan.

The target plan is automatically selected as the source plan and can't be changed in these cases:

◦ In the Demand Management or Demand and Supply Planning work area, you selected a demand plan as
the source plan.

◦ In the Demand and Supply Planning work area, you selected a demand and supply plan as the source
plan.

◦ In the Sales and Operations Planning work area, you selected a sales and operations plan as the source
plan.

3. (Optional) To insert new combinations in the target plan, select the Create new combinations check box.

Selecting the Create new combinations check box doesn't insert new item and organization combinations
from the source plan into the target plan. Instead, the planning process inserts new demand combinations
from the source plan that don't already exist in the target plan. If you don't select this check box, source plan
combinations aren't created in the target plan if they don't already exist there, and measure data isn't copied for
these combinations.
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4. In the Copy Range Relative to Start Date section, do the following:
a. Copy Time Level: Copy Time Level conveys the time level at which measure data is copied. It is read-only

and informational.
b. Time Level Range Start: Enter the range start value to copy the measure data for either the history or

future time period.
c. Time Level Range End: Enter the range end value to copy the measure data for either the history or

future time period.

Note:  For history, enter negative values for both Time Level Range Start and Time Level Range End.

5. In the Measure Mapping section, click the Add Row icon to add a source and target measure mapping row.

a. In the Source Measure field, select the name of source measure. Don't select a measure that's already
used as a source measure in another mapping row.

b. In the Target Measure field, select the name of the target measure. Don't select a measure that's already
used as a target measure in another mapping row.

If you're copying measure data between plans, by default, the source measure is automatically selected
as the target measure if it's in the measure catalog of the target plan.

If you're copying measure data within the plan, the source measure isn't available for selection as the
target measure.

6. (Optional) To save the mapping to reuse later to quickly load data into your plan, click Save as Measure Copy
Set.

a. In the Save as Measure Copy Set dialog box, enter a name and description for your measure copy set.
b. To replace an existing measure copy set, select the Overwrite existing check box.
c. Click Save and Close to return to the Load Measures from Other Plans page.

7. Click Submit to run the Load Measures from Other Plans scheduled process.

The Status dialog box opens and displays the request number. You can use this request number to search for
the result of the parent scheduled process (Orchestrate Load Measures Processes) in the Scheduled Processes
work area.

Related Topics
• Overview of Loading Measures from Other Plans

Orchestrate Load Measures Processes  
This topic provides steps to load measures between plans or within a plan using the Orchestrate Load Measures
Processes scheduled process.

Note:  Before you copy the measure data, ensure that the source and target plans have run without any errors. Also
ensure that the measure copy set has been created on the Load Measures from Other Plans page.

1. In the Scheduled Processes work area, click the Schedule New Process button on the Overview page.
2. In the Schedule New Process dialog box, search for and select Orchestrate Load Measures Processes, and

then click OK.
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3. In the Process Details dialog box, Basic Options section, do the following:

a. From Plan: Select a source plan name.
b. To Plan: Select a target plan name.

You can select the source plan as the target plan if you want to copy measure data within the plan.
c. Measure Copy Set: Select a measure copy set.

If you're copying measure data within the plan, the source measure and target measure in a row of the
measure copy set can't be the same.

d. Create new combinations: Optionally, select the check box to insert new combinations in the target plan.

When you're copying measure data between plan types, if you select this check box, source plan
combinations are created in the target plan if they don't already exist there before the measure data is
copied. If you don't select this check box, source plan combinations aren't created in the target plan if
they don't already exist there, and measure data isn't copied for these combinations.

4. Click the Advanced button and navigate to the Schedule tab. You can set up the process to run as soon as
possible or establish a schedule.

5. When done, click Submit.

The Confirmation dialog box opens and displays the process number. You can use this process number to
search for the process result in the Scheduled Processes work area.

Related Topics
• Overview of Loading Measures from Other Plans

• Load Measures from Other Plans

• Orchestrate Load Measures Processes

View the Audit Trail for a Measure  
Use the Audit Trail of Measure Updates table to view the audit trail for a measure.

The table displays details of changes made to measure values for auditing purposes. You can view the audit trail for all
measure types, such as numeric, date, and string.

The Audit Trail of Measure Updates table is available for Demand Plan, Supply Plan, Demand and Supply Plan, and Sales
and Operations Plan types. You can access the audit trail from your respective Supply Chain Planning work area.

Only editable measures that are part of the plan's measure catalog appear in the Audit Trail of Measure Updates table.

Note:  Only the user who updated the measure can view the previous value and new value in the audit row. Other
users, who have permissions to view the audit trail, must open the Audit Trail Details page to view the details.

The security permissions are set according to the job roles on a measure group or on a specific hierarchies, such as
Item, Organization, Customer or Supplier. For additional details, open the Administer Planning Security page from the
task drawer of the Plan Inputs work area.

Use the following steps to view the audit trail for a measure:

1. From a Supply Chain Planning work area, click the Open button and then select a pane.
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2. In the Open Table, Graph, or Tile Set dialog box, search for the Audit Trail of Measure Updates table. Select the
table and then click OK.

3. On the Audit Trail of Measure Updates tab, type a specific measure name and click Search.

You can click the Search button without typing any search criteria to display all the measures that have the audit
trails.

4. In the Search Results region, you can view the audit trails for a measure, which includes the following
information:

◦ Measure Name: Name of the measure on which the updates were made.

◦ Last Updated Date: Date and time when updates were made to the measure.

◦ Updated By: Name of the user who made the updates.

◦ Previous Value: Previous value for the measure.

◦ New Value: New value for the measure.

◦ Details: When you click Details, the Audit Trail Details page opens. You can review additional details, such
as levels, members, filtered levels, and filtered members.

Guidelines for Setting the Calculation Order  
How you set the calculation order for a measure affects its computation of data.

On the Aggregation and Disaggregation tab on the Create Measure page, in Aggregation Parameters, you can select
Calculate then aggregate or Aggregate then calculate in the Calculation Order field. If you make an incorrect
selection in this field, the measure value won't be correct.

Note these guidelines for setting the calculation order of the measure:

• When the measure's calculation order is Calculate then aggregate, all dependent measures must also use the
same order.

Dependent measures are all the measures (and their dependent measures, in turn) that are used in the main
measure's expression.

• On the Expression tab, your selection of the calculation order along with your use of the Lag and Lead
functions can affect the calculation of data.

The Lag and Lead functions have two parameters. The first parameter contains the measure the function is
applied to. The second parameter contains the number of time buckets.

When you use the Calculate then aggregate order, the second parameter is interpreted as being in days. For
example, Lag(Bookings History Average, 10) returns the value of the Bookings History Average measure from
10 days prior to the time period of the table cell.

When you use the Aggregate then calculate order, the second parameter is interpreted as being in the time
level that the measure data is displayed at in the table. For example, in a table that displays monthly time
buckets, Lead(Consensus Forecast MAD, 6) returns the value of the Consensus Forecast MAD measure 6
months after the month of the table cell.

If you've configured the table so that time buckets can be expanded or collapsed, then the time buckets can be
interpreted at different levels. For example, if you've configured the table to display both quarterly and monthly
time buckets and can expand a quarter to see the underlying months, Lag(Shipments History, 2) returns the
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value of the Shipments History measure from 2 quarters prior to the cell being reviewed if the quarters are
collapsed or 2 months prior to the cell being reviewed if the quarters are expanded.

Manage User-Defined Measures  

Create Measures and Assign to a Measure Catalog  
In addition to reviewing measures, you use the Manage Planning Measure task to create, edit, duplicate, and delete
measures. You can also create measure groups and add predefined and user-defined measures in them.

This topic discusses the following:

• Creating measures

• Assigning measures to a measure catalog

Create Measures
If you have the required privileges, you can create measures if the predefined ones don't meet your requirements. The
measures that you create have the same features and functionality as predefined measures.

To create a measure:

1. In a Supply Chain Planning work area link, click the Tasks panel tab.

You can create measures from one of the following work areas: Demand Management, Replenishment
Planning, Supply Planning, Sales and Operations Planning, Demand and Supply Planning, or Plan Inputs.

2. In the Tasks panel, click the Manage Planning Measures link.
3. Click Create from the Actions menu.

a. On the Create Measure page, enter a measure name and description.
b. Select a measure group.
c. Select a data type.
d. Select the Allow editing check box if you want the measure to be editable in a pivot table.
e. Select Edit Range to enable the Edit Lock tab, which controls the editable status of the measure

The Edit Range value determines the time range over which the measure is editable. The available values
are: History, Future, History and Future.

f. On the Aggregation and Disaggregation tab, define the dimension parameters. Select the dimensions,
hierarchy, and hierarchy level within the dimension to store the measure data. When a dimension and
hierarchy are selected, the default setting for the Stored Level is the lowest level of the dimension's

120



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 6
Planning Measures

hierarchy. You can modify the level to store by selecting the hierarchy from the list and setting the stored
level parameter within that hierarchy.

- Aggregation Parameters: The Aggregation parameters control the way a measure's data is
aggregated. You have two options:

◦ Calculate and aggregate: Calculate and Aggregate calculates the measure's expression at the
lowest data level and then aggregate up.

◦ Aggregate then calculate: Aggregate and Calculate aggregates all measures referenced in
this measure's expression and then calculate the expression.

In the Time Dimension field, select the aggregation function that controls how data is aggregated
for the time dimension. The Other Dimensions fields are the same as the Time dimension fields.
These options control how the data is aggregated across all the dimensions except for time. The
Weighted By field is enabled only if you select Weighted Average as the aggregation parameter
for either Time or Other Dimensions. It enables you to select the measure to drive the weighted
average calculation.

The aggregation types include: Sum, Average, Weighted Average, Minimum, Maximum, Count,
Latest, Median, Variance, and Standard Deviation.

- Disaggregation Parameters: The Disaggregation Parameters control how changes to the data at
an aggregated level are allocated down for storage. This is used when data changes are made in a
pivot table, but also when made by the demand forecast. The weights for each combination, such
as item-organization, are calculated and stored for the measure during plan run. These weights
are used to allocate the data. For example, the forecasts for P1-Org1 and P2-Org1 are 40 and 60
respectively. Therefore, the weights used for allocation would be 40% for P1-Org1 and 60% for P2-
Org1.

The parameters for the Disaggregation Type field are: By Measure, By Self, Equal, and Same Value.
The default parameter is Equal.

The Disaggregation Basis field is enabled only if you select the Disaggregation Type as By Measure.
Select the measure to use as the disaggregation basis from the list of measures.

The Secondary Basis field is enabled only if you have selected the Disaggregation Type field as
By Measure or By Self. The values for Secondary Basis are Booking History Average or Shipment
History Average.

The Secondary Basis measure is selected in case the basis measure has no value. You can select
only measures that contain pre-calculated proportions as a secondary basis. That is, they're
calculated during plan run.

g. On the Expression tab, define any new expressions for a measure. You create an expression when you
have to show any value other than its stored information. The expression provides a flexible framework
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for an extensive variety of calculations and information. An expression for a measure references other
measures, operators, and numbers.

For example, to create a user defined measure that shows archived time periods, you need to use an
archive expression. See the View Planning Measures from Archived Time Periods topic to learn more.

In the Expressions subtabs:

- The Functions tab lists the available functions, a description, an example of the function's use.
- The Measures tab lists the available measures, their descriptions, and data type. The Insert button

inserts the highlighted measure into the expression building area where functions or arithmetic
operations can be specified.

- The Attribute tab lists the attributes available for the Product dimension at Item level. The
description and data type of the attribute is shown in the description pane.

After you complete the expression, use the Validate button to ensure the syntax is correct. An error or
succeeded messaged is displayed.

h. On the Edit Lock tab, you can define a new expression similar to the measure expression. The difference
is rather than evaluating and displaying the expression result, the expression result is used to control or
refine the editable status of the measure. If the expression evaluates as true, the measure is locked from
editing. The expression is evaluated every time the table is run, and may change as relevant measures or
attributes are modified.

i. On the Advanced tab, click the Properties tab and review the following parameters:

- If you select the Shared measure check box, then the measure is shared across plans. By default,
the parameter isn't selected, and the measure is plan-specific.

Note:  You can share measures across only demand plans with the day planning time level or
across demand and supply plans. In such plans, shared measures are common, and the entries
you make in one plan apply to other plans. For plans of other types, even if you select the check
box, the measures are plan-specific.

- If you select the Refresh with current data check box, then the current measure value needs a
placeholder to store the result in the application. For example, a noneditable measure where the
data is imported from a legacy or other application. Selecting this check box allocates a space to
store the measure by the defined dimensions.

- Conversion Type enables you to define the valid Unit of Measure (UOM) and Currency conversions
that are available for a measure in a table.

Base Units of Measure defines the default unit of measure used to convert displayed data. The field
is editable only for Numeric measures, which don't have Product and Organization-based levels
(for measures that have product and organization, the definition comes from the data source).
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Select any relevant units of measure, which may be useful in a table, graph, or tile. Only the UOMs
that you select are available for selection in a table or graph.

Base currency defines the default currency to which displayed data are converted. The field is
editable for only Currency type measures.

You use Price lists to convert quantities into values, which are then converted to a currency.
- Data Lookup value enables you to identify a data lookup source that displays the measure as a list

of value. The source attributes have 3 options: None (Default), Level, and List.

◦ If Source=Level, you must identify the level and the attribute to display in the measure list.

◦ If Source=List, then you can create and maintain the list of values. You can either add or
remove members in this list.

j. On the Advanced tab, click the Goals tab to define if low or high values are better for measure goals.
k. On the Advanced tab, click the Conditional Formatting tab to define conditional formatting settings for

the measure.
4. Click Save and Close.

Assign Measures to a Measure Catalog
To use the user-defined measure in your plan, add the new measure to the plan's measure catalog. Navigate to
Configure Planning Analytics, find the plan's measure catalog on the Measures Catalog tab. In the Available Measures
pane, search for the new user-defined measure, and add it to the Selected Measures. After you perform a plan run you
can create a table or use an existing table, and add your new measure to the table.

Related Topics
• Configure Global Goals for Measures

• Duplicate, Edit, and Delete Measures

• Create Measure Groups

Duplicate, Edit, and Delete Measures  
You can duplicate, edit, or delete user-defined measures using the Manage Planning Measures task, which is available in
the Tasks drawer.

To duplicate the measure: Select a measure from the list of measures, select the Action menu on the toolbar, and then
click Duplicate. Duplicating the existing measure gives you a starting point for creating a new measure definition. When
you duplicate a measure the default name is Copy of <original measure name>. Other definitions of the duplicated
measure remain the same as the original measure.

To edit the measure: Select a measure from the list of measures, select Actions menu, and then click Edit. Editing a
measure enables you to select an existing measure and edit its attributes.

To delete the measure: Select a measure from the list of measures, select Actions menu, and then Delete. A complete
list of all objects including tables and measure groups are be displayed to ensure you are aware of impacts of deleting a
measure.
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Related Topics
• Create Measure Groups

• Configure Global Goals for Measures

Create Measure Groups  
Use Manage Planning Measures task to create a measure group. Measure groups are created to group measures
together that you need frequently. Depending on your business need you can create measure groups and associate
measures with appropriate groups.

To create a measure group:

1. In the Navigator, click a Supply Chain Planning work area link.
2. Click the Tasks panel tab.
3. In the Tasks panel drawer, select the Manage Planning Measures link.
4. Select Create Group from the Actions menu.

◦ Enter a name and description.

◦ From the Available Measures pane you can select measures and move them to the Selected Measures
pane.

5. Click Save and Close.

Related Topics
• Create Measures and Assign to a Measure Catalog

• Duplicate, Edit, and Delete Measures

Configure Global Goals for Measures  
You can define global goals for a measure using the Goals tab when you create or edit a measure. On the Create
Measure page, click the Advanced tab and then select the Goals tab to configure global goals.

Define if low or high values are better. For example, a high value is good for revenue; a low value is good for expenses.

For global goals, you can provide a low range or a high range.

Goals option is available only for measures of type Currency, Number, and Percent. Using Global Goals, you can first
define if low or high values are better for a measure. The ranges are displayed on the page when you are viewing a
measure in comparison with its goal, for example, in an infotile. Global goals are measure level parameters and are
not defined specifically for a subset of the data. For example, you cannot have a goal of 1000 for one organization and
50000 for another.

Related Topics
• Create Measures and Assign to a Measure Catalog

• Duplicate, Edit, and Delete Measures
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Sales Orders Measure for Demand Plans  

Sales Orders Measure and Comparison of the Forecast with
Actuals  
You can use the predefined Sales Orders measure to view past due or open sales orders in your demand plan and
compare the generated forecast with actuals.

For demand planning, monitoring the performance of the forecast against actuals is important, and the Sales Orders
measure enables you to make this comparison. With this information, you can adjust demand for products and
organizations; focus on products, organizations, and sales representatives to meet the forecast; and assess the
requirement for sales promotions.

Using the shipments history along with the Sales Orders measure, you can have a complete view of both shipped and
past due or open sales orders so that you can improve the forecast accuracy.

Note:  This feature is specific to demand plans in the Demand Management, Demand and Supply Planning, or
Planning Central work area.

Additional Points About the Sales Orders Measure
Note these additional points about the Sales Orders measure:

• The measure reflects the required quantity for the booked item on the scheduled ship date.

• You can't use the measure to view individual sales orders in demand plans.
The measure information is aggregated by the Customer, Demand Class, Organization, Product, Sales
Organization, and Time dimensions.

• For viewing sales orders in your demand plan, you must ensure that the measure is present in the measure
catalog that's attached to your plan.
The measure is in the Default Demand Management Catalog and Default Planning Central Catalog and must be
added to user-defined measure catalogs.

• The measure is populated when these conditions are met:
◦ The measure is present in the measure catalog that's attached to the demand plan.

◦ The demand plan is run with the Refresh with current data option selected on the Parameters tab in the
Run Plan dialog box.

• You can collect data for the measure through these methods:
◦ Use the Collect Planning Data page.

On the Supply Planning Data subtab on the Parameters tab, select the supply entity for sales orders.
◦ Fill in the file-based data import (FBDI) template named Supply Chain Planning Sales Orders.

Use the Load Planning Data from Flat Files scheduled process to upload the import template.
You can't refresh this measure using the Orchestrate Refresh Measures Processes scheduled process.
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• By default, to cover the backlog, the measure contains information for all past due or open sales orders with
a scheduled ship date that's later than or equal to 90 days before the start date of the plan. The measure also
contains information for all past due or open sales orders with a scheduled ship date that's between the plan
start date and before or equal to the plan end date.

To change the number of days before the plan start date for considering sales orders, you must modify the
profile value for the MSC_SALES_ORDERS_SNAPSHOT profile option code. For example, if you set the profile
value to 30, then the measure contains information for all sales orders with a scheduled ship date that's later
than or equal to 30 days before the start date of the plan.

If you don't want to populate the measure on account of performance-related issues, you must set the profile
value to -1. The measure won't be populated even if it's in the measure catalog for the demand plan.

• For configure-to-order (CTO) products, the measure returns information for only the end products. The
measure doesn't return information for the options for the base models.

• If you aggregate data for customers using the FBDI template named Supply Chain Planning Key Customer
Options, the measure data is aggregated according to your selections in the import template.

• When you use a planning level profile in the demand plan, the Sales Orders measure isn't populated.

Related Topics
• Change the Default Period for Including Sales Orders in the Sales Orders Measure

• Overview of Planning Level Profiles

Change the Default Period for Including Sales Orders in the Sales
Orders Measure  
To change the default period from 90 days before the plan start date for including sales orders in the Sales Orders
measure for a demand plan, you must create a profile option with the MSC_SALES_ORDERS_SNAPSHOT profile option
code.

You can then enter a whole number for the profile value for the days before the plan start date for which past due or
open sales orders must be included in the Sales Orders measure. For example, if you create the profile option and enter
a value of 30, then the measure includes past due or open sales orders with a scheduled ship date that's later than or
equal to 30 days before the plan start date.

Before you start
You may need administrator privileges to make the changes described in this topic.

Follow these steps to create and configure the profile option:

Here's what to do

1. In the Setup and Maintenance work area, go to the Manage Profile Options task.
2. Under Search Results: Profile Options, click Actions > New.
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3. On the Create Profile Option page, do these steps:
a. In Profile Option Code, enter MSC_SALES_ORDERS_SNAPSHOT.
b. In Profile Display Name, enter MSC_SALES_ORDERS_SNAPSHOT.
c. In Application, select Planning Common.
d. In Module, select Planning Common.
e. In Start Date, select the current date using the date editor.
f. Click Save and Close.

4. On the Manage Profile Options page, search for and select the MSC_SALES_ORDERS_SNAPSHOT profile option
code.

5. Under MSC_SALES_ORDERS_SNAPSHOT: Profile Options Levels, for the Site level, select the Enabled and
Updatable check boxes.

6. Click Save and Close.
7. In the Demand Management work area, on the Tasks panel tab, under Configuration, select Manage Planning

Profile Options.
8. On the Manage Planning Profile Options page, search for and select the MSC_SALES_ORDERS_SNAPSHOT profile

option code.
9. Under MSC_SALES_ORDERS_SNAPSHOT: Profile Values, click Actions > New.
10. In the new row, do the following:

a. Under Profile Level, select Site to make the profile option available to all users of the work area.
b. Under Profile Value, enter a whole number.

11. Click Save and Close.

Related Topics
• Sales Orders Measure and Comparison of the Forecast with Actuals
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7  Planning Data Collections

Overview of Data Collections for Supply Chain Planning  
Before running plans from one of the Oracle Fusion Cloud Supply Chain Planning work areas, you must collect data into
the planning data repository. Order promising and order management processes also use the planning data repository
to promise and manage orders.

To collect data into the planning data repository from one of the Supply Chain Planning work areas, you can do one of
the following:

• Collect Planning Data: Use this page when you collect data from the source system for Fusion Applications.

• Load Planning Data from Flat Files: Use this scheduled process when you collect data from a completely
external source system.

Depending on your security privileges, you might need to manually add these tasks. In the Setup and Maintenance work
area, use the following:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Collect Planning Data

In the collections process flow, when you begin data collections from the Fusion Applications source system, the
staging table pulls data from the source system. Similarly, when you begin data collections from comma-separated
values (CSV) files, the data is pushed from files to the staging table. Then, the data from the staging table is loaded into
the planning repository with the use of scheduled processes.

The following figure illustrates the collections processes that you can use to populate the planning data repository.
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Collect Planning Data
There are two steps involved in the data collection process. The Collect Planning Data process first pulls data from the
Fusion Applications source system into staging tables. The process then loads data from the staging tables into the
planning data repository.

On the Collect Planning Data page, use the following tabs to select what data you want to collect:

• Reference Data

• Demand Planning Data

• Supply Planning Data

Most of the reference data are global entities. Global entities are common for all source systems. For example, Units of
Measure (UOM) is common for all source systems. The supply planning and demand planning data are transactional
data. Most of the transactional data are local entities. Local entities are specific to each source system. For example, on-
hand quantity is specific for each source system.

Note:  You must have the Run Plan with Snapshot privilege to collect the item relationships preference data.

You can also select collection filters to further refine what data you want to collect. You can save your selections to
collection templates.

Note:  If you're collecting information at the Customer Site level for a demand plan that uses a planning level profile,
you must run the Aggregate Collected Planning Data scheduled process after data collection is over. Then, you
must run the Create Trees for Dimensions scheduled process in the net change mode for the Customer dimension.

Load Planning Data from Flat Files
When you submit the Load Planning Data from Flat Files scheduled process, data from the CSV files is first pushed
into the staging tables. The process then loads the data from the staging tables into the planning data repository.

To load the planning data using CSV files, follow this high-level process:

1. Create the CSV files. To create the CSV files, you can use a predefined set of file-based data import (FBDI)
templates.

2. Import the CSV files. From the Navigator, click File Import and Export, and create a new import. Specify scm/
planningDataLoader/Import for the account.

3. Submit the Load Planning Data from Flat Files scheduled process.

Note:  If you're collecting information at the Customer Site level or deleting customer-related information using the
Load Planning Data from Flat Files scheduled process for a demand plan that uses a planning level profile, you must
run the Aggregate Collected Planning Data scheduled process after data collection is over. Then, you must run the
Create Trees for Dimensions scheduled process in the net change mode for the Customer dimension.

Related Topics
• How do I update existing setup data?

• Load Planning Data from Flat Files

• Overview of Planning Level Profiles
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Global Entities  
Within data collections, certain business entities in Oracle Fusion Cloud Supply Chain Planning are referred to as global
entities.

Global entities are specific for each instance and are common for all source systems. They're common without regard to
whether they're collected from the Oracle Fusion source system or from an external source system with the use of the
file-based data import (FBDI) templates.

When data is collected for a global entity, the planning data repository stores only one record for each instance of the
global entity. The data collections process removes the source system reference from the global entity and stores the
data in the data repository. If the data collections process collects the same instance of a global entity from more than
one source system, the data repository stores the value from the last collection.

The following example describes the collection of the global entity called unit of measure (UOM) from three source
systems, namely A, B, and C:

• A has an instance of a UOM. During the collection of UOMs from A, the kilogram UOM is collected. This is the
first time the kilogram UOM is collected. The data collections process creates a kilogram record in the data
repository.

• B doesn't have any instances of a UOM. During the collection of UOMs from B, the data collections process
doesn't collect the kilogram value. Because there was no record for the kilogram UOM in B, the data collections
process doesn't change the kilogram record in the data repository. The record of the kilogram value from A is
still valid.

• C has an instance of a UOM. During the collection of UOMs from C, the kilogram UOM is again collected. The
data collections process registers the kilogram record in the data repository to match the value from C.

Note:  When you use the FBDI templates, the global entity files require a source system. The collections framework
validates that the source system matches each record's source system. A source system identifier marks each data
record.

In Oracle Supply Chain Planning, the following entities are classified as global entities:

• Approved Supplier List

• Currencies and Currency Conversion Class

• Customer and Customer Site

• Demand Class

• Order Orchestration Reference Objects

• Planners

• Regions and Zones

Note:  When you set up your geographies in the Oracle Trading Community Architecture or regions using the
Supply Chain Planning Regions import template (ScpRegionsImportTemplate.xlsm), ensure that the names
used for the first- and second-level regions are different. If the names are the same, collections won't happen
for the second-level region and child regions.

• Shipping Methods (Carrier, Mode of Transport, Service Level)
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• Supplier Capacity

• Suppliers and Supplier Sites

• Units of Measure and UOM Conversions

Data Collection Types for Supply Chain Planning  
When you collect planning data, one of the parameters you specify for the Collect Planning Data task is the Collection
Type parameter.

You can select this task from any of your Supply Chain Planning work areas. For the Collection Type parameter, you can
select one of the following values:

• Targeted: Choose the Targeted collection type when you want to collect a significant volume of source system
data. Typically, you use the Targeted collection type in scenarios such as bulk upload of transaction data,
instance upgrade, and change in collection filters.

• Net change: Choose the Net change collection type when you want to collect changed data and new records
since the last successful collection cycle.

• Automatic selection: Choose the Automatic collection type when you want the planning process to decide and
automatically select an appropriate collection type for each of the entities.

Targeted
You use the Targeted collection type when you want to perform a complete refresh of the data in the data repository.
In this mode, the planning process deletes the existing data for the selected entities from the data repository. Next, if
subsequently collected from the source, the data for the selected entities replaces the deleted data.

Note:  For the following data collection entities, you can use only the Targeted collection type: Item Costs, Resource
Availability, Fiscal Calendars, and all Shipment and Booking History data.

Net change
When you use the Net Change collection type, you collect data incrementally. The Net Change collection type collects
only changed or new data. Collecting data using the Net Change collection type is usually faster than using the Targeted
collection type. You typically use the Net Change collection type when you have previously performed a Targeted
collection, and now you want to keep your planning data current with your execution system data. You cannot select the
demand planning data when the collection type is Net Change.

Automatic selection
You use the Automatic collection type when you are not sure which collection type to select and you want the planning
process to decide the collection type for each entity. The planning process evaluates each entity on multiple factors,
such as the last collected date for an entity, and decides whether to perform a Targeted or a Net Change collection for
the entity. You can manually select the entities that you want to collect or you can use one of the predefined templates
to select your entities. If you select one of the predefined templates, you can't make any changes in the Reference Data,
Demand Planning Data, and Supply Planning Data tabs.
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Manage Planning Source Systems for Data Collections  
To populate the planning data repository, also known as the order orchestration and planning data repository, you
collect data from the Oracle Fusion source system.

On the Manage Planning Source Systems page in one of the Supply Chain Planning work areas, enable organizations for
collections. Depending on your security privilege, you can also enable organizations from the Setup and Maintenance
work area.

Go to the Setup and Maintenance work area, then go to the task:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Manage Planning Source Systems

The Oracle Fusion Source System
The Oracle Fusion source system is included as a source system for data collection. Supply chain planning, order
orchestration, and order promising processes use data that are stored in the planning data repository. You ensure the
Collections Allowed check box is enabled and manage which organizations you enable for collections.

To open the Manage Trading Community Source Systems page, navigate to the Setup and Maintenance work area and
use the following:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Manage Trading Community Source System

External Source Systems
You can also allow collections for external source systems if you will be loading planning data from files for Oracle
Fusion Global Order Promising. You must first define the external source system on the Manage Trading Community
Source Systems.

There are two types of external source systems: Others and External.

Version External
The version External source system indicates that the source system is not connected to any other Oracle Fusion
Cloud Applications Suite. This source system is not integrated with the Product Information Management work area,
Oracle Trading Community Model, and Oracle Order Management. The external source system is also referred as a
completely external source system. You cannot enable any other source system settings that are related to other Oracle
Fusion applications. You can select the Collections allowed check box now or later depending on when you want to start
collecting data. This enables the source system for data collections using the file-based import process.

Version Others
The version Others source system indicates that the source system is connected to other Oracle Fusion Applications
Suite. This source system is integrated for the Product Information Management work area, Oracle Trading Community
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Model, and Oracle Fusion Cloud Order Management. The following conditions are applicable when the external source
is Others.

• External system data for Items, Item Structures, and Catalogs is uploaded to the Product Information
Management work area

• External system data for Customers, Customer Sites, Regions and Zones is uploaded to Oracle Oracle Trading
Community Model

• External system data for Sales Orders is uploaded to Oracle Fusion Cloud Order Management

For more information on types of data that can be collected for each source system, see the Import Templates Used to
Create CSV Files for Supply Chain Planning topic.

Organizations Enabled for Data Collections
The process for enabling organizations varies depending on the version of the source system.

To enable organizations for data collections when the source system version is Oracle Fusion, perform the following
steps:

1. Click the Manage Organization List button for your Oracle Fusion source system.
2. Click the Refresh Organization List button to update the organizations list.

When adding organizations to the Oracle Fusion source system to be collected into planning, you must click the
Refresh Organization List button and then enable the organizations for collections.

3. Select the Enable for Collections check box for the organizations from which you want to collect data.

Tip:  When performing collections during your initial setup, collect order orchestration reference objects from the
predefined Oracle Fusion source system, and consider collecting organizations. After enabling organizations for
collection, collect organizations first. You can confirm the collection results on the Supply Network Model page.

To enable organizations for data collections when the source system version is External (completely external source
system), upload organizations using the file-based import process. The organizations are automatically enabled for
collections. In the Supply Chain Planning Organizations FBDI import template (ScpOrganizationImportTemplate.xlsm),
Organization tab, enter Active in the Status column for all organizations you want to import. If you leave the field blank
for an organization, that organization won't show up in the Maintain Supply Network Model page in the Plan Inputs
work area.

To enable organizations for data collections when the source system version is Others, perform the following steps:

1. Define an organization as an item-organization in the product data model.
2. Upload the organization using the file-based import process and associate the organization with Others source

system.

Related Topics
• Import Templates Used to Create CSV Files for Supply Chain Planning

• Considerations for Enabling Organizations for Data Collections

• Define Flexfield Mappings
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How the Order Orchestration and Order Promising
Processes Use the Collected Planning Data  
You perform data collections to populate the planning data repository. In addition to being used by Supply Chain
Planning processes, the collected data is used by Oracle Order Management order orchestration processes and by
Oracle Global Order Promising processes.

Data Collections
You must perform data collections to populate the planning data repository, also called the order orchestration and
planning data repository, with data from the Oracle source system or from a completely external source system. When
you load data from an external source system, use the XLSM files to organize your data in the required format and then
convert the data into CSV files. You can then upload the CSV files to the planning data repository.

Order Orchestration
Order orchestration processes use some reference data directly from the planning data repository. You must perform
data collections for the order orchestration reference entities even if you are not using the Supply Chain Planning work
areas.

Note:  Before collecting data from your Oracle source system, you must define at least one organization for the
source system. After you have set up at least one organization, you must update the organization list on the Manage
Planning Source Systems page and then enable at least one of the organizations for collections. If you have not
enabled any organization, then the collections process ends with an error.

Order Promising
The Global Order Promising processes use an in-memory copy of the data from the planning data repository. When
order orchestration processes send a scheduling request or a check availability request to Oracle Global Order
Promising, the order promising processes use the data stored in main memory to determine the response to send back
to order orchestration. You must refresh the Global Order Promising data store after every collections so that the main
memory always reflect the current.

Related Topics
• Collect Data for Global Order Promising
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How You Enable Cross-References of Entities by Data
Collections  
Cross-references enable you to locate the correct source value for each cross-referenced entity. When you enable
entities for cross-referencing, data collection pays attention to the cross-references that you have set up for certain
values.

To enable cross-referencing of entities, click the Manage Planning Data Collection Processes task from your supply
chain planning work area. Select the source system from the list, and then enable the available entities that you want to
cross-reference during data collections.

You can view the cross-referenced data for each entity on the Cross-Reference Relationships for Collected Data page in
the Plan Inputs work area.

How Planning Processes Collect Different Work
Definitions and Item Structures  
You may be concerned that the work definition and item structure data in your supply chain planning work area does
not match with what was defined in Oracle Manufacturing.

You may be concerned that the work definition and item structure data in your supply chain planning work area does
not match with what was defined in Oracle Fusion Cloud Manufacturing.

You don't need to worry. The planning application collects and uses data based on how the work definitions and item
structures are defined and associated in the manufacturing source system.

Work Definitions and Item Structures in the Source System
The work definition is a primary source of data for the planning application. The planning process uses the work
definition of make order items to determine component and resource requirements. In case the work definition is not
defined, the planning process uses the defined item structure, but to plan for components only. If a work definition
is defined and no item structure is associated to it, then you can manually add ad hoc components to it. If an item
structure is associated to it, you can still add ad hoc components to the work definition, alongside the components in
the item structure. Remember that while a work definition can be associated with only one item structure, one item
structure can be associated with several work definitions within the parent item.

Work Definitions and Item Structures in the Planning Data Repository
In the manufacturing source system, the work definitions and item structures for an item can be defined and associated
in different ways. The following table lists the most common source system combinations and how the collections and
run plan processes proceed accordingly:
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Oracle Manufacturing Definition Item Structure Name and Work Definition
Name in the Planning Data Repository

Planning Collections Processes

Only item structure is defined for an item. No
work definition is defined.
 

Item structure name exists, no work definition
name
 

The planning process collects the item structure
information but does not collect information for
routing, operations, or item resources.
 
The planning process uses item structure to
plan components and does not plan resources.
 

Only work definition is defined for an item. No
item structure is defined.
 

Work definition name exists, no item structure
name
 

The planning process collects the work
definition information to populate the item
structure and routing information.
 
The planning process populates the component
information and operation sequence number
in the item structure based on the ad hoc
components and operation assignment
available in the work definition.
 
The planning process uses the work definition
information to plan both components and
resources.
 

Both item structure and work definition are
defined for the item.
 

Both work definition name and item structure
name exist
 

The planning process uses the components
that are associated with the work definition to
plan. The planning process does not consider
any components of item structure that are not
associated with the work definition. You can
override the item structure component usage
within the work definition.
 
The planning process collects component
attributes (such as component effectivity)
from the item structure if the components are
associated with the work definition.
 
The planning process uses the work definition
to plan resources.
 

Both item structure and work definition are
defined for the item, but the work definition
does not refer to the item structure. Ad hoc
components are assigned to the work definition
operations.
 

Work definition name exists, no item structure
name
 

The planning process collects the components
from the work definition and not from the
item structure in the Oracle Fusion Product
Information Management solution.
 
The process plans components based on work
definition operation assignments and plans
resources based on the work definition.
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Enable External Data Collection for the Oracle Fusion
Source System  
Enable external data collection if you want to load transactional data from external systems. Typically, you do this if
some of your supply chain processes are managed in external applications. You load the transactional data from these
applications using file-based data imports (FBDI).

You can use external data sources for these functional areas: Inventory and Materials Management, Procurement, Order
Management, and Manufacturing. When you enable external data collection for a functional area, be aware of these
restrictions:

• You can't use configure-to-order, drop shipment, and back-to-back fulfillment.

• The entities associated with the functional area are no longer available for Oracle Fusion source collection. For
example, if you enable Order Management, the Sales Orders entity won't be available on the Collect Planning
Data page for you to select for Oracle Fusion source collection.

This table lists the entities for each functional area.

Functional Area Entities

Inventory and Materials Management
 

On-hand Quantity and Transfer Orders
 

Procurement
 

Purchase Orders and Requisitions
 

Order Management
 

Sales Orders and Reservations
 

Manufacturing
 

Work Order Supplies, Resource Availability, Resources, Work Definitions, and Item Structures
 

Enable External Data Collection
Use these steps to enable external data collection:

1. Select the Manage Planning Source Systems task in the Tasks panel from any Supply Planning work area
page. Or use this task in the Setup and Maintenance work area:

◦ Offering: Supply Chain Planning

◦ Functional Area: Supply Chain Planning Configuration

◦ Task: Manage Planning Source Systems

2. In the list of source systems, select the row that has Oracle Fusion in the Version column.
3. In the Actions menu, click Select Data Sources.
4. Select the Enable External Data check box, and then select the functional areas that you want to source

transactional entities for.

138



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 7
Planning Data Collections

Note:  Every time you enable or disable external data collection, you must run a targeted data collection to ensure
complete refresh of data in the data repository. Only the data for the organizations included in the FBDI template is
refreshed.

Related Topics
• How You Load Planning Data from Files

Collection of Safety Stock Levels  
This topic explains how you collect safety stock levels for modules of Oracle Fusion Cloud Supply Chain Planning.

Note these points about collecting safety stock levels:

• You must use the file-based data import (FBDI) template named Supply Chain Planning Safety Stock Levels
(ScpSafetyStockLevelImportTemplate.xlsm) to import externally calculated safety stock levels.

You can't use the Collect Planning Data page to collect safety stock levels from an Oracle Fusion source system.

• You can import safety stock levels at only the organization level.

You can't import safety stock levels at the subinventory level.

• You can import only time-phased safety stock quantities using the import template. You can't use the null value
for the Effective Date column.

For Oracle Replenishment Planning, only one value is accepted for a combination of an item and an
organization. If you upload time-phased safety stock quantities, the quantity for which the effective date is on
or before the plan start date and that's closest to the plan start date is used. For information about externally
calculated safety stock quantities for replenishment plans, see the topic titled How You Upload Externally
Calculated Safety Stock.

Collect Planning Data from the Oracle Fusion Source
System  

How You Collect Different Data Types for Supply Chain Planning  
When you collect data, you collect data from three categories: reference data, demand data, and supply data. On the
Collect Planning Data page there is a tab for each of these categories.

The collected data are stored in the planning data repository.

The following figure illustrates the three categories of data that you collect from the Oracle Fusion source system to the
planning data repository.
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Explanation of Callouts

1. Reference data is primarily sourced from Oracle Fusion Cloud SCM
2. Demand data comes from Oracle Fusion Cloud Order Management and Oracle Fusion Cloud Inventory

Management
3. Supply data is sourced from Oracle Inventory Management, Oracle Fusion Cloud Manufacturing, and Oracle

Fusion Cloud Purchasing

Reference Data
The collection process begins with reference data, which is primarily sourced from Oracle Fusion Cloud SCM. You collect
the data collection entities, such as basic item, resource, organization, customers and suppliers, and calendar data.

Note:  Oracle Sales and Operations Planning uses the Bill of Resources entity to link the make items with their
associated components and resource requirements. For more information on collecting Bill of Resources from an
external source system, see the Loading Planning Data from Files section.

You also use Oracle Fusion Cloud Supply Chain Planning to collect the following items:

• Item structures: To explode item-level demand into component demands and supplies.

• Work Definitions: To assign the component and resource requirements for make items.

• Units of measure: To align plan data and to convert plans from one set of units to another.

• Costs: To review plans in financial terms and evaluate the financial impact of planning decisions.

Demand Data
You collect demand data from two potential sources:

• Sales orders that flow from Oracle Fusion Cloud Order Management: You can use this as the basis of the
demand forecast, while current orders can consume the demand in near-term forecast time buckets.

• Shipment history from Oracle Fusion Cloud Inventory Management: You can use this to generate a shipments
forecast.
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Supply Data
You collect supply data from three sources:

• Oracle Inventory Management: This provides data related to on hand inventory, reservations, material transfers,
in-transit supplies, and receipts.

• Oracle Manufacturing: This provides work in process status and any manufacturing work orders.

• Oracle Purchasing: This provides purchase requisitions and purchase orders.

Related Topics
• How You Load Planning Data from Files

• Run the Load Planning Data from Files Process

• Import Templates Used to Create CSV Files for Supply Chain Planning

Collection Filters and Collection Templates  
You use collection filters and collection templates when you need to collect some common set of entities repeatedly.

The collection filters and collection templates are located on the Collect Planning Data page. To open the Collect
Planning Data page, click the Collect Planning Data task from one of the Supply Chain Planning work areas.

Depending on your security privileges, you can also open the Collect Planning Data page from the Setup and
Maintenance work area. In the Setup and Maintenance work area, use the following:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Collect Planning Data

Collection Filters
Use collection filters to improve the performance and efficiency of the collections process, and to avoid accumulation of
irrelevant data in the planning data repository. You can use several filter criteria while performing collections, such as by
employing catalogs, order types, and price lists. You can also use date-based filters for collecting shipment and booking
history information.

Enabling Collection Filters
To enable collection filters, you must first run the schedule process called Load Filter Names for Planning Data
Collection from the Scheduled Processes work area. When you run the scheduled process, the filters get enabled in the
Collect Planning Data page. Then, you can apply the filters from the next collection.

Collection Templates
Use collection templates when you want to collect a set of data repeatedly over a period. You can select either one of the
predefined templates that serves your specific need, or you can create your own template and save it for future use.

When you select a predefined template from the list, the Collection Type field is defaulted to Automatic selection and
you cannot edit the field. Also, when you select a predefined template, the Select Collection Filters field is disabled.
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You can create a collection template on the Collect Planning Data page by selecting the data collection entities and
saving the template for future use. For example, if you frequently collect certain supply planning transactional entities,
such as On Hand, Purchase Orders, and Purchase Requisitions, then save these entities as a collection template. It
reduces the overhead of selecting the same entities for subsequent collection cycles.

If the template file contains any error during the upload process, rectify the issue found in the log file and upload the
template file again.

Collect Data Using the Targeted Collection Type  
To perform a complete refresh of the data repository used by the Supply Chain Planning products, run a targeted
collection.

You can run the targeted collection immediately or you can schedule the process to run later. Demand planning data
can only be collected by using the Targeted collection type.

Note:  Before collecting demand planning data, you must successfully run the Load Filter Names for Planning Data
Collection scheduled process.

Perform the following steps to collect reference data, demand planning data, and supply planning data using the
Targeted collection type.

1. Access the Collect Planning Data page from a Supply Planning work area or the Setup and Maintenance work
area.

◦ If you are in one of the Supply chain Planning work areas:

i. Click the Tasks panel tab.
ii. In the Tasks panel drawer, click the Collect Planning Data link.

◦ If you are in the Setup and Maintenance work area, then select the following:

- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Collect Planning Data
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2. On the Collect Planning Data page, complete the following steps.

◦ On the Parameters tab:

i. Select your source system.
ii. For the collection type, select Targeted.

Demand planning data can only be collected by using the Targeted collection type.
iii. Click Select Collection Filters to select the collection filters.

◦ On the Reference Data subtab, move the required reference entities to the Selected Entities area.

◦ On the Demand Planning Data subtab, set options to collect the historical demand data in the planning
data repository. The planning process uses the historical demand data for statistical forecasting.

- Collection Time Frame Options: You can specify a fixed or rolling date range for which to collect
data.

The Fixed Date Range option enables you to collect history data within a fixed date range that you
specify.

The Rolling Date Range option enables you to collect the history data for the number of days that
you specify. For example, if you forecast weekly, specify 7 in the Number of Days to Collect field
to collect the demand history data once per week. The data collections collect the demand history
data for the latest week.

Select Roll off time periods automatically to truncate the history data by the number of days that
you specify in the Number of days to keep field each time you run collections for the demand
history data. For example, if you prefer to forecast each week based on the history data of 52
weeks, select the Roll off time periods automatically check box and specify Number of days
to keep as 364 days. This setting ensures that as you collect data every week, you keep the most
recent history of 52 weeks and automatically purge history data older than 52 weeks.

- History Measures and Attributes: Select your shipments history and bookings history measures.
- Collection for ETO Items: Select Collect history from associated base models to collect

bookings and shipments history for Engineer to Order (ETO) items from the associated base
models. When you don't select this option, the history is collected from the standard ETO items.

- History Data Options: To collect only specific order types, select from the Order Types to Include
list of values. By default, all order types are included.

Select Organization - Consumption Inventory Transactions to Include to collect consumption
inventory transactions at the organization level. You can collect only the transfer orders inventory
transactions or all consumption inventory transactions.

Select Subinventory - Consumption Inventory Transactions to Include to collect consumption
inventory transactions at the subinventory level. You can collect only the transfer orders inventory
transactions or all consumption inventory transactions for the organizations that you enabled for
subinventory planning.

Select the Collect amount data for history check box to collect amount data.
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- Additional Options: Select additional options for collections.

Collect Price Lists: Collect the price lists specified in the collections filter for price lists, or collect all
price lists if no filter is specified.

Collect Configure to Order Data: If you selected history measures and attributes, then select the
relevant check boxes to collect shipment history options and booking history options.

Sales Organization Hierarchy: Select Enable sales organization hierarchy collection to collect
one or more sales hierarchies.

◦ On the Supply Planning Data subtab:

i. Move the required supply entities to the Selected Entities area.
ii. If you collect resource availability, then select a date range type: Fixed or Relative to collection

run date.

If you selected Fixed, then provide a start date and an end date for collecting resource availability.

If you selected Relative to collection run date, then enter a number of days in the Collection
Window in Days field. The number that you enter determines a collection window in days to
collect resource availability based on a rolling time window. That rolling time window adjusts itself,
based on the date that you run collections. For example, if you specify 90, then resource availability
is collected for the next 90 days each time from the date of the collection run.

Note:  You can save your date range type selection for resource availability collection as a
collection template to use later.

iii. You can collect the existing data for the resource availability.
iv. You can also regenerate the resource availability data and then collect the data. If you select the

Regenerate data, and then collect option, the collections process runs the Update Resource
Availability Job scheduled process first and then collects the resource availability data.

3. (Optional) Click the Schedule tab and set collections to run as soon as possible or schedule to run at a different
time.

4. Click Submit to start the collections process.
5. Monitor the collection status using the Scheduled Processes page.
6. Review the collected data in the Plan Inputs work area.

Related Topics
• Verify the Load Planning Data from Files Process

• Review Data in the Planning Data Repository

• Set Up Forecast Consumption for Transfer Orders

Collect Data Using the Net Change Collection Type  
You can collect data from the Oracle Fusion source system by running the net change collection or by scheduling to run
the process later.

Before running a Net Change collection, you must run a Targeted collection for the selected entities. After the first
Targeted collection, you can run Net Change collections.
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Perform the following procedure to collect reference data and supply planning data using the net change collection
type:

1. If you are in one of the Supply Chain Planning work areas, then click the Tasks panel tab. In the Tasks panel
drawer, click the Collect Planning Data task. If you are in the Setup and Maintenance work area, then use the
following:

◦ Offering: Supply Chain Planning

◦ Functional Area: Supply Chain Planning Configuration

◦ Task: Collect Planning Data

2. Complete the following parameters for the Collect Planning Data process:

a. Select your source system.
b. Select the collection type as Net change.

Note:  You cannot make any changes to the filter criteria and demand planning data in the net change
collection type.

c. In the Reference Data tab, move the required reference entities to the Selected Entities area.
d. In the Supplies Planning Data tab, move the required supply entities to the Selected Entities area.

3. (Optional) Click the Schedule tab and set collections to run as soon as possible or schedule to run at a different
time.

4. Click Submit to initiate the collections process.
5. Monitor the collection status using the Scheduled Processes page.
6. Review the collected data in the Plan Inputs work area.

Related Topics
• Verify the Load Planning Data from Files Process

• Review Data in the Planning Data Repository

• How do I update existing setup data?

Enable Organization Group Collection for the Net Change
Collection Type  
You can use organization groups to limit the net change data collection from a source system to specific organizations.

Using organization groups for collection also eliminates the chances of data overlap when multiple instances of net
change collections are run at a time. Planners can run collections for their organizations without waiting for each other.

Let's take a simple example where your organization considers only the D1 and D2 distribution centers in your source
system for shipments to your customers. In such a case, you can create an organization group, assign D1 and D2 to the
organization group, and collect net change data specifically for this group.

Note:  Before you begin, ensure that you have your organization groups created. A supply planner creates and
manages organization groups using the Manage Organization Groups button on the Maintain Supply Network Model
page.
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Do these to collect net change data for an organization group.

1. Access the Collect Planning Data page or Load Planning Data from Files page from a Supply Planning work
area.

2. Select the source system. Organization groups are managed within the source systems.
3. Select the Net Change collection type. You can select an organization group for data collection only when the

collection type is Net Change.
4. Enable the organization group collection, and then select an organization group.
5. Perform the net change data collection. Refer to the Collect Data Using Net Change Collection Type topic in this

chapter for instructions.

Note:  After selecting your organization group and other data collection entities, you can also save your selections as
a template. Refer to the Collection Filters and Collection Templates topic in this chapter for additional information.

Related Topics
• Collect Data Using the Net Change Collection Type

• Collection Filters and Collection Templates

• How You Maintain Your Supply Network Model

Manage Incremental Planning Collections Artifacts Scheduled
Process  
Use the Manage Incremental Planning Collections Artifacts scheduled process to create, maintain, drop, or truncate net-
change planning collection log tables.

Log tables store information about modifications to supported entities within net-change or incremental collections.
These modifications include actions such as deletion, updating, or creation of entities or their attributes. For example,
the details could reflect alterations to the date or quantity of a purchase order schedule.

The Manage Incremental Planning Collections Artifacts scheduled process is run to manage log tables in these
modules:

• Oracle Supply Planning

• Oracle Demand and Supply Planning

• Oracle Sales and Operations Planning

• Oracle Demand Management

• Oracle Replenishment Planning

• Oracle Global Order Promising

• Oracle Backlog Management

For more information on this scheduled process, see the topic titled Manage Incremental Planning Collections Artifacts.
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Load Planning Data from Others and External Source
Systems  

How You Load Planning Data from Files  
You upload data using CSV files for specific business objects using the targeted or net change method.

Note:  To create the CSV files, you can use a set of Microsoft Excel template files that are provided for this purpose.
You can download the templates from the File-Based Data Import (FBDI) for SCM guide in the Oracle Help Center.

You use the targeted mode when you want to refresh data for selected entities in the planning data repository. You use
the net change mode to collect data incrementally. The net change collections mode collects only the changed or new
data. Data collection using the net change mode is fast compared to the targeted mode. The net change mode is used
to retain planning data to current with that of the executing system.

The following figure illustrates the process of collecting data from files.
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To load planning data from files, you perform the following steps:

1. Create CSV files using Microsoft Excel template and compress them into zip files.

a. Save the CSV file using the suggested entity name. You can add an underscore and other additional
characters to the CSV file name. However, you can provide any name to the zipped file.

For example, you can name the CSV file ShipmentHistory_abc.csv and the zip file LoadingCSV.zip.
2. Run the process to load planning data from files
3. Verify the load planning data process
4. Review the loaded data

Related Topics
• Create CSV Files to Load Planning Data

• Import Templates Used to Create CSV Files for Supply Chain Planning

• Run the Load Planning Data from Files Process

• Verify the Load Planning Data from Files Process

• Review Data in the Planning Data Repository

Create CSV Files to Load Planning Data  
To perform the Load Planning Data from Files task in one of the Supply Chain Planning work areas or Setup and
Maintenance work area, you must prepare the data you want to load.

You must create the necessary CSV files used to create files for import. This procedure explains how to create CSV files
to prepare planning data for loading.

1. Locate the applicable file import templates (XLSM files) in the following guide: File-Based Data Import (FBDI) for
SCM. Extract the templates to a local space.

For additional information about creating and importing CSV files, see the following section in the
Implementing Common Features for SCM guide: External Integration chapter, External Data Integration
Services for Oracle Cloud section.

2. Open the template file for the entity you are preparing and complete the file import template worksheet.

You must enable the macros in the template file before generating the CSV file.

CAUTION:  For the cells that contain dates, ensure that the data is set to the correct format in the data type.
For example, date must be set to YYYY/MM/DD.

3. After you finish preparing the data in the worksheet, generate the CSV file. The Generate CSV File button is
located in the Instructions and CSV Generation worksheet of the workbook.

4. When you save the generated CSV file, you must use the suggested name of the entity. You can add
underscore and add additional characters to the file name. For example, you can name the CSV file as
ShipmentHistory_abc.csv and you can name the file as LoadingCSV.zip.
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5. Compress the CSV file into a zipped file format using a compression utility. You can provide any name to the
zipped file.

Note:  You can include multiple CSV files in a single compressed file for a source system. The load process
uploads them in a sequential order. Select the CSV files and compress them directly. Do not compress the
parent folder that contains the files.

This completes the preparation of a file that you will upload to collect planning data.

Related Topics
• How You Load Planning Data from Files

• Run the Load Planning Data from Files Process

Data Collection Sequence  
This topic explores the sequence that you should follow for data collection.

Data collection involves collecting entities in a predefined sequence. The collected entities form the basis for supply
planning calculations. To have accurate data, you must ensure to collect the entities in a proper sequence. You cannot
collect some entities without collecting their precursor entities. The data collection sequence is very crucial when you
collect data from an external source system using CSV files.

If you run targeted collections for all entities, you can ignore the sequence for collections because targeted collections
automate the collection sequence for all entities within a single collections request. If you collect many entities in a
single request, collections will process them according to the sequences shown in this topic. If you collect only a few
entities, then you must be aware of the collections sequence information. For example, you should not collect work
orders before you collect items or resources.

To make the workflow simple, the collection sequence is divided into two parts - Part A and Part B. The collection
entities in Part B are dependent on the collection entities in Part A. You must collect the entities in Part A before you
collect the entities in Part B. Also, the collection entities are grouped together for easier presentation. The data groups
in Part A are:

• Collections Sequence Part A for Item Data

• Collections Sequence Part A for Region, Location, and Customer Data

• Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data

The data groups in Part B are:

• Collections Sequence Part B for Sales Order and Assignment Sets

• Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Every collection sequence in Part A starts with defining a source system where the collected data will reside. If you are
collecting data to the same source system, you define the source system only once. Then, use the same source system
to collect all the entities.

The following figure provides an overview of the data collection sequence. The overview shows how Part A and Part B
fit together to form a complete data collection flow.
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Collections Sequence Part A for Item Data
The following image shows the collections sequence to follow while collecting Item data from external source systems.
This image represents only half of the entities for collecting Item data.

Note:  The Organization entity is marked with an asterisk because you can collect other entities such as Planner, Item
Cost, Subinventory, Carrier, Calendar Assignment, Supplier, and Supplier Site after collecting Organization. For more
information on the collection sequence for these entities, see the Collections Sequence Part A for Currency, Calendar,
Demand Class, and UOM Data figure. Refer to the entities that are collected after Organization. Also, ensure that you
collect Location before collecting Supplier Site.
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When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.

• Collection Sequence Part B for Sales and Order and Assignment Sets

• Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Collections Sequence Part A for Region, Location, and Customer Data
The following image shows the collections sequence to follow while collecting Regions and Customers data from
external source systems. This image represents only half of the entities for Item data.
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When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.

• Collection Sequence Part B for Sales and Order and Assignment Sets

• Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data
The following image shows the collections sequence to follow while collecting Currency, Calendar, Demand Class, and
UOM data from external source systems. Also, ensure that you collect Location before collecting Supplier Site.

Note:  The Calendar entity is marked with an asterisk because there are other entities that are associated with
Calendar that you must collect in a sequence. To collect other entities associated with Calendar, see the Calendar
Upload Sequence figure.
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When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.

• Collection Sequence Part B for Sales and Order and Assignment Sets

• Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Collection Sequence for Calendar Data
The following image shows the collections sequence to follow for collecting the Calendar data. Calendar data is a part
of the data collection in Part A. You collect the Calendar data in the following subsection: Collection Sequence Part A for
Currency, Calendar, Demand Class, and UOM Data.
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Collections Sequence Part B for Sales Order and Assignment Sets
The following image shows the collections sequence to follow while collecting Sales Order and Assignment Sets data
from external source systems. The data entities in Part B are dependent on Part A. So, you must collect entities listed in
Part A before you collect the entities in Part B.
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Collection Sequence Part B for Work Orders, Work Definition, and Item Structures
The following image shows the collections sequence to follow while collecting Work Orders, Work Definition, and Item
Structure data from external source systems. The data entities in Part B are dependent on Part A. So, you must collect
entities listed in Part A before you collect the entities in Part B.
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Templates Used to Create CSV Files  
You can use the Microsoft Excel templates (XLSM files) to prepare the data for the supported collection entities.

The templates are listed in the following guide: File-Based Data Import (FBDI) for SCM. Extract the templates to a local
drive, enter appropriate data as described in the template, and generate CSV files. Compress the CSV files to a zipped
file format and upload the .zip file to the Universal Content Manager using the File Import and Export utility. The data is
then loaded from the Universal Content Manager to the planning data repository.

Collect Data from the Oracle Fusion Source

The following table lists the collections entities that can be loaded into the planning data repository for the Oracle
Fusion source. The Collection Entity column provides the name of the entities for which you can collect the data.
The XLSM File Name column provides the template name that you will download for the respective collection entity.
Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data Import Guide
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column provides the name of the topic in the FBDI guide from where you will download the template. For example, to
collect data for the Item Costs collection entity, refer to the Item Cost Import topic in the FBDI guide.

Collections Entity Link in Data Import Guide XLSM File Name

Item Costs
 

Supply Chain Planning Item Cost
 

ScpItemCostImportTemplate.xlsm
 

Customer Specific Item Relationships
 

Supply Chain Planning Item Substitute
 

ScpItemSubstituteImportTemplate.xlsm
 

Planners
 

Supply Chain Planning Planners
 

ScpPlannersImportTemplate.xlsm
 

Item Suppliers
 

Supply Chain Planning Approved Supplier List
 

ScpApprovedSupplierListImportTemplate.xlsm
 

Demand Classes
 

Supply Chain Planning Demand Classes
 

ScpDemandClassImportTemplate.xlsm
 

Allocation Assignments and Allocation Rules
 

Supply Chain Planning Planning Allocation
Rules
 

ScpPlanningAllocationRulesImportTemplate.xlsm
 

ATP Assignments and ATP Rules
 

Supply Chain Planning Available-to-Promise
Rules
 

ScpATPRulesImportTemplate.xlsm
 

Supply Update Rules
 

Supply Chain Planning Real Time Supply
Updates
 

ScpRealTimeSupplyUpdatesImportTemplate.xlsm
 

Measures
 

Supply Chain Planning Measures
 

ScpMeasuresImportTemplate.xlsm
 

Note:
You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.
 

Booking History
 

Supply Chain Planning Bookings History
 

ScpBookingHistoryImportTemplate.xlsm
 

Option Booking History
 

Supply Chain Planning Option Bookings History
 

ScpOptionBookingHistoryImportTemplate.xlsm
 

Shipment History
 

Supply Chain Planning Shipments History
 

ScpShipmentHistoryImportTemplate.xlsm
 

Option Shipment History
 

Supply Chain Planning Option Shipments
History
 

ScpOptionShipmentHistoryImportTemplate.xlsm
 

Price Lists
 

Supply Chain Planning Price List
 

ScpPriceListImportTemplate.xlsm
 

Causal Factors
 

Supply Chain Planning Causal Factors
 

ScpCausalFactorsImportTemplate.xlsm
 

Forecast Measures
 

Supply Chain Planning Forecast Measures
 

ScpForecastMeasureImportTemplate.xlsm
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Collections Entity Link in Data Import Guide XLSM File Name

Note:
This template has been superseded
by the generic template
ScpMeasuresImportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.
 

Fiscal Calendars
 

Supply Chain Planning Fiscal Calendars
 

ScpFiscalCalendarImportTemplate.xlsm
 

Forecasts
 

Supply Chain Planning External Forecasts
 

ScpExternalForecastImportTemplate.xlsm
 

Safety Stock Levels
 

Supply Chain Planning Safety Stock Levels
 

ScpSafetyStockLevelImportTemplate.xlsm
 

Supplier Capacity
 

Supply Chain Planning Approved Supplier
Capacity
 

ScpApprovedSupplierCapacityImportTemplate.xlsm
 

Planned Order Supplies
 

Supply Chain Planning Planned Order Supply
 

ScpPlannedOrderSupplyImportTemplate.xlsm
 

Note:
This template is only used to load planned
order supply to Global Order Promising.
 

Sourcing Rule and Assignments
 

Supply Chain Planning Sourcing Rules
 

ScpSourcingImportTemplate.xlsm
 

Cross-Reference Mapping Information
 

Supply Chain Planning Cross-Reference Data
 

ScpCrossReferenceDataImportTemplate.xlsm
 

Collect Data from External Source - Version Others

The following table lists the collections entities that can be loaded into the planning data repository from an external
source, where the version is Others. The Collection Entity column provides the name of the entities for which you can
collect the data. The XLSM File Name column provides the template name that you will download for the respective
collection entity. Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data
Import Guide column provides the name of the topic in the FBDI guide from where you will download the template. For
example, to collect data for the Items and Item Costs collection entities, refer to the Item Cost Import topic in the FBDI
guide.

Collections Entity Link in Data Import Guide XLSM File Name

Item Costs
 

Supply Chain Planning Item Cost
 

ScpItemCostImportTemplate.xlsm
 

Customer Specific Item Relationships
 

Supply Chain Planning Item Substitute
 

ScpItemSubstituteImportTemplate.xlsm
 

Planners Supply Chain Planning Planners ScpPlannersImportTemplate.xlsm
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Collections Entity Link in Data Import Guide XLSM File Name

   

Organizations (Warehouses) and Organization
Site (Including Organization Site - Internal
Location Mapping)
 

Supply Chain Planning Organizations
 

ScpOrganizationImportTemplate.xlsm
 

Subinventories
 

Supply Chain Planning Subinventories
 

ScpSubInventoryImportTemplate.xlsm
 

Suppliers and Supplier Sites
 

Supply Chain Planning Suppliers
 

ScpPlanningSupplierImportTemplate.xlsm
 

Item Suppliers
 

Supply Chain Planning Approved Supplier List
 

ScpApprovedSupplierListImportTemplate.xlsm
 

Interlocation Shipping Networks
 

Supply Chain Planning Interlocation Shipping
Methods
 

ScpInterLocationShipMethodsImportTemplate.xlsm
 

Currencies, Currency Conversion Types, and
Currency Conversion Rates
 

Supply Chain Planning Currencies
 

ScpCurrencyImportTemplate.xlsm
 

Units of Measure, Units of Measure
Conversions, and Units of Measure Class
Conversions
 

Supply Chain Planning Units of Measure
 

ScpUOMImportTemplate.xlsm
 

Calendars, Calendar Exceptions, Calendar
Shifts, Week Start Dates, Period Start Dates,
 and Calendar Shift Workday Pattern
 

Supply Chain Planning Calendars
 

ScpCalendarImportTemplate.xlsm
 

Calendar Associations
 

Supply Chain Planning Calendar Assignments
 

ScpCalendarAssignmentsImportTemplate.xlsm
 

Demand Classes
 

Supply Chain Planning Demand Classes
 

ScpDemandClassImportTemplate.xlsm
 

Ship Mode of Transport, Ship Class of Service,
 and Carrier
 

Supply Chain Planning Carriers
 

ScpCarrierImportTemplate.xlsm
 

Allocation Assignments and Allocation Rules
 

Supply Chain Planning Planning Allocation
Rules
 

ScpPlanningAllocationRulesImportTemplate.xlsm
 

ATP Assignments and ATP Rules
 

Supply Chain Planning Available-to-Promise
Rules
 

ScpATPRulesImportTemplate.xlsm
 

Supply Update Rule
 

Supply Chain Planning Real Time Supply
Updates
 

ScpRealTimeSupplyUpdatesImportTemplate.xlsm
 

Freight Terms, FOB Points, Invoicing and
Accounting Rules, Shipment Priorities, Payment
Terms, Return Reason, Tax Classification Code,
 Tax Exemption Reason, Sales Credit Type,
 Activity Type, Document Categories, Payment
Methods, and Receipt Methods
 

Supply Chain Planning Order Orchestration
 

ScpOrderOrchestrationImportTemplate.xlsm
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Collections Entity Link in Data Import Guide XLSM File Name

Measures
 

Supply Chain Planning Measures
 

ScpMeasuresImportTemplate.xlsm
 

Note:
You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.
 

Booking History
 

Supply Chain Planning Bookings History
 

ScpBookingHistoryImportTemplate.xlsm
 

Option Booking History
 

Supply Chain Planning Option Bookings History
 

ScpOptionBookingHistoryImportTemplate.xlsm
 

Shipment History
 

Supply Chain Planning Shipments History
 

ScpShipmentHistoryImportTemplate.xlsm
 

Option Shipment History
 

Supply Chain Planning Option Shipments
History
 

ScpOptionShipmentHistoryImportTemplate.xlsm
 

Price Lists
 

Supply Chain Planning Price Lists
 

ScpPriceListImportTemplate.xlsm
 

Causal Factors
 

Supply Chain Planning Causal Factors
 

ScpCausalFactorsImportTemplate.xlsm
 

Forecasts Measures
 

Supply Chain Planning Forecast Measures
 

ScpForecastMeasureImportTemplate.xlsm
 

Note:
This template has been superseded
by the generic template
ScpMeasuresImportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.
 

Fiscal Calendars
 

Supply Chain Planning Fiscal Calendars
 

ScpFiscalCalendarImportTemplate.xlsm
 

Forecasts
 

Supply Chain Planning External Forecast
 

ScpExternalForecastImportTemplate.xlsm
 

User-Defined Hierarchies
 

Supply Chain Planning User-Defined
Hierarchies
 

ScpUser-DefinedHierarchyImportTemplate.xlsm
 

Safety Stock Levels
 

Supply Chain Planning Safety Stock Levels
 

ScpSafetyStockLevelImportTemplate.xlsm
 

Supply Reservations to Sales Orders
 

Supply Chain Planning Reservations
 

ScpReservationImportTemplate.xlsm
 

On Hand
 

Supply Chain Planning Supply On Hand
 

ScpOnhandImportTemplate.xlsm
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Collections Entity Link in Data Import Guide XLSM File Name

Purchase Orders, Purchase Requisitions, PO in
Receiving, and In Transits
 

Supply Chain Planning Purchase Order
Requisitions
 

ScpPurchaseOrderRequisitionImportTemplate.xlsm
 

Transfer Orders
 

Supply Chain Planning Transfer Orders
 

ScpTransferOrderImportTemplate.xlsm
 

Supplier Capacity
 

Supply Chain Planning Approved Supplier
Capacity
 

ScpApprovedSupplierCapacityImportTemplate.xlsm
 

Resources and Resource Shifts
 

Supply Chain Planning Resources
 

ScpResourcesImportTemplate.xlsm
 

Resource Availability
 

Supply Chain Planning Resource Availability
 

ScpResourceAvailabilityImportTemplate.xlsm
 

Work Definition (Including mapping between
Item Structures and Work Definitions), Work
Definition Operations, and Work Definition
Operation Resources
 

Supply Chain Planning Routings
 

ScpRoutingsImportTemplate.xlsm
 

Work Order Supply
 

Supply Chain Planning Work Order Supplies
 

ScpWorkOrderSuppliesImportTemplate.xlsm
 

Work Order Material Requirements
 

Supply Chain Planning Work Order Component
Demands
 

ScpWIPComponentDemandsImportTemplate.xlsm
 

Work Order Resource Requirements
 

Supply Chain Planning Work Order Operation
Resources
 

ScpWIPOperationResourceImportTemplate.xlsm
 

Planned Order Supplies
 

Supply Chain Planning Planned Order Supply
 

ScpPlannedOrderSupplyImportTemplate.xlsm
 

Note:
This template is only used to load planned
order supply to Global Order Promising.
 

Sourcing Rule and Assignments
 

Supply Chain Planning Sourcing Rules
 

ScpSourcingImportTemplate.xlsm
 

Cross Reference Mapping Information
 

Supply Chain Planning Cross-Reference Data
 

ScpCrossReferenceDataImportTemplate.xlsm
 

Key Customer Options
 

Supply Chain Planning Key Customer Options
 

ScpKeyCustomerOptionsImportTemplate.xlsm
 

Collect Data from External Source - Version External

The following table lists the collections entities that can be loaded into the planning data repository from an external
source, where the version is External. The Collection Entity column provides the name of the entities for which you can
collect the data. The XLSM File Name column provides the template name that you will download for the respective
collection entity. Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data
Import Guide column provides the name of the topic in the File-Based Data Import (FBDI) for SCM guide from where
you will download the template. For example, to collect data for the Items and Item Costs collection entities, refer to the
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Item Cost Import topic in the File-Based Data Import (FBDI) for SCM guide. All the planning-related entity names are
prefixed with Supply Chain Planning in the FBDI guide.

Collection Entities Link in FBDI Guide XLSM File Name

Items
 

Supply Chain Planning Items
 

ScpItemImportTemplate.xlsm
 

Item Costs
 

Supply Chain Planning Item Cost
 

ScpItemCostImportTemplate.xlsm
 

Item Relationships
 

Supply Chain Planning Item Substitute
 

ScpItemSubstituteImportTemplate.xlsm
 

Catalogs, Categories, and Item Categories
 

Supply Chain Planning Catalogs
 

ScpCatalogImportTemplate.xlsm.xlsm
 

Item Structures
 

Supply Chain Planning Item Structures
 

ScpBillofMaterialImportTemplate.xlsm
 

Bill of Resources
 

Supply Chain Planning Bill of Resources
 

ScpBillOfResourcesImportTemplate.xlsm
 

Planners
 

Supply Chain Planning Planners
 

ScpPlannersImportTemplate.xlsm
 

Customers and Customer Sites
 

Supply Chain Planning Customers
 

ScpCustomerImportTemplate.xlsm
 

Regions
 

Supply Chain Planning Regions
 

ScpRegionsImportTemplate.xlsm
 

Zones
 

Supply Chain Planning Zones
 

ScpZonesImportTemplate.xlsm
 

Region-Zone Mapping
 

Supply Chain Planning Region Zone Mappings
 

ScpRegionZoneMappingImportTemplate.xlsm
 

Locations and Region-Location Mapping
 

Supply Chain Planning Locations
 

ScpLocationsImportTemplate.xlsm
 

Organizations and Organization Sites
 

Supply Chain Planning Organizations
 

ScpOrganizationImportTemplate.xlsm
 

Subinventories
 

Supply Chain Planning Subinventories
 

ScpSubInventoryImportTemplate.xlsm
 

Suppliers and Supplier Sites
 

Supply Chain Planning Suppliers
 

ScpSupplierImportTemplate.xlsm
 

Item Suppliers (Approved Supplier List)
 

Supply Chain Planning Approved Supplier List
 

ScpApprovedSupplierListImportTemplate.xlsm
 

Interlocation Shipping Networks and Transit
Times
 

Supply Chain Planning Interlocation Shipping
Methods
 

ScpInterLocationShipMethodsImportTemplate.xlsm
 

Currencies and Currency Conversions
 

Supply Chain Planning Currencies
 

ScpCurrencyImportTemplate.xlsm
 

Units of Measure, Units of Measure
Conversions, and Units of Measure Class
Conversions

Supply Chain Planning Units of Measure
 

ScpUOMImportTemplate.xlsm
 

163



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 7
Planning Data Collections

Collection Entities Link in FBDI Guide XLSM File Name

 

Calendars, Calendar Exceptions, Shifts, Shift
Workday Pattern, Week Start Dates, and Period
Start Dates
 

Supply Chain Planning Calendars
 

ScpCalendarImportTemplate.xlsm
 

Calendar Associations
 

Supply Chain Planning Calendar Assignments
 

ScpCalendarAssignmentsImportTemplate.xlsm
 

Demand Classes
 

Supply Chain Planning Demand Classes
 

ScpDemandClassImportTemplate.xlsm
 

Carrier, Ship Mode of Transport, and Ship Class
of Service
 

Supply Chain Planning Carriers
 

ScpCarrierImportTemplate.xlsm
 

GOP Allocation Rules and Rule Assignments
 

Supply Chain Planning Planning Allocation
Rules
 

ScpPlanningAllocationRulesImportTemplate.xlsm
 

GOP ATP Rules and Rule Assignments
 

Supply Chain Planning Available-to-Promise
Rules
 

ScpATPRulesImportTemplate.xlsm
 

GOP Supply Update Rules
 

Supply Chain Planning Real Time Supply
Updates
 

ScpRealTimeSupplyUpdatesImportTemplate.xlsm
 

Order Orchestration Reference Objects: Freight
Terms, FOB Points, Invoicing and Accounting
Rules, Shipment Priorities, Payment Terms,
 Return Reason, Tax Classification Code, Tax
Exemption Reason, Sales Credit Type, Activity
Type, Document Categories, Payment Methods,
 and Receipt Methods
 

Supply Chain Planning Order Orchestration
 

ScpOrderOrchestrationImportTemplate.xlsm
 

Cross Reference Mapping Information
 

Supply Chain Planning Cross-Reference Data
 

ScpCrossReferenceDataImportTemplate.xlsm
 

Measures
 

Supply Chain Planning Measures
 

ScpMeasuresImportTemplate.xlsm
 

Note:
You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.
 

Booking History
 

Supply Chain Planning Bookings History
 

ScpBookingHistoryImportTemplate.xlsm
 

Option Booking History
 

Supply Chain Planning Option Bookings History
 

ScpOptionBookingHistoryImportTemplate.xlsm
 

Shipment History
 

Supply Chain Planning Shipments History
 

ScpShipmentHistoryImportTemplate.xlsm
 

Option Shipment History
 

Supply Chain Planning Option Shipments
History

ScpOptionShipmentHistoryImportTemplate.xlsm
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Collection Entities Link in FBDI Guide XLSM File Name

 

Price Lists
 

Supply Chain Planning Price Lists
 

ScpPriceListImportTemplate.xlsm
 

Causal Factors
 

Supply Chain Planning Causal Factors
 

ScpCausalFactorsImportTemplate.xlsm
 

Forecast Measures
 

Supply Chain Planning Forecast Measures
 

ScpForecastMeasureImportTemplate.xlsm
 

Note:
This template has been superseded
by the generic template
ScpMeasuresImportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.
 

Fiscal Calendars
 

Supply Chain Planning Fiscal Calendars
 

ScpFiscalCalendarImportTemplate.xlsm
 

Measures, Sales and Operations Planning
Backlog, Inventory, and Production History
 

Supply Chain Planning Measures
 

ScpMeasuresImportTemplate.xlsm
 

Note:
You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.
 

User-Defined Hierarchies
 

Supply Chain Planning User-Defined
Hierarchies
 

ScpUser-DefinedHierarchyImportTemplate.xlsm
 

Forecasts
 

Supply Chain Planning External Forecasts
 

ScpExternalForecastImportTemplate.xlsm
 

Sales Orders
 

Supply Chain Planning Sales Orders
 

ScpSalesOrderImportTemplate.xlsm
 

Safety Stock Levels
 

Supply Chain Planning Safety Stock Levels
 

ScpSafetyStockLevelImportTemplate.xlsm
 

Supply Reservations to Sales Orders
 

Supply Chain Planning Reservations
 

ScpReservationImportTemplate.xlsm
 

On Hand
 

Supply Chain Planning Supply On Hand
 

ScpOnhandImportTemplate.xlsm
 

Purchase Orders, Purchase Requisitions, PO in
Receiving, In Transits
 

Supply Chain Planning Purchase Order
Requisitions
 

ScpPurchaseOrderRequisitionImportTemplate.xlsm
 

Transfer Orders (including expense type
transfers)
 

Supply Chain Planning Transfer Orders
 

ScpTransferOrderImportTemplate.xlsm
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Collection Entities Link in FBDI Guide XLSM File Name

Supplier Capacity
 

Supply Chain Planning Approved Supplier
Capacity
 

ScpApprovedSupplierCapacityImportTemplate.xlsm
 

Resources, Resource Shifts
 

Supply Chain Planning Resources
 

ScpResourceImportTemplate.xlsm
 

Resource Availability
 

Supply Chain Planning Resource Availability
 

ScpResourceAvailabilityImportTemplate.xlsm
 

Work Definition (including mapping between
Item Structures and Work Definitions), Work
Definition Operations, Work Definition
Operation Resources
 

Supply Chain Planning Routings
 

ScpRoutingsImportTemplate.xlsm
 

Work Order Supply
 

Supply Chain Planning Work Order Supplies
 

ScpWorkOrderSuppliesImportTemplate.xlsm
 

Work Order Material Requirements
 

Supply Chain Planning Work Order Component
Demands
 

ScpWIPComponentDemandsImportTemplate.xlsm
 

Work Order Resource Requirements
 

Supply Chain Planning Work Order Operation
Resources
 

ScpWIPOperationResourceImportTemplate.xlsm
 

Planned Order Supplies
 

Supply Chain Planning Planned Order Supply
 

ScpPlannedOrderSupplyImportTemplate.xlsm
 

Note:
This template is only used to load planned
order supply to Global Order Promising.
 

Sourcing Rule and Assignments
 

Supply Chain Planning Sourcing Rules
 

ScpSourcingImportTemplate.xlsm
 

Key Customer Options
 

Supply Chain Planning Key Customer Options
 

ScpKeyCustomerOptionsImportTemplate.xlsm
 

Related Topics
• Run the Load Planning Data from Files Process

Run the Load Planning Data from Files Process  
To load planning data from files, first you must prepare the data you want to load.
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To prepare the data, download the relevant XLSM template, update the XLSM template with required data, and create
the necessary CSV files for upload. This procedure explains how to load planning data from files after you have
prepared the data and created CSV files.

1. From the Navigator, use the File Import and Export page to upload the previously prepared and zipped CSV
files to the Universal Content Manager. Use the account scm/planningDataLoader/Import to upload the zipped
file.

Note:  For more information about uploading files to the Universal Content Manager server, see the following
section in the Implementing Common Features for SCM guide: External Integration chapter, External Data
Integration Services for Oracle Cloud section.

2. From one of the Supply Chain Planning work areas or Setup and Maintenance work area, Supply Chain
Planning offering, select the Load Planning Data from Files task.

3. Complete the following parameters on the Load Planning Data from Files page:

a. Select the source system.
b. Select Collection Type: Net change or Target.
c. Select the .zip file you previously imported into the Universal Content Manager.

4. Click Submit. Make a note of the process ID. You will need this process ID to review the status of the process.

Related Topics
• Create CSV Files to Load Planning Data

Load Planning Data from Files for a Selected Group of
Organizations  
When you load planning data from files for the net change or targeted collection type, you can enable organization
group collection and then select an organization group.

Data is collected for only the organizations in the organization group, and the purge of data before the load of the
new data is also done for only the organizations in the organization group. That is, previously collected data for
organizations that aren't included in the organization group is retained when you're doing collections using the file-
based data import (FBDI) process.

Note:  Enabling organization group collection isn't applicable to reference entities and entities for Oracle Demand
Management, such as history, measures, and price lists.

Parameters for the Load Planning Data from Flat Files Scheduled Process
These are the parameters for the Load Planning Data from Flat Files scheduled process:

• Source System: The source system for the data determines which organization groups are applicable.

• Collection Type: You must select Net change or Targeted.

• Data File: The file previously uploaded to the Oracle WebCenter Content server.

• Enable Organization Group Collection: Select Yes for this parameter.

• Organization Group: Select an organization group.
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Organization Groups
The organization group you can select for the Organization Group parameter is determined by:

• Which source system you select for the Source System parameter

• What organization groups are set up for that source system

You set up organization groups in the Manage Organization Groups dialog box that you open from the Organizations
tab on the Maintain Supply Network Model page.

Example
Here's an example that shows how data is retained for organizations in other organization groups when you load
planning data for a selected organization group.

For this example, let's say you've three organizations and two organization groups, and the source for your data is the
EX1 source system.

• Organization group OG1 includes organization M1.

• Organization group OG2 includes organizations B1 and B2.

First, you load planning data for the OG1 organization group for the Work Order Supplies entity. Two rows of data are
collected for the OG1 organization group.

Item Organization Order Type Order Quantity Suggested Due Date

Item 1
 

EX1:M1
 

Work order
 

10
 

2/14/22
 

Item 2
 

EX1:M1
 

Work order
 

15
 

2/11/22
 

Then, you load planning data for the OG2 organization group for the Work Order Supplies entity.

• Three rows of data are collected for the OG2 organization group.

• The two rows that were previously collected for the OG1 organization group are retained.

Item Organization Order Type Order Quantity Suggested Due Date

Item 1
 

EX1:M1
 

Work order
 

10
 

2/14/22
 

Item 2
 

EX1:M1
 

Work order
 

15
 

2/11/22
 

Item 1
 

EX1:B1
 

Work order
 

11
 

2/09/22
 

Item 1
 

EX1:B2
 

Work order
 

16
 

1/31/22
 

Item 2
 

EX1:B2
 

Work order
 

10
 

2/09/22
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Applicable Entities
You can use FBDI templates to load data for organization groups for these entities:

Source Entities

From an Oracle Fusion Cloud SCM source
 

• External Forecasts

• Planned Order Supply

• Safety Stock Levels

From an Oracle Fusion Cloud SCM source
for which you've selected the Enable
external data check box and other check
boxes in the Select Data Sources dialog
box that you open from the Setup and
Maintenance work area, Supply Chain
Planning Configuration functional area,
 Manage Planning Source Systems page
 

• On Hand

• Transfer Orders

• Purchase Orders and Purchase Requisitions

• Sales Order and Associated Reservations

• Work Order Component Demands

• Work Order Supplies, Work Order By-Product and Co-Product Supplies, Work Order Operation
Resources

• Resource Availability

Note:  These entities are in addition to those mentioned in the previous row for the Oracle Fusion
Cloud SCM source.

From an external source
 

• External Forecasts

• Movement Requests

• Planned Order Supply

• Purchase Orders and Purchase Requisitions

• Reservations

• Safety Stock Levels

• Sales Orders

• Transfer Orders

• On Hand

• Work Order Component Demands

• Work Order Supplies, Work Order By-Product and Co-Product Supplies, Work Order Operation
Resources

• Resource Availability

More Details About Using Organization Groups for Loading Data
Here are a few more details to know about loading planning data from files for a selected group of organizations:

• If you've included the history, measures, or price list entities in a data file used during collections with
organization group collection enabled, collections will be done for these entities for all organizations and not
just the organizations in the groups.

• If you've included reference data entities in a data file used during collections with organization group
collection enabled, these entities will be ignored.
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• Data security created and enabled at the organization level for any role isn't applied to organization groups.

• You can submit the Load Planning Data from Flat Files scheduled process multiple times to specify a different
organization group for each submission. The submissions are processed in the order of submission.

• You can specify an organization group when you submit the Load Planning Data from Flat Files scheduled
process or when using a scheduled process job set.

• You can specify an organization group when you submit the Load Planning Data from Flat Files scheduled
process using the ERP Integrations REST resource.

• If you use the Collect Planning Data page to collect some of your data, note that you can use organization
groups for only the net change collection type. For the targeted collection type, you must use the collection
filter named Organizations Filter for Transaction Data.

Related Topics
• Enable External Data Collection for the Oracle Fusion Source System

• Enable Organization Group Collection for the Net Change Collection Type

Improve Performance of Measure Disaggregation  

Overview of Improving Performance While Disaggregating Measure Data  
While importing data at an aggregate level to stored measures for Oracle Fusion Cloud Supply Chain Planning, you can
improve the performance by enabling multithreading for the disaggregation process.

While using the file-based data import (FBDI) template named Supply Chain Planning Measures, you can import data at
the stored levels or aggregate levels of the stored levels. For example, if your measure is configured with the dimension
levels of Item, Organization, Sales Rep, Customer Site, Demand Class, and Day, you can import data at these stored
levels or aggregate levels, such as product category, business unit, sales organization level, customer, demand class,
and month.

Measure data that's collected at an aggregate level is disaggregated to the stored levels during the data refresh step in a
plan run or when you incrementally refresh a plan after loading new measure data.

By default, the process for disaggregating the measure data is single-threaded. Consequently, long processing times
can result when there's a large volume of measure data to disaggregate.

To improve performance, you can configure disaggregation to run as a multithreaded process. The disaggregation
process runs in parallel for different time ranges within the time range for the collected measure data.

The multithreaded process runs in 90-day increments by default. For example, if you've collected measure data at an
aggregate level for the past year (365 days), then the process runs five disaggregation jobs in parallel, four jobs of 90
days each and one job for the remaining five days of data.

You can do the following:

• Enable multithreading for measure data disaggregation for all plans in the Demand Management, Demand and
Supply Planning, Planning Central, Replenishment Planning, Sales and Operations Planning, or Supply Planning
work area.

• Enable multithreading for measure data disaggregation for a single plan that's enabled for demand forecasting.

• Override the default of 90 days for the multithreaded process.
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Related Topics
• Enable Multithreading for Measure Data Disaggregation for All Plans

• Enable Multithreading for Measure Data Disaggregation for a Single Plan

• Override the Default Value for the Multithreaded Process

Enable Multithreading for Measure Data Disaggregation for All Plans  
You can enable multithreading for measure data disaggregation for all demand, demand and supply, replenishment,
sales and operations, or supply plans.

Before you start
You may need to work with someone who has administration privileges to make these profile-related changes.

Here's what to do

1. In the Demand Management, Demand and Supply Planning, Plan Inputs, Planning Central, Replenishment Planning,
Sales and Operations Planning, or Supply Planning work area, on the Tasks panel tab, under Configuration, select
Manage Planning Profile Options.
The Manage Planning Profile Options page opens.

2. Search for the SCP_PARAMETER_OVERRIDES profile option code.
3. If the SCP_PARAMETER_OVERRIDES profile option code exists, then click the New icon.

A new row appears for the profile value.
4. Add the profile value as follows:

◦ Profile Level: Select Site to set the value globally for all users. Select User to set the value for a specific user,
in which case you must then select a user. User-level values take precedence over the site-level value.

◦ Profile Value: Enter enableParallelDisaggMeasure=true.

Note:  You can enter multiple profile values for a profile level provided you separate them with the space
or semicolon. Whether you can select the site or user depends on the enabled levels in the profile option.

5. Click Save and Close.
6. If the SCP_PARAMETER_OVERRIDES profile option code doesn't exist, then follow these steps:

a. In the Setup and Maintenance work area, go to the Manage Profile Options task.
The Manage Profile Options page opens.

b. Click New.
The Create Profile Option page opens.

c. Create the profile option as follows:
- Profile Option Code: SCP_PARAMETER_OVERRIDES
- Profile Display Name: SCP_PARAMETER_OVERRIDES
- Application: Planning Common
- Module: Planning Common
- Start Date: Current date

Leave the remaining fields blank.

7. Click Save and Close.
8. For the profile option levels for the profile option, select the check boxes under the Enabled and Updatable columns

for both the Site and User levels.
9. Click Save and Close.
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10. In your work area, open the Manage Planning Profile Options page.
11. Search for the SCP_PARAMETER_OVERRIDES profile option code.
12. Set the profile level and value as previously explained.
13. Click Save and Close.

Related Topics
• Overview of Improving Performance While Disaggregating Measure Data

• Enable Multithreading for Measure Data Disaggregation for a Single Plan

• Override the Default Value for the Multithreaded Process

Enable Multithreading for Measure Data Disaggregation for a Single Plan  
You can enable multithreading for measure data disaggregation for a single, forecast-enabled plan in the Demand
Management, Demand and Supply Planning, Planning Central, Replenishment Planning, or Sales and Operations
Planning work area.

1. In your work area, open the Plan Options page for your forecast-enabled plan.
2. On the Demand tab, click Select Advanced Options.

The Demand: Advanced Options dialog box opens.
3. In Forecasting Control Parameters, in Parameter Overrides, enter enableParallelDisaggMeasure=true.

Note:  You can enter multiple values in the Parameter Overrides field provided you separate them with the
number sign (#).

4. Click Done.
5. Save your plan.

Related Topics
• Overview of Improving Performance While Disaggregating Measure Data

• Enable Multithreading for Measure Data Disaggregation for All Plans

• Override the Default Value for the Multithreaded Process

Override the Default Value for the Multithreaded Process  
After you've enabled multithreading for the measure disaggregation process for all plans in your work area or a single,
forecast-enabled plan, you can override the default value of 90 days for the process.

Before you start
You may need to work with someone who has administration privileges to make these profile-related changes.

Here's what to do

1. In the Setup and Maintenance work area, go to the Manage Profile Options task.
The Manage Profile Options page opens.

2. Click New.
The Create Profile Option page opens.
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3. Create a profile option as follows:

◦ Profile Option Code: MSC_DISAGG_PERF_BATCH_SIZE

◦ Profile Display Name: MSC_DISAGG_PERF_BATCH_SIZE

◦ Application: Planning Common

◦ Module: Planning Common

◦ Start Date: Current date

Leave the remaining fields blank.

4. Click Save and Close.
5. For the profile option levels for the profile option, select the check boxes under the Enabled and Updatable columns

for both the Site and User levels.
6. Click Save and Close.
7. In the Demand Management, Demand and Supply Planning, Plan Inputs, Planning Central, Replenishment Planning,

Sales and Operations Planning or Supply Planning work area, on the Tasks panel tab, in Configuration, select
Manage Planning Profile Options.
The Manage Planning Profile Options page appears.

8. Search for the MSC_DISAGG_PERF_BATCH_SIZE profile option code.
9. Click the New icon.

A new row appears for the profile value.
10.Add the profile value as follows:

◦ Profile Level: Select Site to set the value globally for all users. Select User to set the value for a specific user,
in which case you must then select a user. User-level values take precedence over the site-level value.

◦ Profile Value: Enter the number of days for processing in each parallel job.

11. Click Save and Close.

Related Topics
• Overview of Improving Performance While Disaggregating Measure Data

• Enable Multithreading for Measure Data Disaggregation for All Plans

• Enable Multithreading for Measure Data Disaggregation for a Single Plan

Collections for Oracle Replenishment Planning  
This topic explains how collections are done for Oracle Replenishment Planning.

Collections are done at the organization level.

Collections are also done for all subinventories of organizations that are marked for subinventory-level planning on the
Organizations tab on the Maintain Supply Network Model page.

Collected Business Objects That Are Relevant for Replenishment Planning
This table lists the collected business objects that are relevant for replenishment planning:
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Oracle Fusion Cloud Applications Business Object

Oracle Fusion Cloud Procurement
and Oracle Fusion Cloud Inventory
Management
 

• Purchase orders and requisitions

• Suppliers

• Approved supplier lists

• Units of measure (UOMs)

• Transfer orders

• Shipping methods

• Subinventories

• On-hand inventory

Oracle Fusion Cloud Product Lifecycle
Management
 

• Items

• Organizations

• Catalogs

Oracle Cost Management, Oracle Order
Management, and others
 

 
• Item costs

• Currencies

• Calendars and fiscal calendars

• Sales orders

• Bookings history

• Shipments history

• Transfer order history

• Price lists

Related Topics
• How You Maintain Your Supply Network Model

• How You Set Up Replenishment Planning for Subinventories

Collection of Consumption Data for Oracle
Replenishment Planning  
This topic discusses the collection of consumption inventory transactions or point-of-sale (POS) data from Oracle
Fusion Inventory Management for the generation of consumption-based forecasts in Oracle Replenishment Planning.

To generate consumption-based forecasts for your replenishment plan, make these selections on the Collect Planning
Data page:

• On the Parameters tab, for the Targeted collection type, under History Data Options on the Demand Planning
Data tab, in Organization - Consumption Inventory Transactions to Include, select the types of consumption
inventory transactions you want to collect at the organization level. If you select Transfer orders, historical
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transfer orders at the organization level are collected. If you select All, all historical consumption inventory
transactions at the organization level are collected.

• In Subinventory - Consumption Inventory Transactions to Include, select the types of consumption
inventory transactions you want to collect at the subinventory level. If you select Transfer orders, both
historical transfer orders and historical movement requests at the subinventory level are collected. If you select
All, all historical consumption inventory transactions at the subinventory level are collected.

Consumption-based forecasting provides you with these benefits:

• You can improve the effectiveness of your forecast by basing it on demand signals that are closest to your
customers.

Thereby, you can effectively compute your policy parameters and calculate and release your replenishment
orders.

• In the retail and healthcare sectors, you can model stores and departments as subinventories. By collecting
consumption inventory transactions at the subinventory level, you can generate forecasts at this level.

Historical Transaction Collections for Consumption-Based Forecasting at
the Organization Level
When you select All in the Organization - Consumption Inventory Transactions to Include field, all historical
transactions are collected at the organization level from Inventory Management for consumption-based forecasting
except for those listed in this table:

Transaction Action Transaction Source Transaction Type

Issue from stores
 

Purchase Order
 

Return to Supplier
 

Issue from stores
 

Sales Order
 

Sales Order Issue
 

Issue from stores
 

Transfer Order Return
 

Transfer Order Return with Scrap
 

Item Transaction Collections for Consumption-Based Forecasting at the
Subinventory Level
When you select All in the Subinventory - Consumption Inventory Transactions to Include field, all item transactions
are collected at the subinventory level from Inventory Management for consumption-based forecasting except for those
listed in this table:

Transaction Action Transaction Source Transaction Type

Direct organization transfer
 

Transfer Order Return
 

Transfer Order Return Transfer
 

Intransit shipment
 

Transfer Order Return
 

Transfer Order Return Shipment
 

Issue from stores
 

Purchase Order
 

Return to Supplier
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Transaction Action Transaction Source Transaction Type

Issue from stores
 

Transfer Order Return
 

Transfer Order Return with Scrap
 

Staging transfer
 

Transfer Order Return
 

Transfer Order Return Pick
 

Difference Between Consumption History and Shipments History
While shipments history includes the history for shipped sales orders, consumption history includes the shipments
history as well as the consumption-related history that falls under transaction actions such as Issue from stores.

Measures for Storing Collected or Uploaded Consumption Data
If you're collecting consumption data from Inventory Management, the collected data is stored in the measure that you
select in the Shipments History Measures field under History Measures and Attributes on the Demand Planning Data
tab.

If you're uploading consumption data from an external source, use the file-based data import (FBDI) template named
Supply Chain Planning Measures (ScpMeasuresImportTemplate.xlsm) to import consumption data into the predefined
Consumption History measure.

In the import template, enter #ignore under the Customer Level Name and Demand Class Level Name columns if you
don't want to specify these levels. Don't enter values in the columns for level member names.

ERP Integrations REST Service  

Use of ERP Integrations REST Service in Collections  
You can upload all reference and transactional data to Oracle Fusion Cloud Supply Chain Planning from an external
source using the ERP Integrations REST service. This external source can be data from Oracle E-Business Suite, Oracle
Fusion Cloud Applications, or third-party source. In Collections, this REST service is used to upload data and submit the
collection job set.

Overview
This service updates all key changes in supply chain operations like unexpected changes in inventory levels or
manufacturing capacities in your application in real-time. Hence when compared to the system that relies on batch
integration and synchronizes data only on periodic basis, this system provides accurate results.

Note:  To upload data for Oracle Supply Chain Planning products, use of ERP Integrations REST service is preferred
over use of ERP Integrations SOAP Service.
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ERP Integrations REST Service  
The ERP Integrations REST service that is available as part of Oracle Fusion Cloud Financials is used with Oracle Fusion
Cloud Supply Chain Planning products to import bulk data, upload files to UCM server, and to load planning data from
flat files. The REST resource name is ERP Integrations and it supports multiple POST operations.

This topic provides specific guidelines on how to use these REST operations with Oracle Supply Chain Planning
products. For the Oracle Financials documentation regarding the ERP Integrations REST service, refer to the REST API
for Oracle Fusion Cloud Financials book, ERP Integrations task, in Oracle Help Center.

Import Bulk Data
The ERP Integration Service importBulkData is the main REST operation that’s used to import data for Oracle Supply
Chain Planning. This is a multistep operation that invokes the following subprocesses to complete the data load:

1. Upload file content to UCM Server
2. Loads data into Planning staging tables
3. Launches Load Planning Data from Files scheduled process
4. Launches the Collect Planning Data Job Set

This operation is completed in a single API call and also handles encrypted data files and decrypts them as part of
upload.

Here are the specific parameters that are used in the importBulkData REST operation.

• JobName: For Oracle Supply Chain Planning data loads, this parameter must be specified as
JobName: /oracle/apps/ess/scm/advancedPlanning/collection/configuration/CSVController

• Parameter List: This parameter contains a comma separated list of the parameter values. This is used by the
Load Planning Data from Files scheduled process that is launched as part of this REST service operation. Here
are the parameters that are used in the parameter list.

Parameters

Scheduled Process Internal
Parameter

Maps to the displayed
parameter of this process

Expected Value Parameter Details

Parameter 1 Source System Source System Source system code of the
source system for which the
data is being uploaded. This
code is specified during the set
up of the source system

Parameter 2 Collection Type 1 or 2 Type of collections to be
launched. Valid values are:

◦ 1 denotes Targeted
Collection type

◦ 2 denotes Net change
Collection type

Parameter 3 Data File Zip File name Name of the zip file to be
uploaded.
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Scheduled Process Internal
Parameter

Maps to the displayed
parameter of this process

Expected Value Parameter Details

Parameter 4 Not displayed Not used Specify as #NULL.

Parameter 5 Not displayed Document ID (DId) Value Document ID of the zip file to be
uploaded to UCM.
 
Optional when using
importBulkData operation but
mandatory when using the
submitEssJobRequest operation.
 

Parameter 6 Not displayed Instance ID Internal ID of the source
system specified in Parameter
1 (instance code). This is stored
internally as MSC_APPS_
INSTANCES.INSTANCE_ID
and can be derived using the
following SQL query:
 

SELECT instance_id FROM
 msc_apps_instances
 WHERE instance_code =
 '<instance code>'

 

Parameter 7 Not displayed Apps Version Internal value of the version of
the source system specified in
Parameter 1 (instance code).
This is stored internally as MSC_
APPS_INSTANCES.APPS_VER
and can be derived using the
following SQL query:

SELECT apps_ver FROM
 msc_apps_instances
 WHERE instance_code =
 '<instance code>'

 

Parameter 8 Not displayed Not used Specify as #NULL.

Parameter 9 Organization Group Organization Group This is optional. It is required
only if the user wants to
run collections for a specific
organization group. The value
is the name of the organization
group. If not specifying, use
#NULL.
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Parameters File
You must include the special parameters file Supply Chain Planning ERP Integration Service Parameters that’s generated
using the ScpErpIntegrationServiceParamsImportTemplate.xlsm template file when using ERP Integrations REST service
with Oracle Supply Chain Planning products. This parameters file is the file that provides metadata that you need to
include in the zip file along with other CSV files to load data in the ERP Integrations Flow. This file contains the following
parameters:

• Source System Code (Parameter 1 in the Parameters table)

• Collection Type (Parameter 9 in the Parameters table)

• Organization Group (Parameter 9 in the Parameters table)

If the input zip file does not contain ScpErpIntegrationServiceParams.csv, then the mode of collections is defaulted to
Net change and the Load Planning Data from Flat Files schedule process reads the value of instance code from the
respective data files.

The ScpErpIntegrationServiceParams.csv meta data file is required only when your loading data using the ERP
Integration importBulkData operation and isn’t required when you submit the Load Planning Data from Flat Files
process either from the Scheduled Processes page or using the submitEssJobRequest operation.

Note:  Oracle Supply Chain Planning data loads using importBulkData operation don’t need any other properties files
like jobDetails.properties that are required for other product areas.

Upload File to UCM
The uploadfiletoUCM operation uploads a file to the UCM server in a single step based on the document specified in the
REST operation.

Here is the parameter that is used to complete the operation.

DocumentAccount: For Oracle Supply Chain Planning data loads, this parameter must be specified as

DocumentAccount":"scm$/planningDataLoader$/import$

The REST response includes the DocumentId as one of the data elements.

Load Planning Data from Flat Files
The submitEssJobRequest operation is used to load planning data from flat files. It submits the collections job set with a
set of parameters in a single step.

When loading data for Oracle Supply Chain Planning products, use the following parameters and respective guidelines
to complete the operation.

• JobPackageName: This parameter must be specified as
JobPackageName:oracle/apps/ess/scm/advancedPlanning/collection/configuration 

• JobDefName: This parameter must be specified as
JobDefName: CSVController

• DocumentId: Use the document ID from the response of uploadFileToUCM operation.

• ESSParameters: This parameter must include a list of values as indicated for the Parameter List parameter of
importBulkData operation. For example,
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ESSParameters:EX8,2,UOM.zip,#NULL,289568,300100110961358,3,#NULL,#NULL

The REST response includes the RqstId as one of the data elements. This data element is the process ID of the
submitted scheduled process which in this case is the Load Planning Data from Files process. This process is completed
only after total flow including Collect Planning Data job set is launched and completed.

For other Oracle Supply Chain Planning processes, like the Publish Data and Release Plan processes, the recommended
approach is to use the respective REST services under Oracle Supply Chain Planning group and not use the
submitEssJobRequest operation. For example:

• For Publish Data – use Supply Chain Planning/Supply Chain Plans/Publish Data

• For Release Plan – use Supply Chain Planning/Supply Chain Plans/Releases

• For Archive Plan – use Supply Chain Planning/Supply Chain Plans/Archives

Note:  loadAndImportData operation isn't recommended for use with Oracle Supply Chain Planning products because
with this operation you can’t upload encrypted data files.

Verify Collection Processes  

Verify the Load Planning Data from Files Process  
Perform the following steps to verify the process status of the uploaded file and review log file for any errors or
warnings.

1. In the Navigator, click Scheduled Processes.
2. In the search area, enter the process ID you noted when you submitted during the Load Planning Data from

Files process. Click Search.
3. Monitor the process to verify completion.

If the process completes with warnings, select the request that shows the warning status and click the View
Log button to review the details.

4. For the rows with errors, resolve the issues found in the log file, and then upload the CSV file again. To load only
the revised rows, use the Net Change option.

Review Data in the Planning Data Repository  
You can review the data collected or loaded into the planning data repository using two different options. The option
you use depends on which data collection entities you want to review.

To review the data collected or loaded into the planning data repository, use one of the following options:

• Review data using the Plan Inputs page layout

• Review data using the Maintain Supply Network Model page
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To review the following entities, use the Maintain Supply Network Model page:

• Organizations

• Customers

• Suppliers

• Carriers

• Interlocation Shipping Networks

To review data that's not part of the supply network model, use the Plan Inputs page layout. You can view the following
data in the Plan Inputs page layout

• Supply data

• Demand data

You can view Carriers and Suppliers using either option.

Review Data Using the Plan Inputs Page Layout
Perform the following steps to review the planning data that you loaded.

1. In the Navigator, click Plan Inputs.
2. From the Plans menu, right-click Plan Inputs, and click Open.

Tip:  You can set the preview pane to Full Pane for viewing your data in full pane. Click Change and select
Full Pane.

3. On the Plan Inputs page, click Open, and click Full Pane.
4. On the Open Table, Graph, or Tile Set page, search for the table name.
5. Enter the criteria for the data you want to verify and click Search.
6. Review the data in the Search Results table.

Review Data Using the Maintain Supply Network Model Page
Perform the following steps to review the planning data using the Maintain Supply Network Model page.

1. In the Navigator, click Plan Inputs.
2. From the Tasks menu, click Maintain Supply Network Model.
3. Enter the criteria for the data you want to verify and click Search.
4. Review the data in the Search Results table.
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Purge Data  

How You Purge Collected Data from the Data Repository for
Supply Chain Planning  
Use the Purge Data Repository scheduled process to purge data collected by supply chain planning collections
processes into the database tables that comprise the planning data repository.

Delete data from these tables to free up space and improve performance. Use the Scheduled Processes work area to run
the scheduled process. This topic explains the parameters of the Purge Data Repository scheduled process.

The parameters for the Purge Data Repository scheduled process are in one of these categories:

• The Source System and Purge Global Entities parameters

• Parameters on the Reference Data tab

• Parameters on the Demand Planning Data tab

• Parameters on the Supply Planning Data tab

Note:  If you're purging Customer dimension data or measure data at the Customer Site level for a demand plan that
uses a planning level profile, you must manually run the Aggregated Collected Planning Data and Create Trees for
Dimensions scheduled processes after you've purged the data.

The Source System and Purge Global Entities Parameters
Provide values for these parameters to determine which data records for reference data will be purged from the staging
tables when you run the Purge Data Repository scheduled process.

Parameter Notes

Source System
 

You must select a source system.
 

• For data collected from the Oracle Fusion source system, select OPS.

• For data collected from an external system, select the applicable source system code.

Purge Global Entities
 

You can select Yes if you want to delete data for the entities for which the planning data repository
stores only one record for each instance of the global entity so there's no reference to a source system.
The default is No.
 

Parameters on the Reference Data Tab
Provide values for these parameters on the Reference Data tab to determine which data records for reference data will
be purged from the staging tables when you run the Purge Data Repository scheduled process.
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Parameter Notes

The set of entities categorized as reference
entities. The entities you haven't selected
yet are included in the Reference Entities
list on the Reference Data tab.
 

You select which reference entities you want data deleted for. The entities you select are included in
the Selected Entities list on the Reference Data tab.
 

Parameters on the Demand Planning Data Tab
Provide values for these parameters on the Demand Planning Data tab to determine which data records for demand
planning data will be purged from the staging tables when you run the Purge Data Repository scheduled process.

Parameter Notes

The set of entities categorized as reference
entities. The entries you haven't selected
yet are included in the Demand Entities list
on the Demand Planning Data tab.
 

You select which demand entities you want data deleted for. The entities you select are included in the
Selected Entities list on the Demand Planning Data tab.
 

Limit the Days to Purge
 

You can choose to limit the number of days to purge by selecting one of three choices. For each choice
you must also specify the additional details needed for that choice:
 

• By date range, followed by a from date and a to date

• By number of days in the future, followed by a number of most recent days to keep

• By number of days in the past, followed by either a number of most recent days to keep or a
number of oldest days to purge

Parameters on the Supply Planning Data Tab
Provide values for these parameters on the Supply Planning Data tab to determine which data records for supply data
will be purged from the staging tables when you run the Purge Data Repository scheduled process.

Parameter Notes

The set of entities categorized as supply
entities. The entities you haven't selected
yet are included in the Supply Entities list
on the Supply Planning Data tab.
 

You select which supply entities you want data deleted for. The entities you select are included in the
Selected Entities list on the Supply Planning Data tab.
 

Related Topics
• Purge Data Repository

• Overview of Planning Level Profiles
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How You Purge Staging Tables for Supply Chain Planning  
Use the Purge Staging Tables scheduled process to delete data from the staging tables used during collections
processes for supply chain planning.

Delete data from the staging tables to free up space and improve performance. Use the Scheduled Processes work
area to run the scheduled process. This topic explains the parameters of the Purge Staging Tables scheduled process.
For information on how to run scheduled processes, refer to the Scheduled Processes chapter in the Implementing
Common Features for SCM guide.

Provide values for these parameters to determine which data records will be purged from the staging tables when you
run the Purge Staging Tables scheduled process.

Parameter Notes

Source System
 

You must select a source system.
 

• For data collected from the Oracle Fusion source system, select OPS.

• For data collected from an external system, select the applicable source system code.

Record Type
 

You must select a record type, but you can select All if you want to purge all records that meet the
values of the other parameters, regardless of their record type. The record types other than the All type
are the status of records in the staging tables in regard to the next stage of the collections process. The
next stage of the collections process is the import of the records that are in the staging tables into the
tables that comprise the planning data repository.
 

• All: All records regardless of status.

• Complete: Records that were successfully imported into the tables that comprise the planning
data repository.

• Error: Records that are in the Error status in the staging tables after import into the planning data
repository was tried, but not successful.

• New: Records that were collected into the staging tables, but import into the planning data
repository hasn't been tried yet.

• Retry: Records in the staging tables for which import into the planning data repository is being
tried again.

• Warning: Records in the staging tables for which a warning occurred when the record was
imported into the planning data repository.

Collection Cycle ID
 

You can enter a request number if you want to do so.
 

Collected From Date
 
and
 
Collected To Date
 

You can provide these dates if you want to purge data within a specific time frame.
 

The set of specific entities for which data is
collected and deletion of the data from the
staging tables is supported.
 

Each entity is a parameter for the scheduled process. You can select No for any of the parameters if
you don't want to purge the data for that entity. The default value for each parameter is Yes.
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Aggregate Customer Data  

How You Aggregate Customer Data  
Use the key customer data options collections template to identify key customers.

The data for these customers will be visible. For each Zone, all non-key customers' data will be aggregated to a member
named All Other. By aggregating the planning data for non-key customers, you can focus your analysis on the key
customers. You use the Supply Chain Planning Key Customer Options (ScpKeyCustomerOptionsImportTemplate.xlsm)
import template to identify the key customers; the rest of the customers' data will be aggregated under an All Other
member.

The data that aren't identified in the upload template are aggregated to an All Other member for each zone. You can
view the key customers and the All Other member containing the aggregated non-key customer data when you analyze
the forecasts and other data.

Identifying key customers and aggregating non-key customer data helps you to do the following:

• Organize key customer data that are required for planning

• Save time by collecting only the required data from Oracle Fusion Cloud Supply Chain Management

• Build a plan specifically for your key customers

Note:  You can't use the functionality for aggregating data for non-key customers in a demand plan to which you've
attached a planning level profile. The Aggregate non-key customer data to an All Other level member check box
on the Demand tab on the Plan Options page is disabled if you've attached a planning level profile to the demand
plan.

Related Topics
• Collection Filters and Collection Templates

• Overview of Planning Level Profiles

How can I reset the key customer aggregated data for a plan?  
After you make changes to the aggregation level values in the ScpKeyCustomerOptionsImportTemplate.xlsm file, you
must upload the file and run the plan again.

To reset the key customer aggregated data for a plan, do the following:

1. Review the ScpKeyCustomerOptionsImportTemplate.xlsm file.
2. Update the Aggregation Level values for all of the Level Name values (for example, Customer) and upload the

CSV file.
3. From your Supply Chain Planning work area, open the plan and enable the Aggregate non-key customer data

to All Other level member check box. Run the plan again.
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Related Topics
• Considerations for Collecting Key Customer Information

Considerations for Collecting Key Customer Information  
Use the ScpKeyCustomerOptionsImportTemplate.xlsm file to identify the key customers for which nonaggregated data
must be made available.

For non-key customers, the aggregation level that you define in the import template determines whether the data is
retained or aggregated. You can differentiate between key customers and non-key customers and use the aggregated
key customer data to build a plan specifically for your key customers.

Note:  For details regarding the ScpKeyCustomerOptionsImportTemplate.xlsm file, refer to the File-Based Data Import
(FBDI) for SCM guide. This guide is one of the guides in the Oracle Help Center for Oracle Fusion Cloud Supply Chain
Management. Use the All Books link for a list of the guides by category, and look for the Development category.

In the ScpKeyCustomerOptionsImportTemplate.xlsm file template:

1. Define your key customers on the KeyCusOptnHeader tab. Enter the name of a valid customer hierarchy in the
Hierarchy Name column.

2. Next, enter the level of that hierarchy in the Level Name column. All customers in this level are identified as key
customers.

3. To have only certain customers identified as key customers, enter the specific customer names on the
KeyCusOptnMembers detail tab.

4. Set the aggregation level values for both key and non-key customers. Use the settings in the template to set the
data to different aggregation levels, such as 1, 2, or 3.

5. Upload the template.

Ignore Aggregate by Zone
There are two Customer hierarchies--Customer and Customer Zone--where the lowest level of each hierarchy is
Customer Site. If you don't have any key customers, leave the Hierarchy Name and Hierarchy Level columns blank on
the KeyCusOptnHeader tab. All customers not named in the template (non-key customers) are aggregated into an All
Other member for the hierarchy.

The upload also creates All Other Zone members for the non-key customers in the Customer Zone hierarchy. If you
don't want to aggregate by zone, enter #ignore_zone in the Hierarchy Name column in the KeyCusOptnHeader.csv and
leave the Level Name column blank.

Aggregation Levels
The aggregation levels are listed in the following table.

Aggregation Level Description

1
 

Retain all customer sites, and aggregate non-key customer sites. In addition to key customer data
being available, non-key customer data is retained for plans that require data that's not aggregated.
Aggregated customer data is available for plans that require aggregated non-key customer data.
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Aggregation Level Description

2
 

Aggregate non-key customer sites. Customers that aren't identified as key customers are aggregated
to an All Other site by zone. However, if the Hierarchy Name and Level Name columns are blank, all
customers are identified as non-key customers and aggregated to an All Other site by zone. This
means that there are no key customers.
 

3
 

No aggregation of customer sites. All data is available at customer site level.
 

To remove the key customer designation for previously-loaded customers, use Aggregation Level 3. This enables data
for all customers to be made available at the lowest level. No customers are marked as key customers.

If you select the aggregation level 3, the following happens:

• No aggregation is done. All data is at the customer site level only.

• If option 2 or 3 was used in previous collection runs, all non-key customer by zone members and data are
deleted.

• Plans using the Key Customer feature become invalid and you have to run them again.

The KeyCusOptnMembers detail tab is optional. Use this tab to identify specific customers as key customers.
The Hierarchy Name and Level Name column entries must be the same as the information entered on the
KeyCusOptnHeader tab. Enter valid level member names in the Level Member Name column. These members are the
only customers that will be identified as key customers.

• If the KeyCusOptnMembers detail tab is empty, all child members of the hierarchy level chosen in the Header
tab are flagged as key customers.

• If the KeyCusOptnMembers detail tab isn't empty, only the listed members are identified as key customers.

The members must be children of the hierarchy level named on the Header tab.

When you create a plan, there is an option in the Plan Options dialog box that determines what level of customer
aggregation is used for the plan:

• Key customer data is available and non-key customer data is aggregated to a level member named All Other.

• No customer data is aggregated for the plan if the option is deselected.

Related Topics
• How can I reset the key customer aggregated data for a plan?

Load Aggregated Customer Data from Oracle E-Business Suite  
This topic explains the procedure you follow to load aggregated customer data from an Oracle E-Business Suite source
system into your Oracle Fusion Cloud Supply Chain Planning destination system.

The procedure is composed of the following steps:

1. Extract data from your Oracle E-Business Suite source system.
2. Prepare the Supply Chain Planning Key Customer Options file if you have defined key customers in your Oracle

E-Business Suite source system.
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3. Add the files to your desktop or local hard drive.
4. Import data into your Oracle Supply Chain Planning destination system.

Additional details for each step are provided in this topic.

Prerequisites
To perform the process that extracts data from your Oracle E-Business Suite source system, you must be assigned a
configured, administrator-level role that’s similar to either the Advanced Planning Administrator role or the Advanced
Supply Chain Planner role.

Your source system must be set up as one of the Trading Community Source Systems for Oracle Supply Chain Planning.

You can perform the steps to import data into your Oracle Supply Chain Planning destination system from one of the
Supply Chain Planning work areas. You don't need an administrator role to perform these steps.

Extract Data
To extract the data from your Oracle E-Business Suite source system, run the Extract Data for Oracle Supply Chain
Planning process.

Consider the following conditions for the MSD_DEM_CUSTOMER attribute when you run the process:

• If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to null, then all sites are extracted.

• If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to none, then all records are aggregated to Default Customer
Site.

• If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to a valid customer attribute, then all sites are extracted.

The extracted data is stored in a file in the zipped file format in the middle tier of your source system.

Prepare the Key Customer Options File
If you have defined key customers in your Oracle E-Business Suite source system, then perform these steps to prepare
the Supply Chain Planning Key Customer Option file:

1. Download the template for file-based data loads for the Supply Chain Planning Key Customer Options object.
2. Add your data to the file.
3. Generate the CSV file.

For details on preparing files for loading planning data, refer to these help topics: Loading Planning Data from Files:
Overview and Creating CSV Files Used to Load Planning Data: Procedure.

Add the Files to Your Desktop or Local Hard Drive
Locate the extracted Zip file on your Oracle E-Business Suite middle tier, and download or transfer the file to your
desktop or local hard drive.

If you have defined key customers in the Oracle E-Business Suites source system, then include the Key Customer
Options file in the Zip file.

Import Data into Your Oracle Supply Chain Planning Destination System
To import the data into your Oracle Supply Chain Planning destination system, perform these steps:

1. From the Navigator, click File Import and Export.
2. On the File Import and Export page, perform the upload action using these values:
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◦ File: The file you created

◦ Account: scm/planning DataLoader/Import

3. From one of the Supply Chain Planning work areas, perform the Manage Planning Source Systems task to
check if your source system is already created. If your source system is not already created, then create it with
the following values:

◦ Version: External.

◦ Code: Must be the same as the one used for your Oracle E-Business Suite source system.

4. From a Supply Chain Planning work area, perform the Load Planning Data from Files task.

View and Refresh Collected Measure Data  

View Collected Data for Measures Before Running a Plan  
The Collected Measure Data table enables you to view imported or collected records and their statuses without having
to examine log files or run a plan. The table lists measures that were successfully populated as well as also those that
weren’t for your plan. By using this table, you can quickly resolve problems in the data load process.

Just as you can use the Supplies and Demands table to view the collected or imported supplies and demands, you can
use the Collected Measure Data table to view bookings, shipments, and other entities.

For example, Small Inc. imported its shipments history data using the Supply Chain Planning Shipments History file-
based data import (FBDI) template. To save time and work efficiently, the company wants to ensure that data was
correctly imported before running its plan. The company uses the Collected Measure Data table and selects the option
to view only records with errors. The company notices that several records have an error pertaining to invalid names for
the Customer Site level member. Now that the reason behind the error has been identified, Small Inc. can fix the data
in the FBDI file, import the data again, and run the plan. By using the Collected Measure Data table, Small Inc. quickly
identified data import-related problems and didn’t have to spend time analyzing the log files for the import or analyzing
the plan after running it.

1. In the Plan Inputs work area, click the Open drop-down button.
The Open Table, Graph, or Tile Set dialog box opens.

2. Select the Collected Measure Data table and click OK.
The Collected Measure Data table opens in a new tab.

3. Specify your search criteria, and click Search.
Use the Errors field to limit the records to those with errors or those without errors.

Note:  By default, the table displays only the first 10,000 records that meet your search criteria. To change this
limit, you need to create and use a profile option with the MSC_COLLECTED_MEASURE_DATA_MAX_ROWS code.
No indication is provided if the table has records that aren’t displayed because the predefined or user-defined limit
has been exceeded.

4. Analyze the records that are returned according to your search criteria.
The Last Updated Date column displays the date on which the records were created or last updated.
The Refresh Number column displays the refresh numbers of the collection job sets through which the measures
were populated when the FBDI templates or collections feature was used.
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5. Optionally, to export the records to a Microsoft Excel file for further analysis, click Actions > Export to Excel.
The records available in the Collected Measure Data table are exported to the file. The predefined or user-defined
limit is applied when the records are exported.

Tip:  When you export the records to an Excel file, you can view more than 15 records at a time. You may find it
helpful during your error analysis to view more than 15 records at a time.

Additional Points About the Collected Measure Data Table  
These are some additional points about the Collected Measure Data table:

• The table displays records that are successfully uploaded to the MSC_MEASURE_DATA table.

• For records with errors, the table displays records from the MSC_ST_MEASURE_DATA staging table that have
information in the ERROR_TEXT column.
The table doesn't display records from the staging table that weren't moved to the MSC_MEASURE_DATA table
and don't have error information.

• The table filters records by the applicable security privileges of the user. For example, if you have access to only
certain organizations, you can view measure values for only those organizations.

• The table lists both predefined and user-defined measures.

• The table displays measure data that’s imported through these file-based data import (FBDI) templates:
◦ Supply Chain Planning Bookings History

◦ Supply Chain Planning Causal Factors

◦ Supply Chain Planning Forecast Measures

◦ Supply Chain Planning Measures

◦ Supply Chain Planning Option Bookings History

◦ Supply Chain Planning Option Shipments History

◦ Supply Chain Planning Shipments History

• The table doesn’t display measure data that’s imported through the Supply Chain Planning External Forecasts
and Supply Chain Planning Price Lists FBDI templates.
To troubleshoot imported data for external forecasts or price lists, examine the log files or run your plan.

• The table also displays any measure for which information is collected from Oracle Fusion Cloud Applications
Suite or imported from Oracle E-Business Suite.

• To view aggregated non-key customer data in the table for demand, demand and supply, and sales and
operations plans, before collecting or importing measure data, select the Aggregate non-key customer data
to an All Other level member check box on the Demand tab on the Plan Options page for the plan. Then, enter
the required aggregation levels in the Supply Chain Planning Key Customer Options FBDI template, and import
customer data with the template. After you collect or import measure data, when you filter your records by the
plan name in the table, you can view the aggregated data for non-key customers. For aggregated records, the
value displayed in the Customer column is “<zone name>:All Other.”

• The table doesn't return aggregated data for a planning level profile.

• To avoid reduced performance, don’t sort the records if you increase the maximum
number of records displayed in the table by creating and using a profile option with the
MSC_COLLECTED_MEASURE_DATA_MAX_ROWS code.
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Related Topics
• How You Aggregate Customer Data

Refresh Collected Measure Data  
The Orchestrate Refresh Measures Processes scheduled process lets you update the plan data for collected planning
measures without running the plan.

You can refresh a subset of predefined or user-defined measures such as shipments and bookings history, sales and
marketing forecasts, and financial measures such as Budget Value and Financial Forecast Value. This scheduled process
retains the measure data for statistical and simulation demand forecasts usually purged when running your plan. By
defining a job set, you can automate this scheduled process to refresh measures immediately after loading external
measure data from flat files.

For example, an enterprise has a weekly demand planning cycle. They need to generate a baseline statistical forecast
once a week but continue to get daily updates for recent shipments, bookings, and sales forecasts. Instead of running
the plan daily, they modify their planning process to run it at the start of the week and then refresh the key collected
measures daily.

Orchestrate Refresh Measures Processes  
Use these steps to configure the Orchestrate Refresh Measures Processes scheduled process using a measure catalog
containing only a subset of plan measures:

1. In the Scheduled Processes work area, click Schedule New Process on the Overview page.
2. In the Schedule New Process dialog box, search for and select Orchestrate Refresh Measures Processes, and

then click OK.
3. In the Process Details dialog box, Basic Options section, do the following:

◦ Plan: Select a plan name.

◦ Measure Catalog: Select a measure catalog.

4. Click Advanced and navigate to the Schedule tab. You can set up the process to run as soon as possible or
establish a schedule.

5. When done, click Submit.

The Confirmation dialog box opens and displays the process number. You can use this process number to search for the
process result in the Scheduled Processes work area.

Related Topics
• Orchestrate Refresh Measures Processes
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Additional Information About Orchestrate Refresh Measures
Processes  
Here’s some additional information about the Orchestrate Refresh Measures Processes scheduled process:

• You can schedule the Orchestrate Refresh Measures Processes scheduled process to refresh collected
measure data for one time or on a repetitive schedule from the Scheduled Processes work area. You can
configure a job set that contains the Orchestrate Refresh Measures Processes scheduled process after the
Load Planning Data from Flat Files scheduled process to sequence and automate these planning processes.

• When copying a plan, you get the following options:

◦ Copy plan options only

◦ Copy plan with reference to the base plan

◦ Copy plan with no reference to the base plan

If the copied plan was created using the second option (Copy plan with reference to the base plan), then it
doesn't support the Refresh Collected Measure Data capability. Such plans don't appear in the Plan field of the
Orchestrate Refresh Measures Processes scheduled process.

• The Orchestrate Refresh Measures Processes scheduled process considers the measure data uploaded using
file-based data import (FBDI) templates, including planning measures and demand history. The scheduled
process doesn't consider transactional data such as sales orders, price changes, or new items and organizations
that aren't already included in a plan. For supply plans, measure data loaded using the Supply Chain Planning
External Forecasts import template can't be refreshed.

• If you've defined a measure with the Refresh with current data option on the Properties subtab on the
Advanced tab in the Create Measure dialog box, after you add the measure to a plan, you must first run the plan
to refresh it with the current data before you can refresh that measure's data using this scheduled process.

Note:  Run your plan after a release upgrade before using this scheduled process.

• You need to include both the Shipments History (or Bookings History) measure and the default measure used
to refresh shipments history in your measure catalog. For example, if the default measure used for the Default
Shipments History Measure profile option is Shipments History: Requested Item by Shipped Date, then include
both this measure and the Shipments History measure in the measure catalog used to refresh your plan.

• You can't use the Orchestrate Refresh Measures Processes scheduled process to refresh the measures in a
demand plan that has a planning level profile. Such plans aren't available for selection in the Plan field for the
scheduled process.

Related Topics
• Orchestrate Refresh Measures Processes

• Overview of Planning Level Profiles
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8  Segmentation

Work with Segment Groups  

Create a Segment Group  
A segment group consists of segments into which combinations are grouped. The segment group has a granularity
that's also applicable to the segments. You define the segments on the basis of dimension-based or measure-based
criteria.

• In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

• In the Supply Planning and Planning Central work areas, the combinations consist of items and locations that
are collected from Oracle Product Lifecycle Management.

• In the Sales and Operations Planning work area, the combinations consist of items and locations that are
collected from Oracle Product Lifecycle Management.

• In the Demand Management work area, the combinations could include both:

◦ Items and locations that are collected from Oracle Product Lifecycle Management.

◦ Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

To create a segment group, you must:

1. Create the segment group.
2. Define the segments.
3. Define criteria for the segments.

To restrict segmentation to items for which replenishment planning must be done, you first set the MPS and MRP
Planning Method attribute of items to Replenishment planning in Oracle Product Lifecycle Management. Then, while
setting up criteria for segments of the segment group, you set the Planning Method attribute for the Product dimension
to Replenishment planning. After collection and segmentation, only replenishment planning items are grouped into the
segments of the segment group.

If you're planning replenishments at the item-subinventory level, select the Organization dimension for the segment
group. Then, add the dimension to segments of the group, and use the Location attribute of the dimension to include
subinventories in the segments. The subinventories are listed in the <organization>:<subinventory> format.

Create the Segment Group
Follow these steps to create the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.

The Manage Segment Groups and Criteria page opens.
2. Under Search Results, click Actions > Create.

The Create Segment Group page opens.
3. In Segment Group, enter the segment group name.
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4. In Source System, select the source system for the segment group.
The source system must be the same as that used in the plan to which you attach the segment group. Only the
combinations in the selected source system are available after segmentation in the segment group.

5. In Simulation Set, select a simulation set for the segment group.
If you plan to simulate changes to the same item attributes at the segment group and plan levels, preferably,
use the same simulation set in both cases.

6. In Description, enter the segment group description.
7. Under Segment Granularity, in the Dimension column, select the dimension that you want to specify for the

segment group granularity.
The lowest levels for the selected dimensions are displayed in the Level column, and the displayed levels make
up the segment group's granularity.
Note the following:

◦ For demand, demand and supply, sales and operations, and supply plans, only the predefined Customer,
Demand Class, Organization, and Product dimensions are supported. You must select the Product
dimension. If you select the Customer or Demand Class dimension, you must specify measure-based
criteria for each segment.

◦ For replenishment plans, you must select only the Organization and Product dimensions.

8. Add more dimensions as required by clicking the Add Row icon.
9. In Catalog, select the Oracle Product Lifecycle Management catalog from which you want to use categories

while specifying the attributes for Product dimension-based criteria of segments in the group.
10. Click Save.

Define the Segments
Follow these steps to create a segment in the segment group:

1. Under Segments, click the Add Row icon.
2. Enter the segment name and description.
3. Under Rank, accept the default number that's a multiple of 10 or enter a whole number that's unique for the

segment group.
During segmentation, if a combination meets the criteria for more than one segment, the combination is
assigned to the segment with the lower rank.

4. Add more segments as required.
5. Click Save.

Define Criteria for the Segments
Follow these steps to define criteria for segments:

1. Under Segments, select the segment for which you want to define criteria.
2. Under Segment Criteria, click the Add Row icon.

A row appears for the segment criterion of the segment.
3. Set the criterion as follows:

a. In the list under Dimension, if you want the criterion to be based on the selected dimensions for the
segment group:

i. Select a dimension.
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The list under Attribute is enabled and displays the attributes for the selected dimension.
ii. In the list for attributes, select an attribute for the dimension.

If you selected the Product dimension, and you previously specified an Oracle Product Lifecycle
Management catalog, the list includes Category as an attribute.

If you selected the Product dimension, you can select the attribute named Safety Stock Planning
Method.

iii. In the list for operators, select the operator with which you want to evaluate the attribute.

Depending on your selection, fields or lists under From Value and To Value may be enabled, and
dialog boxes may open.

iv. Specify the values for the attribute.

If you selected Category as an attribute, the categories for the selected Oracle Product Lifecycle
Management catalog are displayed in the list under From Value.

If you selected Safety Stock Planning Method as an attribute, you can select Safety stock
quantity, Days of cover, or Not planned in the list under From Value.

b. In the list under Dimension, if you want the criterion to be based on measures:

i. Select Measure-based criteria.

The Search and Select: Plans dialog box appears.
ii. In the Available Plans pane, in Type, specify the plan type.

iii. Click the Find icon.

The available plans are displayed. For Replenishment Planning, only those plans for which the
Generate forecast check box is selected on the Plan Options page are displayed.

The plans should have been run and contain tables with the required measures. The tables should
have only those dimensions and levels that are in the segment group.

iv. Select and move plans to the Selected Plans pane.
v. Click OK to return to the Create Segment Group page.

vi. In Measure Evaluation Table, select the table from which a measure should be selected for the
segment criterion.

The tables associated with the selected demand or replenishment plans are available in the list.
vii. In Measure Name, select a measure.

viii. In Operator, select the operator with which you want to evaluate the measure value.

Depending on your selection, the From Value field, To Value field, or both are enabled.
ix. Specify the values for the measure.

4. Add more rows for segment criteria as required.

If you're adding rows, enter a whole number in the field under Group for each row. During segmentation,
those rows with the same whole number are processed with the AND operator. Then, the resulting criteria are
processed with the OR operator.

5. Click Save.
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Related Topics
• How You Set Up Replenishment Planning for Subinventories

Edit a Segment Group  
You can edit and delete segment groups, segments, and segment criteria.

Edit the Segment Group
You can duplicate, edit, and delete a segment group.

You can delete the segment group only if it's not associated with a policy assignment set or a plan for the work area.

The changes you can make to the segment group are limited. You can't change the name or source system for the
segment group, and you can't change its granularity by adding or deleting dimensions.

Follow these steps to edit the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.
The Manage Segment Groups and Criteria page opens.

2. Search for the segment group that you want to edit.
3. Select the segment group, and click Actions > Edit.

The Edit Segment Group page opens.
4. Change the description and simulation set as required.

If you plan to simulate changes to the same item attributes at the segment group and plan levels, preferably,
use the same simulation set in both cases.

5. In Catalog, select the catalog from Oracle Fusion Cloud Product Lifecycle Management from which you want to
use categories while specifying the attributes for Product dimension-based criteria of segments in the group.
If you previously selected a catalog and used one of its categories while setting up a Product dimension-based
criterion, the list is grayed out.

6. Click Save.

Edit the Segments
You can add, duplicate, and delete segments and change their names, descriptions, and ranks.

In the Replenishment Planning work area, you can delete segments only if the segment group isn't associated with a
policy assignment set or replenishment plan. In the Supply Planning work area, you can delete the segment group only
if it's not associated with a policy assignment set or supply plan. In the Sales and Operations Planning work area, you
can delete the segment group only if it's not associated with a plan.

If you change the rank of a segment, you may change how combinations are assigned to segments after you run
segmentation again. During segmentation, if a combination meets the criteria for more than one segment, the
combination is assigned to the segment with the lower rank.

Edit the Segment Criteria
You can add, edit, and delete criteria for a segment.
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For dimension-based criteria, you can change the attributes, operators, and values. For measure-based criteria, you can
change the plans, measure evaluation tables, measures, operators, and values.

Depending on the operator used for a criterion, you can change the values under From Value, To Value, or both.

If you change the value under Group for the criterion, you may affect the segmentation result. During segmentation,
those criteria with the same whole number are processed with the AND operator. Then, the resulting criteria are
processed with the OR operator.

Run Segmentation  
You can run segmentation for a segment group from the Manage Segment Groups and Criteria page.

Follow these steps to run segmentation for the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.

The Manage Segment Groups and Criteria page opens.
2. Search for the segment group for which you want to run segmentation.
3. Select the segment group, and click Actions > Execute Segmentation.

The Execute Segmentation dialog box opens.
4. To retain your segment overrides, select Retain segment overrides.

To save your last segmentation result for display on the Segmentation Summary page, select Save the last
segmentation result. When you select this check box, the results of the last segmentation run are displayed
under the Previous heading on the Segmentation Summary page, and the results of the segmentation run you
are presently submitting are displayed under the Latest heading.

Tip:  If you're performing simulations, you may want to repeatedly make changes to your segmentation
criteria and run segmentation so that you can compare the results of your changes with the results of the
last segmentation run, which are displayed under the Latest heading on the Segmentation Summary page.
In such cases, you don't want to select this check box. When you have finished your simulations and are
satisfied with the results of your changes, then select this check box.

5. Click Submit.

The Information dialog box opens and provides you with the request number (process ID) of the segmentation
run. You can use this request number to search for the process status and log on the Scheduled Processes
page. If the segmentation run fails, see the log for more information and troubleshooting.

6. Click OK.

The Information dialog box closes.
7. On the Manage Segment Groups and Criteria page, click View > Refresh to update the status and last run date

of segmentation for the segment group.
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View the Segmentation Summary  
You can view segmentation results on the Segmentation Summary page. The results of the latest and previous
segmentation runs are displayed.

A segment group consists of segments into which combinations are grouped.

• In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

• In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

• In the Sales and Operations work area, the combinations consist of items and locations that are collected from
Oracle Fusion Cloud Product Lifecycle Management.

• In the Demand Management work area, the combinations could include both:

◦ Items and locations that are collected from Oracle Fusion Cloud Product Lifecycle Management.

◦ Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

View the Summary
Follow this procedure to view the segmentation summary for a segment group:

1. Perform one of these steps:

◦ On the Tasks panel tab, under Plan Inputs, select View Segmentation Summary.

The Segmentation Summary page opens.

◦ On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > View
Segmentation Summary.

The Segmentation Summary page opens.
2. In Segment Group, select the segment group for which you want to view the segmentation summary.

The page is refreshed with the segmentation summary for the segment group. The results of the latest and
previous segmentation runs are displayed, along with other details of the combinations for each segment.

You can click a number for a segment under a column to open the Manage Segment Members page and view
the combinations that meet the criteria for the number that you clicked. If you perform any overrides on the
Manage Segment Members page, the changes are immediately reflected on the Segmentation Summary page.

If you opened the segmentation summary from the Manage Segment Groups and Criteria page, the field is
grayed out, and you can view segmentation results for only the segment group you selected on the page.

3. Click Done to close the Segmentation Summary page.

198



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 8
Segmentation

Points to Note About Displayed Information
Note these points about the information displayed on the Segmentation Summary page:

• You can use the latest and previous results to understand how and why combinations have moved from one
segment to another. These movements happen because of changes in demands, sales, and consumption. By
identifying the factors underlying these movements, you can fine-tune the segmentation process and apply
manual overrides as required.

• Every time you run segmentation with the Save the last segmentation result check box selected in the
Execute Segmentation dialog box, the latest results presently displayed on the Segmentation Summary page
are displayed as the previous results, and the results of the job you just submitted are displayed as the latest
results. Your manual overrides remain unaffected so long as you selected the Retain segment overrides check
box in the Execute Segmentation dialog box.

• If you have run segmentation for the first time for the segment group, the previous results aren't displayed.

• No previous results are displayed for a segment that's added during the latest segmentation run.

• The values under the Latest Count, Previous Count, Added in Latest Run, and Removed in Latest Run
columns don't include your manual overrides.

Override Segmentation Results  
You can override segmentation results by manually assigning combinations to segments.

• In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

• In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

• In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

• In the Demand Management work area, the combinations could include both:

◦ Items and locations that are collected from Oracle Fusion Cloud Product Lifecycle Management.

◦ Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

In the case of Replenishment Planning, the combinations consist of items and locations that are collected from Oracle
Fusion Product Lifecycle Management. In the case of Demand Management, the combinations could also include
customers and demand classes that are collected from Oracle Fusion Cloud Applications and external sources.

You can override segmentation results using the:

• Manage Segment Members page

• Edit-in-spreadsheet feature

Changes you make to the segments for combinations are overwritten the next time you run segmentation for the
segment group unless you have selected the Retain segment overrides check box in the Execute Segmentation dialog
box.
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Override Segmentation Results Using the GUI
To override segmentation results through the Manage Segment Members page, follow this procedure:

1. Perform one of these steps:

◦ On the Tasks panel tab, under Plan Inputs, select Manage Segment Members.

The Manage Segment Members page opens.

◦ On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > Manage
Segment Members.

The Manage Segment Members page opens and displays the combinations for the segment group.

◦ On the Segmentation Summary page, for the segment of a segment group, click the number under
Latest Count, Previous Count, Added in Latest Run, Removed in Latest Run, Manually Added to
Segment, Manually Removed from Segment, or Final Count.

The Manage Segment Members page opens and displays the combinations corresponding to the
number you clicked.

2. On the Manage Segment Members page, under Search, select the segment group for which you want to
override the segmentation results, and click Search. You can further refine your search by the segment,
previous segment, and levels for the dimensions in the segment group.

The page is refreshed with the segmentation results. For each combination, the assigned segment in the latest
segmentation run, assigned segment in the previous segmentation run, and segment override are displayed.

3. For each combination for which you want to override the segmentation results, under Segment Override,
select the new segment.

4. Click Save and Close.

Override Segmentation Results Using a Spreadsheet
To override segmentation results through the edit-in-spreadsheet feature, follow this procedure:

Note:  You must first download and install the desktop integration installer that's available under Navigator > Tools.
Otherwise, you can't override segmentation results using a spreadsheet.

1. Perform one of these steps:

◦ On the Tasks panel tab, under Plan Inputs, select Manage Segment Members.

The Manage Segment Members page opens.

◦ On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > Manage
Segment Members.

The Manage Segment Members page opens and displays the combinations for the segment group.

◦ On the Segmentation Summary page, for the segment of a segment group, click the number under
Latest Count, Previous Count, Added in Latest Run, Removed in Latest Run, Manually Added to
Segment, Manually Removed from Segment, or Final Count.

The Manage Segment Members page opens and displays the combinations corresponding to the
number you clicked.
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2. On the Manage Segment Members page, under Search, select the segment group for which you want to
override the segmentation results, and click Search.

The page refreshes with the segmentation results.
3. Under Search Results, click Edit in Spreadsheet.

A dialog box opens and prompts you to open or save a Microsoft Excel file.
4. Open the spreadsheet.

The Connect dialog box opens and prompts you to connect to the application URL.
5. Click Yes.

A dialog box opens and prompts you to enter your credentials.
6. Sign in with your Oracle Applications Cloud credentials.

The spreadsheet is refreshed with the combinations in the segment group displayed on the Manage Segment
Members page. For each combination, the assigned segment in the latest segmentation run, assigned segment
in the previous segmentation run, and segment override are displayed. Only the first 2,000 rows are displayed.

7. To narrow your search to a combination in the segment group, enter the details in the first table, and click
Manage Segment Members > Search.

You can use the percent sign as a wildcard character for your search.
8. For each combination for which you want to override the segmentation results, under the Segment Override

column, select the new segment.

A symbol appears in the cell under the Changed column for each changed row.
9. To upload your changes, click Manage Segment Members > Upload.

The results of the upload for each row are displayed under the Status column.

The symbol in the cell under the Changed column disappears for each successfully uploaded row.
10. Save and close the spreadsheet.
11. To view your changes on the Manage Segment Members page, click View > Refresh.
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9  Demand Plans

Manage Demand Plans  

Create a Plan  
You can create plans and then duplicate them to save time and perform planning activities incrementally. For example,
you have defined the line of business associated with an existing plan, such as organizations and items.

You can create a copy from that existing plan rather than define a new plan.

Use this generic procedure to create a plan.

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel drawer, click the Manage Plans link.
3. In the Search Results region, from the Actions menu, select Create.
4. On the Create Plan page, complete the general information for the plan:

a. Enter a name.
b. (Optional) Provide a description for the plan.
c. Select the plan type.
d. Select a supply planning mode.

Note:  The Supply Planning Mode attribute is only available for a supply plan, demand and supply plan,
or a sales and operations plan type.

- Supply plan and demand and supply plan types: Options are Constrained and Unconstrained.
Constrained is only available if you have opted in for Constraint-Based Supply Planning. Otherwise,
the supply planning mode defaults to Unconstrained.

- Sales and operations plan type: The supply planning mode defaults to Aggregate.
e. (Optional) Select the Enable for OTBI reporting check box to make measures from a plan available in

Oracle Transactional Business Intelligence (OTBI) for reporting.
f. Select the owner.

g. Define the access level:

i. Select Public to make the plan accessible for all users.
ii. Select Private to restrict the plan accessible to you and to a list of users that you want to provide

access.
5. Based on the type of plan that you selected, complete the required information in one or more tabs (Scope,

Demand, Safety Stock, and Supply).
6. Click Save and Close.

Related Topics
• Copy a Plan

• View a Plan
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Copy a Plan  
You can create plans and then duplicate them to save time and perform planning activities incrementally.

For example, you have defined the line of business associated with an existing plan, such as organizations and items.
You can create a copy from that existing plan rather than define a new plan.

Use the Duplicate procedure to:

• Create a copy of an existing plan that includes the plan data.

• Create only a copy of plan options.

Use these steps to copy a plan.

1. Navigate to the Duplicate Plan dialog box:

a. In a Supply Chain Planning work area link, click the Tasks panel tab.
b. In the Tasks panel drawer, click the Manage Plans link.
c. Enter the search parameters and click the Search button.
d. In the Search Results region, select the plan that you want to copy, click Actions, and then select

Duplicate.
2. In the Duplicate Plan dialog box, complete the following information for the plan:

a. Select a copy type:

- Copy plan options only: The planning process copies plan options to the duplicate plan, but not
the plan data.

Typically, when you duplicate the plan with the Copy plan options only option, the next step is to
edit the plan options before running the plan.

- Copy plan with reference to base plan: When you duplicate the plan with reference to the base
plan, the next step is to open the copied plan as you're likely to make edits before running the plan.
On the Manage Plans page, the Copied From column displays the name of the plan that you copied
from.

CAUTION:  If you delete the base plan or rerun the base plan with the Refresh with current data
option, plans copied from the base plan become invalid.

- Copy all plan data with no reference to base plan: The planning process makes a full, standalone
copy of the plan, which can include archived measures. For approved sales and operations plans,

204



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 9
Demand Plans

this option enables you to create a full backup copy of your plans at the end of every planning
cycle.

On the Manage Plans page, the Copied From column is empty for the new plan because it's a
standalone copy of the base plan. Therefore, there's no reference to the base plan.

The Copy all plan data with no reference to base plan option isn't available for demand plan types.
b. Enter a name and a description.
c. Define the access level:

- Select Public to make the plan accessible for all users.
- Select Private to restrict the plan accessible to you and to a list of users that you want to provide

access.
d. (Optional) Select the Load plan after copy check box to load the copied plan to memory. This check box

isn't available for demand plan or sales and operations plan types.
e. Select the owner.
f. (Optional) Select the Include archives check box to make a standalone copy of your plan that includes

archived measures. The copies of the archived versions are relabeled to remain consistent with the new
plan name. This relabeling applies to both scheduled and ad hoc archive versions.

The transaction history of when archived versions were created in the original plan isn't copied to the
new plan. However, the new archived version names retain the date stamp and sequence number of
when the archives were originally run.

The Include archives check box is available only when:

- The Enable for archiving check box is selected in the Scope: Advanced Options dialog box in the
plan options.

- The Copy all plan data with no reference to base plan is selected as the copy type in the
Duplicate Plan dialog box.

3. Click Save and Close

Related Topics
• Create a Plan

• View a Plan

View a Plan  
If you already have an existing plan, you can open the plan from the Plans drawer or by using the Manage Plans task.
You must always run a plan before you can view it.

To open an existing plan from the Plans drawer to view it, do the following:

1. In a Supply Chain Planning work area link, click the Plans drawer.
2. Expand Plans, and select the plan of your choice.
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3. Click the Actions button and select Open.

Tip:  If you have many plans, you have an option to search a plan by using the Manage Plans task. In this
case, provide appropriate search criteria and click Search. In the search results area, select your plan and click
the Action button and select Open. Oracle recommends this method to view sales and operations plans.

Note:  If you’re planning to show archived measures in your plan, you need to set the duration in days for the archived
time periods and enable viewing the past days on the plan table. See the View Planning Measures from Archived Time
Periods topic to learn more.

Related Topics
• Create a Plan

Enable Plans for OTBI Reporting  
Oracle Transactional Business Intelligence (OTBI) is a real-time, self-service reporting solution that helps you create
user-defined and interactive reports.

You can enable OTBI reporting for plans created in your Supply Chain Planning work area to:

• Run reports in real-time to analyze supply, demand, and sales and operations planning plans

• Generate user-configurable and easy-to-use reports by using business intelligence tools and charts

• Analyze key metrics, such as exception metrics, inventory balances, pegged quantity, and orders to be released

• Compare two or more plans that are enabled for OTBI reporting

To improve your supply chain performance, you can monitor and identify problem areas by using strategic insights into
live and operational data. Compare different scenarios in real-time by using key measures to decide the best course of
action. You can respond to changes by modeling complex strategies and plans to analyze and compare them. You can
also define native OTBI capabilities like alerts based on exception conditions, user-defined measures, and conditional
formatting to monitor or track problem areas.

To create OTBI reports, navigate to the Reports and Analytics work area. You can build reports by using the base
measures available in your Supply Chain Planning work area. You can also create user-defined measures based on the
base measures by using the standard business intelligence tools.

To open OTBI reports in a Supply Chain Planning work area, save the OTBI reports into the Report Components
subfolder within the Transactional Analysis Samples folder. The Report Components folder is located in the shared
Supply Chain Planning folder in the Reports and Analytics work area.

To enable OTBI reporting for plans, you must do the following:

• Select the Enable for OTBI reporting check box on the Plan Options page of your supply, demand, or sales and
operations plan.

Note:  You must run the plan after you enable it for OTBI reporting.

• Set up reporting hierarchies by configuring the Product and Time hierarchies in the dimension catalog named
Reporting Catalog. To configure the Product and Time hierarchies, use the Configure Planning Analytics task
in your Supply Chain Planning work area. Depending on the reports that you want to generate, move the
Product and Time hierarchies from the Available Hierarchies pane to the Selected Hierarchies pane. If you select
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multiple Product and Time hierarchies, ensure that you select a default hierarchy for the Product and Time
hierarchies. The default hierarchies are used by default in the predefined reports.

You can build reports by using the base measures available in your Supply Chain Planning work area. You can also
create user-defined measures based on the base measures by using the standard business intelligence tools.

Accessing the OTBI Reports
Perform these steps to access the OTBI reports:

1. In a Supply Chain Planning work area, open a plan that is enabled for OTBI reporting.
2. Click the Open button and then select a pane.
3. In the Open Table, Graph, or Tile Set dialog box, do one of the following:

◦ Search for your report.

◦ Filter the list by selecting Type and then Report.

4. Select a report and then click OK.

The OTBI report opens in the context of the current, open plan.

When you search for reports, the list of reports in the search results includes predefined reports and user-defined
reports created by you. You must save the user-defined reports into the Reports Components subfolder within the
Transactional Analysis Samples folder to make them available in the Supply Chain Planning work areas. The following
predefined reports are available only in the Supply Planning and Planning Central work areas:

• Build Plan by End Item

• Exception Summary by Item Order

• Details by Item

• Pegging Details by End Item

• Plan Recommendations Summary Graph

Available Measures
The following measures are available in the Reports and Analytics work area:

• Configure to Order Forecast Metrics: The following configure to order forecast metrics are available for demand
plans, and demand and supply plans:

◦ Final Option Demand Forecast

◦ Final Planning Percent

◦ Option Demand Forecast

Configure to order forecast metrics support dimensions, such as Plan, Time, Product, Organization,
Customer, Top Model, and Demand Class.

• Demand Management Metrics: The following demand management metrics are available for demand plans,
and demand and supply plans:

◦ Bookings Forecast

◦ Bookings History

◦ Bookings History Value
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◦ Final Bookings Forecast

◦ Final Shipments Forecast

◦ Shipments Forecast

◦ Shipments Forecast Value

◦ Shipments History

◦ Shipments History Value

Demand management metrics support dimensions, such as Time, Product, Organization, Customer, and
Demand Class.

• Exception Metrics: The following exception metrics are available for supply plans, and demand and supply
plans:

◦ Exception Count

◦ Exception Quantity

◦ Exception Days

◦ Exception Ratio

◦ Exception Value

Exception metrics support dimensions, such as Plan, Time, Product, Organization, Customer, Supplier,
Manufacturing Resource, and Exception Type.

• Order Metrics: The following order metrics are available for supply plans, and demand and supply plans:

◦ Order Quantity

◦ Implemented Supply Quantity

◦ Order Value

Order metrics support dimensions, such as Plan, Time, Product, Organization, Order Details, and Order
Type.

• Pegging Metrics: The following pegging metric is available for supply plans, and demand and supply plans:

◦ Pegged Quantity

Pegging metric supports dimensions, such as Plan, Time, Product, Organization, Customer, Supplier, End
Demand, and Order Type.
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• Sales and Operations Planning Metrics: The following sales and operations planning metrics are available for
sales and operations plans:

◦ Consensus Forecast

◦ Consensus Forecast Value

◦ Final Sales Forecast

◦ Final Sales Forecast Value

◦ Sales Forecast

◦ Sales Forecast Value

Sales and operations planning metrics support dimensions, such as Plan, Time, Product, Organization,
Customer, and Demand Class.

Define Scope Plan Options  
Scope options determine the scope of the plan. Define or modify scope plan options on the Scope tab on the Plan
Options page. You can configure the plan organizations, items, plan horizon, and planning level for demand forecasting.

You can also define the filters for a plan, such as the hierarchy, level, and level members.

The Scope tab includes the following sections:

• Plan Organizations

• Plan Items (available only for demand plans or demand and supply plans)

• Supply Planned Items (available only for demand and supply plans or supply plans)

• Plan Parameters

Plan Organizations
Specify a hierarchy, level, and level members by which to filter the plan. Also, select the source system code to use
for filtering organizations. Fields in the Plan Organizations section are required. If you select a level that's above the
organization level, then organizations that belong to that parent level are included in the plan.

Plan Items
Specify a hierarchy, level, and level members by which to filter specific items for demand planning. Your selections are
used with your selections in the Plan Organizations section. Items that belong to a parent level are included. Fields in
this section aren't required. However, if you don't specify a hierarchy, level, and level members, then you can't filter
planned items. In this situation, your plan includes all planned items in the selected organizations, which can have
performance implications.

Note:  The Plan Items section isn't available for supply-only plans.

Supply Planned Items
For Supply Planned Item Type, select Manufacturing Plan (MRP) or Production Plan (MPS).
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For Supply Planned Items, select the option to control the items to include in the supply plan. Options are:

• All planned items: This option can have performance implications.

• Demand plan items and all sales orders

• Demand plan and WIP components

• Demand plan items only

• Demand plan items, WIP components, and all sales orders

Select the Include items with only safety stock as demand check box to plan items with safety stock targets, even if
there is no demand yet for the items. For example, you want enough safety stock to support demand for new products
with long lead times even when you can't formally forecast for the new products or don't have any sales orders.

Note:  The Supply Planned Items section isn't available for demand-only plans.

Plan Parameters
The Plan Parameters section is available for plans of the demand, demand and supply, and supply plan types.

The following table describes the plan parameters.

Parameter Definition Plan Types

Plan Horizon Days
 

Number of days in the plan. Set horizon days
to forecast and plan for future needs. Minimize
horizon days to avoid long-running plans.
Default is 180 days.
 

Demand Plan
 

Forecasting Calendar
 

Select the forecasting calendar, which must
belong to the dimension catalog associated
with the plan.
 

Demand and Supply Plan
 

Planning Calendar
 

Select the planning calendar, which must
belong to the dimension catalog associated
with the plan.
 

Demand Plan
 

Planning Time Level
 

Set the planning time level on the Scope tab,
 and set the Forecasting time level on the
Demand tab. The time levels you can choose
depend on the selected planning calendar.
 
If you selected a hybrid time hierarchy as
the planning calendar for a demand plan,
 the planning time level is defaulted to the
corresponding Hybrid time level and mustn't be
changed.
 
In the Demand Management or Demand and
Supply Planning work area, for a demand plan
that uses feature-based forecasting, select only
Day, Week, or Month.
 

Demand Plan
 

Supply Planning Calendar
 

Select a supply planning calendar.
 

Demand and Supply Plan
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Parameter Definition Plan Types

The list of available calendars includes only
calendars that meet all of the following criteria:

• Belong to the dimension catalog
associated with the plan.

• Have calendar start and end dates that
encompass the entire plan horizon.

• Are Gregorian, fiscal, or organization
calendars.

 

Supply Plan
 

Supply Planning Buckets
 

Specify your supply planning buckets. The list
of values for the bucket types is determined by
the supply planning calendar that you specify.
 
You can base your planning horizon on days,
 weeks, periods, or months. Or, you can specify
a combination of daily time buckets and then
specify less granular time buckets such as
weeks, periods, or months. If you use two
bucket types, the first bucket type must be Day.
 

Demand and Supply Plan
 
Supply Plan
 

Number of Buckets
 

Specify the number of supply planning buckets.
 

Note:
For a constrained supply plan, the total
number of planning time buckets can't
exceed 120.
 

Demand and Supply Plan
 
Supply Plan
 

Don't create partial buckets
 

Select to create additional daily buckets in the
plan to avoid partial buckets.
 
The planning process adds additional daily
buckets to avoid the creation of partial buckets.
This ensures that a week, month, or period
always starts on the first defined day of that
particular week, month, or period.
 
If you don't select this option, the plan doesn't
add any additional daily buckets. Instead, the
planning process creates a partial bucket and
counts that partial bucket as the first week,
 period, or month, as specified in the plan
options.
 

Note:  The option is disabled if you select
the Week-Period combination in Supply
Planning Buckets.

Demand and Supply Plan
 
Supply Plan
 

Measure Catalog
 

Group multiple sets of measures for use in a
plan. By enabling only those measures that are
needed for any specific plan, you can perform
a focused analysis with improved performance.
A planning administrator can create and modify
measure catalogs.
 

Demand Plan
 
Demand and Supply Plan
 
Supply Plan
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Parameter Definition Plan Types

Price Lists
 

Price list used in revenue calculations. The
default price list for use in value calculations
is Item List Price, defined in the Items table for
Organization and Item. Item List Price is always
used to calculate revenue, even if a collected
price list is marked as the primary.
 

Demand Plan
 
Demand and Supply Plan
 
Supply Plan
 

Exception Set
 

Lists exceptions to compute as part of a plan
and also filters on Organizations and Categories
for computing exceptions.
 

Demand Plan
 
Demand and Supply Plan
 
Supply Plan
 

Simulation Set
 

Lists simulation sets to use in your plan. A
simulation set is a set of adjustments to plan
inputs. Apply a simulation set to a plan to
model different business scenarios.
 

Demand Plan
 
Demand and Supply Plan
 
Supply Plan
 

Related Topics
• Plan Items with Safety Stock Targets with No Demand

Set Up Forecast Consumption for Transfer Orders  
In Supply Chain Planning, you can use internal orders, also known as transfer orders, to track movement of product
between locations.

Transfers and transfer demand can be modeled by including both the transfer from and the transfer to organizations
in the plan. However, you can also choose to model transfer orders as independent demand during the forecasting and
forecast consumption processes when you need to plan the source location but not the destination location.

When you create a demand plan or a supply and demand plan that includes transfer orders, the plan can only include
the source organization. The forecasts will account for the supplies needed at the source organization. If you set up
the plan with both source and destination organizations, then the planning process won't create a transfer forecast.
Transfer orders between organizations in the same demand plan are excluded so that demand isn't counted twice. An
organization forecast can include both sales orders and transfers orders.

The transfer order history is collected into Demand Management and Demand Management creates a forecast for the
transfers. The transfer forecast will come into supply planning, and supply planning will also get transfer orders and
consume, or reduce, the forecast appropriately.
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The general setup for transfer order forecast consumption involves the following steps:

1. On the Maintain Supply Network Model page:

a. Associate the destination organization to the customer and customer site.
b. If the customer and customer site is for interorganization transfers, then select the Use Customer and

Customer Site for Interorganization Transfers check box.

Note:  You must set up these parameters on the Supply Network Model page before you can collect historical
transfer orders.

2. On the Collect Planning Data page, Parameters tab:

a. Select your source system and then select Targeted for your collection type.
b. On the Demand Planning Data subtab, select your shipments and bookings history measures in the

History Measures and Attributes section.
c. On the Demand Planning Data subtab, select the Collect historical transfer orders check box in the

History Data Options section.

Selecting this check box results in the planning process including the transfer orders with the sales orders
when you collect the historical data.

3. In the Demand: Advanced Options dialog box, select the Include transfer orders check box to include transfer
order history in the demand plan. Access the Demand: Advanced Options dialog box from the Plan Options
page, Demand tab.

When you select the check box, then transfer order history is brought into demand planning, except when the
transfer order history is between two organizations that are in the same demand plan.

Note:  The Include transfer orders check box is available only for demand plans or demand and supply plans
from a Demand Management, Planning Central, or a Demand and Supply Planning work area.

Consumption of Forecasts Based on Transfers by Planning Central and
Supply Planning
Planning Central and Supply Planning don't collect historical data, but they can get historical data from Demand
Management. First, you must select the demand plan or demand and supply plan in the Demand Schedules section on
the Plan Options page, Supply tab, Organizations and Schedules subtab. Next, the forecast consumption process checks
the demand schedule advanced plan option Include transfer orders. If you selected this check box for your demand
plan, then transfer order demands consume the forecasts at the transfer from organization in the demand schedule.

When you feed a demand plan as a demand schedule to Planning Central, Planning Central gets a transfer forecast
from the demand plan. For example, you feed a demand plan that includes a transfer forecast for ORG-X and the plan
in Planning Central plans for ORG-A and ORG-B. Planning Central gets that transfer order forecast for ORG-X where it's
transferring from ORG-A, and the Planning Central plan consumes it.

Related Topics
• Collect Data Using the Targeted Collection Type

• How You Maintain Your Supply Network Model
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Considerations for Storing Plan Data at Aggregate Time
Levels  
For demand plans and replenishment plans, you can select a planning time level to determine whether plan data is
stored at aggregate time levels.

Storing the demand signal data at a daily level isn't efficient if you forecast using demand signals at aggregate
levels, such as weekly and monthly. When your data is stored at aggregate time levels, embedded analytics are more
responsive and perform faster across your demand plan or replenishment plan. This decision is applicable to the
Demand Management, Demand and Supply Planning, Planning Central, and Replenishment Planning work areas. Your
choices for your forecasting time level are based on what you selected for your planning time level.

Planning Time Level Parameter
The Planning Time Level parameter is located on the Plan Options page, Scope tab, in the Plan Parameters section.
Your selection for the Planning Time Level parameter determines the time level at which the plan data is stored. The
values available for the Planning Time Level parameter are based on what you selected for the Planning Calendar
parameter as follows:

• Gregorian calendar: Day or Month

Oracle Fusion Replenishment Planning doesn't support the daily planning time level for the Gregorian calendar.

• Manufacturing calendar: Day, Week, or Period

Forecasting Time Level Parameter
For demand plans or replenishment plans, the Forecasting Time Level parameter is located on the Demand tab of
the Plan Options page. The selections available for the Forecasting Time Level parameter are limited to the selected
planning time level and any parent levels above it in the selected planning calendar. For example, if the Month level in
the Gregorian calendar is selected for the planning time level, then the Forecasting Time Level parameter is limited to
Month, Quarter, and Year.

Configuration Examples: Weekly and Monthly Plans
Weekly Plan: The following table shows an example of a configuration for a weekly demand plan or replenishment plan.

Parameter Location Parameter Value

Plan Parameters section of the Scope tab
 

Planning Calendar
 

a manufacturing calendar
 

Plan Parameters section of the Scope tab
 

Planning Time Level
 

Week
 

Demand tab
 

Forecasting Time Level
 

Week
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Monthly Plan: The following table shows an example of a configuration for a monthly demand plan or replenishment
plan.

Parameter Location Parameter Value

Plan Parameters section of the Scope tab
 

Planning Calendar
 

Gregorian calendar
 

Plan Parameters section of the Scope tab
 

Planning Time Level
 

Month
 

Demand tab
 

Forecasting Time Level
 

Month
 

Forecasting Profile Options for Demand Plans  
Demand plan options determine the forecasting profiles to include as part of a demand, demand and supply, or sales
and operations plan run.

Define forecasting profile options for a plan in a Supply Chain Planning work area on the Plan Options page, Demand
tab. The Demand tab isn't available for supply plans.

In the Forecast Profiles region, select which forecasting profiles are available for the plan run. You can also indicate the
amount of historical data used for forecast generation. When you run the plan, the forecast profiles run in the specified
order.

The demand planning engine generates statistical demand forecasts at different time levels such as day, week, or
month. For a demand plan, specify the time level in the Forecasting Time Level field on the Demand tab.

For a demand plan that uses a hybrid time hierarchy, the available forecasting time levels are parent levels of the Hybrid
time level for the hierarchy that you selected as the planning calendar on the Scope tab.

Note:  For sales and operations plans, the demand planning engine can generate statistical demand forecasts at
weekly, monthly, or quarterly time levels. You specify the time level in the Planning Time Level field on the Plan
Options page, Scope tab.

Forecasting Profiles with Input Measures and Output Measures
In the Forecast Profiles region, specify which forecasting profiles to include as part of a plan. You can't edit the input
measure or output measure for a forecasting profile.

The following table lists the predefined forecasting profiles.

Forecasting Profile Name Input Measure Output Measure

Forecast Shipments
 

Final Shipments History
 

Shipments Forecast
 

Forecast Shipments Including Event Activity
 

Final Shipments History
 

Shipments Forecast
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Forecasting Profile Name Input Measure Output Measure

(Not available in the Planning Central or Sales
and Operations Planning work area)
 

Forecast Shipments Including Product Lifecycle
 
(Not available in the Planning Central work area)
 

Final Shipments History
 

Shipments Forecast
 

Forecast Bookings
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings Including Event Activity
 
(Not available in the Planning Central or Sales
and Operations Planning work area)
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings Including Product Lifecycle
 
(Not available in the Planning Central work area)
 

Final Bookings History
 

Booking Forecast
 

Analysis Set
An analysis set is an optional criterion used to apply a forecasting profile to a subset of a plan.

• If you don't select an analysis set, then the forecasting profile applies to the full scope of the plan.

• If you select an analysis set, then the forecasting profile is applied to only the subset of the plan scope defined
by the analysis set.

For example, you have an analysis set containing a specific set of products, and you select that analysis set for a
forecasting profile. The forecast is generated for the specific products included in both the analysis set and plan, instead
of for all the products in the plan.

Historical Buckets
Define the amount of historical data to use during the forecasting process. The statistical demand forecasting process
uses the number of buckets in this field to define the amount of historical data used.

The historical buckets substantially affect the demand forecast generated when you run the plan. Use at least 12 months
of history, but 18 to 36 months of history is the best practice. When setting the historical buckets, keep the following in
mind:

• Very long history affects plan runtimes and makes the forecast less relevant to current demand patterns.

• Less than 1 year of history affects seasonal analysis. This includes both yearly seasonality and holiday impacts.

The historical buckets setting is the maximum amount of history used when generating a forecast. The actual amount
depends on the data available for a given item and organization. For each item and organization, the forecasting
process identifies all available historical data, removes any leading zero demand prior to the first positive demand point,
and generates a forecast.
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History Start and End Dates
The plan definitions drive the history end date. The history start date is calculated based on the end date and historical
buckets.

Forecast Buckets
Indicates how far into the future a demand forecast is generated and is driven by the planning horizon set for the plan.

Locked Forecast Buckets
Indicates the number of buckets from the end of historical data that don't receive a new forecast when you run the
demand plan.

Forecast End Date
Indicates the end date for a forecast that's generated when you run the plan. The end date is based on the planning
horizon and the current plan start date.

Demand Plan Options for Demand or Replenishment
Plans  
Define or modify demand options for a demand plan or replenishment plan on the Demand tab on the Plan Options
page.

For a replenishment plan, the Demand tab is enabled only when you select the Generate forecast check box on the
Plan Options page.

The following table explains how you use the Demand tab:

Demand Plan Option Explanation

Aggregate Non-Key Customer Data to an
All Other Level Member
 

Select this check box to aggregate data for customers whom you don't identify as key customers.
When you select this check box, the data for these non-key customers is aggregated to an All Other
member for analysis, and the number of customers and customer sites is reduced in the demand plan.
While certain customers and customer sites are relevant to your demand plan, most others aren't and
only add to the volume of data in your demand plan.
 
Before using this feature, you first need to use the file-based data import (FBDI) template titled Supply
Chain Planning Key Customer Options (ScpKeyCustomerOptionsImportTemplate.xlsm) to identify key
customers by hierarchy and level or by customer name and run the collections process.
 
This check box is available in only the Demand Management work area. The check box is disabled for a
demand plan if you've selected a planning level profile on the Scope tab on the Plan Options page.
 

Forecasting Time Level
 

Select the time level at which the forecast is generated. The selections are restricted to the planning
time level that you selected on the Scope tab or higher levels. For example, for a planning time level of
a week, the available forecasting time levels are week and period.
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Demand Plan Option Explanation

For a demand plan that uses a hybrid time hierarchy, the available forecasting time levels are parent
levels of the Hybrid time level for the hierarchy that you selected as the planning calendar on the Scope
tab.
 
The bucket you select for the forecasting time level is also used for the historical buckets, history
offset, forecast buckets, and locked forecast buckets displayed on the Demand tab.
 

Note:
The forecasting time level doesn't apply to forecasting profiles that use feature-based machine
learning.
 

Forecasting Profile, Input Measure, and
Output Measure
 

In the Forecast Profiles section, specify the forecasting profiles for the plan. Only those forecasting
profiles that are enabled for the Demand Management or Replenishment Planning work area are
available for selection. When you run the plan, the forecasting profiles run in the specified order. If
the forecasting profiles use the same output measure, it stores the output of the last run forecasting
profile.
 
You can't edit the input measure or output measure for a forecasting profile. The data in the input
measure serves as the basis of historical demand for the forecast. The output measure stores the
generated forecast.
 
The following are the predefined forecasting profiles:
 

• Forecast Bookings

◦ Input Measure: Final Bookings History

◦ Output Measure: Bookings Forecast

◦ Use: For forecasting on the basis of bookings history. Not available in the Replenishment Planning
work area.

• Forecast Bookings Including Event Activity

◦ Input Measure: Final Bookings History

◦ Output Measure: Bookings Forecast

◦ Use: For forecasting on the basis of bookings history while incorporating the impact of events.
Not available in the Replenishment Planning work area.

• Forecast Consumption

◦ Input Measure: Final Consumption History

◦ Output Measure: Consumption Forecast

◦ Use: For forecasting on the basis of consumption history. Not available in the Demand
Management work area.

• Forecast Shipments

◦ Input Measure: Final Shipments History

◦ Output Measure: Shipments Forecast

◦ Use: For forecasting on the basis of shipments history
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Demand Plan Option Explanation

• Forecast Shipments Including Event Activity

◦ Input Measure: Final Shipments History

◦ Output Measure: Shipments Forecast

◦ Use: For forecasting on the basis of shipments history while incorporating the impact of events.
Not available in the Replenishment Planning work area.

Analysis Set
 

Select an analysis set.
 

• If you don't select an analysis set, the forecasting profile applies to the full scope of the plan.

• If you select an analysis set, the forecasting profile is applied to only the subset of the plan scope
that's defined by the analysis set.

For example, you've an analysis set containing a specific set of products, and you select that analysis
set for a forecasting profile. The forecast is generated for only the products included in both the
analysis set and the plan, instead of for all the products in the plan.
 
You can use segments as member filters while configuring the analysis sets. Then, you can apply
forecasting profiles to specific segments by selecting the associated analysis sets.
 

Historical Buckets
 

Define the amount of historical data to use during the forecasting process. The number of historical
buckets is multiplied by the forecasting time level for determining the time horizon (number of days
between the history start and end dates) for considering the collected historical demand.
 
The historical buckets substantially affect the demand forecast generated when you run the plan. Use
at least 12 months of history, but using 18 to 36 months of history is the best practice. When setting the
historical buckets, keep the following in mind:
 

• Very long history affects the plan runtime and makes the forecast less relevant to current demand
patterns.

• Less than 1 year of history makes determining the impact of seasonal occurrences and holidays
difficult or impossible.

The historical bucket setting is the maximum amount of history used during forecast generation.
The actual amount depends on the data available for a given item and organization or item-location
combination. For each item and organization or item-location combination, the forecasting process
identifies all available historical data, removes any leading zero demand before the first positive
demand point, and generates a forecast.
 

History Offset
 

Define the buckets by which the history start date is moved backward. The forecast start date is
then set to one bucket ahead of the new history end date, and the history start and end dates and
forecast end date are automatically updated. The bucket size is determined by your selection in the
Forecasting Time Level field.
 
You use the history offset when you want to perform out-of-sample forecast tuning or back testing. By
moving the history start and end dates backward, you can generate a forecast for the period between
the history end date and the forecast start date, for which period you already have data. You can
compare your forecast with the actual data to refine your statistical forecast.
 

History Start and End Dates
 

For a demand plan, the history end date is determined by the plan run date and the planning calendar.
 
For a replenishment plan, the history end date is determined by the plan start date (displayed on the
General subtab on the Supply tab on the Plan Options page) and the planning calendar.
 
The history start date is determined from the history end date and the number of days between the
dates. The number of days between the history start and end dates is determined by multiplying the
number of historical buckets by the forecasting time level.
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Demand Plan Option Explanation

 

Forecast Buckets
 

Indicates the number of time periods for the demand forecast and is driven by the planning horizon set
for the plan and the forecasting time level.
 

Locked Forecast Buckets
 

Indicate the number of buckets from the end of historical data that don't receive a new forecast when
you run the plan. The bucket size is determined by your selection in the Forecasting Time Level field.
 
Ensure that the number you enter doesn't exceed the displayed number of forecast buckets.
 

Forecast End Date
 

Indicates the end date for the generated forecast. The end date is set to an end-of-period date based
on the history end date, forecasting buckets, and forecasting time level.
 

Related Topics
• Create a Forecasting Profile

• Edit a User-Defined Forecasting Profile

• Use the History Offset for Out-of-Sample Forecast Tuning

• Segmentation in Oracle Replenishment Planning

• Segmentation in Oracle Demand Management

Use the History Offset for Out-of-Sample Forecast
Tuning  
This topic explains how you can use the history offset for a forecasting profile for performing out-of-sample forecast
tuning or back testing.

You set the history offset in the Forecast Profiles section on the Demand tab of the Plan Options page for a demand
plan, demand and supply plan (in the Demand and Supply Planning work area), or replenishment plan. When you set
the history offset, the forecast start date is one bucket after the history end date.

Benefits of Using the History Offset
The history offset enables you to shift the history end date backward so that you can generate a forecast for the period
for which you have actual data. By comparing the forecast with your actual data in the period between the history
end date and the current date, you can accurately fine-tune the forecasting methods, causal factors, and forecasting
parameters used in your forecasting profile, thereby increasing the reliability of the statistical forecast.

By using this feature, you don't have to wait for several months to collect data and compare it with your forecast so that
you can fine-tune your forecasting profile.
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Points to Note When Using the History Offset
Some points to note when using the history offset are as follows:

• Preferably, create a forecasting profile for using the history offset. Ensure that the output measure isn't used by
other forecasting profiles.

This forecasting profile should contain the forecasting methods, causal factors, and forecasting parameters
that are used by the other forecasting profiles that you use for the statistical forecast.

• The history offset uses the time level you specify in the Forecasting Time Level field.

• When you set or change the history offset, the history start date, history end date, and forecast end date are
automatically updated.

• When you use the history offset, you should ensure that the tables and graphs in your plan display historical
data for enough days to cover the new history start and end dates.

You can control the number of days for displaying historical demand before the plan start date in tables and
graphs by using the Demand History Days field in the Demand: Advanced Options dialog box that you open
from the Demand tab on the Plan Options page. Enter the number of days to display historical demand before
the plan start date in tables and graphs when a time filter isn't specified. The default is 182.

• If your data is seasonal, you preferably should have at least two years of history before the new history end date
so that trends are captured and an accurate statistical forecast is generated. You can't generate an accurate
statistical forecast if you have less than one year of history before the new history end date.

• The history offset isn't considered in the calculation of the measure that stores the history average for the
forecasting profile. Instead, the original history end date is used in the calculation of the history average.

• If the plan is used as a demand schedule for a replenishment plan or a supply plan, the history offset isn't
considered.

Refine Your Statistical Forecast by Using the History Offset
These are the high-level steps for using the history offset for refining your statistical forecast:

1. Run your plan with the forecasting profile that you normally use.

On the Parameters tab of the Run Plan dialog box, under Details, select Refresh with current data.
2. Create a forecasting profile and output measure for using the history offset.
3. Attach the new forecasting profile to the plan, and set the history offset.
4. Run the plan with the new forecasting profile.

On the Parameters tab of the Run Plan dialog box, under Details, select Do not refresh with current data. For
as long as you're fine-tuning the statistical forecast, you don't need to select Refresh with current data.

5. Compare the forecast with the actual data, and fine-tune the forecasting methods, causal factors, and
forecasting parameters.

6. Make changes to the forecasting methods, causal factors, and forecasting parameters in the forecasting profile
that you want to use for the statistical forecast, and run the plan with the forecasting profile.
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Related Topics
• Demand Plan Options for Demand or Replenishment Plans

• Create a Forecasting Profile

• Run a Demand Plan

• Run a Replenishment Plan

Run a Demand Plan  
Run a demand plan to generate forecasts. When you run a demand plan, you can specify the scope of the plan that you
want to run. You can decide whether to refresh the plans input data before running it.

Also, you can run the plan immediately or you can run the plan in the background at a set time or on a repetitive
schedule, such as daily or weekly.

After you create a plan, you must run the plan to generate the data. In the Run Plan dialog box, Parameters tab, run plan
options are sequenced in the order of operations: data refresh, scope, and demand. The forecasting process runs first,
and then the output is used for planning calculations. You can configure the following options for a demand plan:

• Data Refresh Options

• Scope Options

• Demand Plan Run Options

Data Refresh Options
The following data refresh options are available:

• Do not refresh with current data: Select this option to run your plan with no changes to demand, including no
advancement of the plan start date. You also use this option for simulation planning.

• Refresh with selected current data: Select this option to partially refresh your data. You can refresh
transaction data and some reference data without performing a full refresh.

• Refresh with current data: Select this option to refresh the complete plan with the latest collected data and
advance the plan start date. If you're running the plan for the first time, this is the only data refresh option
available and it's selected by default.

Scope Options
Select Archive plan to archive data from the plan.

Demand Plan Run Options
Use Demand Plan Run Options to generate a demand forecast. Select the forecasting profiles that you want to include
as part of the plan. If you don't select a forecasting profile, then the demand forecasting process doesn't run.

Forecast Profiles: Select the forecasting profiles that you want to include as part of the plan. If you don't select a
forecasting profile, then the forecasting process doesn't run.
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Include details of forecast methods: Select to specify whether to provide details of the forecast methods that make
up the forecast. You must select this option to view the resulting forecast decomposed by the forecasting method.
Selecting this option increases the time required to run the plan.

Include details of causal factors: Select to specify whether to provide details of the causal factors that make up the
forecast. You must select this option to view the resulting forecast decomposed by the causal factor group. Selecting
this option increases the time required to run the plan.

Running a Demand Plan
To run a supply plan or an integrated plan, do the following:

1. Open the Run Plan dialog box:
a. In the Navigator, click the Demand Management work area.
b. Click the Plans panel tab and expand the Plans list.
c. Select the plan that you want to run, click Actions, and then select Run.

2. In the Run Plan dialog box, Parameters, tab, expand Details to review the plan options:
a. In the Data Refresh Options section, review the options and make appropriate selections.

Note:  If you're running the plan for the first time, you must select Refresh with Current Data. This
option refreshes historical data, imports sales orders, and advances the plan start date to align with the
current date.

b. In the Scope Options section, select Archive plan to archive the plan during the plan run.
c. In the Demand Plan Options section, select the appropriate options, including the forecasting profiles

that you want to include as part of the plan run.
3. To schedule running the plan, click the Schedule tab to set up the frequency parameters:

a. To run the plan immediately, select As soon as possible.
b. To run the plan in the background at a set time, select Using a schedule and then select a Frequency,

such as Daily or Weekly
.

4. Click OK to run the plan.

Related Topics
• Forecasting Methods for Demand Plans

• When do I run a demand plan?

• Review Plan Messages

Publish Plan Data  
You can publish data for a plan in the Demand Management, Demand and Supply Planning, Planning Central,
Replenishment Planning, Sales and Operations Planning, or Supply Planning work area to a compressed file.

You can then use the file for data integration between your Supply Chain Planning application and other Oracle or
external applications.
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By submitting a scheduled process from your Supply Chain Planning work area or the Scheduled Processes work area,
you can publish the data in a pivot table within your plan to a file on the content server of Oracle WebCenter Content.

Using APIs of Oracle's ERP integration service for automating the data integration between your Supply Chain Planning
Application and an external application, you can submit the scheduled process, check its status, and get the details of
the published document.

The file name is in the <plan name>_<pivot table name>.zip format.

Publish Plan Data from a Supply Chain Planning Work Area
Here's how you can publish data for your plan from your Supply Chain Planning work area:

1. Do one of the following to open the Publish Data dialog box:

◦ On the Manage Plans page, select the plan and click Actions > Publish Data.

The Publish Data dialog box opens.

◦ Open your plan and click Actions > Publish Data.

The Publish Data dialog box opens.
2. Optionally, enter submission notes for your scheduled process.
3. On the Parameters tab, optionally, select the Append request number to output file name check box.

Selecting this check box results in the request number being appended to the file name, which enables
easy identification of the file on the content server. The resulting file name (<plan name>_<pivot table
name>_<request number>) is also used as the document title.

If you don't select this check box, the document title is PUBLISHPLANDATA.
4. In Table Name, select the pivot table of your plan for which you want to publish data.

The available tables are enabled for the work area of the plan, and you have the required access to these tables.
5. In Source System, select the source system that's specified on the Scope tab of the Plan Options page for the

plan.
6. On the Schedule tab, specify whether you want to run the process as soon as possible or according to a

schedule.

If you publish the file according to a schedule, you can specify the frequency and start and end dates for the
process.

7. Click Submit.

The Status dialog box opens and displays the request number. Make a note of this number and then click OK.

You can use this number to search for the result of your request in the Scheduled Processes work area.

If you appended this number to the compressed file's name, you can use this number to search for the file in
the File Import and Export work area. You can then download and check the file.

Publish Plan Data from the Scheduled Processes Work Area
Here's how you can publish data for your plan from the Scheduled Processes work area:

1. On the Overview page, click the Schedule New Process button.

The Schedule New Process dialog box opens.
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2. In Name, select the Publish Plan job, and click OK.

The Process Details dialog box opens.
3. To be notified when the process ends regardless of the result, select the Notify me when this process ends

check box.
4. Optionally, enter submission notes for your scheduled process.
5. On the Parameters tab, in Plan Name, select your plan.
6. Optionally, select the Append request number to output file name check box.

Selecting this check box results in the request number being appended to the file name, which enables
easy identification of the file on the content server. The resulting file name (<plan name>_<pivot table
name>_<request number>) is also used as the document title.

If you don't select this check box, the document title is PUBLISHPLANDATA.
7. In Table Name, select the pivot table of your plan for which you want to publish data.

The available tables are enabled for the work area of the plan, and you have the required access to these tables.
8. In Source System, select the source system that's specified on the Scope tab of the Plan Options page for the

plan.
9. To set a schedule for your request and notify other users about the result, click the Advanced button.

The Schedule and Notification tabs are displayed.

◦ On the Schedule tab, specify whether you want to run the process as soon as possible or according to a
schedule.

If you publish the file according to a schedule, you can specify the frequency and start and end dates for
the process.

◦ On the Notification tab, specify the recipients to whom result notifications should be sent and the
conditions under which the notifications are sent.

10. Click Submit.

The Confirmation dialog box opens and displays the process number. Make a note of this number, and click OK.

You can use this number to search for the result of your request in the Scheduled Processes work area.

If you appended this number to the compressed file's name, you can use this number to search for the file in
the File Import and Export work area. You can then download and check the file.

Forecasting Methods for Demand Plans  
Application supports the following forecasting methods:

• Regression: The classical regression model is useful in identifying seasonal demands and casual-driven effects
of holidays and price.

• Ridge Regression: Regression that safeguards against one or more causal factors getting dramatically larger
affects than others. It is often similar to regression.

• Log Transformed Regression: Regression on a log transformed demand pattern. Useful to smooth out variance
which can't be easily explained in demand. It is best suited for highly variable demand patterns.
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• Holt Exponential Smoothing: Use this method for instances where the amount of data is limited, such as newly
introduced products. It creates a level-driven forecast without seasonality or other causal factors.

• Croston Method for Sparse Demand: Use this method when a large amount of historical data is intermittent or
spare. This method evaluates periodicity of demand.

• Regression for Sparse Demand: Useful for sparse demand where there are still some seasonal or causal driven
impacts.

When you forecast using a demand plan:

• Each item-organization combination that has historical demand is analyzed separately.

• The analysis automatically removes any zero demand entries and fills the missing historical data.

• The analysis also identifies peaks and valleys in the history that are erroneous information or outliers.

• The forecasting process evaluates which of the predefined forecasting methods are most appropriate for
analyzing the particular item-organization's historical demand and selects one or more forecasting methods.

Related Topics
• Run a Demand Plan

Modify Causal Factors  
You use causal factors to understand the variation in historical demand and produce a highly accurate and adaptive
forecast. You have 27 causal factors that you can use during the forecasting process to evaluate each item-organization
and determine the impacts.

The causal factors include:

• 12 months of the year

• 7 days of the week when forecasting using daily data

• Trend

• Price

• 6 holidays (They include New Year's, Thanksgiving, Christmas, and three placeholder holidays. You can use
these to model any other holidays.)

Note:  Except for Price, all causal factors have a dimension of Time only and do not vary by item and organization.

Modifying Causal Factors
You can modify and repurpose causal factors to meet the demand planning needs. Since all causal factors are on shared
measures, changes to one plan's causal factor values impacts other plans simultaneously. Typically, you load the causal
factor data from a flat file and then modify as required.

To modify a causal factor:

1. Open a demand plan with history and horizon that matches the causal dates.
2. Create a table displaying the causal factor measure and relevant time period.
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3. Modify the values of the causal factor and save. Next time you run any plan, the changes to the causal factor
can impact the forecast.

Related Topics
• Run a Demand Plan

• Forecasting Methods for Demand Plans

• Create a Plan

• Copy a Plan

Modify Demand Exceptions  
You open a demand plan and open the exceptions table to view the demand exceptions. The exception table shows any
demand exception with at least one exception.

You can use the search capabilities to focus on specific areas of exceptions, such as:

• Exception Date

• Specification values

• Organization

• Product

Modifying Demand Exceptions
You can modify the threshold associated with each demand exceptions to meet your business requirements. In addition,
you can also modify the data aggregation level at which the measure is evaluated. Typically, when you calculate at a
lower level, an exception returns more occurrences for the same threshold than when set at a higher level.

The reduction in exceptions is tied to two factors:

• Less data points to evaluate at a higher level.

• A large amount of data variability and noise that occurs at lower levels is reduced in aggregation. Hence, it's
recommended that the threshold and levels be set to the most business-meaningful levels. For example, if the
primary use of forecast is to ensure enough is produced, then organization aggregation should be increased
from organization to line of business.

Overriding Demand Forecast
Based on business information and intelligence, you can override the statistical forecast.

To perform a forecast override:

1. Open the relevant plan and open a table with the forecast measures.
The table must contain the dimension and hierarchies that you want to view the data. You can use a table with
several hierarchies and levels and collapse or expand a hierarchy until they see the relevant data aggregation.

2. Double-click the cell and enter the desired value to enter an override. When you navigate away from the cell,
the calculated measure associated with the override measure changes immediately.

3. Click Save. Close the table without saving to discard any unsaved changes.
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Related Topics
• Run a Demand Plan

• Forecasting Methods for Demand Plans

Approve a Demand Plan  
As a demand planner, you typically follow a weekly or monthly planning cycle. During this cycle, you can review different
forecasts and try different scenarios in an effort to get to the most appropriate future projection of demand.

After the cycle is complete, it is best practice to take a snapshot or archive forecast results so that it can remain static
while the next forecast cycle begins. You can reuse the static forecast as an input for other processes.

In your Supply Chain Planning application, you can set aside the demand forecast and save using the Approve action.
After a forecast is approved, the approved values remain unchanged until the forecast is approved again.

Note:  A plan approval is a recommended step, but not mandatory in the demand planning.

The following illustration is a visual representation of the demand planning process and shows how plan approval
interacts.

Demand planning process typically includes running a plan, user reviewing the plan, and overriding. These steps can
impact the Final Shipments Forecast and Final Bookings Forecast.

When you determine that a plan's forecast is sufficiently complete for approval, you perform the Approve action. The
approve action takes the data from the two final forecast measures and copies to Approved Final Shipments Forecast
and Approved Final Bookings Forecast, respectively.
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Related Topics
• Run a Demand Plan

• Plan Approval, Plan Attributes, and Plan Status

When do I run a demand plan?  
You run a demand plan depending on your organization's demand forecasting cycle, which is typically either weekly or
monthly.

You also run a demand plan when major changes have been made to historical data or causal factors, or when new
products have been added.
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10  Statistical Forecasts for Demand

Create a Forecasting Profile  
A forecasting profile is a collection of definitions used during the generation of demand forecasts. Each profile includes
the definitions of the forecasting methods used and at what level demand data is aggregated.

Predefined Forecasting Profiles
This table lists the predefined forecasting profiles:

Forecasting Profile Work Area Input Measure Output Measure Forecasting Table Use

Forecast Bookings
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings
Definitions
 

For forecasting on
the basis of bookings
history
 

Forecast Bookings for
Supersession Chain
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings
Definitions
 

For forecasting on
the basis of bookings
history for the
current item revision
and latest (future)
item revision in a
supersession chain
 

Forecast Bookings
Including Event
Activity
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings
Definitions
 

For forecasting
on the basis of
bookings history while
incorporating the
impact of events
 

Forecast Bookings
Including Product
Lifecycle
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings
Definitions
 

For forecasting on
the basis of bookings
history and the
launch date and
discontinuation date
 

Feature-Based
Bookings Forecast for
New Products
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Feature Based
Bookings Forecast
 

Feature-Based
Bookings Forecast
Definitions
 

For forecasting for
new products on the
basis of historical
bookings and features
that are used to
analyze effects on
product demand
 

Forecast Consumption
 

Replenishment
Planning
 

Final Consumption
History
 

Consumption Forecast
 

Forecast Consumption
Definitions
 

For forecasting on the
basis of consumption
history
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Forecasting Profile Work Area Input Measure Output Measure Forecasting Table Use

Forecast Shipments
 

Demand Management
 
Demand and Supply
Planning
 
Replenishment
Planning
 

Final Shipments
History
 

Shipments Forecast
 

Forecast Shipments
Definitions
 

For forecasting on the
basis of shipments
history
 

Forecast Shipments
for Supersession
Chain
 

Demand Management
 
Demand and Supply
Planning
 
Replenishment
Planning
 

Final Shipments
History
 

Shipments Forecast
 

Forecast Shipments
Definitions
 

For forecasting on the
basis of shipments
history for the
current item revision
and latest (future)
item revision in a
supersession chain
 

Forecast Shipments
Including Event
Activity
 

Demand Management
 
Demand and Supply
Planning
 

Final Shipments
History
 

Shipments Forecast
 

Forecast Shipments
Definitions
 

For forecasting
on the basis of
shipments history
while incorporating
the impact of events
 

Forecast Shipments
Including Product
Lifecycle
 

Demand Management
 
Demand and Supply
Planning
 
Replenishment
Planning
 

Final Shipments
History
 

Shipments Forecast
 

Forecast Shipments
Definitions
 

For forecasting on the
basis of shipments
history and the
launch date and
discontinuation date
 

Feature-Based
Shipments Forecast
for New Products
 

Demand Management
 
Demand and Supply
Planning
 

Final Shipments
History
 

Feature Based
Shipments Forecast
 

Feature-Based
Shipments Forecast
Definitions
 

For forecasting for
new products on the
basis of historical
shipments and
features that are used
to analyze effects on
product demand
 

You can't edit predefined forecasting profiles. However, you can modify copies of predefined forecasting profiles for
your use.

Create a Forecasting Profile
Follow these steps to create a forecasting profile:

1. In the Demand Management, Demand and Supply Planning, or Replenishment Planning work area, on the
Tasks panel tab, under Configuration, select Manage Forecasting Profiles.

The Manage Forecasting Profiles page opens.
2. Click Actions > Create.

The Manage Forecasting Profiles page opens.
3. Enter the name and description for the forecasting profile.
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4. In Machine Learning Type, select Bayesian if you want the forecasting profile to use Bayesian machine
learning for new or existing products. Bayesian machine learning uses the algorithms in Oracle Demand
Management.

Select Feature-based if you want the forecasting profile to use feature-based machine learning for new
products. Feature-based machine learning uses the algorithm in the Oracle Fusion Internet of Things Intelligent
Applications Cloud Service.

Note:  You can't select Feature-based if you want to enable your forecasting profile for the Replenishment
Planning work area.

5. In Enable in Work Area, select the check boxes for the work areas in which the forecasting profile should be
available.

After the forecasting profile is created, it'll be visible on the Managing Forecasting Profiles page in only these
work areas. Moreover, during the creation of a demand plan, demand and supply plan, or replenishment plan,
in the Forecast Profiles section on the Demand tab on the Plan Options page, only the forecasting profiles
enabled for the work area can be selected.

6. In Forecasting Table, select the forecasting table for the forecasting profile.

The forecasting table defines the data aggregation levels that are used in the forecasts.
7. In Input Measure, select the input measure for the forecasting profile.

This measure's data is used as the basis of historical demand in forecasts.

The measures available for selection are in the selected forecasting table and are dimensioned by time.
8. In Output Measure, select the output measure for the forecasting profile.

This measure stores the forecast after the plan is run.

The measures available for selection are in the selected forecasting table and are dimensioned by time.
Moreover, the available measures can't be shared across plans and are refreshed with current data.

9. In Measure Catalogs, select the measure catalogs for the forecasting profile.

Select all the measure catalogs that you anticipate are required for plans that use the forecasting profile.
Predefined measure catalogs aren't available for selection.

10. If your forecasting profile uses Bayesian machine learning, use the Forecasting Methods tab to configure the
forecasting methods and method parameters. For more information, refer to the topic on forecasting methods
for Bayesian machine learning in this chapter.

If your forecasting profile uses feature-based machine learning, accept the default selection of the XG Boost
forecasting method on the Forecasting Methods tab. For more information, refer to the topic on the forecasting
method for feature-based forecasting in this chapter.

11. If your forecasting profile uses Bayesian machine learning, use the Decomposition Groups tab to select and
configure decomposition groups. For more information, refer to the topic on decomposition groups in this
chapter.

If your forecasting profile uses feature-based machine learning, use the Feature Groups tab to select and
configure measures, levels, and attributes. For more information, refer to the topic on feature groups in this
chapter.

12. Use the Forecasting Parameters tab to configure forecasting parameters.

For more information, refer to the topic on forecasting parameters for Bayesian machine learning or forecasting
parameters for feature-based forecasting in this chapter.
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13. Click Save and Close.

Related Topics
• Overview of Forecasting Using Supersession Relationships

• Overview of the Product Lifecycle Management Page Layout

• Overview of Feature-Based Forecasting for New Products

Edit a User-Defined Forecasting Profile  
You can duplicate, edit, or delete a user-defined forecasting profile.

You can't edit a predefined forecasting profile. However, you can duplicate the predefined forecasting profile and edit
the copy.

You also can't change the machine learning type for a forecasting profile. If you duplicate the forecasting profile, the
Machine Learning Type field is set to the selection for the original forecasting profile and can't be changed.

To delete the user-defined forecasting profile, you must first deselect it for the associated demand, demand and supply,
or replenishment plan in the Forecast Profiles section on the Demand tab of the Plan Options page.

Follow these steps to edit the user-defined forecasting profile:

1. In the Demand Management, Demand and Supply Planning, or Replenishment Planning work area, on the
Tasks panel tab, under Configuration, select Manage Forecasting Profiles.

The Manage Forecasting Profiles page opens.
2. Select the forecasting profile, and click Actions > Edit

The Manage Forecasting Profiles page opens.
3. Edit the name and description as required.
4. In Enable in Work Area, select or deselect the work areas in which the forecasting profile should be available.

You can't deselect a work area if the forecasting profile is associated with a plan in that work area. Before
deselecting the work area, you must first deselect the forecasting profile for the plan in the Forecast Profiles
section on the Demand tab of the Plan Options page.

5. In Forecasting Table, select the forecasting table that defines the data aggregation levels that are used in the
forecasts.

6. In Input Measure, select the input measure for the forecasting profile.

This measure's data is used as the basis of historical demand in forecasts.

The measures available for selection are in the selected forecasting table and are dimensioned by time.
7. In Output Measure, select the output measure for the forecasting profile.

This measure stores the forecast after the plan is run.

The measures available for selection are in the selected forecasting table and are dimensioned by time.
Moreover, the available measures can't be shared across plans and are refreshed with current data.
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8. In Measure Catalogs, select the measure catalogs for the forecasting profile.

Select all the measure catalogs that you anticipate are required for plans that use the forecasting profile.
Predefined measure catalogs aren't available for selection.

9. If your forecasting profile is based on Bayesian machine learning, use the Forecasting Methods tab to configure
the forecasting methods and method parameters. For more information, refer to the topic on forecasting
methods for Bayesian machine learning in this chapter.

If your forecasting profile is based on feature-based machine learning, accept the default selection of the XG
Boost forecasting method on the Forecasting Methods tab. For more information, refer to the topic on the
forecasting method for feature-based forecasting in this chapter.

10. If your forecasting profile uses Bayesian machine learning, use the Decomposition Groups tab to select and
configure decomposition groups. For more information, refer to the topic on decomposition groups in this
chapter.

If your forecasting profile uses feature-based machine learning, use the Feature Groups tab to select and
configure measures, levels, and attributes. For more information, refer to the topic on feature groups in this
chapter.

11. Use the Forecasting Parameters tab to configure forecasting parameters.

For more information, refer to the topic on forecasting parameters for Bayesian machine learning or forecasting
parameters for feature-based machine learning in this chapter.

12. Click Save and Close.

The edited forecasting profile takes effect the next time you run the associated plan.

Forecasting Methods  
You have 15 forecasting methods for use in forecasting profiles that are based on Bayesian machine learning.

You can use one or a combination of these forecasting methods while configuring your forecasting profile. You also
have three naive forecasting methods that are used when the other forecasting methods can't produce an acceptable
forecast in a forecasting profile that's based on Bayesian machine learning.

The following table lists the 15 forecasting methods and three naive forecasting methods:

Forecasting
Method

Enabled in
Predefined
Forecasting
Profiles

Uses Short
Causal
Factors

Uses Long
Causal
Factors

Uses
Multiplicative
Causal
Factors

Uses
Nonseasonal
Causal
Factors

Supports
Method
Decomposition

Supports
Causal
Decomposition

Calculates
MAPE, MAD,
 and Bias

Auto
Regressive
External
Inputs (X)
 

No
 

No No No Yes Yes Yes Yes

Auto
Regressive
Integrated
External (V)
 

No
 

No No No Yes Yes Yes Yes
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Forecasting
Method

Enabled in
Predefined
Forecasting
Profiles

Uses Short
Causal
Factors

Uses Long
Causal
Factors

Uses
Multiplicative
Causal
Factors

Uses
Nonseasonal
Causal
Factors

Supports
Method
Decomposition

Supports
Causal
Decomposition

Calculates
MAPE, MAD,
 and Bias

Auto
Regressive
Logistic (A)
 

No
 

No Yes No No Yes Yes Yes

Causal
Winters (B)
 

No
 

Yes No No No Yes No Yes

Combined
Transformation
(E)
 

No
 

No Yes No No Yes Yes Yes

Croston for
Intermittent
(F)
 

Yes
 

No No No No No No Yes

Dual Group
Multiplicative
(D)
 

No
 

No No Yes No Yes Yes Yes

Holt (H)
 

Yes
 

No No No No Yes Yes Yes

Logistic (G)
 

No
 

Yes No No No Yes Yes Yes

Modified
Ridge
Regression
(M)
 

Yes
 

No Yes No No Yes Yes Yes

Multiplicative
Monte Carlo
Intermittent
(K)
 

No
 

No Yes No No No No Yes

Multiplicative
Monte Carlo
Regression (C)
 

No
 

No Yes No No Yes Yes Yes

Regression (R)
 

Yes
 

Yes No No No Yes Yes Yes

Regression for
Intermittent
(J)
 

Yes
 

Yes No No No No No Yes

Transformation
Regression (L)
 

Yes
 

Yes No No No Yes Yes Yes
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Forecasting
Method

Enabled in
Predefined
Forecasting
Profiles

Uses Short
Causal
Factors

Uses Long
Causal
Factors

Uses
Multiplicative
Causal
Factors

Uses
Nonseasonal
Causal
Factors

Supports
Method
Decomposition

Supports
Causal
Decomposition

Calculates
MAPE, MAD,
 and Bias

Naive (N) Yes No No No No No No No

Holt Naive (T) Yes No No No No No No No

Moving
Average Naive
(O)

Yes No No No No No No No

The six forecasting methods that are enabled in predefined forecasting profiles provide the best results in most
business scenarios that are commonly found. You can use the remaining forecasting methods in user-defined
forecasting profiles.

To enable you to analyze the generated forecasts, the letters representing the used forecasting methods and their
weights are stored in these measures:

Note:  The measures for method weights are populated only when you select the Include details of forecast
methods check box on the Parameters tab in the Run Plan dialog box for a demand or demand and supply plan.

Measure Description Applicable Work Areas

Bookings Forecasting Methods
 

Contains the letters for the forecasting methods
that are used for generating the bookings
forecast for an item.
 

• Demand Management

• Demand and Supply Planning

• Sales and Operations Planning

Bookings Forecasting Methods Weight
 

Contains the weight (percentage) assigned
to a forecasting method during the bookings
forecast generation.
 

• Demand Management

• Demand and Supply Planning

Consumption Forecasting Methods
 

Contains the letters for the forecasting methods
that are used for generating the consumption
forecast for an item.
 

Replenishment Planning
 

Shipments Forecasting Methods
 

Contains the letters for the forecasting methods
that are used for generating the shipments
forecast for an item.
 

• Demand Management

• Demand and Supply Planning

• Replenishment Planning

• Sales and Operations Planning

Shipments Forecasting Methods Weight
 

Contains the weight (percentage) assigned to
a forecasting method during the shipments
forecast generation.
 

Note:  In a replenishment or sales and
operations plan, this measure won't return
any value because causal decomposition
isn't supported in such plans.

• Demand Management

• Demand and Supply Planning

• Replenishment Planning

• Sales and Operations Planning

237



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 10
Statistical Forecasts for Demand

For information about forecasting methods, refer to the white paper titled "Oracle Demand Management Cloud
Analytical Methods (Forecasting Methods)" that's available in Document ID 2582285.1 on My Oracle Support.

Naive Forecasting Methods
If none of the enabled forecasting methods in the predefined or user-defined forecasting profile can generate an
acceptable forecast at any level of the forecast tree, then the following steps are taken:

1. If the Holt (H) forecasting method wasn't enabled, and the number of data points in the history is sufficient,
then a simplified version of the forecasting method called Holt Naive (T) is used at the highest level of the
forecast tree. The generated forecast is used if acceptable.

2. If the Holt Naive (T) forecasting method doesn't generate an acceptable forecast, then the following steps are
taken on the basis of the value of the EnableNaiveForecast forecasting parameter:

a. If the value of the forecasting parameter is zero, no forecast is generated.
b. If the value of the forecasting parameter is 1, the Naive (N) forecasting method is used at the highest

level of the forecast tree. A simple forecast is generated on the basis of the average of the bookings,
consumption or shipments history.

Note:  In predefined forecasting profiles, the value of the EnableNaiveForecast forecasting parameter is
1. Therefore, in predefined forecasting profiles, the Naive (N) forecasting method is used.

c. If the value of the forecasting parameter is greater than 1, then the Moving Average Naive (O) forecasting
method is used at the highest level of the forecast tree. A simple moving average of the bookings,
consumption, or shipments history is used for generation of the forecast. The value of the forecasting
parameter determines the number of buckets that are used, and the bucket is specified in the
Forecasting Time Level field on the Demand Tab on the Plan Options page for the demand, demand
and supply, or replenishment plan.

Method decomposition and causal decomposition aren't available for naive forecasting methods.

Related Topics
• Create a Forecasting Profile

• Statistical Forecasts, Causal Factors, and Decomposition Groups

Configure Decomposition Groups  
A decomposition group is a container for the measures that you use as causal factors in a forecasting profile that's
based on Bayesian machine learning.

Causal factors enable forecasting methods to understand the variation in historical demand and produce an accurate
and adoptive forecast. Decomposition groups let you organize measures that have similar effects on a forecast.

Several predefined causal factors (predefined measures) are available for meeting commonly found forecasting needs.
You can also use user-defined measures as causal factors. You can easily view and modify the information in causal
factors using tables. Causal factors are the best way for you to add information that drives demand into the forecasting
process and thereby improve it.

For your user-defined forecasting profile, you can add, edit, or delete decomposition groups. You can also activate and
deactivate all causal factors in a decomposition group using its check box.
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In a demand or demand and supply plan, you can decompose the forecast by the causal factor group. When you select
the Include details of causal factors check box on the Parameters tab in the Run Plan dialog box, the duration of the
plan run increases significantly. For this reason, decompose the forecast by causal factors preferably when you simulate
the demand from a table for a subset of the plan that's based on the table selections. By doing so, you can perform a
focused analysis of the causal factors. Include the details of the causal factors only when you want to analyze the results
and not every time you run the plan.

Note:  Causal decomposition isn't supported for the Causal Winters (B), Croston for Intermittent (F), Multiplicative
Monte Carlo Intermittent (K), Regression for Intermittent (J), Naive (N), Moving Average Naive (O), and Holt Naive (T)
forecasting methods. No decomposed values are generated for any items that are forecast with these forecasting
methods.

For information about causal factors, refer to the white paper titled "Demand Management Forecasting Causal Factors"
that's available in Document ID 2551482.1 on My Oracle Support.

Create a Decomposition Group
Perform these steps to create a decomposition group:

1. On the Decomposition Groups tab in your forecasting profile, click Actions > Create.
2. In the Create Decomposition Group dialog box, do the following:

◦ Provide a name and description for the decomposition group.

◦ From the Available Measures pane, move the required measures to the Selected Measures pane.

The available measures are those that are enabled for the work area in which you create the
decomposition group. Ensure that the selected measures are in the measure catalog of the plan that uses
the forecasting profile.

3. Click OK.

Configure Causal Factors in a Decomposition Group
Perform these steps to configure the causal factors in a decomposition group:

1. On the Decomposition Groups tab in your forecasting profile, expand the decomposition group.

The expanded list details the available causal factors.
2. Select the check boxes for each causal factor:

◦ Short: Use this setting to assign the causal factor to the Causal Winters (B), Logistic (G), Regression
(R), Regression for Intermittent (J), and Transformation Regression (L) forecasting methods that use all
assigned causal factors. These forecasting methods use a limited set of causal factors and aren't efficient
at determining which causal factors are useful. You select this check box for most causal factors.

◦ Long: Use this setting to assign the causal factor to forecasting methods that use an extended set
of causal factors and are efficient at determining which causal factors are useful. These forecasting
methods are Auto Regressive Logistic (A), Combined Transformation (E), Modified Ridge Regression (M),
Multiplicative Monte Carlo Intermittent (K), and Multiplicative Monte Carlo Regression (C).

◦ Multiplicative: Use this setting to assign the causal factor to the Dual Group Multiplicative (D) forecasting
method. If you have enabled this forecasting method, each causal factor of your forecasting profile can
use the Group One or Group Two value of the list. Each of these values should be selected for at least
one causal factor.
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◦ Not Seasonal: Use this setting to assign the causal factor to the Auto Regressive External Inputs (X)
and Auto Regressive Integrated External (V) forecasting methods. The only causal factors that should
be assigned this setting are those that aren't predictable functions of time. For example, price varies
randomly with time and can be assigned this setting.

◦ Fill Missing: Use this setting for causal factors when there are missing values for dates, and you want to
have values for these dates. The values that are entered for a causal factor are based on values of the
same causal factor for other dates. Use this setting for causal factors, such as those for price, that should
always have a value.

Related Topics
• Create a Forecasting Profile

• Forecasting Methods

• Forecasting Parameters

Forecasting Parameters  
Forecasting parameters control several aspects of a demand forecast, such as the handling of missing values, outlier
detection, fit and forecast validation, and sparse data forecasting.

You can improve the default settings for forecasting parameters based on your data analysis and forecast results.

The settings for all forecasting parameters related to time are in days and automatically adjusted for aggregate
forecasting time levels. For example, the default setting of 182 days for a forecasting parameter is automatically
adjusted to 26 days for a weekly forecast.

Note:  You can’t make any change to the displayed forecasting parameters or their values in a predefined forecasting
profile. You can make such changes in only a copy of the predefined forecasting profile.

This table lists the commonly used forecasting parameters.

Forecasting Parameter Description

FillMissingMethod
 

Specifies how to fill any undefined historical values. Parameter values may be 0, 1, 2. 0 for no missing
values field. 1 for linear interpolation based on not missing neighbors. 2 for omitting missing values.
 

GlobalAllocationPeriods
 

Specifies the number of days going backward from the history end date that's used for calculating the
average demand (for bookings, consumption, or shipments).
 

DiscontinueDateMeasure
 

Specifies the measure that contains the product discontinuation date for use in the functionality
for managing product launches. If the measure is specified, the forecast ends on the product
discontinuation date instead of the plan's forecast end date.
 
If the measure date is after the forecast end date of the plan, the forecast end date is used. When the
selected measure doesn’t contain a value or isn’t present in the plan’s measure catalog, the forecast
end date of the plan is used.
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Forecasting Parameter Description

If the date for the LaunchDateMeasure forecasting parameter is later than the date for the
DiscontinueDateMeasure forecasting parameter, both dates are ignored, and the forecast is generated
from the plan's forecast start date to the plan's forecast end date.
 
The default value for the DiscontinueDateMeasure forecasting parameter is the Final Discontinuation
Date measure. The available measures for selection are of the Date data type, are available in the
forecasting profile’s work areas, and have all dimensions of the forecasting profile's output measure
except for Time.
 

EnableNaiveForecast
 

Specifies whether naive modeling is used, and if so, what type. The parameter value may be 0 or a
positive integer. Use 0 to disable naive modeling. 1 to use Oracle proprietary naive modeling. Any
integer greater than 1 to use the simple moving average with the value controlling the number of
historical periods used.
 

IntermitCriterion
 

Specifies the lowest percentage of zero values in historical demand for which the time series are
evaluated using intermittent forecasting methods.
 

LaunchDateMeasure
 

Specifies the measure that contains the product launch date for use in the functionality for managing
product launches. If the measure is specified, the forecast starts on the product launch date instead of
the plan's forecast start date.
 
If the measure date is earlier than the forecast start date of the plan, the forecast start date is used.
When the selected measure doesn’t contain a value or isn’t present in the plan’s measure catalog, the
forecast start date of the plan is used.
 
If the date for the LaunchDateMeasure forecasting parameter is later than the date for the
DiscontinueDateMeasure forecasting parameter, both dates are ignored, and the forecast is generated
from the plan's forecast start date to the plan's forecast end date.
 
The default value for the LaunchDateMeasure forecasting parameter is the Final Launch Date measure.
The available measures for selection are of the Date data type, are available in the forecasting profile’s
work areas, and have all dimensions of the forecasting profile's output measure except for Time.
 

WriteFit
 

Specifies whether the forecast is generated for the future or also for the history. Enter 0 to write the
forecast for only the future, or 1 to write the forecast for the future and history. When you enter 1, the fit
forecast is written for the entire history used during the forecasting process.
 

DetectOutlier
 

Specifies whether an attempt should be made to detect and smooth outliers in the time series. If
extreme highs and lows are acceptable in your demand pattern, you can disable this forecasting
parameter by entering zero.
 

OutlierSensitivity
 

Specifies the sensitivity of outlier detection. The greater the value, the more liberal the detection. For
common detection, use values less than 2.
 

RemoveExtremeOutlier
 

Specifies whether aggressive outlier smoothing should be performed, and if extreme values should
be removed before being processed by forecasting methods. Enable this forecasting parameter by
entering 1 only if there's a clear cause to remove extreme values, if extreme values are rare or because
of data errors, and you want a very smooth forecast.
 

EnableFitValidation
 

Specifies whether to enable statistical fit validation. 1 to enable validation. 0 to disable validation.
 

EnableForecastValidation
 

Specifies whether to enable statistical forecast validation. 1 to enable validation. 0 to disable validation.
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Forecasting Parameter Description

FitValidationSensitivity
 

Controls the sensitivity of fit validation. Forecasting methods with a mean absolute percentage
error (MAPE) greater than the specified value are rejected. The smaller the value, the stricter is the
validation. For loose validation, use values between 1 and 2. For strict validation, use values between .3
and .5.
 
This forecasting parameter may be the most important one for your forecast. If your forecast is failing
at the required level, increasing the value of this forecasting parameter might help.
 

ForecastValidationSensitivity
 

Specifies the sensitivity of forecast validation. The smaller the value, the stricter the test. For loose
forecast validation, use values between 5 and 10.
 

Additional forecasting parameters are available, and you can include them in your user-defined forecasting profile by
clicking Actions > Add to open the Add Parameter to Viewable List dialog box. Select the forecasting parameter you
want, and click the Add button to include it in the forecasting profile.

For information about forecasting parameters, refer to the white paper titled "Demand Management Forecasting
Parameters" that's available in Document ID 2551481.1 on My Oracle Support.

Related Topics
• Create a Forecasting Profile

• Forecasting Methods

• Configure Decomposition Groups

Measures for Bayesian Forecasting  
This topic lists the measures that are used in Bayesian forecasting.

Input Measures
This table lists the predefined input measures for Bayesian forecasting and the associated measures that are predefined
or automatically created:

Input Measure Associated Measure

Final Bookings History
 

Bookings History Average
 
(predefined)
 

Final Consumption History
 

Consumption History Average
 
(predefined)
 

Final Shipments History
 

Shipments History Average
 
(predefined)
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Input Measure Associated Measure

 

user-defined input measure
 

<user-defined input measure name> History average
 
(automatically created and added to the measure catalog for the user-defined forecasting profile)
 

Output Measures
This table lists the predefined output measures for Bayesian forecasting and the associated measures that are
predefined or automatically created:

Output Measure Associated Measures

Bookings Forecast
 
Consumption Forecast
 
Shipments Forecast
 

<predefined output measure name> Average Interarrival Time
 
<predefined output measure name> Batch Size
 
<predefined output measure name> Bias
 
<predefined output measure name> Complexity
 
<predefined output measure name> Decomposed
 
<predefined output measure name> Decomposed Outlier
 
<predefined output measure name> Decomposed Regime Change
 
Bookings Forecasting Levels/Consumption Forecasting Level/Shipments Forecasting Levels
 
Bookings Forecasting Methods/Consumption Forecasting Methods/Shipments Forecasting Methods
 
Bookings Forecasting Methods Weight/Consumption Forecasting Methods Weight/Shipments
Forecasting Methods Weight
 
<predefined output measure name> Generate Forecast/Consumption Forecast Generation Status
 
<predefined output measure name> Has Outliers
 
Bookings Forecast Has Regime Change/Shipments Forecast Has Regime Change
 
<predefined output measure name> Interval Time
 
<predefined output measure name> Is Intermittent
 
<predefined output measure name> MAD
 
<predefined output measure name> MAPE
 
<predefined output measure name> Outlier Values/Consumption Forecast Outlier Value
 
<predefined output measure name> Status
 
<predefined output measure name> Total
 
(all predefined)
 

user-defined output measure <user-defined output measure name> Average interarrival time
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Output Measure Associated Measures

  
<user-defined output measure name> Batch size
 
<user-defined output measure name> Bias
 
<user-defined output measure name> Complexity
 
<user-defined output measure name> Decomposed model and causal factor forecast
 
<user-defined output measure name> Decomposed outlier values
 
<user-defined output measure name> Decomposed regime change indicator
 
<user-defined output measure name> Forecast level
 
<user-defined output measure name> Forecast method weights
 
<user-defined output measure name> Forecast methods
 
<user-defined output measure name> Forecast status
 
<user-defined output measure name> Generate forecast indicator
 
<user-defined output measure name> Intermittent indicator
 
<user-defined output measure name> Interval time
 
<user-defined output measure name> MAD
 
<user-defined output measure name> MAPE
 
<user-defined output measure name> Outlier indicator
 
<user-defined output measure name> Outlier values
 
<user-defined output measure name> Regime change indicator
 
<user-defined output measure name> Total Forecast
 
The measures are automatically created and added to the measure catalog for the user-defined
forecasting profile. If the user-defined output measure is used in more than one user-defined
forecasting profile, the associated measures are reused and not created anew.
 

Forecast Trees  

Overview of Forecast Trees  
A forecast tree is a structure of hierarchy levels at which data can be aggregated during the demand forecasting
process.

The forecast tree enables Oracle Demand Management to aggregate data while performing analytical forecasts. In other
words, the forecast tree for a forecasting profile organizes the data for the forecasting process.

The forecasting process begins at the most granular (lowest) level of the forecast tree. If the forecast can’t be made
at this level because of inadequate or sparse data, the process moves up the forecast tree and attempts to forecast
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at higher levels of data aggregation. In general, forecasts are more accurate when they’re made at lower levels of the
forecast tree.

The forecast tree supports up to two dimensions. The available dimensions for the forecast tree are Product,
Organization, Customer, and Demand Class. Your configuration of the forecast tree depends on your business. You
typically use the Product dimension along with another dimension (for example, Product and Organization, Product and
Customer, or Product and Demand Class). With respect to the Product dimension, you can use levels from any hierarchy
except for levels from the configure-to-order (CTO) hierarchy (Model BOM).

The run time is short if the forecasting process has to do less data aggregation while traversing the forecast tree. If
the data quality allows, use the lowest levels for two dimensions (for example, Item and Customer Site) as the first
forecastable level in the forecast tree. The run time is long when the lowest forecastable levels are aggregated, or only
one dimension is used.

The quality of the forecast is influenced by the forecast tree’s construction. Thus, you must carefully include and
arrange levels for the forecast tree.

Related Topics
• How a Forecast Tree Is Constructed

• Best Practices for Setting Up Forecasting Tables for Forecast Trees

• Example of an Incorrectly Constructed Forecast Tree

How a Forecast Tree Is Constructed  
You determine the forecast tree by configuring a table just as you would for a table displayed in your Oracle Fusion
Cloud Supply Chain Planning module.

The forecast tree is derived from the table's layout. In the table, you select levels to include in the forecast tree, and on
the Layout tab in the Selector Tool, you arrange the levels in the decreasing order of data aggregation. Finally, you select
the table as the forecasting table for a forecasting profile.

Note:  You must arrange the levels on the row edge for the forecasting table. On the Layout tab, the row edge is the
vertical axis to the left of the pivot table's body.

The forecasting process constructs the forecast tree downwards from a fictitious top level (All – All) to the lowest level
of aggregation. Each included level is taken one at a time and placed in a forecast tree level under the column for the
respective dimension.

Assume that you have arranged the levels in the decreasing order of aggregation as follows: Category Level 2, Legal
Entity, Category Level 1, Organization, and Item.

For this level arrangement, the forecasting process constructs the forecast tree as follows:

1. First, the fictitious top level of the tree is designated as All – All.
2. At the next forecast tree level, the Category Level 2 level replaces the All level under the column for the Product

dimension.
3. At the next forecast tree level, the Legal Entity level replaces the All level under the column for the Organization

dimension. The Category Level 2 level is retained under the column for the Product dimension.
4. At the next forecast tree level, the Category Level 1 level replaces the Category Level 2 level under the column

for the Product dimension. The Legal Entity level is retained under the column for the Organization dimension.

245



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 10
Statistical Forecasts for Demand

5. At the next forecast tree level, the Organization level replaces the Legal Entity level under the column for the
Organization dimension. The Category Level 1 level is retained under the column for the Product dimension.

6. At the lowest forecast tree level, the Item level replaces the Category Level 1 level under the column for the
Product dimension. The Organization level is retained under the column for the Organization dimension.

The demand forecasting process moves up this forecast tree while performing the forecast. First, the forecast is
attempted at the level of Item and Organization. If a forecast can’t be performed at this level, the forecast is attempted at
the next level of Category Level 1 and Organization, and so on.

The following figure depicts this forecast tree:

The following screenshot depicts the arrangement of levels on the Layout tab in the Selector Tool for the previously
provided forecast tree:
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Related Topics
• Overview of Forecast Trees

• Best Practices for Setting Up Forecasting Tables for Forecast Trees

• Example of an Incorrectly Constructed Forecast Tree

Best Practices for Setting Up Forecasting Tables for Forecast Trees
 
Keep these points in mind while you set up the forecasting tables based on which the demand forecasting process
constructs forecast trees:

• Oracle recommends that you not start from scratch while constructing the forecasting table for a forecast tree.
Instead, make a copy of one of the predefined forecasting tables (for example, Forecast Bookings Definitions or
Forecast Shipments Definitions), and change the copy to suit your requirements.

• Don’t use any time-related dimensions in the forecasting table.

• Include at least three effective hierarchy levels in the forecasting table.

• Ensure that the data aggregation of the levels decreases along the row edge of the forecasting table. The
arrangement of levels must be meaningful to your business process.

• For each dimension, select levels from a single hierarchy while configuring the forecasting table, and don’t
select levels from multiple hierarchies.

If you select levels from multiple hierarchies, the demand forecasting process uses the hierarchy that has the
most levels. If there is a tie in this regard, the hierarchy with the lowest internal ID is selected. Consequently, you
have less control over the final structure of the forecast tree.

Related Topics
• Overview of Forecast Trees

• How a Forecast Tree Is Constructed

• Example of an Incorrectly Constructed Forecast Tree
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Example of an Incorrectly Constructed Forecast Tree  
This topic provides an example of a forecast tree that's incorrectly constructed because the underlying forecasting table
was incorrectly set up.

On the Layout tab in the Selector Tool, the hierarchy levels on the row edge of the forecasting table for the forecast
tree must be in the order of decreasing data aggregation. While generating the forecast tree, the demand forecasting
process can move in only the direction of decreasing aggregation. If a level of higher aggregation follows a level of lower
aggregation, the process ignores the former. Thus, an incorrect arrangement of levels results in a forecast tree that
doesn’t meet expectations and causes an incorrect aggregation of data during the forecasting process.

Assume that you have arranged the levels as follows: Category Level 2, Legal Entity, Item, Organization, and Category
Level 1. Here, a level with a higher aggregation (Category Level 1) is placed after a level with a lower aggregation (Item).

For this level arrangement, the forecasting process constructs the forecast tree as follows:

1. First, the fictitious top level of the forecast tree is designated as All – All.
2. At the next forecast tree level, the Category Level 2 level replaces the All level under the column for the Product

dimension.
3. At the next forecast tree level, the Legal Entity level replaces the All level under the column for the Organization

dimension. The Category Level 2 level is retained under the column for the Product dimension.
4. At the next forecast tree level, the Item level replaces the Category Level 2 level under the column for the

Product dimension. The Legal Entity level is retained under the column for the Organization dimension.
5. At the next forecast tree level, the Organization level replaces the Legal Entity level under the column for the

Organization dimension. The Item level is retained under the column for the Product dimension.
6. Finally, the Category 1 level is omitted from the forecast tree on account of having a higher aggregation than

the Item level.
The following figure depicts the forecast tree:

248



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 10
Statistical Forecasts for Demand

Related Topics
• Overview of Forecast Trees

• How a Forecast Tree Is Constructed

• Best Practices for Setting Up Forecasting Tables for Forecast Trees

Disaggregation of Statistical Forecasts  

How Statistical Forecasts Are Disaggregated by Default  
This topic explains how statistical forecasts are disaggregated by default in the Demand Management, Demand and
Supply Planning, Planning Central, Replenishment Planning, and Sales and Operations Planning work areas.
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Note:  The default disaggregation described in this topic is limited to plans that use forecasting profiles that are based
on Bayesian machine learning.

Settings That Affect Default Disaggregation of Statistical Forecasts
This table lists the forecasting parameters that affect the default disaggregation of statistical forecasts:

Note:  In the Demand Management, Demand and Supply Planning, and Replenishment Planning work areas, you can
modify these forecasting parameters in only user-defined forecasting profiles. You can use predefined forecasting
profiles with only the default values. In the Planning Central and Sales and Operations Planning work areas, you can
use only predefined forecasting profiles and can't modify forecasting parameters.

Name Description Default Value

PeriodsUntilActive
 

Specifies the number of days going backward
from the history end date that's used for
determining the forecast status for a product
combination. If the demand for the product
combination falls only within this period, the
forecast status is Inactive/New/Immature. If
the demand is wholly or partially before this
period but within the days specified in the
PeriodsUntilInactive forecasting parameter, the
forecast status is Active.
 
For example, if the value of the forecasting
parameter is 14, but the only demand for the
product combination was 10 days before the
history end date, the forecast status is Inactive/
New/Immature.
 

14 days
 

PeriodsUntilInactive
 

Specifies the number of days going backward
from the history end date that's used for
determining the forecast status for a product
combination. If the demand for the product
combination falls wholly before this period,
 the forecast status is Inactive/Retired/
Discontinued.
 
For example, if the value of the forecasting
parameter is 182, but the only demand for the
product combination was 200 days before the
history end date, the forecast status is Inactive/
Retired/Discontinued.
 

182 days
 

GlobalAllocationPeriods
 

Specifies the number of days going backward
from the history end date that's used for
calculating the average demand (for bookings,
 consumption, or shipments).
 

182 days
 

This table lists the forecast status measures and generate forecast measures for output measures of forecasting
profiles:
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Output Measure Forecast Status Measure Generate Forecast Measure

Bookings Forecast
 

Bookings Forecast Status
 
Indicates if a product combination receives a
disaggregated statistical forecast for bookings.
 
Available in the Demand Management, Demand
and Supply Planning, Planning Central, and
Sales and Operations Planning work areas.
 

Bookings Forecast Generate Forecast
 
Indicates whether historical bookings should be
analyzed and a forecast generated for a product
combination. You can edit this measure.
 
Available in the Demand Management, Demand
and Supply Planning, Planning Central, and
Sales and Operations Planning work areas.
 

Consumption Forecast
 

Consumption Forecast Status
 
Indicates if a product combination receives
a disaggregated statistical forecast for
consumption.
 
Available in the Replenishment Planning work
area.
 

Consumption Forecast Generation Status
 
Indicates whether historical consumption
should be analyzed and a forecast generated
for a product combination. You can edit this
measure.
 
Available in the Replenishment Planning work
area.
 

Shipments Forecast
 

Shipments Forecast Status
 
Indicates if a product combination receives a
disaggregated statistical forecast for shipments.
 
Available in the Demand Management, Demand
and Supply Planning, Planning Central,
 Replenishment Planning, and Sales and
Operations Planning work areas.
 

Shipments Forecast Generate Forecast
 
Indicates whether historical shipments should
be analyzed and a forecast generated for
a product combination. You can edit this
measure.
 
Available in the Demand Management, Demand
and Supply Planning, Planning Central,
 Replenishment Planning, and Sales and
Operations Planning work areas.
 

User-Defined Output Measure
 

<User-defined output measure name> Forecast
Status
 
(created automatically)
 

<User-defined output measure name>
Generate Forecast Indicator
 
(created automatically)
 

The table lists the history average measures for input measures of forecasting profiles:

Input Measure History Average Measure

Final Bookings History
 

Bookings History Average
 
Contains the average daily bookings over the days before the history end date as specified in the
GlobalAllocationPeriods forecasting parameter.
 
Available in the Demand Management, Demand and Supply Planning, Planning Central, and Sales and
Operations Planning work areas.
 

Final Consumption History
 

Consumption History Average
 
Contains the average daily consumption over the days before the history end date as specified in the
GlobalAllocationPeriods forecasting parameter.
 
Available in the Replenishment Planning work area.
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Input Measure History Average Measure

 

Final Shipments History
 

Shipments History Average
 
Contains the average daily shipments over the days before the history end date as specified in the
GlobalAllocationPeriods forecasting parameter.
 
Available in the Demand Management, Demand and Supply Planning, Planning Central, Replenishment
Planning, and Sales and Operations Planning work areas.
 

User-Defined Input Measure
 

<User-defined input measure name> History Average
 
(created automatically)
 

How Statistical Forecasts Are Disaggregated by Default
Whether a product combination receives a disaggregated statistical forecast depends on the forecast status of the
combination, which can be one of the following:

Forecast Status Description

1
 

Active
 
A product combination has this forecast status if the demand is wholly or partially before the period
specified in the PeriodsUntilActive forecasting parameter and wholly or partially within the period
specified in the PeriodsUntilInactive forecasting parameter.
 
Only product combinations with this forecast status receive a disaggregated forecast by default.
 

2
 

Inactive/New/Immature
 
A product combination has this forecast status if the demand is wholly within the period specified in
the PeriodsUntilActive forecasting parameter.
 

3
 

Inactive/Retired/Discontinued
 
A product combination has this forecast status if the demand is wholly before the period specified in
the PeriodsUntilInactive forecasting parameter.
 

These points explain the default disaggregation of statistical forecasts:

• The forecast status measure is identified on the basis of the output measure for the forecasting profile and
calculated for a product combination after these criteria are considered:

◦ The values of the PeriodsUntilActive and PeriodsUntilInactive forecasting parameters.

◦ The value of the associated generate forecast measure for the product combination.

Note:  The generate forecast measure is an override for the forecast status measure. Edit the generate
forecast measure for only those active product combinations that must not receive a forecast. Don't
use this measure if you want inactive product combinations to receive a forecast.
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• Depending on the input measure for the forecasting profile, the history average measure is selected. The
history average for the product combination is then calculated on the basis of the GlobalAllocationPeriods
forecasting parameter.

• The input history for all product combinations is collected irrespective of their forecast status (Active, Inactive/
New/Immature, or Inactive/Retired/Discontinued) and aggregated to active product combinations at a higher
level for generating the forecast.

• The generated forecast is disaggregated to only active product combinations at the lowest level on the basis of
the history average (contained in the history average measure) and disaggregation parameters for the output
measure of the forecasting profile.

As depicted in this figure, history is collected from active, inactive/new/immature, and inactive/retired/discontinued
product combinations and aggregated to active product combinations at a higher level, and the forecast is
disaggregated to only active product combinations at the lowest level.

Related Topics
• How You Configure Disaggregation of Statistical Forecasts

How You Configure Disaggregation of Statistical Forecasts  
This topic explains how you can configure the disaggregation of statistical forecasts in the Demand Management,
Demand and Supply Planning, and Replenishment Planning work areas.
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Instead of having the forecast disaggregated by default to active product combinations at the lowest level, you can use
a measure to disaggregate the forecast to product combinations of your choice. Thereby, you can override the default
logic of using the forecast status measure that corresponds to the output measure of the selected forecasting profile for
identifying active product combinations that receive the disaggregated forecast.

Configuring disaggregation of statistical forecasts is useful when your organization has a product that's frequently
updated, but only the latest version is available for ordering. You can generate the forecast using the historical demand
for old product versions that are currently available in the market and disaggregate the forecast to only the latest
product version.

Note:  You can use this feature in only a user-defined forecasting profile that's based on Bayesian machine learning.

Configure Disaggregation of Statistical Forecasts
Follow these high-level steps to configure the disaggregation of statistical forecasts:

1. Create a measure as follows:

◦ The measure should be of the Number data type.

◦ The measure should have all dimensions of the output measure of your user-defined forecasting profile
except for the Time dimension.

Any dependent measures of the created measure must also have the supported dimensions.

◦ The measure expression should return 1 for product combinations that should receive the disaggregated
forecast. For example, the expression could be as follows: Case(Lifecycle Phase When 'Active' Then 1
Else 0)

You can also configure the expression using Item-level attributes.

Preferably, the measure expression must not use these functions:

- Archive
- Bias
- Fpos
- Fsum
- Lag
- Lead
- Log
- Mad
- Mape
- MeasureOffset
- Moving_Maximum
- Moving_Minimum
- Moving_Total
- Pi
- Power
- Rand

◦ You can populate the measure through the regular collections process or the file-based data import
(FBDI) template for Supply Chain Planning measures.

2. Add the measure to the predefined Output Filters for Forecast Disaggregation measure group.
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3. Add the measure and its dependent measures to the measure catalog of your plan.

If you're using an Item-level attribute, ensure that it's present in the dimension catalog of your plan.
4. Add the ForecastOutputFilter forecasting parameter from the General Settings category to your forecasting

profile.
5. Select the measure that you created for the forecasting parameter.

Only these measures are available for the forecasting parameter:

◦ The measures have the Number data type.

◦ The measures have all the dimensions of the forecasting profile's output measure except for the Time
dimension.

◦ The measures are in the Output Filters for Forecast Disaggregation measure group.

When the plan is run, the forecast status measure corresponding to the output measure of the forecasting profile is
selected for the forecasting parameter, forecast disaggregation occurs according to the default logic, and an error
message is displayed on the Review Plan Messages page in these situations:

• The measure you selected for the forecasting parameter isn't in the plan's measure catalog.

• The dimensions of the dependent measures of the measure you selected for the forecasting parameter aren't
supported.

• The Item-level attribute used in the measure you selected for the forecasting parameter isn't in the plan's
dimension catalog.

Related Topics
• How Statistical Forecasts Are Disaggregated by Default

• Create Measures and Assign to a Measure Catalog

• Create a Forecasting Profile

• Forecasting Parameters

Manage Product Launch Page  

Overview of the Manage Product Launch Page  
Use the Manage Product Launch page to generate customer-organization combinations and copy measure data for a
new product from a source product so that you can generate a forecast for the new product.

This functionality enables you to predict initial demand and associated supply requirements for the new product.

The Manage Product Launch page is available in the Demand Management, Demand and Supply Planning, Planning
Central, and Sales and Operations Planning work areas for demand, demand and supply, and sales and operations
plans.

You can accomplish the following using this functionality:

• For a new product that's similar to an existing product, you can generate customer-organization combinations
for the new product on the basis of combinations for the source product. You can also copy measure data from
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the source product to the new product and apply a factor to the copied data if you expect the new product to
outsell or undersell the source product.

If the new product isn't similar to the source product, the history of the source product isn't useful, or you have
already determined the forecast for the new product, you can only generate the combinations for the new
product. Then, you can manually enter the history and forecast overrides for the new product before generating
the forecast.

• For each combination, you can specify a process end date (launch date for the new product). By default, the
process end date is set to 30 days after the system date.

Until the process end date, every time you run the plan, these actions occur:

◦ Combinations are generated, and measure data is copied from the source product to the new product.

◦ Tables with the Product, Customer, and Organization dimensions are updated.

◦ A forecast is generated for the new product.

• You can better align inventory with sales and successfully launch the new product.

The following are the statuses displayed for the relationship between the new product and source product on the
Manage Product Launch page:

Status Explanation

In progress
 

The relationship is being defined.
 

Active
 

The relationship has been saved, and the process end date hasn't been reached.
 
Combinations are generated, and measure data is copied from the source product to the new product
every time the plan is run.
 
The generated combinations and copied measure data for the new product are retained even after you
run the plan with the Refresh with current data option selected on the Parameters tab in the Run Plan
dialog box.
 

Complete
 

The process end date has been reached.
 
Combinations aren't generated, and measure data isn't copied from the source product to the new
product every time the plan is run. The previously generated combinations and copied measure data
are retained.
 

Related Topics
• Use the Manage Product Launch Page

Use the Manage Product Launch Page  
This topic explains how you use the Manage Product Launch page.
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You can do the following on the Manage Product Launch page:

• Specify a relationship between a source product and new product.
You can generate customer-organization combinations for the new product on the basis of those for the
source product. If the products are similar, you can also copy measure data from the source product to the new
product.
If you only generate combinations, you can manually enter historical data and forecast overrides for the new
product after the combinations are generated.

• Edit a relationship between a source product and new product.
For example, after the collection process, new combinations could be available for the source product, and you
want to generate them for the new product. You may also want to change the process end date (launch date for
the new product).
You can edit a relationship only if it's in the Active status.

• Delete an existing relationship between a source product and new product.
When you delete the relationship, the combinations are also deleted unless you made changes to the generated
combinations or copied measure data.

Create a Relationship Between a Source Product and New Product
To create a relationship between a source product and new product, perform these steps:

Note:  Before you begin, ensure that the new product exists in the Items table. You can add the product in Oracle
Fusion Product Management and then perform a collection. Alternatively, you can add the product by using the file-
based data import (FBDI) template for Supply Chain Planning items.

1. In the Demand Management, Demand and Supply Planning, Planning Central, or Sales and Operations
Planning work area, open a demand, demand and supply, or sales and operations plan.

2. Do one of the following to open the Manage Product Launch page:

◦ In the plan, click Actions > Manage Product Launch.

◦ In a pivot table or graph, click Actions > Manage Product Launch.

◦ In a pivot table, right-click a cell, and select Manage Product Launch.

3. On the Manage Product Launch page, click Actions > Create.
A row with the In progress status is created for the new relationship.

a. Select the source product.
b. Select the new product.

4. On the Source Relation tab, do the following:
a. Select the customers and organizations of the source product that you want to use to drive the forecast

for the new product.
b. Move the selected customers and organizations from Available Members to Selected Members.
c. Click Insert.

Combinations for the selected members are displayed with the Include Selected check box selected and
the process end date set to 30 days after the system date.
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d. For the combinations that you want to generate for the new product, keep the Include Selected check
box selected.

For the combinations that you don't want to generate, deselect the check box.
e. Edit the process end date for each combination.

Until the process end date, every time you run the plan, combinations are generated for the new product
before the forecast is generated.

5. If you also want to copy measure data from the source product to the new product for all selected
combinations, on the Measures tab, do the following:

a. Click Actions > Add.
b. In the new row, select the source measure for the source product and target measure for the new

product.

Alternatively, you can click Apply Measure Copy Set to open the Apply Measure Copy Set dialog box,
and search for and add a previously defined measure copy set.

The measures available for selection are from the measure catalog that's specified on the Scope tab
on the Plan Options page for the plan. Only stored and editable measures are available for selection
as source and target measures, and measures with expressions aren't available. The available target
measures are filtered by the granularity (available dimensions) of the selected source measure.

c. Enter a factor to increase or decrease the measure data for the new product.

For example, if you expect the new product to sell 1.5 times more than the source product, enter a factor
of 150%.

d. Add more rows for source and target measures.
e. To save the selected rows for use in relationships that you create or edit in the future, click Save as

Measure Copy Set.

In the Save as Measure Copy Set dialog box, provide a name and description for the measure copy set,
and specify if you want to overwrite an existing measure copy set or use the new measure copy set as the
default.

6. Click Save and Close.

The Manage Product Launch Data Copy Individual process is submitted. In the Scheduled Processes work
area, you can check the process status. Once the process is completed, the relationship status changes from In
progress to Active on the Manage Product Launch page.

7. Run the plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog
box.

The forecast is generated for the new product if you copied measure data.
8. If you generated only combinations, enter the history, including forecast overrides, for the new product in tables

that have the Product, Customer, and Organization dimensions.

To generate the forecast for the new product, run the plan again with the Refresh with current data option
selected on the Parameters tab in the Run Plan dialog box.

Edit a Relationship Between a Source Product and New Product
To edit the relationship between a source product and new product, follow these steps:

1. In the Demand Management, Demand and Supply Planning, Planning Central, or Sales and Operations
Planning work area, open a demand, demand and supply, or sales and operations plan.
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2. Do one of the following to open the Manage Product Launch page:

◦ In the plan, click Actions > Manage Product Launch.

◦ In a pivot table or graph, click Actions > Manage Product Launch.

◦ In a pivot table, right-click a cell, and select Manage Product Launch.

3. On the Manage Product Launch page, search for the relationship that you want to edit by the source product,
new product, or status.

Note:  If the status is Complete, the process end date specified in the relationship has been reached. When
you run the plan, combinations aren't generated, and measure data isn't copied for the new product from the
source product. You can only delete the relationship.

4. Select the relationship that you want to modify, and click Edit.
5. On the Source Relation tab, do the following:

a. Move members for which combinations must be generated to the Selected Members list.

Move members for which combinations should not be generated to the Available Members list.
b. Click Insert.
c. For the combinations that you want to generate for the new product, keep the Include Selected check

box selected.

For the combinations that you don't want to generate, deselect the check box.
d. Edit the process end date for each combination.

6. If you also want to copy measure data from the source product to the new product, on the Measures tab, do the
following:

◦ To add a row, click Actions > Add.

In the new row, select the source measure for the source product and target measure for the new
product.

Alternatively, you can click Apply Measure Copy Set to open the Apply Measure Copy Set dialog box,
and search for and add a previously defined measure copy set or replace the existing rows by the
measure copy set.

Enter a factor to increase or decrease the measure data for the new product.

◦ To edit a row, select it, and modify the factor.

◦ To delete a row, select it, and click Delete.

7. Click Save and Close.

The Manage Product Launch Data Copy Individual process is submitted. In the Scheduled Processes work area,
you can check the process status.

8. Run the plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog
box.

The forecast is regenerated for the new product if you copied measure data.
9. If you regenerated only combinations, enter the history, including forecast overrides, for the new product in

tables that have the Product, Customer, and Organization dimensions.

To regenerate the forecast for the new product, run the plan again with the Refresh with current data option
selected on the Parameters tab in the Run Plan dialog box.
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Forecasting Using Supersession Relationships  

Overview of Forecasting Using Supersession Relationships  
You can generate a forecast for the current revision and latest (future) revision of an item in a supersession chain or
across multiple supersession chains by using the demand history of previous item revisions.

When the functionality for forecasting using supersession relationships is used, the demand history for previous item
revisions and the available demand history for the current item revision from the history start date to the history end
date of a plan are aggregated. Then, a forecast is generated on the basis of this aggregated demand history and applied
to the current item revision and latest item revision from the plan start date to the forecast end date.

In industries such as automobile manufacturing, the hundreds or thousands of parts that make up a finished end item
go through numerous revisions on account of design or production changes. Without the functionality for forecasting
using supersession relationships, you would have to manually copy the demand history of previous item revisions to the
current revision and latest revision to generate a forecast. Thus, this functionality enables you to improve efficiency by
automating the process for forecasting for the current revision and latest revision in a supersession chain.

Points to Note About Forecasting Using Supersession Relationships
Note these points about forecasting using supersession relationships:

• The functionality covers only supersession chains with reciprocal relationships among the item revisions.

Supersession chains with unidirectional relationships aren't considered.

For example, consider a supersession chain with item revisions A, B, C, and D, in which A and B have a
reciprocal relationship, B is superseded by C, and C and D have a reciprocal relationship. Two supersession
chains (A < > B and C < > D) are considered. If B is the current revision in the A < > B supersession chain, then
B receives a forecast on the basis of the demand history for A and the available demand history for B. Similarly,
if D is the current revision in the C < > D supersession chain, then D receives a forecast on the basis of the
demand history for C and the available demand history for D.

• Item revisions with start dates that are beyond the plan horizon or forecast end date won't be considered for
forecasting.

For example, if item revision N supersedes item revision M from 01-Sep-2024, and the forecast end date is 31-
Aug-2024, then a forecast won't be generated for N.

The start date for an item revision is stored in the Item Revision Start Date measure.

• Providing the end date for an item revision is optional. This date is stored in the Item Revision End Date
measure.

If an item revision has been defined without an end date, then the Item Revision End Date measure for
that item revision is populated with the date one day before the start date of the next item revision in the
supersession chain. For the latest item revision, the measure is populated with the end date of the plan horizon.

For example, consider a supersession chain with item revisions A, B, C, and D. In this supersession chain,
B supersedes A, C supersedes B, and D supersedes C. The start dates for B, C, and D are 01-Feb-2021, 01-
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Nov-2022, and 01-Jan-2024. The end date of the plan horizon is 31-Aug-2024. For this supersession chain, the
end dates set for A, B, C, and D are 31-Jan-2021, 31-Oct-2022, 31-Dec-2023, and 31-Aug-2024.

• When you have a one-to-many supersession relationship in which an item revision is superseded by more than
one item revision, the item revision for the supersession relationship with the highest rank set in Oracle Fusion
Cloud Product Lifecycle Management receives the forecast.

For example, consider a supersession chain with item revision A that's superseded by item revisions B and C.
The supersession relationship between A and B has a rank of one, while the supersession relationship between
A and C has a rank of two. For this supersession chain, B receives the forecast that's based on the demand
history for A, and C doesn't receive a forecast.

• When you have a many-to-one supersession relationship in which many item revisions are superseded by one
item revision, the demand histories for the previous revisions across supersession chains are aggregated for
the forecast generation for the current revision and latest revision.

For example, if item revision X is superseded by item revision Z, and item revision Y is also superseded by Z,
then the demand history for X and Y is aggregated for the forecast generation for Z.

• You can define supersession relationships in Oracle Product Lifecycle Management or using the file-based data
import (FBDI) template named Supply Chain Planning Item Substitute.

Note these points about supersession relationships that are defined in Oracle Product Lifecycle Management:

◦ The item revisions in a supersession chain can belong to different organizations.

◦ You can collect the item relationships using the Collect Planning Data page. You must select the Item
Relationships reference entity on the Reference Data subtab on the Parameters tab.

Note these points about supersession relationships that are defined through the import template

◦ The item revisions in a supersession chain must belong to the same organization.

◦ You can collect the item relationships using the Load Planning Data from Flat Files scheduled process.

• To prevent adjusting of the editable forecast measures for the current revision and latest revision outside their
effective dates, you can configure an expression using the Item Revision Start Date and Item Revision End Date
measures on the Edit Lock tab in the Edit Measure dialog box.

• A forecasting profile that includes the SupersessionForecastLevelMeasure forecasting parameter can generate
a forecast for items with and without a supersession relationship.

However, for better control over the forecasting process, you may choose to set up one forecasting
profile for supersession forecasting and add it to your plan with an analysis set that contains only the
items with supersession relationships. You can then set up another forecasting profile without the
SupersessionForecastLevelMeasure forecasting parameter for items without supersession relationships and
add the forecasting profile to your plan with an analysis set that contains only these items.

• If you use separate organizations for your items with supersession relationships, you can define a plan for
these organizations. The organizations containing items without supersession relationships can be covered by
another plan.

• During supersession forecasting in demand plans, when the SupersessionForecastLevelMeasure forecasting
parameter is in the forecasting profiles, relationships among the Item, Organization, Customer Site, and
Demand Class members are created for the current revision and latest revision on the basis of the relationships
among these members for the previous revisions. These combinations of members for the current revision and
latest revision receive the forecast. The relationships are created for current revisions and latest revisions that
have item revision start dates within 365 days before the plan start date and item revision end dates after the
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plan start date. These relationships are stored in the granularity tables that correspond to the input measure of
the forecasting profile and the forecast status measure.

For example, consider a supersession chain with items A, B, C, and D, in which A and B are the previous
revisions, C is the current revision, and D is the latest revision. Item revision A is related to organization M1,
customer site S1, and demand class X, while item revision B is related to organization M2, customer site S2, and
demand class X. During supersession forecasting, relationships are created for current revision C and latest
revision D with organizations M1 and M2, customer sites S1 and S2, and demand class X. These combinations of
members for current revision C and latest revision D receive the forecast.

During supersession forecasting in replenishment plans, these relationships are created among the Item and
Organization members because the Customer and Demand Class dimensions aren't supported for such plans.
The Organization members (locations) can also be subinventories.

• For correct functioning of this feature, the previous revisions, current revision, and latest revision for an item
must be present in the plan's scope.

Example of Forecasting Using Supersession Relationships
Consider a supersession chain that consists of item revisions A, B, C, and D. There are reciprocal supersession
relationships between A and B starting from February 2021, between B and C starting from November 2022, and
between C and D starting from January 2024.

If the plan start date is between November 2022 and January 2024, A and B are the previous revisions, C is the current
revision, and D is the latest revision.

When the functionality for forecasting using supersession relationships is used, the demand history for A and B and
the available demand history for C from the history start date to the history end date are aggregated. Then, a forecast is
generated and disaggregated for C from the plan start date to the end of December 2023 and for D from January 2024
to the forecast end date.

The following figure depicts this example:
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Related Topics
• How You Set Up Forecasting with Supersession Relationships

• How the History Average Measure Is Calculated for the Current Revision and Latest Revision

• Measures for Forecasting Using Supersession Relationships

How You Set Up Forecasting with Supersession Relationships  
This topic describes the high-level process for setting up forecasting with supersession relationships.

1. Define your supersession chains in Oracle Fusion Cloud Product Lifecycle Management or using the file-based
data import (FBDI) template named Supply Chain Planning Item Substitute.

2. Collect your item relationships using one of the following:

◦ The Item Relationships reference entity on the Reference Data subtab on the Parameters tab on the
Collect Planning Data page

◦ The Load Planning Data from Flat Files scheduled process

3. Add these predefined measures to the measure catalog for your plan:

◦ Current Revision

◦ Inventory ID of Latest Item Revision

◦ Item Revision End Date

◦ Item Revision Start Date

◦ Latest Revision

◦ Name of Latest Item Revision

Alternatively, you can use the predefined measure catalog named Supersession Forecasting Catalog in your
plan. This measure catalog contains the previously listed measures along with other measures.

4. Add these forecasting parameters to the forecasting profile used by your plan:

◦ SupersessionForecastLevelMeasure: Select the Inventory ID of Latest Item Revision measure for this
forecasting parameter.

◦ LaunchDateMeasure: Select the Item Revision Start Date measure for this forecasting parameter.

◦ DiscontinueDateMeasure: Select the Item Revision End Date measure for this forecasting parameter.

◦ SmoothIntermittent: Set the value of this forecasting parameter to zero to generate a sparse and spiky
demand forecast.

Otherwise, the forecast generated by intermittent forecasting methods is spread across the time buckets.

Alternatively, you can use the predefined Forecast Bookings for Supersession Chain or Forecast Shipments for
Supersession Chain forecasting profile in your plan. These forecasting profiles use the previously mentioned
forecasting parameters and values.

5. Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog
box.
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Related Topics
• Overview of Forecasting Using Supersession Relationships

• Create a Forecasting Profile

• Measures for Forecasting Using Supersession Relationships

How the History Average Measure Is Calculated for the Current
Revision and Latest Revision  
When you run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog
box, the history average measure is calculated for the current revision and latest (future) revision of an item.

When you run your plan while refreshing it with current data, during the calculation of proportions, a history average is
calculated and forecast status set for each combination in the historical demand. The specific measures that store these
values are determined by the forecasting profile for the plan.

History Average Measure
The history average measure is used for disaggregating a forecast from the level that it's generated at to the level that
it's stored at. This disaggregation results in each combination getting its share of the forecast based on its share of the
historical demand.

Examples of the history average measure are the predefined Bookings History Average and Shipments History Average
measures.

Forecast Status Measure
The forecast status measure identifies which combinations are active and should receive forecasts. The measure values
are 1 (Active), 2 (Inactive/New/Immature), and 3 (Inactive/Retired/Discontinued). Only combinations with a forecast
status of 1 receive forecasts.

Examples of the forecast status measure are the predefined Bookings Forecast Status and Shipments Forecast Status
measures.

Calculation of the History Average Measure for the Current Revision and Latest
Revision
For the current revision, the value of the history average measure from the corresponding, active previous revision in
a supersession chain or across supersession chains is taken. The final value of the measure for the current revision is
calculated according to this formula:

History Average Measure = History Average Measure of the Current Revision Available up to the Plan Start Date +
(Forecast Status Measure of the Previous Revision x History Average Measure of the Previous Revision)

The final value of the history average measure for the current revision is taken as the measure value for the latest
revision.

When the history average measure is computed, the value of the forecast status measure is also changed for the
previous revisions, current revision, and latest revision. The value of the measure is set to 1 for the current revision
and latest revision irrespective of the demand history. The value of the measure is set to 2 for the previous revisions.
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These statuses are set because the current revision and latest revision should receive the forecast, but the superseded
(previous) versions shouldn't receive a forecast.

Note:  Don't use the generate forecast measure (for example, Bookings Forecast Generate Forecast or Shipments
Forecast Generate Forecast) to turn off forecast generation for previous revisions. The value of the forecast status
measure is automatically set to 2 for these revisions after the calculation of the history average measure for the
current revision and latest revision.

Consider an example in which a supersession chain has previous revisions A and B, current revision C, and latest
revision D:

1. For A, the value of the history average measure is 4. The value of the forecast status measure is 2.
2. For B, the value of the history average measure is 7. The value of the forecast status measure is 1.
3. For C, the value of the history average measure available up to the plan start date is 3. The value of the forecast

status measure is 1.

Thus, the final value of the history average measure for C is 10 [3 + (1 * 7)].
4. For D, the value of the history average measure is 10 (the value of the measure for C). The value of the forecast

status measure is 1.
5. After the final values of the history average measure for C and D are calculated, the value of the forecast status

measure for B is set to 2.

The following figure depicts this example:
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Related Topics
• Overview of Forecasting Using Supersession Relationships

• How Statistical Forecasts Are Disaggregated by Default
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Measures for Forecasting Using Supersession Relationships  
Predefined measures are available for use in forecasting with supersession relationships.

This table lists the predefined measures for forecasting with supersession relationships:

Name Description

Current Revision Contains 1 if an item revision is current as of today for a supersession chain. Otherwise, the value is
zero.

Inventory ID of Latest Item Revision Contains the inventory ID for the latest (future) revision of an item in a supersession chain.

Item Revision End Date Contains the effective end date for the revision of an item in a supersession chain.

Item Revision Start Date Contains the effective start date for the revision of an item in a supersession chain.

Latest Revision Contains 1 if an item revision is the latest (future) revision for a supersession chain. Otherwise, the
value is zero.

Name of Latest Item Revision Contains the name of the latest (future) revision of an item in a supersession chain.

The predefined measure catalog named Supersession Forecasting Catalog contains these measures.

Related Topics
• Overview of Forecasting Using Supersession Relationships

Use the Product Lifecycle Management Page Layout  

Overview of the Product Lifecycle Management Page Layout  
The Product Lifecycle Management page layout helps you to manage product introductions and retirements. On this
page layout, you can modify launch dates and discontinuation dates for products, while increasing or reducing baseline
forecasts.

The introduction or retirement of a product often affects the demand for a related product. When the product
introduction reduces the demand for the related product, the effect is termed as the cannibalization effect. When the
product introduction increases the demand for the related product, the effect is termed as the halo effect.

Using this page layout along with predefined forecasting profiles in demand, demand and supply, replenishment, and
sales and operations plans, you can do the following:

• Generate forecasts while allowing for the cannibalization or halo effect.

• Plan for cannibalization of existing products, and avoid revenue loss.

• Plan for the increased demand for related products on account of the halo effect.
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Note:  The page layout isn’t available in the Planning Central work area.

Description of the Page Layout
The Product Lifecycle Management page layout consists of two panes:

• The top pane displays the predefined Manage Product Life Cycle by Item and Date table, using which you can
modify the launch and discontinuation dates for products.

• The bottom pane displays the predefined Manage Forecast During Product Life Cycle table, using which you
can modify the shipments or bookings forecast for products.

By default, both tables display products under the Category level 1 level of the Product hierarchy in the Product
dimension.

The top table is dynamically linked to the bottom table; the former passes the highlighted selection in the Category level
1 level to the latter.

Note:  If your products are in a different Product dimension level, you need to make a copy of the page layout and
its tables, modify the Product dimension level for the table copies, and ensure that the top table dynamically passes
the highlighted selection in the required Product dimension level to the bottom table. You can’t make changes to
predefined page layouts or the hierarchy levels and links of predefined tables.

Measures for Managing Dates for Product Lifecycle Management
The measures you use for managing dates in this page layout are as follows:

• Launch Date: Use this measure to store the date when the product is available for sale in the market. The value
for this measure is collected or imported through the file-based data import (FBDI) template for Supply Chain
Planning measures.

• Adjusted Launch Date: Use this measure to modify the date when the product is available for sale in the market.
You can modify this measure on the page layout.

• Final Launch Date: This measure displays the final value for the date when the product is available for sale
in the market. If the Adjusted Launch Date measure contains a value, that value is displayed by the Final
Launch Date measure. Otherwise, the value of the Launch Date measure is displayed by the Final Launch Date
measure.

The Final Launch Date measure is the default value for the LaunchDateMeasure forecasting parameter of
the Forecast Bookings Including Product Life Cycle and Forecast Shipments Including Product Life Cycle
forecasting profiles.

• Discontinuation Date: Use this measure to store the date when the product is no longer available for sale in
the market. The value for this measure is collected or imported through the FBDI template for Supply Chain
Planning measures.

• Adjusted Discontinuation Date: Use this measure to modify the date when the product is no longer available for
sale in the market. You can modify this measure on the page layout.

• Final Discontinuation Date: This measure displays the final value for the date when the product is no longer
available for sale in the market. If the Adjusted Discontinuation Date measure contains a value, that value is
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displayed by the Final Discontinuation Date measure. Otherwise, the value of the Discontinuation Date measure
is displayed by the Final Discontinuation Date measure.
The Final Discontinuation Date measure is the default value for the DiscontinueDateMeasure forecasting
parameter of the Forecast Bookings Including Product Life Cycle and Forecast Shipments Including Product Life
Cycle forecasting profiles.

Measures for Managing Forecasts for Product Lifecycle Management

Note:  By default, the predefined Manage Forecast During Product Life Cycle table displays shipments forecast
measures. If you want to generate a forecast that’s based on historical bookings, you need to click View > Measures >
Manage Measures, select the hidden and visible measures according to your requirement, and save the table layout.

The measures you use for managing the shipments forecast in this page layout are as follows:

• Shipments Forecast: This measure is the output measure for the predefined Forecast Shipments Including
Product Life Cycle forecasting profile. The measure stores the shipments forecast that's based on shipments
history.

• Adjusted Shipments Forecast: Use this measure to modify the shipments forecast for the product by using a
number. You can modify this measure on the page layout.

• Change to Shipments Forecast Percentage: Use this measure to modify the shipments forecast for the product
by using a percentage. You can modify this measure on the page layout.
For example, to increase the shipments forecast by 75%, enter 0.75 for the Change to Shipments Forecast
Percentage measure. To decrease the shipments forecast by 25%, enter -0.25 for the Change to Shipments
Forecast Percentage measure.

• Final Shipments Forecast: This measure displays the final value for the shipments forecast and is dynamically
updated in the Manage Forecast During Product Life Cycle table. If the Adjusted Shipments Forecast measure
contains a value, it’s displayed by the Final Shipments Forecast measure. If the Change to Shipments Forecast
Percentage measure contains a value, the calculated value is displayed by the Final Shipments Forecast
measure. Otherwise, the value of the Shipments Forecast measure is displayed by the Final Shipments Forecast
measure.
If both the Adjusted Shipments Forecast and Change to Shipments Forecast Percentage measures contain
values, the percentage of the value in the Adjusted Shipments Forecast measure is calculated and displayed by
the Final Shipments Forecast measure.

The measures you use for managing the bookings forecast in this page layout are as follows:

• Bookings Forecast: This measure is the output measure for the predefined Forecast Bookings Including Product
Life Cycle forecasting profile. The measure stores the bookings forecast that's based on bookings history.

• Adjusted Bookings Forecast: Use this measure to modify the bookings forecast for the product by using a
number. You can modify this measure on the page layout.

• Change to Bookings Forecast Percentage: Use this measure to modify the bookings forecast for the product by
using a percentage. You can modify this measure on the page layout.
For example, to increase the bookings forecast by 75%, enter 0.75 for the Change to Bookings Forecast
Percentage measure. To decrease the bookings forecast by 25%, enter -0.25 for the Change to Bookings
Forecast Percentage measure.

• Final Bookings Forecast: This measure displays the final value for the bookings forecast and is dynamically
updated in the Manage Forecast During Product Life Cycle table. If the Adjusted Bookings Forecast measure
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contains a value, it’s displayed by the Final Bookings Forecast measure. If the Change to Bookings Forecast
Percentage measure contains a value, the calculated value is displayed by the Final Bookings Forecast measure.
Otherwise, the value of the Bookings Forecast measure is displayed by the Final Bookings Forecast measure.

If both the Adjusted Bookings Forecast and Change to Bookings Forecast Percentage measures contain values,
the percentage of the value in the Adjusted Bookings Forecast measure is calculated and displayed by the Final
Bookings Forecast measure.

Forecasting Profiles for Product Lifecycle Management
You use these predefined forecasting profiles for managing product life cycles:

• Forecast Shipments Including Product Life Cycle: This forecasting profile generates a forecast on the basis of
historical shipments and the Final Launch Date and Final Discontinuation Date measures.

The forecasting profile is available for demand, demand and supply, replenishment, and sales and operations
plans.

• Forecast Bookings Including Product Life Cycle: This forecasting profile generates a forecast on the basis of
historical bookings and the Final Launch Date and Final Discontinuation Date measures.

The forecasting profile is available for demand, demand and supply, and sales and operations plans.

Other Points to Note
Note these other points about the functionality for managing the product life cycle:

• If the Final Launch Date measure doesn’t contain a value or isn’t present in the plan’s measure catalog, the
forecast is generated from the forecast start date of the plan.

The plan’s forecast start date is used if it’s later than the value of the Final Launch Date measure.

• If the Final Discontinuation Date measure doesn’t contain a value or isn’t present in the plan’s measure catalog,
the forecast is generated till the forecast end date of the plan.

The plan’s forecast end date is used if it’s earlier than the value of the Final Discontinuation Date measure.

• If the date in the Final Launch Date measure is later than the date in the Final Discontinuation Date measure,
both measures are ignored, and the forecast is generated from the plan’s forecast start date to the plan’s
forecast end date.

• Optionally, you can use an override label for the Change to Shipments Forecast Percentage or Change to
Bookings Forecast Percentage measure in the Manage Forecast During Product Life Cycle table so that the
functionality of the page layout is better reflected. For example, you can use Launch and Cannibalization Factor
as the override label in the Format Measures dialog box.

Related Topics
• Create a Forecasting Profile

• How You Generate Forecasts While Managing Product Life Cycles

• Work with Page Layouts in Demand Management

• Work with Page Layouts in Replenishment Planning

• Manage Page Layouts in Sales and Operations Planning
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How You Generate Forecasts While Managing Product Life Cycles  
To generate forecasts for your products while managing their life cycles, you can use the Product Lifecycle Management
page layout in your demand, demand and supply, replenishment, or sales and operations plan.

The following is the high-level procedure for forecasting for your products while using this page layout:

1. Set up your plan.
Include the predefined Forecast Bookings Including Product Life Cycle or Forecast Shipments Including Product Life
Cycle forecasting profile in your plan.

2. Perform the collections process or use the file-based data import (FBDI) templates for importing data.
Collect or import values for the Launch Date and Discontinuation Date measures for your products.

3. Do the following:

◦ If you want to generate the forecast on the basis of historical bookings, in the table, make the bookings
forecast measures visible, and hide the shipments forecast measures.

◦ If your products in your plan are in a different Product dimension level than what’s used in the tables, do
the following:

- Make a copy of the page layout.
- Make copies of the page layout’s tables, and select or hide the shipments forecast or bookings

forecast measures as you require.
- Change the Product dimension level for the copied tables.
- Ensure that the copy of the Manage Product Life Cycle by Item and Date table is dynamically linked

to the copy of the Manage Forecast During Product Life Cycle table, and that the top table passes the
highlighted selections in the required Product dimension level to the bottom table.

4. Run the plan.
5. Open the plan, and view the information in the copy of the page layout.
6. If you’re generating a forecast using shipments history, enter a value in the Adjusted Shipments Forecast or Change

to Shipments Forecast Percentage measure to view the result in the Final Shipments Forecast measure. Save your
changes in the table layout.
If you’re generating a forecast using bookings history, enter a value in the Adjusted Bookings Forecast or Change
to Bookings Forecast Percentage measure to view the result in the Final Bookings Forecast measure. Save your
changes in the table layout.

7. If you must modify the launch date for a product, enter a value in the Adjusted Launch Date measure to view the
final date in the Final Launch Date measure. Save your changes in the table layout.
If you must modify the discontinuation date for a product, enter a value in the Adjusted Discontinuation Date
measure to view the final date in the Final Discontinuation Date measure. Save your changes in the table layout.
Run the plan again to view the forecasts for the required periods for your products.
If required, modify the value in the Adjusted Bookings Forecast, Change to Bookings Forecast Percentage, Adjusted
Shipments Forecast, or Change to Shipments Forecast Percentage measure. Save your changes in the table layout.
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Related Topics
• Overview of the Product Lifecycle Management Page Layout

• Create a Forecasting Profile

• Work with Page Layouts in Demand Management

• Work with Page Layouts in Replenishment Planning

• Manage Page Layouts in Sales and Operations Planning

How You Forecast Product Returns  
This topic explains how you can forecast product returns using forecasting profiles that are based on Bayesian machine
learning.

If you must forecast product returns, Oracle recommends that you create two positive history streams, one for product
demand and the other for product returns. Product sales and product returns don't necessarily occur in the same time
buckets, so modeling two separate history streams is advisable. After you forecast the product demand and product
returns with separate forecasting profiles, you can deduct the returns from the demand through a calculated measure.

You can import returns history only by using the file-based data import (FBDI) template for bookings history or
shipments history. You can't collect returns history from other Oracle applications.

Note:  Oracle doesn't recommend that you import negative values using the FBDI template for bookings history or
shipments history to forecast product demand and product returns in one history stream. If you import negative
values, they're set to zero during the forecasting process.

How You Generate Forecasts from a Product Launch
Date  
This topic explains how you can generate a forecast for a new product starting from its launch date.

How to Set Up This Feature
Do the following to set up this feature:

• Load a launch date into the predefined Launch Date measure using the file-based data import (FBDI) template
for Supply Chain Planning measures.
Alternatively, you can manually enter a launch date into the predefined Adjusted Launch Date measure. You
can also use this measure to override the imported value in the Launch Date measure.

• Add the LaunchDateMeasure forecasting parameter to your user-defined forecasting profile that's based on
Bayesian machine learning.
This forecasting parameter is in the General Settings category in the Add Parameter to Viewable List dialog box.
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Note:  You can't use this forecasting parameter in a forecasting profile that uses feature-based machine
learning. You also can't add this forecasting parameter to a predefined forecasting profile.

• Select the predefined Final Launch Date measure or a user-defined measure for the forecasting parameter.

This measure returns the value of the Adjusted Launch Date measure if it has a value. Otherwise, the Final
Launch Date measure returns the value of the Launch Date measure.

• Optionally, add the Final Launch Date, Adjusted Launch Date, and Launch Date measures to a table so that you
can view and adjust the data.

The forecasting process uses the value of the measure selected for the LaunchDateMeasure forecasting
parameter even if the measure isn't present in a table.

Points to Consider
Note these points while using this feature:

• Ensure the following if you create a measure to use instead of the Final Launch Date measure:

◦ The measure has the same dimensions as those of the output measure of the forecasting profile except
for the Time dimension.

◦ You enable the measure for the work areas for which the forecasting profile is enabled.

◦ The measure is in the measure catalog for the plan.

• The forecast is generated from the start of the forecasting horizon if these conditions are met:

◦ The selected measure for the LaunchDateMeasure forecasting parameter doesn't contain a date.

◦ The launch date is before the forecast start date.

• If the launch date falls within a time bucket, the beginning of the time bucket is taken as the launch date.

• The launch date is respected at the lowest level of the forecasting tree of your forecasting profile. For example,
if the lowest level is a combination of the Item and Organization levels, the forecast starts on the same launch
date for all customers and demand classes within the same item-organization combination. If the launch date
varies by customer or demand class within the item-organization combination, the earliest launch date is used.

To respect varying launch dates by customers for the same item, configure your forecast tree with the Product
and Customer dimensions so that the lowest level is a combination of the Item and Customer Site levels.

Related Topics
• Forecasting Parameters

• Overview of Forecast Trees

• How You Stop Forecasts from a Product Discontinuation Date
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How You Stop Forecasts from a Product Discontinuation
Date  
This topic explains how you can stop a forecast for a product starting from a discontinuation date.

How to Set Up This Feature
Do the following to set up this feature:

• Load a discontinuation date into the predefined Discontinuation Date measure using the file-based data import
(FBDI) template for Supply Chain Planning measures.

Alternatively, you can manually enter a discontinuation date into the predefined Adjusted Discontinuation Date
measure. You can also use this measure to override the imported value in the Discontinuation Date measure.

• Add the DiscontinueDateMeasure forecasting parameter to your user-defined forecasting profile that's based
on Bayesian machine learning.

This forecasting parameter is in the General Settings category in the Add Parameter to Viewable List dialog box.

Note:  You can't use this forecasting parameter in a forecasting profile that uses feature-based machine
learning. You also can't add this forecasting parameter to a predefined forecasting profile.

• Select the predefined Final Discontinuation Date measure or a user-defined measure for the forecasting
parameter.

This measure returns the value of the Adjusted Discontinuation Date measure if it has a value. Otherwise, the
Final Discontinuation Date measure returns the value of the Discontinuation Date measure.

• Optionally, add the Final Discontinuation Date, Adjusted Discontinuation Date, and Discontinuation Date
measures to a table so that you can view and adjust the data.

The forecasting process uses the value of the measure selected for the DiscontinueDateMeasure forecasting
parameter even if the measure isn't present in a table.

Points to Consider
Note these points while using this feature:

• Ensure the following if you create a measure to use instead of the Final Discontinuation Date measure:

◦ The measure has the same dimensions as those of the output measure of the forecasting profile except
for the Time dimension.

◦ You enable the measure for the work areas for which the forecasting profile is enabled.

◦ The measure is in the measure catalog for the plan.

• The forecast is generated through the end of the forecasting horizon if these conditions are met:

◦ The selected measure for the DiscontinueDateMeasure forecasting parameter doesn't contain a date.
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◦ The discontinuation date is after the forecast end date.

• If the discontinuation date falls within a time bucket, the beginning of the time bucket is taken as the
discontinuation date.

• The discontinuation date is respected at the lowest level of the forecasting tree of your forecasting profile. For
example, if the lowest level is a combination of the Item and Organization levels, the forecast stops on the same
discontinuation date for all customers and demand classes within the same item-organization combination.
If the discontinuation date varies by customer or demand class within the item-organization combination, the
latest discontinuation date is used.

To respect varying discontinuation dates by customers for the same item, configure your forecast tree with
the Product and Customer dimensions so that the lowest level is a combination of the Item and Customer Site
levels.

Related Topics
• Forecasting Parameters

• Overview of Forecast Trees

• How You Generate Forecasts from a Product Launch Date
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11  Supply Plans

Manage Supply Plans  

Create a Plan  
You can create plans and then duplicate them to save time and perform planning activities incrementally. For example,
you have defined the line of business associated with an existing plan, such as organizations and items.

You can create a copy from that existing plan rather than define a new plan.

Use this generic procedure to create a plan.

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel drawer, click the Manage Plans link.
3. In the Search Results region, from the Actions menu, select Create.
4. On the Create Plan page, complete the general information for the plan:

a. Enter a name.
b. (Optional) Provide a description for the plan.
c. Select the plan type.
d. Select a supply planning mode.

Note:  The Supply Planning Mode attribute is only available for a supply plan, demand and supply plan,
or a sales and operations plan type.

- Supply plan and demand and supply plan types: Options are Constrained and Unconstrained.
Constrained is only available if you have opted in for Constraint-Based Supply Planning. Otherwise,
the supply planning mode defaults to Unconstrained.

- Sales and operations plan type: The supply planning mode defaults to Aggregate.
e. (Optional) Select the Enable for OTBI reporting check box to make measures from a plan available in

Oracle Transactional Business Intelligence (OTBI) for reporting.
f. Select the owner.

g. Define the access level:

i. Select Public to make the plan accessible for all users.
ii. Select Private to restrict the plan accessible to you and to a list of users that you want to provide

access.
5. Based on the type of plan that you selected, complete the required information in one or more tabs (Scope,

Demand, Safety Stock, and Supply).

If you’re planning to show archived measures in your plan, you need to set the duration in days for the archived
time periods and enable viewing the past days on the plan table. See the View Planning Measures from Archived
Time Periods topic to learn more.

6. Click Save and Close.
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Related Topics
• Copy a Plan

• View a Plan

Copy a Plan  
You can create plans and then duplicate them to save time and perform planning activities incrementally.

For example, you have defined the line of business associated with an existing plan, such as organizations and items.
You can create a copy from that existing plan rather than define a new plan.

Use the Duplicate procedure to:

• Create a copy of an existing plan that includes the plan data.

• Create only a copy of plan options.

Use these steps to copy a plan.

1. Navigate to the Duplicate Plan dialog box:

a. In a Supply Chain Planning work area link, click the Tasks panel tab.
b. In the Tasks panel drawer, click the Manage Plans link.
c. Enter the search parameters and click the Search button.
d. In the Search Results region, select the plan that you want to copy, click Actions, and then select

Duplicate.
2. In the Duplicate Plan dialog box, complete the following information for the plan:

a. Select a copy type:

- Copy plan options only: The planning process copies plan options to the duplicate plan, but not
the plan data.

Typically, when you duplicate the plan with the Copy plan options only option, the next step is to
edit the plan options before running the plan.

- Copy plan with reference to base plan: When you duplicate the plan with reference to the base
plan, the next step is to open the copied plan as you're likely to make edits before running the plan.
On the Manage Plans page, the Copied From column displays the name of the plan that you copied
from.

CAUTION:  If you delete the base plan or rerun the base plan with the Refresh with current data
option, plans copied from the base plan become invalid.

- Copy all plan data with no reference to base plan: The planning process makes a full, standalone
copy of the plan, which can include archived measures. For approved sales and operations plans,
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this option enables you to create a full backup copy of your plans at the end of every planning
cycle.

On the Manage Plans page, the Copied From column is empty for the new plan because it's a
standalone copy of the base plan. Therefore, there's no reference to the base plan.

The Copy all plan data with no reference to base plan option isn't available for demand plan types.
b. Enter a name and a description.
c. Define the access level:

- Select Public to make the plan accessible for all users.
- Select Private to restrict the plan accessible to you and to a list of users that you want to provide

access.
d. (Optional) Select the Load plan after copy check box to load the copied plan to memory. This check box

isn't available for demand plan or sales and operations plan types.
e. Select the owner.
f. (Optional) Select the Include archives check box to make a standalone copy of your plan that includes

archived measures. The copies of the archived versions are relabeled to remain consistent with the new
plan name. This relabeling applies to both scheduled and ad hoc archive versions.

The transaction history of when archived versions were created in the original plan isn't copied to the
new plan. However, the new archived version names retain the date stamp and sequence number of
when the archives were originally run.

The Include archives check box is available only when:

- The Enable for archiving check box is selected in the Scope: Advanced Options dialog box in the
plan options.

- The Copy all plan data with no reference to base plan is selected as the copy type in the
Duplicate Plan dialog box.

3. Click Save and Close

Related Topics
• Create a Plan

• View a Plan

View a Plan  
If you already have an existing plan, you can open the plan from the Plans drawer or by using the Manage Plans task.
You must always run a plan before you can view it.

To open an existing plan from the Plans drawer to view it, do the following:

1. In a Supply Chain Planning work area link, click the Plans drawer.
2. Expand Plans, and select the plan of your choice.
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3. Click the Actions button and select Open.

Tip:  If you have many plans, you have an option to search a plan by using the Manage Plans task. In this
case, provide appropriate search criteria and click Search. In the search results area, select your plan and click
the Action button and select Open. Oracle recommends this method to view sales and operations plans.

Note:  If you’re planning to show archived measures in your plan, you need to set the duration in days for the archived
time periods and enable viewing the past days on the plan table. See the View Planning Measures from Archived Time
Periods topic to learn more.

Related Topics
• Create a Plan

Enable Plans for OTBI Reporting  
Oracle Transactional Business Intelligence (OTBI) is a real-time, self-service reporting solution that helps you create
user-defined and interactive reports.

You can enable OTBI reporting for plans created in your Supply Chain Planning work area to:

• Run reports in real-time to analyze supply, demand, and sales and operations planning plans

• Generate user-configurable and easy-to-use reports by using business intelligence tools and charts

• Analyze key metrics, such as exception metrics, inventory balances, pegged quantity, and orders to be released

• Compare two or more plans that are enabled for OTBI reporting

To improve your supply chain performance, you can monitor and identify problem areas by using strategic insights into
live and operational data. Compare different scenarios in real-time by using key measures to decide the best course of
action. You can respond to changes by modeling complex strategies and plans to analyze and compare them. You can
also define native OTBI capabilities like alerts based on exception conditions, user-defined measures, and conditional
formatting to monitor or track problem areas.

To create OTBI reports, navigate to the Reports and Analytics work area. You can build reports by using the base
measures available in your Supply Chain Planning work area. You can also create user-defined measures based on the
base measures by using the standard business intelligence tools.

To open OTBI reports in a Supply Chain Planning work area, save the OTBI reports into the Report Components
subfolder within the Transactional Analysis Samples folder. The Report Components folder is located in the shared
Supply Chain Planning folder in the Reports and Analytics work area.

To enable OTBI reporting for plans, you must do the following:

• Select the Enable for OTBI reporting check box on the Plan Options page of your supply, demand, or sales and
operations plan.

Note:  You must run the plan after you enable it for OTBI reporting.

• Set up reporting hierarchies by configuring the Product and Time hierarchies in the dimension catalog named
Reporting Catalog. To configure the Product and Time hierarchies, use the Configure Planning Analytics task
in your Supply Chain Planning work area. Depending on the reports that you want to generate, move the
Product and Time hierarchies from the Available Hierarchies pane to the Selected Hierarchies pane. If you select
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multiple Product and Time hierarchies, ensure that you select a default hierarchy for the Product and Time
hierarchies. The default hierarchies are used by default in the predefined reports.

You can build reports by using the base measures available in your Supply Chain Planning work area. You can also
create user-defined measures based on the base measures by using the standard business intelligence tools.

Accessing the OTBI Reports
Perform these steps to access the OTBI reports:

1. In a Supply Chain Planning work area, open a plan that is enabled for OTBI reporting.
2. Click the Open button and then select a pane.
3. In the Open Table, Graph, or Tile Set dialog box, do one of the following:

◦ Search for your report.

◦ Filter the list by selecting Type and then Report.

4. Select a report and then click OK.

The OTBI report opens in the context of the current, open plan.

When you search for reports, the list of reports in the search results includes predefined reports and user-defined
reports created by you. You must save the user-defined reports into the Reports Components subfolder within the
Transactional Analysis Samples folder to make them available in the Supply Chain Planning work areas. The following
predefined reports are available only in the Supply Planning and Planning Central work areas:

• Build Plan by End Item

• Exception Summary by Item Order

• Details by Item

• Pegging Details by End Item

• Plan Recommendations Summary Graph

Available Measures
The following measures are available in the Reports and Analytics work area:

• Configure to Order Forecast Metrics: The following configure to order forecast metrics are available for demand
plans, and demand and supply plans:

◦ Final Option Demand Forecast

◦ Final Planning Percent

◦ Option Demand Forecast

Configure to order forecast metrics support dimensions, such as Plan, Time, Product, Organization,
Customer, Top Model, and Demand Class.

• Demand Management Metrics: The following demand management metrics are available for demand plans,
and demand and supply plans:

◦ Bookings Forecast

◦ Bookings History

◦ Bookings History Value
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◦ Final Bookings Forecast

◦ Final Shipments Forecast

◦ Shipments Forecast

◦ Shipments Forecast Value

◦ Shipments History

◦ Shipments History Value

Demand management metrics support dimensions, such as Time, Product, Organization, Customer, and
Demand Class.

• Exception Metrics: The following exception metrics are available for supply plans, and demand and supply
plans:

◦ Exception Count

◦ Exception Quantity

◦ Exception Days

◦ Exception Ratio

◦ Exception Value

Exception metrics support dimensions, such as Plan, Time, Product, Organization, Customer, Supplier,
Manufacturing Resource, and Exception Type.

• Order Metrics: The following order metrics are available for supply plans, and demand and supply plans:

◦ Order Quantity

◦ Implemented Supply Quantity

◦ Order Value

Order metrics support dimensions, such as Plan, Time, Product, Organization, Order Details, and Order
Type.

• Pegging Metrics: The following pegging metric is available for supply plans, and demand and supply plans:

◦ Pegged Quantity

Pegging metric supports dimensions, such as Plan, Time, Product, Organization, Customer, Supplier, End
Demand, and Order Type.
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• Sales and Operations Planning Metrics: The following sales and operations planning metrics are available for
sales and operations plans:

◦ Consensus Forecast

◦ Consensus Forecast Value

◦ Final Sales Forecast

◦ Final Sales Forecast Value

◦ Sales Forecast

◦ Sales Forecast Value

Sales and operations planning metrics support dimensions, such as Plan, Time, Product, Organization,
Customer, and Demand Class.

Define Scope Plan Options  
Scope options determine the scope of the plan. Define or edit scope plan options on the Scope tab on the Plan Options
page.

You can configure the plan organizations, items, plan horizon, and planning level for demand forecasting. You also can
define the filters for a plan, such as the hierarchy, level, and level members.

The Scope tab displays these sections:

• Plan Organizations

• Plan Items (available only for demand plans or demand and supply plans)

• Supply Planned Items (available only for demand and supply plans or supply plans)

• Plan Parameters

Plan Organizations
Specify a hierarchy, level, and level members by which to filter the plan. Also, select the source system code to use
for filtering organizations. Fields in the Plan Organizations section are required. If you select a level that's above the
organization level, then organizations that belong to that parent level are included in the plan.

Plan Items
Specify a hierarchy, level, and level members by which to filter specific items for demand planning. Your selections here
are used with your selections in the Plan Organizations section. Items that belong to a parent level are included. Fields
in this section aren't required. However, if you don't specify a hierarchy, level, and level members, then you can't filter
by planned items. In this situation, your plan includes all planned items in the organizations you select, which can have
performance implications.

Supply Planned Items
For Supply Planned Item Type, select Manufacturing Plan (MRP) or Production Plan (MPS).
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For Supply Planned Items, select one of these options to control the items to include in the supply plan:

• All planned items: This option can have performance implications.

• Demand plan items and all sales orders

• Demand plan and WIP components

• Demand plan items only

• Demand plan items, WIP components, and all sales orders

Select the Include items with only safety stock as demand check box to plan items with safety stock targets, even if
there's no demand yet for the items. For example, you want enough safety stock to support demand for new products
with long lead times even when you can't formally forecast for the new products or don't have any sales orders.

Select Include items with only existing supplies, but no demand to include items with existing supplies but no
demand in the plan scope. The supply plan includes those items that aren't part of the existing selection but have
existing supplies and no demands in the plan scope. When an item has only existing supplies but no demand in the plan
scope, then the items of its upstream supply chain will also be part of the plan.

These check boxes are disabled if you select All planned items in Supply Planned Items.

Note:  The plan option Include items with only existing supplies, but no demand is available in the Supply Planning
and Demand and Supply Planning work areas.

Plan Parameters
The Plan Parameters section is available for plans of the demand, demand and supply, and supply plan types.

The following table describes the plan parameters.

Parameter Definition Plan Types

Plan Horizon Days
 

Number of days in the plan. Set horizon days
to forecast and plan for future needs. Minimize
horizon days to avoid long-running plans.
Default is 180 days.
 

Demand Plan
 

Forecasting Calendar
 

Select the forecasting calendar, which must
belong to the dimension catalog associated
with the plan.
 

Demand and Supply Plan
 

Planning Calendar
 

Select the planning calendar, which must
belong to the dimension catalog associated
with the plan.
 

Demand Plan
 

Planning Time Level
 

Set the planning time level on the Scope tab,
 and set the forecasting time level on the
Demand tab. The time levels you can choose
depend on the selected planning calendar.
 
If you selected a hybrid time hierarchy as
the planning calendar for a demand plan,
 the planning time level is defaulted to the

Demand Plan
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Parameter Definition Plan Types

corresponding Hybrid time level and mustn't be
changed.
 
In the Demand Management or Demand and
Supply Planning work area, for a demand plan
that uses feature-based forecasting, select only
Day, Week, or Month.
 

Planning Level Profiles Select a planning level profile for the plan to use
aggregated data for the Customer dimension.
The planning level profiles that are available for
selection are in the Enabled or Ready status.
You can select only one planning level profile
for your demand plan.
 
If you select a planning level profile, the
Aggregate non-key customer data to an All
Other level member check box is disabled on
the Demand tab.
 

Note:  Ensure that the selected hierarchies in
your planning level profile are also contained
in the dimension catalog for your demand
plan.

The Edit Planning Level Profiles icon is
disabled if you select Day in Planning Time
Level.
 
After you successfully run your plan, you can't
change or remove the planning level profile,
 and the Edit Planning Level Profiles icon is
disabled.
 

Demand Plan (in only the Demand
Management work area)

Supply Planning Calendar
 

Select a supply planning calendar.
 
The list of available calendars includes only
calendars that meet all the following criteria:

• Belong to the dimension catalog
associated with the plan.

• Have calendar start and end dates that
encompass the entire plan horizon.

• Are Gregorian, fiscal, or organization
calendars.

 

Demand and Supply Plan
 
Supply Plan
 

Supply Planning Buckets
 

Specify your supply planning buckets. The list
of values for the bucket types is determined by
the supply planning calendar that you specify.
 
You can base your planning horizon on days,
 weeks, periods, or months. Or, you can specify
a combination of daily time buckets and then
specify less granular time buckets such as
weeks, periods, or months. If you use two
bucket types, the first bucket type must be Day
or Week.
 

Demand and Supply Plan
 
Supply Plan
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Parameter Definition Plan Types

Number of Buckets
 

Specify the number of supply planning buckets.
 

Note:
For a constrained supply plan, the total
number of planning time buckets can't
exceed 120.
 

Demand and Supply Plan
 
Supply Plan
 

Don't create partial buckets
 

Select to create additional daily buckets in the
plan to avoid partial buckets.
 
The planning process adds additional daily
buckets to avoid the creation of partial buckets.
This ensures that a week, month, or period
always starts on the first defined day of that
particular week, month, or period.
 
If you don't select this option, the plan doesn't
add any additional daily buckets. Instead, the
planning process creates a partial bucket and
counts that partial bucket as the first week,
 period, or month, as specified in the plan
options.
 

Note:  The option is disabled if you select
the Week-Period combination in Supply
Planning Buckets.

Demand and Supply Plan
 
Supply Plan
 

Measure Catalog
 

Group multiple sets of measures for use in a
plan. By enabling only those measures that are
needed for any specific plan, you can perform
a focused analysis with improved performance.
A planning administrator can create and edit
measure catalogs.
 

Demand Plan
 
Demand and Supply Plan
 
Supply Plan
 

Price Lists
 

Price list used in revenue calculations. The
default price list for use in value calculations
is Item List Price, defined in the Items table for
Organization and Item. However, if a collected
price list is marked as the primary and the
Include When Deriving Selling Price check box
is selected, the revenue is calculated using the
derived price.
 

Demand Plan
 
Demand and Supply Plan
 
Supply Plan
 

Exception Set
 

Lists exceptions to compute as part of a plan
and also filters on Organizations and Categories
for computing exceptions.
 

Demand Plan
 
Demand and Supply Plan
 
Supply Plan
 

Simulation Set
 

Lists simulation sets to use in your plan. A
simulation set is a set of adjustments to plan
inputs. Apply a simulation set to a plan to
model different business scenarios.
 

Demand Plan
 
Demand and Supply Plan
 
Supply Plan
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Parameter Definition Plan Types

 

Related Topics
• Actions to Manage Your Plans

• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Why can't I select Supply Planned Items?

• Plan Items with Safety Stock Targets with No Demand

• Plan Items with Only Transfer Order Demand

Calculate Financial Metrics Using Price Lists  
You can determine the selling price of an item using a single price list or by averaging multiple price lists associated with
a plan.

You can use this selling price to calculate end demand values and financial metrics, such as revenue and margin. The
measures can be displayed in tables and graphs. The updated end demand values are displayed in the Supplies and
Demands, Exceptions, and Demand Fulfillment views in the supply plan output.

This functionality is available for constrained and unconstrained supply, demand and supply, and sales and operations
plans.

Here’s how you can calculate financial metrics using a price list in a plan.

1. Navigate to the Plan Inputs work area from the navigator.
2. From the Tasks menu, click Collect Planning Data.
3. Select Items in the Reference Data tab and Include Price List check box in the Demand Planning Data tab.
4. Click Submit to initiate the collections process.
5. On the Manage Plans page, create a new plan by selecting the price lists in the plan option to derive the selling

price for the item.

You also can edit the existing plan options to allow the price lists to derive the selling price.
6. Click Edit for the price list in the plan option.
7. Click Add in the Manage Price Lists window.
8. Select the Primary check box to indicate a primary price list.

You can select a user-defined price list or the Item list Price.
9. Enable the Include When Deriving Selling Price plan option for the price lists that must be used to calculate

the selling price. Select multiple price lists to compute the average selling price of the item.

The planning process performs all the necessary units of measure and base currency conversions and
represents them in the primary unit of measure. This value takes precedence over the Item List Price.

10. Click OK to save the options and run the plan.
11. Click Open in the plan output work area and search for the Items view.

You can see that the plan has computed the Selling Price and Net Selling Price from the price list associated
with the plan.
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In the Supplies and Demands view, the Selling Price is used to compute and display the End Demand Value for
the forecast.

Note:  This view is available in supply and demand, and supply plans.

Things to Consider When Calculating Financial Metrics Using Price Lists
Here’s some additional information about this functionality.

• The Include When Deriving Selling Price check box is disabled for Item List Price since it is the default price list
for all calculations. The check box is enabled for user-defined price lists collected from Product Information
Management (Fusion source) or using file-based data integration (external source).

• The Selling Price is the same as the Item List Price if you don’t assign any user-defined price lists to the plan.
You can uncheck Include When Deriving Selling Price to consider the Item List price as the Selling Price.

• The Price measure is calculated for the price list you set as Primary. The planning process does not compute
the time-varying Price measure values for a price list that is not set as Primary and for which Include When
Deriving Selling Price is enabled.

• The Price measure calculated with a Primary price list is used to compute shipment or booking forecast value
measures. You also can use it to compute the value in a user-defined measure with an expression in a supply
plan.

Examples Showing How to Calculate Financial Metrics Using Price Lists
Example 1 shows how the selling price of an item is derived from the price lists for price list details specified in Oracle
SCM. The price list and item price details are created in the Pricing work area.

The item KB-SS-PUMP106’s price is defined in two price lists in Pricing. In the price list SN PRICE: LIST1, the price is 98
USD, and in the price list SN PRICE LIST2, the price is 99 USD.

1. Select the item’s price list and price details, and run the Collect Planning Data scheduled process. The details
are collected in Oracle SCP.

2. Create a plan, and add price lists SN PRICE LIST1 and SN PRICE LIST2 in the Manage Price Lists in the plan
option.

3. Select the Include When Deriving Selling Price check box for both the lists.
4. Run the plan to see the item's Selling Price and Net Selling Price values in the Items view. These values are

calculated from the price lists associated with the plan.

Example 2 shows how the time-varying price is used to calculate the revenue in a sales and operations plan.

The planning process uses the time-varying price for revenue calculation when you mark a single price list as Primary,
and select Include When Deriving Selling Price in plan options.

For example, the Revenue of 32,000 in March 2030 is calculated by multiplying the Constrained Forecast (200) and
Price (160).

The Selling Price value in the Items table is computed as the average of the time-varying prices for an item in the plan
output.

If you mark more than one price list as Include When Deriving Selling Price in plan options, then the computed
average Selling Price is used in revenue calculations instead of the time-varying price.

Example 3 shows how the average selling price is derived for an item from price lists in a supply plan.
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The item AS7311 in an organization M1 is collected with the following price list details from the source system:

• Price List 1 with the price of 10 USD, effective from January 1st, 2022.

• Price List 2 with the price of 11 USD, effective from February 2nd, 2022.

• Price List 3 with the price of 9.5 Euros, effective from March 3rd, 2022.

• Price List 4 with the price of 14 USD, effective from January 1st, 2022 to June 30th, 2022.

A supply plan is created with the plan horizon start date of July 29th, 2022. The supply planning process derives the
selling price for item AS7311 from price lists. Include When Deriving Selling Price is marked for all four price lists. The
default price list “Item List Price” is marked as Primary.

The items AS7311 and CM1234 have a collected list price as a selling price of 10 USD.

The currency of Organization M1 is USD. The latest collected conversion rate from Euros to USD is 1.2, with the
conversion date effective from Jan 1st,2022. The price of 9.5 Euros from Price List 3 is converted to USD using the latest
conversion rate. The price of 14 USD from Price List 4 is ignored, as the To Date ends before the plan horizon start date.
So, the average selling price for the item AS7311 is derived from Price List 1, Price List 2, and Price List 3 as 10.8 USD.

Since item CM1234 does not have any price list detail, the list price of the item is applied as a selling price of 10 USD in
the plan.

The financial metrics in the plan for item AS7311 are calculated based on the selling price derived from price lists
associated to the supply plan.

Why can't I select Supply Planned Items?  
The Supply Planned Items option is inactive until you select level members in the Forecasting Items section. When
Supply Planned Items is inactive, the planning process considers that all level members are selected.

Safety Stock Parameters  

Safety Stock Planning Methods  
You can select a Safety Stock Planning Method to plan safety stock for your plan.

Use the Supply Planning, Planning Central, or Demand and Supply work area to open the Plan Options page, Safety
Stock tab, where you can select the safety stock planning method.

The following are the four safety stock planning methods from which to select:

• Do not plan safety stock

• User-specified values for all items

• Statistical safety stock for end items, none for all others

• Statistical for end items, user-specified for all others

289



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 11
Supply Plans

Note:  The safety stock override is used and the planning process doesn't calculate any values for items when the
following applies:

• If the Apply the override quantities for safety stock check box is selected for the plan.

• If a planned item has its safety stock override item attribute set to Not Null.

Do Not Plan Safety Stock
Select this method if you don't want safety stock calculated or planned for any item in the plan.

If you select this method, the Parameters for Safety Stock Calculation and Parameters for Safety Stock Smoothing
sections aren't available.

User-Specified Values for All Items
Select this method to plan safety stock for all items based on the safety stock method for each item. In this case, safety
stock planning doesn't consider statistical safety stock parameters. With this option the planning process calculates
safety stock in one or more of the following ways:

• If the Safety Stock Planning Method item attribute is set to Non-MRP Planned, then you can upload safety stock
quantities by using CSV files for those items.

• If the Safety Stock Planning Method item attribute is set to Days of cover, then the planning process calculates
safety stock based on the user-specified days of cover for those items.

• If the Safety Stock Planning Method item attribute is blank, the planning process doesn't plan safety stock.

If you select this method, the Parameters for Safety Stock Smoothing section is editable. However, the Parameters for
Safety Stock Calculation section isn't available.

Statistical Safety Stock for End Items, None for All Others
Select this method to plan safety stock only for the end items that have statistical safety stock parameters defined for
them. The planning process doesn't plan safety stock for items that don't have forecasts defined.

If you select this method, the Parameters for Safety Stock Calculation and Parameters for Safety Stock Smoothing
sections are editable. Statistical safety stock is calculated with parameters specified at the item, policy, or measure level.

Statistical for End Items, User-Specified for All Others
Select this method to calculate and plan statistical safety stock for end items and user-specified safety stock for all other
items.

If you select this method, the Parameters for Safety Stock Calculation and Parameters for Safety Stock Smoothing
sections are editable. Statistical safety stock is calculated with parameters specified at the item, policy, or measure level.

Safety Stock Planning Logic
The following flowchart describes the logic used by supply planning to determine the safety stock method for an item.
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Related Topics
• Parameters for Safety Stock Smoothing

• Parameters for Safety Stock Calculation

Parameters for Safety Stock Calculation  
You can configure parameters in which to calculate safety stock quantities as part of Run Plan. The safety stock
calculation process outputs to plan data for the related safety stock fields for each item-organization attribute.

The process calculates statistical safety stock levels based on forecasts and forecast error measures.

Define or modify safety stock plan options on the Plan Options page, Safety Stock tab. The safety stock calculation
process also outputs values to the plan simulation set specified on the Plan Options page, Scope tab.

Note:  The Parameters for Safety Stock Calculation section is available only when one of the following safety stock
planning methods is selected:

• Statistical safety stock for end items, none for all others

• Statistical for end items, user-specified for all others

The following table lists safety stock calculation parameters that you can select or configure.

Parameter Description

Use item-specific values
 

Select to specify whether the supply plan run uses item-specific values in safety stock calculations.
 

Service Level Percentage
 

Enter a value between 0 and 100 to set the level of customer service that you want in satisfying the
product demand immediately out of inventory.
 

Apply policy overrides
 

Select to calculate safety stock for an item and organization combination using policy level overrides. If
selected, then you must select a policy assignment set.
 

Policy Assignment Set
 

Select the policy assignment set to use for the item and organization combinations that correspond to
the segments and service level percentages defined in the Manage Supply Planning Policy Assignment
Sets task.
 

Forecast Error Type
 

Determines whether the quality of a forecast is measured by using MAD, MAPE, Intermittent, or
Demand schedule specific.
 

Overwrite
 

Select a value to use to overwrite the previously generated or entered safety stock levels.
 

Save to collected data
 

If selected, then the collected data is updated with the safety stock quantities that are calculated and
with safety stock quantity overrides.
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Related Topics
• Safety Stock Planning Methods

• Parameters for Safety Stock Smoothing

• How You Calculate Safety Stock Based on Multiple Demand Schedules

• Overview of Supply Planning Policy Assignment Sets

• Create a Supply Planning Policy Assignment Set

Parameters for Safety Stock Smoothing  
You use the Parameters for Safety Stock Smoothing section on the Plan Options page, Safety Stock tab to configure the
following options:

• Apply safety stock change interval to all items

• Smoothing method to calculate safety stock within change interval

• Safety stock change interval in days

• Safety stock bucket start offset days

• Maximum percentage variation in safety stock values

• Minimum percentage variation in safety stock values

Note:  The Parameters for Safety Stock Smoothing section on the Plan Options page, Safety Stock tab, is available
only when one of the following safety stock planning methods is selected:

• User-specified values for all items

• Statistical for end items, user-specified for all others

• Statistical safety stock for end items, none for all others

Apply Safety Stock Change Interval to All Items
If you enable this option, the planning process applies safety stock change interval to all items. If you disable this option,
then the safety stock change interval applies only to items with Days of Cover safety stock method. Safety stock change
interval is the time interval used for the smoothing within time interval functionality. If you specify an interval of 20
days, then starting from the application date, the planning process groups the safety stock calculation in 20-days
bucket. The planning process then uses the smoothing method to calculate the safety stock within change interval to
determine the safety stock level for the bucket.

Smoothing Method to Calculate Safety Stock Within Change Interval
Use this option for smoothing raw safety stock quantities in every interval, starting from the plan horizon. You can
select Minimum, Maximum, or Average from the drop-down list. The result is always rounded up to nearest integer.

Safety Stock Change Interval in Days
Safety stock change interval is the number of working days used for smoothing safety stock within the time interval. If
you specify an interval of 20 days, then starting from the application date, the planning process groups the safety stock
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calculation in 20-day buckets. The planning process then uses Smoothing method to calculate the safety stock within
change interval to determine the safety stock level for the bucket. Enter a value greater than zero (0).

Safety Stock Bucket Start Offset Days
Use the current day for this option to ignore the impacts of high near-term demand that's possible due to high backlog
demand. Enter a value greater than zero (0).

Maximum Percentage Variation in Safety Stock Values
When you use this option, the planning process doesn't let the safety stock deviate by more than the specified value
when changing the time interval. Enter a value greater than zero (0). For example, if you specify 25 percent, the
planning process sets 25 percent as the maximum percentage of change in safety stock quantity between buckets.

Minimum Percentage Variation in Safety Stock Values
When you use this option, the planning process keeps the safety stock constant across time intervals if the deviation is
within the specified percentage. Enter a value greater than zero (0).

Related Topics
• Safety Stock Planning Methods

• Parameters for Safety Stock Calculation

Plan Items with Safety Stock Targets with No Demand  
You can plan items with safety stock targets even if there is no demand yet for the items.

For example, you want enough safety stock to support demand for new products with long lead times even when you
can't formally forecast for the new products or don't have any sales orders.

Where there are no forecasts or actual demand yet for items, use the safety stock planning method Safety Stock
Quantity to plan safety stock. Also, select the Include items with only safety stock as demand option on the Plan
Options page, Scope tab. The supply planning process plans for safety stock, even if there's no actual demand to ensure
that there's stock on hand to support any unexpected demand.

The Include items with only safety stock as demand check box is available for supply plan and demand and supply
plan types for constrained and unconstrained supply planning. This check box isn't available if the Supply Planned Items
plan option is set to All planned items.

Steps to Include Items with Only Safety Stock as Demand
Perform the following steps to plan items with safety stock targets in your plan for which there is no demand.

1. In the Product Information Management work area, use the Manage Items task to set the Safety Stock
Planning Method item organization attribute to the Safety Stock Quantity value.

2. In the Supply Planning work area, open your plan and navigate to the Plan Options page, Scope tab. In the
Supply Planned Items section, select the Include items with only safety stock as demand check box.
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3. Navigate to the Plan Options page, Safety Stock tab and set the options to one of the following:

◦ Set the Safety Stock Planning Method field to the User-specified values for all items value.

◦ Set the Safety Stock Planning Method field to the Statistical for end items, user-specified for all
others value. Next, select the Apply the override quantities for safety stock check box.

◦ Set the Safety Stock Planning Method field to the Statistical safety stock for end items, none for all
others value. Next, select the Apply the override quantities for safety stock check box.

Related Topics
• Define Scope Plan Options

Policy Assignment Sets in Supply Planning  

Overview of Supply Planning Policy Assignment Sets  
A policy assignment set is a group of policy parameters that are defined for each segment of a segment group.

Policies are calculated for item-location combinations on the basis of these policy parameters. The policy assignment
set can also contain policy overrides for segments and item-location combinations.

The policy assignment set is attached to a segment group. You can define multiple policy assignment sets for the
segment group. However, you can specify only one policy assignment set for the segment group on the Scope tab of the
Plan Options page in a supply plan.

For supply planning, policy assignment sets are used to apply policy overrides as part of the parameters for safety stock
calculation.

Related Topics
• Copy, Edit, or Delete a Supply Planning Policy Assignment Set

• Create a Segment Group

• Create a Supply Planning Policy Assignment Set

Create a Supply Planning Policy Assignment Set  
Follow these steps to create a supply planning policy assignment set and associate it with a segment group:

1. On the Tasks panel tab, under Plan Inputs, click Manage Supply Planning Policy Assignment Sets.
The Manage Supply Planning Policy Assignment Sets page opens.

2. In the Search Results section, on the toolbar, click the Create icon.
The Create Supply Planning Policy Assignment Set dialog box opens.

3. Enter the name and description of the policy assignment set.
4. In Segment Group, select the segment group to which the policy assignment set should be attached.

Only those segment groups for which the segmentation process has been successfully run are available for selection.
5. Click the Add Row icon.
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6. Select a Segment.
7. Enter a value in Service Level Percentage. You must enter a percentage between 0 and 100.
8. Click Save and Close.

Related Topics
• Copy, Edit, or Delete a Supply Planning Policy Assignment Set

Copy, Edit, or Delete a Supply Planning Policy Assignment Set  
You can duplicate, edit, and delete a supply planning policy assignment set on the Manage Supply Planning Policy
Assignment Sets page.

The changes you can make to the policy assignment set are limited. You can't change the name of the policy
assignment set and you can't delete it if it's being used in a supply plan. To change the segment group, you must first
delete all the segments from the policy assignment set.

You can duplicate the policy parameters that you have specified for a segment and reuse them in another segment.

Forecast Allocation and Consumption  

Forecast Processing  
Forecast processing adjusts the forecast received as a demand schedule to make it suitable for use in supply planning.
Forecast processing is a multi-step process that involves the following.

1. Forecast Explosion: If enabled, this step explodes the forecast of a model item into separate forecasts for all
underlying option classes and options.

2. Forecast Spreading and Rounding: If enabled, this step spreads the forecasts received at a higher level of time
aggregation to working days per the forecast spreading calendar. When the daily forecast quantity is calculated,
it may be rounded up to a whole number, depending on the Rounding attribute for the item.

3. Forecast Consumption: In this step the forecast quantities, after spreading and rounding, are reduced, at the
specified consumption level, by the open sales order quantities to produce a net forecast quantity.

You can define the following aspects of forecast processing on the Plan Options page, Supply tab, Forecast Allocation
and Consumption subtab:

• Forecast Explosion

• Forecast Spreading

• Forecast Consumption

• Past Due Demands
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Related Topics
• Forecast Explosion

• Forecast Spreading

• Forecast Consumption

• Past Due Demands

• Forecast Consumption View

Forecast Explosion  

Forecast explosion explodes the forecast of a model item into separate forecasts for all underlying option classes and
options.

Select Explode model forecasts to specify whether a top model forecast from a demand schedule is exploded in supply
planning.

Select Use forecasted planning percentages instead of collected data to specify whether the planning percentages
used for the forecast explosion process in supply planning are from demand planning or the Oracle Fusion Product
Model.

Configure the forecast explosion parameters on the Plan Options page, Supply tab, Forecast Allocation and
Consumption subtab.

Related Topics
• Forecast Processing

• Forecast Spreading

• Forecast Consumption

• Past Due Demands

Forecast Spreading  
When you enable forecast spreading, the planning process breaks down the forecast at an aggregate time level to the
day level. This is known as forecast spreading. Configure the forecast spreading parameters on the Plan Options page,
Supply tab, Forecast Allocation and Consumption subtab.
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Use the Forecast Spreading option to decide whether to spread the forecast evenly or to not spread the forecast at all.

• Spread forecast evenly: The planning process spreads forecast to daily buckets if the demand is planned at an
aggregate level, such as a weekly or monthly level.

If selected, then select a calendar from the Forecast Spreading Calendar drop-down list to determine the start
and end date of the consumption buckets as well as the working days. You can only spread the forecast evenly
across all working days.

Let’s say that you have a monthly demand forecast of 100 and you enable forecast spreading. There are 20
working days in the month. The planning process spreads the forecast quantity of 5 to each working day of the
month.

• Do not spread forecast: The planning process retains the forecast at the weekly or monthly level. The planning
process puts the forecast at the first day of the week or the first day of the month.

Note:  You can enable the Rounding item attribute in the product data model or a simulation set. This ensures that
the spread forecast is in integers and helps plan for items that aren't divisible.

Related Topics
• Forecast Processing

• Forecast Explosion

• Forecast Consumption

• Past Due Demands

Forecast Consumption  
Forecast consumption is the process that replaces forecast demand with sales order demand. Each time you place
a sales order, you create actual demand. If you have actual demand, you want to reduce the forecast demand by the
sales order quantity to avoid overstating demand. The forecast consumption process deducts sales orders (actual
demand) from the gross forecast, after spreading and rounding, to come up with a net forecast. Configure the forecast
consumption parameters on the Plan Options page, Supply tab, Forecast Allocation and Consumption subtab.

Use the Consumption Calendar and Consumption Bucket Type options to specify the calendar and bucket type to use
for forecast consumption. Depending on the type of calendar that you select, such as a 4-4-5 or Gregorian calendar, you
can then specify the time bucket to use for forecast consumption.

If you select the Consume by forecast bucket check box, then consumption happens within a single forecast bucket.
For example, if the Forecast Time Level is set to week, then sales orders are deducted from the gross forecast of that
same week.

If you don’t select the Consume by forecast bucket check box and specify values for the options Backward
Consumption Buckets and Forward Consumption Buckets, forecast consumption is affected. These choices create a
forecast consumption window of time consisting of the backward and forward consumption buckets. When consuming
the forecast, these choices determine whether planning nets sales orders from the prior or subsequent time buckets.

For example, you specify 5 backward and 5 forward days and the forecast consumption is in daily buckets. The
consumption search first moves 5 working days backward from the forecast date, deducting open sales order quantities
from the forecast quantity until the forecast quantity is depleted. If there is any remaining forecast quantity, then
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consumption moves 5 working days forward from the forecast bucket, deducting open sales order quantities from the
forecast quantity.

You can specify additional forecast consumption parameters for a plan by defining the following options:

• Consume Forecast Inside Demand Time Fence

• Time Frame for Consuming Forecasts with No Demand Class

• Prefer Consumption Within Forecast Bucket

• Consumption Detail Cutoff Days

Consume Forecast Inside Demand Time Fence
If you enable this option, forecast consumption occurs before enforcing the demand time fence control. The forecast
entries within the demand time fence are used for consumption but not as a demand. After consumption, any forecast
entries within the demand time fence are removed.

If you disable this option, the demand time fence control is implemented before the forecast consumption. Forecast
entries in the demand time fence are dropped as demand statements and are not used for consumption.

Note:  Forecast spreading and rounding always take place prior to forecast consumption or applying the demand time
fence control.

Time Frame for Consuming Forecasts with No Demand Class
Use this option to instruct the forecast consumption process about the order to use to consume forecast entries when
some of the forecasts have a demand class and others don’t have a demand class.

If you select Within each bucket from the drop-down list, the forecast consumption process starts by consuming
forecast entries within the consumption bucket of the sales order. At first, it consumes entries with matching demand
class and then entries with no demand class. Then it consumes forecast entries within the backward and forward
consumption buckets. For each bucket, it uses the matching demand class first and then the no demand class.

If you select After consuming forecasts specific to the demand class from the drop-down list, the forecast
consumption process starts by consuming forecast entries within the consumption bucket of the sales orders with
matching demand class only. Then it consumes forecast entries within the backward and forward consumption buckets
with matching demand class only. If there are any remaining sales order quantity, it repeats the process for forecast
entries with no demand class. At first the process runs within the consumption bucket of the sales order and then within
the backward and forward consumption buckets.

Prefer Consumption Within Forecast Bucket
Select to specify whether to spread forecasts evenly and then consume if a sales order falls in the same time bucket as
the forecast using Backward Consumption Buckets first followed by Forward Consumption Buckets.

If you enable the option, the planning process consumes the forecast within the forecast bucket. This option takes effect
when you select Spread forecast evenly for forecast spreading and deselect the Consume by forecast bucket check
box.

Consumption Detail Cutoff Days
Enter a value for the planning process to use to write forecast consumption detail records for a supply plan. The value
that you enter is the number of days forward from the plan start date that the planning process writes the consumption
details for sales orders or transfer order demands.

299



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 11
Supply Plans

View the sales orders or transfer order demands that consumed a particular forecast in the Forecast Consumption table,
which you access from the Supplies and Demands or Material Plan table.

Here’s some additional information about the Consumption Detail Cutoff Days parameter:

• The number entered must be greater than or equal to zero. If the value is null or zero, then the planning process
won’t calculate any consumption details.

• The number must be less than or equal to the plan horizon in days.

• The number entered is added to the plan start date to get a cutoff date and identify the eligible sales orders.
The planning process writes the corresponding forecast consumption details in the Forecast Consumption
table.

The cutoff date is calculated based on the supply planning calendar associated with the plan. The planning
process writes the forecast consumption details for any sales order or transfer order demand with a due date
less than or equal to the cutoff date.

Note:  If the forecast consumption starts before the plan start date based on past due sales orders and
forecasts that are snapshot into the plan, the planning process clears the forecast consumption details,
beginning with the first consumption bucket.

Related Topics
• Forecast Processing

• Forecast Spreading

• Past Due Demands

• Forecast Consumption View

Past Due Demands  
You can specify parameters to include past-due demands within a supply plan or a demand and supply plan by using
plan option values instead of the supply network model.

Configure the past due demands parameters on the Plan Options page, Supply tab, Forecast Allocation and
Consumption subtab.

Parameter Description

Source for Including Past Due Demands Indicates the source to determine whether to include past due demands in the plan. Source options
are:

• Plan option values: If selected, then the values specified in the past due demand section of plan
options are used instead of the past due values found within the supply network model.

The past due demands plan options in this section apply to all organizations included in the
plan's scope. The values found in the supply network model can vary by organization.

• Supply network model: If selected, then the past due values found in the supply network model
is used to determine what past due demands are copied into the plan.

Past Due Demand Calendar Calendar to use to determine which past due demands to include in the plan. The type of calendar
selected determines the list of values for Past Due Demand Bucket Type.
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Parameter Description

If the past due demand calendar is a Gregorian calendar, the past due demand bucket type list of
values includes only Day and Month. But if the past due demand calendar isn't a Gregorian calendar,
 then the past due demand bucket type list of values includes Day, Week, and Period.
 

Past Due Demand Bucket Type The level of time, such as day, week, or month, to use to determine whether to include a past due
demand in a plan.

Past Due Open Sales Order Buckets Number of time buckets, such as three weeks or two months. Determines how much earlier than the
plan start date to use as a threshold for copying past due open sales orders into a plan.

Past Due Shipped Sales Order Buckets Number of time buckets, such as three weeks or two months. Determines how much earlier than the
plan start date to use as a threshold for copying past due shipped sales orders into a plan.

Past Due Forecast Buckets Number of time buckets, such as three weeks or two months. Determines how much earlier than the
plan start date to use as a threshold for copying past due forecasts into a plan.
The planning process aggregates all of the forecasts within the past due dates of the plan and places
the result at the plan start.
 

Understanding Past Due Demands When Forecast Is in Aggregate Buckets
When the forecast is at a higher level than day, you might see past due forecasts in your plan that are earlier than
expected.

For example, let’s say you’ve specified in the Past Due Demand section of plan options that the plan should include zero
past due forecast buckets. If your forecast is at a higher level than day, the entire forecast of the current forecast bucket
is copied into the plan. If the plan start date is a Wednesday, that means the entire week’s forecast is copied into the
plan.

You can eliminate including Monday’s and Tuesday’s forecast in the plan by doing both of the following:

• Select the Demand time fence control check box on the Supply tab, General subtab, in plan options.

• Set the item’s Demand Time Fence Days to zero.

When the Demand time fence control plan option is turned on in the plan, planning doesn’t consider forecast entries
within the demand time fence as demand.

If you want Monday’s and Tuesday’s forecast to be used in forecast consumption and then drop the remaining
unconsumed forecast, select the Consume forecast inside demand time fence check box. This check box is located on
the Supply tab, Forecast and Allocation subtab, in plan options.

Related Topics
• Forecast Processing

• Forecast Spreading

• Forecast Consumption

• Forecast Consumption View

• Review and Improve Your Demand Fulfillment
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Supply Plan Inputs  

Considerations for Configuring Supply Plan Attributes  
On the Plan Options page, Supply tab, General subtab, you can describe the generic attributes of a supply plan in the
Supply Plan Attributes section, such as:

• Demand time fence control

• Planning time fence control

• Assignment set

• Overwrite firm planned orders

• Netting rule

• Date used to plan sales orders

Plan Start Date and Plan End Date are read-only fields. The planning process calculates the plan end date from the
Plan Horizon Date that you define in the Scope tab. Plan End Date is the sum of Plan Start Date and Plan Horizon Date.

Demand Time Fence Control
When you enable this option, planning calculations ignore forecast demands before the demand time fence date and
considers only sales order demand when calculating gross requirements. Demand time fence is the time duration within
which the planning process doesn't consider forecast demand when calculating actual demand. The demand time fence
start date is the current date and the end date is specified by users.

Planning Time Fence Control
Planning time fence is the time duration within which the planning process doesn't alter the plan. For planned items
within the planning fence, the planning process doesn't reschedule in order due dates or create planned orders for the
item to satisfy net demand requirements. This applies to all order types including make, buy, and transfers.

However, the planning process can reschedule out or cancel an order when it determines that such an order creates
excess supply. For planned items outside the planning time fence, the planning process can generate suggestions to
create, reschedule, or cancel supplies in the plan.

The planning process calculates a planning time fence date for each planned item. The date is calculated based on the
values of the item attributes Planning Time Fence Type and Planning Time Fence Days. The date is calculated based on
the working days in the Organization Manufacturing Calendar. For all planned orders, the suggested due date can't be
earlier than the planning time fence date.

Assignment Set
Assignment set includes the sourcing rules (hierarchy) and bills of distribution (BOD) for material flow within the supply
chain. If you have already created assignment sets, you can select the required assignment set from the drop-down list.
You can create an assignment set in Manage Assignment Sets from the Tasks panel drawer.

Overwrite Firm Planned Orders
Use this option to determine whether firm planned orders are retained between plan runs. When you select All from
the drop-down list, the planning process overwrites all entries, planned and firm planned, from the current material
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plan. When you select None from the drop-down list, the planning process doesn't overwrite any firm planned orders.
However, it overwrites any suggested planned orders that isn't firm.

Netting Rule
This option is available when the project-specific supply planning is enabled for your enterprise. You use this option to
associate an attribute-based netting rule to your supply plan.

You create and manage your project netting rules on the Manage Attribute-Based Netting Rules page. You can access
the Manage Attribute-Based Netting Rules page from the Plan Inputs, Supply Planning, or Demand and Supply Planning
work area.

When you associate a netting rule to your plan, the planning process nets and shares supplies at the project group,
project, or project and task levels. Netting of supplies depends on the netting sequences that you define in your netting
rule.

Date Used to Plan Sales Orders
The Date Used to Plan Sales Orders option enables you to plan customer orders by either the scheduled ship date or by
the customer-requested ship date. This option is available for constrained and unconstrained supply plans and demand
and supply plans.

Schedule ship date: The planning process plans supplies based on the sales order line scheduled ship date.

Requested ship date: The planning process plans supplies based on the request date on the sales order line and
populates the suggested due date based on the following:

• If the order date type on a standard sales order line is Ship Date, then the planning process populates the
Suggested Due Date the same as the Requested Ship Date.

• If the order date type on a standard sales order line is Arrival Date, then the planning process populates the
Suggested Due date as the Requested Arrival Date after reducing the transit time from it and adjusting the date
by the appropriate calendar.

• If the sales order is a drop ship sales order, the Suggested Due Date on the sales order line is the Scheduled
Arrival Date. Drop ship purchase orders are aligned with schedule arrival dates, and planning by request date
can cause unnecessary reschedules on drop ship purchase orders. Forecasts are still consumed based on the
requested ship dates.

Note:  You must provide forecast dates that match your choice of the Date Used to Plan Sales Order plan option. For
example, if you select Requested Ship Date in the plan option, then you must ensure that the forecast dates are in
terms of the requested ship dates.

Related Topics
• Time Fence Options

• How the Planning Time Fence Date Is Calculated

Automatic Release Options  
Automatic release uses scheduled processes to release planned orders automatically after the plan run completes.
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The following options are available in the Automatic Release Parameters section on the Plan Options page, Supply Tab,
General subtab in one of the work areas for Oracle Fusion Cloud Supply Chain Planning:

• Release planned orders automatically

• Include rescheduled and canceled supplies in automatic releases

• Include rescheduled supplies in automatic releases

To navigate to the Automatic Release Parameters section, follow these steps:

1. On the Plan Options page, click the Tasks panel tab.
2. In the Tasks panel tab, click Manage Plans.
3. In the Search area, search for your plan.
4. Select the plan from the displayed search result.
5. Click Actions, and then click Edit Plan Options.
6. On the Plan Options page, click the Supply tab.

The General subtab appears. The Automatic Release Parameters section is a part of this tab.

Release Planned Orders Automatically
To release planned orders automatically, you must perform these steps before you run the plan:

• Select the Release planned orders automatically check box on the Plan Options page, Supply Tab, General
subtab.

• Select the Refresh with current data option on the Parameters tab in the Run Plan dialog box.

The planned orders are automatically released after the run plan is successful.

For a demand and supply plan, replenishment plan, or supply plan, the selections in the Automatic Release Parameters
section aren't copied when you copy a plan. The planning process won't release planned orders when you use the
duplicated plan to perform simulations.

Note:  Release time fence is an item-organization attribute and isn't defined in plan options.

Include Rescheduled and Canceled Supplies in Automatic Releases
When you select the Include rescheduled and canceled supplies in automatic releases check box, the planning
process automatically releases rescheduled and canceled supplies. This check box is available only if you selected the
Release planned orders automatically check box.

Note:  The Include rescheduled and canceled supplies in automatic releases check box isn't available in the
Replenishment Planning work area.

Include Rescheduled Supplies in Automatic Releases
When you select the Include rescheduled supplies in automatic releases check box, the planning process
automatically releases purchase orders and transfer orders that aren't firm and that were rescheduled during the
bottom-up phase of multiechelon replenishment planning. This check box is available only if you selected the Release
planned orders automatically check box.

Note:  The Include rescheduled supplies in automatic releases check box is available in only the Replenishment
Planning work area.
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Related Topics
• How Replenishment Orders Are Automatically Released

• Rescheduling of Orders During Bottom-up Phase of Multiechelon Replenishment Planning

General Parameters for Advanced Supply Options  
Use the General Parameters section in the Supply: Advanced Options dialog box to configure the following supply plan
options:

• Horizon for average daily demand

• Include scheduled receipts in use-up calculation

• Include drop ship demands and supplies

• Plan external manufacturer supplies

• Don’t consider in-transit supplies as firm

Don’t Consider In-Transit Supplies as Firm
By default, supplies that are in transit and shipments that are in receiving are considered firm. However, if you select the
Don’t consider in-transit supplies as firm check box in the Supply: Advanced Options dialog box, then the plan will
consider them as not firm and can reschedule these supplies as needed to meet demand.

The benefits of treating in-transit supplies as not firm are elimination of redundant new planned order generation to
meet the supply shortfalls within the in-transit time fence and reduction of excess inventory by using it to meet the
earlier demand. For example, if the in-transit supply is coming on week 4 and demand is on week 2, then with this
option selected, in-transit supplies are treated as not firm and are rescheduled to meet the earlier demand without
generating an extra planned order.

The Don’t consider in-transit supplies as firm option is supported for both unconstrained and constrained supply
plans. In constrained plans, the related Enforce lead times for in-transit supplies option is enabled only if the Don’t
consider in-transit supplies as firm option is selected. In unconstrained plans, the Enforce lead times for in-transit
supplies option is always disabled.

Access the General Parameters section from a Supply Planning, Demand and Supply Planning, or Planning Central work
area.

Use these steps to navigate to the General Parameters section in the Supply: Advanced Options dialog box.

1. Open a plan:
a. In a Supply Planning, Demand and Supply Planning, or Planning Central work area, click the Tasks panel

drawer.
b. In the Tasks panel drawer, click Manage Plans.
c. In the Search area, search for your plan.
d. Select the plan from the displayed search result.

2. Click Actions and then click Edit Plan Options.
3. On the Edit Plan Options page, click the Supply tab.
4. On the General subtab, click Select Advanced Options.

The Supply: Advanced Options dialog box opens, which includes the General Parameters section.
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Related Topics
• Horizons for the Average Daily Demand

• Why You Include Drop Ship Demands and Supplies in Supply Chain Planning

Horizons for the Average Daily Demand  
You use Average Daily Demand to calculate Projected Available Balance: Days of Cover. Specify a value greater than zero
(0). The default value is seven. You can configure the average daily demand in the Supply: Advanced Options dialog box.

Why You Include Drop Ship Demands and Supplies in Supply
Chain Planning  
When you select the Include drop ship demands and supplies option in the Supply: Advanced Options dialog box, all
drop ship demands and supplies for planned source systems are included in the planning process.

Supply chain planning supports only one source system per plan. Item-organization attributes for the drop ship
validation organization are included by the snapshot. Drop ship validation organization is defined in the Organization
tab of manage supply network. If you don't select this option, the planning process removes drop ship demands and
supplies from the plan.

Supplier Capacity Options  
You use the Supplier Capacity Parameters section to configure the following options on the Edit Plan Options page in
one of the Supply Chain Planning work areas:

• Consume supplier capacity with purchase order

• Supplier capacity accumulation multiplier

Consume Supplier Capacity with Purchase Order
When you select the check box, the planning process consumes supplier capacity with all purchase orders. When you do
not select the check box, the planning process consumes supplier capacity with planned orders.

Supplier Capacity Accumulation Multiplier
Use this option to set the date for the planning process to begin the supplier capacity accumulation. You provide a
number which acts as a multiplier of the Supplier Item Processing Lead-time. The number must be greater than zero.
Supplier capacity is the number of units per day for a specific item that the supplier can produce. To decide the date, the
planning process uses the following formula for supplier capacity accumulation:

[Multiplier *(multiplication symbol) Processing lead time] + 1

For example, if the multiplier = 2 and the processing lead time = 7 days, then the supplier capacity accumulation begins
on day 15.
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To navigate to the Supplier Capacity Parameters section, follow these steps:

1. On the Edit Plan page, click the Tasks panel drawer.
2. In the Tasks panel drawer, click Manage Plans.
3. In the Search area, search for your plan.
4. Select the plan from the displayed search result. Click Actions and then click Edit Plan Options.
5. On the Edit Plan Options page, click the Supply tab.
6. On the General tab, click Select Advanced Options.

The Supply: Advanced Options dialog box opens, which include the Supplier Capacity Parameters section.

Related Topics
• How You Define the Approved Supplier List for Supply Chain Planning

Release Recommendation Options  
Use the Release Recommendations Parameters section in the Supply: Advanced Options dialog box to configure the
following supply plan options:

• Compression days tolerance for automatic release

• Requisition load group by

• Transfer load group by

• Released only by user

Access the Release Recommendations Parameters section from a Supply Planning, Demand and Supply Planning,
Replenishment Planning, or Planning Central work area.

Compression Days Tolerance for Automatic Release
Use this option to indicate the number of compression days allowed for the automatic release of planned orders. The
number of compression days applies only to automatic release of planned orders and recommendations. Compression
days means the number of days reduced between the start date and due date as suggested by the planning process.

The Compression Days Tolerance for Automatic Release field isn't available in the Supply: Advanced Options dialog
box for a replenishment plan.

Requisition Load Group By
Use this option to indicate the requisition load group when loading requisitions to purchasing. For each option, except
All, the planning process creates one line for each planned order within each requisition.

• All: The planning process creates one purchase requisition for all recommended orders.

• Item: The planning process creates one purchase requisition for each item.

• Buyer: The planning process creates one purchase requisition for each buyer.

• Supplier: The planning process creates one purchase requisition for each supplier.

• Category: The planning process creates one purchase requisition for each item category.

• Location: The planning process creates one purchase requisition for each location.
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• Project: The planning process creates one purchase requisition for each project. This option is available only
when the project-specific supply planning is enabled for your enterprise.

Transfer Load Group By
Use this option to indicate the transfer load group when loading transfers to logistics. The value of Transfer Load
Group By determines how the actual transfer order is created.

• All: The planning process creates all transfers in one transfer order.

• Source and destination and ship date: The planning process creates one transfer order for each Ship From
and Ship To organization, and each ship date.

• Source and destination, shipping method and ship date: The planning process creates one transfer for each
Ship From and Ship To organization pair, and shipping method and ship date.

Released Only by User
Use this option to specify whether to restrict implementation of planned orders and recommendations to the current
user. If you enable this option, the planning process implements only those planned orders and recommendations
that the current user has marked. If you disable this option, the planning process implements planned orders and
recommendations that are marked by any user.

Note:  This option applies only to the manual release of planned orders.

Use these steps to navigate to the Release Recommendations Parameters section in the Supply: Advanced Options
dialog box:

1. Open a plan:

a. In a Supply Planning, Demand and Supply Planning, Replenishment Planning, or Planning Central work
area, click the Tasks panel drawer.

b. In the Tasks panel drawer, click Manage Plans.
c. In the Search area, search for your plan.
d. Select the plan from the displayed search result.

2. On the Edit Plan page, click Actions and then click Edit Plan Options.
3. On the Plan Options page, click the Supply tab.
4. On the General subtab, click Select Advanced Options.

The Supply: Advanced Options dialog box opens, which includes the Release Recommendations Parameters
section.

Time Fence Options  
Use the Time Fence Parameters section to configure the following options:

• Create time fence

• Create firm planned order time fence
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Create Time Fence
Select the Create time fence  check box to instruct the planning process to create a natural time fence for an item at the
completion date of the latest firm discrete job, purchase order, or transfer. The natural time fence indicates a new time
fence that's set at the latest date of firm supplies. Completion date means the due date of the supply.

The Create time fence check box and the Planning time fence control check box on the Plan Options page, Supply
tab, General subtab work together.

When Planning time fence control check box
is:

And when Create time fence check box is: Results

Not selected
 

Not selected
 

Planning time fences aren't used in the plan.
 

Selected
 

Not selected
 

Only planning time fence item-organization
attributes are used in the plan to create the time
fence.
 

Not selected
 

Selected
 

Only natural time fences are used in the plan.
 

Selected
 

Selected
 

The planning process considers both planning
time fence item-organization attributes and
natural time fences.
 
The latest date calculated by the planning
process, using either the planning time fence
item-organization attributes or the natural time
fence, is used as the planning time fence date in
the plan.
 

Create Firm Planned Order Time Fence
Use this option to instruct the planning process to create a natural time fence for an item at the completion date of the
latest firm planned order. Completion date means the suggested due date of the firm planned order.

Note:  To enable the Create Firm Planned Order Time Fence plan option, you must first select the Create time
fence check box on the General tab in the Supply: Advanced Options dialog box.

To navigate to the Time Fence Parameters section, follow these steps:

1. On the Edit Plan page, click the Tasks panel drawer.
2. In the Tasks panel drawer, click Manage Plans.
3. In the Search area, search for your plan.
4. Select the plan from the displayed search result. Click Actions and then select Edit Plan Options.
5. On the Edit Plan Options page, click the Supply tab.
6. On the General tab, click Select Advanced Options.

The Supply: Advanced Options dialog box opens, which includes the Time Fence Parameters section.
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Related Topics
• How the Planning Time Fence Date Is Calculated

How the Planning Time Fence Date Is Calculated  
Planning time fence date is an item attribute that's calculated by planning prior to generating any planned orders. The
suggested due date of a planned order is always greater than or equal to the planning time fence date.

Other dates, such as the suggested ship date, can be earlier than the planning time fence date.

You can view the planning time fence date (which is calculated by planning) and the planning time fence days (an input
into calculating the planning time fence date) from the Items user interface.

To explain how the planning time fence date is calculated, let's use the following setup data:

• Use the Organization Manufacturing Calendar, where Monday through Friday are working days.

Sunday Monday Tuesday Wednesday Thursday Friday Saturday

Day 1
 

Day 2
 

Day 3
 

Day 4
 

Day 5
 

Day 6
 

Day 7
 

Day 8
 

Day 9
 

Day 10
 

Day 11
 

Day 12
 

Day 13
 

Day 14
 

Day 15
 

Day 16
 

Day 17
 

Day 18
 

Day 19
 

Day 20
 

Day 21
 

• Plan start date = Day 3

• Planning time fence days = 10 days

In this example, the planning time fence date is Day 17, because the planning time fence days (10 working days) are
added to the start date (Day 3).

Note that unconstrained planning will push out the suggested due date of a planned buy order to ensure the dock date,
after accounting for postprocessing lead time, is a valid working day on the receiving calendar. For example, if the need-
by date is Day 17 and the postprocessing lead time is 12 days, then the suggested due date would be Day 18, to ensure
that the suggested dock date (due date minus postprocessing lead time) is on a valid working day (in this example, Day
2) in the plan.

Related Topics
• Time Fence Options

• Considerations for Configuring Supply Plan Attributes
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Order Modifier Options  
You can control the planning cycle time by deciding whether to use the order policies for an item in aggregate time
buckets, such as a week or period.

To control order policy enforcement in aggregate time buckets for supply plans, use the Order Modifier Parameters
section in the Supply: Advanced Options dialog box, General tab to configure the following options:

• Enforce order modifiers in aggregate time buckets

• Maximum number of planned orders per item-ORG per time bucket

For information on how order modifiers are applied to shrinkage, see the How Shrinkage Is Calculated topic.

Enforce Order Modifiers in Aggregate Time Buckets
Select the checkbox to enforce order modifiers in aggregate time buckets in constrained and unconstrained supply
plans. This plan option applies to aggregate time bucket types of Week and Period.

Maximum Number of Planned Orders per Item-ORG per Time Bucket
The maximum number of planned orders that the planning system can create in a planning time bucket for each item
and organization combination. The default value is 100. This plan option applies to all time bucket types (Day, Week, and
Period).

Related Topics
• Control Order Policy Enforcement in Aggregate Time Buckets

Control Order Policy Enforcement in Aggregate Time Buckets  
You can control the planning cycle time by deciding whether to use the order policies for an item in aggregate time
buckets, such as a week or period.

You will have shorter plan run times if you choose to not enforce order policies in aggregate time buckets. However, you
might have planned supply quantities aggregated for the entire time bucket. You can control order policy enforcement
for constrained and unconstrained supply plans by using the order modifier parameters in the Supply: Advanced
Options dialog box, General tab.

Let’s see how this functionality works. For our example, we have a Fixed Order Quantity of 50 that’s respected in the
weekly bucket.

• If you don’t select the Enforce order modifiers in aggregate time buckets check box, the order policy isn’t
enforced. You might have planned supply quantities aggregated for the entire time bucket.

Demand/Planned Orders Week 1 Week 2 Week 3

Demand 80 120 90

Planned Orders 80 120 90
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• If you do select the Enforce order modifiers in aggregate time buckets check box, the order policy is
enforced. When you enforce order modifiers in aggregate time buckets, you will have multiple planned orders in
each week. In our example, the Maximum Number of Planned Orders per Item-ORG per Time Bucket is set to 3.
You will have 2 planned orders for Week 1, 3 planned orders for Week 2, and 2 planned orders for Week 3.

Demand/Planned Orders Week 1 Week 2 Week 3

Demand 80 120 90

Planned Orders 50 + 30 50 + 50 + 20 50 + 40

Note that the last planned order in each bucket can be less than the Fixed Order Quantity.

Let’s use the following parameters to show you another example of how the control order policy enforcement in
aggregate time buckets functionality works.

• Enforce order modifiers in aggregate time buckets check box is selected

• Maximum Number of Planned Orders per Item-ORG per Time Bucket is set to 5

• Fixed Order Quantity is 2

• Forecast demand is 20

When you look at the Supplies and Demands table for your plan, you will see the following information for the item:

Order Type Order Quantity Uses Order Modifier

Planned Order 2 Yes

Planned Order 2 Yes

Planned Order 2 Yes

Planned Order 2 Yes

Planned Order 12 No

Forecast -20 n/a

In this example, the plan created 5 planned orders for the forecast demand of 20. The order quantity for the first 4
planned orders is 2, which respects the Fixed Order Quantity. However, the last planned order has a quantity of 12 to
satisfy the remaining balance of demand, which is 12.

The Uses Order Modifier column in the Supplies and Demands table is read-only and indicates whether the planning
process respected the order modifiers in aggregate time buckets. For the last planned order in our second example, the
planning process needed more than the fixed order quantity to satisfy demand, so the Uses Order Modifier column will
indicate No. Also, the Uses Order Modifier column is No if the Enforce order modifiers in aggregate time buckets
check box isn’t selected in the Supply: Advanced Options dialog box, General tab.

Related Topics
• Order Modifier Options
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Technical Control Parameters  
You can use multithreading to decrease the overall runtime of a supply plan.

In the plan options, navigate to the Supply: Advanced Options dialog box, Technical tab and select the Enable
multithreading check box. When selected, the planning process implements multithreading during the plan run.

Why You Disable or Enable Dimensions for Supply Plan Measures  
In your organization, you might not use all of the preconfigured dimensions to analyze your supply plans. To improve
system and application performance while working with your supply plans, you can decide which dimensions are
applicable to measures.

You can disable the Customer, Supplier, Demand Class, Order Type, and Exception Type dimensions to optimize data
volumes and improve query performance. The Organization, Item, Resource, and Time dimensions are always used and
you can't disable them.

When you disable a specific dimension, the planning engine preaggregates the related measures along that dimension.
For example, measures such as Revenue or Sales Order Value are computed by default at the most detailed level
of Organization, Item, Day, Customer Site, and Demand Class. However, this type of detailed analysis might not be
necessary. You can configure your plan to compute the measure at only the Organization, Item, and Day level and
ignore calculating the measure at the Customer Site and Demand Class levels.

Configure the dimensions in the Dimensions for Supply Measures section in the Supply: Advanced Options dialog box,
which you open from the Plan Options page, Supply tab. The Supply: Advanced Options dialog box is accessible only for
supply plans from a Supply Planning, Demand and Supply Planning, or Planning Central work area.

Note:  The dimension catalog that is configured in the Configure Planning Analytics task and specified in the
plan options governs the hierarchies that are available in a plan for any selected dimension. If any of the optional
dimensions are not selected in the dimension catalog, those dimensions are automatically disabled in the advanced
plan options.

Because tables are shared across work areas, the selector in pivot tables displays all dimensions (enabled and disabled),
and you can add a disabled dimension to a table or graph. In this case, the dimension does not show individual
members, but shows one aggregated row or column of All.

When you enable a supply plan for Oracle Transactional Business Intelligence (OTBI), the reports won't have any
members in the disabled dimensions of a supply plan.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

• Enable Plans for OTBI Reporting
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Supply Plan Options for Organizations and Schedules  
Use the Organizations and Schedules subtab on the Edit Plan Options page to configure subinventory netting, demand
and supply netting, and the forecast spreading calendar, depending on the organization for a supply plan.

You can also specify the demands that you want to consider in the supply plan.

Configure the supply plan options for organizations and demand schedules on the Plan Options page, Supply tab,
Organizations and Schedules subtab.

Organizations
The organizations are based on the organization level members that you specify on the Scope tab of the Plan Options
page. During data collection, the planning process collects the organization based on your configuration in the source
system.

Subinventory Netting: The subinventories are based on the organization. You can enable or disable the subinventory
netting for purchase orders, on-hand quantity, and work order assembly supply types. You can select or deselect the
listed subinventories under Enable Netting to include or exclude the subinventories from the supply plan. If you enable
the subinventory netting for a new subinventory in the source, the plan automatically includes the new subinventories
that are collected after the initial plan run.

For example, if the material is on hold for quality and is reworked upon, the work order shouldn’t be used in supply
planning. To exclude the work order from being considered in supply planning, deselect the Enable Netting check box
for the subinventory associated with the work order. The work order isn’t considered in supply planning.

Note:  The work order demand and work order resource requirement associated with a nonnettable work order are
considered for supply planning by default.

Demand and Supply Netting: Run plans with only demands or supply types depending on your requirement. You can
include or exclude sales orders, reservations, on hand, purchases, transfers, and work orders for each organization in
your plan. A new plan enables all the demand and supply netting options by default.

Forecast Spreading Calendar: Select a user-defined forecast spreading calendar for each organization.

• The supply planning process uses the calendar to spread aggregate forecast demand across daily buckets.

• If you don't specify any calendar at the organization level, then the supply planning process spreads the
aggregate forecast evenly across daily buckets.

• The planning process uses this calendar only when you select the User-defined calendar value for the Forecast
Spreading Calendar attribute in the Forecast Allocation and Consumption section. The Forecast Allocation and
Consumption section is available on the Plan Options page, Supply tab, General subtab.

Demand Schedules
Select the demands to include in the supply plan. If the plan type is demand and supply, the demand schedule is
automatically included in the supply plan. The supported types of demand schedules are:

• Demand (demand plan)
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• External (external forecast)

• Production (production plan used in manufacturing plan)

Demand Measures: Click Select to access the Demand Measures dialog box where you can select the following
measures:

• End Item Demand

• Option Demand

• Planning Percentage

The Select button for Demand Measures is enabled when the demand schedule type is Demand or Sales and
Operations. The Select button isn't available for an external demand schedule type.

Forecast Accuracy Measures: Click Select to access the Forecast Accuracy Measures dialog box where you can select the
following measures:

• Forecast Error Type for Nonintermittent Demand

• Measure for MAD or MAPE

• Measure for Intermittent Demand

• Measure for Average Interarrival Time

The Select button for Forecast Accuracy Measures is enabled when both of the following attributes are set on the Edit
Plan Options page, Safety Stock tab:

• Safety Stock Planning Method is set to Statistical safety stock for end items, none for all others.

• Forecast Error Type is set to Demand schedule specific.

Measure Levels: Select dimension levels at which to load the measure. If the demand schedule type is external or
production, then the measure level option isn't available.

Ship-to Consumption Level: Select a forecast consumption level for the local demand plan.

Related Topics
• Configure Measure Levels for Demand Schedules

How You Calculate Safety Stock Based on Multiple
Demand Schedules  
For supply plans or supply and demand plans, you can plan statistical safety stock for end items whose forecasts are
distributed across multiple demand schedules. The planning engine calculates safety stock based on forecasts in each
demand schedule.

The calculation uses either the measure values generated in each of the demand schedules or item-specific values
specified for each item and organization combination.

Select your demand schedules in the Demand Schedules section on the Plan Options page, Supply tab, Organizations
and Schedules subtab. The planning engine uses the forecasts and other measures from these demand schedules to
plan statistical safety stock for the respective item-organization combinations.
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The planning engine uses each demand schedule to drive safety stock calculations for the items that belong to that
demand schedule. If the same item is present in two or more demand schedules, the planning engine selects only one
demand schedule to use for safety stock calculation. Oracle recommends that you ensure that forecasts for an item in
an organization are restricted to just one demand schedule.

Related Topics
• Parameters for Safety Stock Calculation

Configure Measure Levels for Demand Schedules  
You can select dimension levels in the Measure Levels dialog box at which to load measures into a plan. After
configuring your measure levels for demand schedules, run your demand plan to generate the forecasts.

Next, run the supply plan and then review the Supplies and Demands table.

You can configure dimension levels for a supply plan or a demand and supply plan from the Planning Central, Supply
Planning, or Demand and Supply Planning work area. To access the Measure Levels dialog box, navigate to the Plan
Options page, Supply tab, Organizations and Schedules subtab. In the Demand Schedule section, click the Select button
in the Measure Levels column.

Note:  If the demand schedule type is External or Production, then the Select button under the Measure Levels
column isn't available.

In the Measure Levels dialog box, you can configure measure levels for the following dimensions:

• Time: The time hierarchy and level choices are based on the planning calendar used for the demand plan. You
set the planning calendar on the Plan Options page, Scope tab, in the Plan Parameters section.

If the demand plan uses a hybrid time hierarchy, the available levels are parent levels of the Hybrid time level
for the selected hybrid time hierarchy. For a manufacturing hybrid hierarchy, the available levels are Week and
Period. For a Gregorian hybrid hierarchy, the available levels are Month, Quarter, and Year. For a fiscal hybrid
hierarchy, the available levels are Month, Quarter, and Year.

• Demand Class: If you leave the Demand Class level and Customer level blank and select Day for the Time level,
then the forecast that comes from the demand schedule into Supply Planning will be aggregated at the item-
organization-day level.

• Customer: If you want an aggregated forecast by day or month, leave the customer level blank.

If you select the Customer Site level, the forecast for each day is broken down into forecasts for each customer
site in the demand plan. For example, you have 20 customer sites for your demand plan and select the
Customer Site level and Day for the Time level. You will see 20 forecasts for each day in the Supplies and
Demands table.

• Organization: The organization hierarchy and level are fixed for the organization dimension. The Enterprise
hierarchy only supports the Organization level.

• Product: The product hierarchy and level are fixed for the product dimension. The Product hierarchy only
supports the Item level.
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Related Topics
• Supply Plan Options for Organizations and Schedules

Run a Supply Plan or an Integrated Plan  
Run a supply plan or an integrated plan to generate forecasts and safety stock levels and to create replenishment.

An integrated plan includes both a demand and a supply plan. You can run a supply plan or a demand and supply plan
from the Supply Planning, Planning Central, or Demand and Supply Planning work areas.

When you run a supply plan or an integrated plan, you can specify the scope of the plan that you want to run. You can
decide whether to refresh the plan input data before running it. Also, you can run the plan immediately or you can run
the plan in the background at a set time or on a repetitive schedule, such as daily or weekly.

Note:  For a constrained supply plan, you can only run the plan in Batch mode.

After you create a supply plan or a demand and supply plan, you must run the plan to generate the data. In the Run Plan
dialog box, Parameters tab, run plan options are sequenced in the order of operations: scope, demand, and supply. You
also have an option to recalculate safety stock levels. The forecasting process runs first, safety stock is calculated next,
and then the output is used for supply planning calculations. You can configure the following options, depending on the
plan type:

• Data Refresh Options

• Scope Options

• Demand Plan Run Options

• Supply Plan Run Options

Data Refresh Options
The following data refresh options are available:

• Do not refresh with current data: Select this option to run your plan with no changes to demand, including no
advancement of the plan start date.

• Refresh with selected current data: Select this option to partially refresh your data. You can refresh
transaction data and some reference data without performing a full refresh. For example, selectively refreshing
Demand history and measures and Forecasts covers the following scenarios:

◦ Demand history and measures: You have reloaded external or third-party forecasts and the plan must
reflect these recent updates (for example, Sales Forecast, Marketing Forecast, Financial Forecast, and
Shipments Forecasts).

◦ Forecast: You have changed the input measure level on the Plan Options page, Supply tab, Organizations
and Schedules subtab, in the Demand Schedules section. For example, you copy a plan, change the
input measure level to another forecast within the same plan, and want to rerun the plan. In this scenario,
specify the Refresh with selected current data option for Forecast. Because you changed the plan
options but didn't edit the plan, the plan doesn't require a full refresh.

• Refresh with current data: Select this option to refresh the complete plan with the latest collected data. When
you run the plan for the first time, this is the only data refresh option available and it's selected by default. If
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you select this option for an integrated plan (Demand and Supply Plan type), the Plan demand and Plan supply
check boxes in the Scope Options section are selected by default and can't be deselected.

Scope Options
Scope options restrict the focus of the replan. The following scope options are available:

• Plan demand: Select to forecast demand when running a plan. If you selected Refresh with current data in
the Data Refresh Options section, then this option is selected by default for an integrated plan. This option is
available for Demand and Supply Plan types in the Planning Central and Demand and Supply Planning work
areas.

• Approve plan: Select to approve the plan during the plan run. This option is available for Demand and Supply
Plan types in the Demand and Supply Planning work area.

• Recalculate safety stock: Select to recalculate safety stock quantities when running a plan. This option is
available for Supply Plan or Demand and Supply Plan types in the Planning Central, Supply Planning, and
Demand and Supply Planning work areas.

The Recalculate safety stock check box is available only when one of the following safety stock planning
methods is selected on the Plan Options page, Safety Stock tab:

◦ Statistical safety stock for end items, none for all others

◦ Statistical for end items, user-specified for all others

• Plan supply: Select to have the planning process calculate only the supply. If you selected the Refresh with
current data check box in the Data Refresh Options section, then this option is selected by default for an
integrated plan. This option is available for Demand and Supply Plan types in the Planning Central and Demand
and Supply Planning work areas.

• Archive plan: Select to archive data from the plan. This option is available for Supply Plan or Demand and
Supply Plan types in the Supply Planning and Demand and Supply Planning work areas.

Demand Plan Run Options
The Demand Plan Run Options section is available for Demand and Supply Plan types, but isn't available for Supply Plan
types.

Forecast Profiles: Select the forecasting profiles that you want to include as part of the plan. If you don't select a
forecasting profile, then the forecasting process doesn't run.

Include details of forecast methods: Select to specify whether to provide details of the forecast methods that make up
the forecast. This option is available for Demand and Supply Plan types in the Demand and Supply Planning work area.

Include details of causal factors: Select to specify whether to provide details of the causal factors that make up the
forecast. This option is available for Demand and Supply Plan types in the Demand and Supply Planning work area.
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Supply Plan Run Options
The Supply Plan Run Options section appears for unconstrained supply plans but not for constrained supply plans. You
can only run constrained supply plans in batch mode. The following supply plan run options are available:

• Interactive: Select this option to run a plan into memory, without saving the plan to the database. If a typical
plan is scheduled to run on weekends, you can use the Interactive option to run the plan during the week. If you
select Interactive, the Schedule tab is disabled and the plan is set to run as soon as possible.

Note:  Interactive option isn't available for a constrained supply plan.

• Batch: Select this option to run the plan per a schedule. When you select this option, the Schedule tab becomes
available where you can set up when to run the plan.

Use Batch to save all plan data to a database, including calculated totals. To save a plan to a database, you must
run the plan at least once. The plan will be available for analysis without loading into memory.

Run a Supply Plan or an Integrated Plan
Use these generic steps to run a supply plan or an integrated demand and supply plan:

1. Open the Run Plan dialog box:

a. From a Supply Chain Planning work area, click the Plans panel tab and expand the Plans list.
b. Select the plan that you want to run, click Actions, and then select Run.

2. In the Run Plan dialog box, Parameters, tab, expand Details to review the plan options:

a. In the Data Refresh Options section, review the options and make appropriate selections.

Note:  When you run the plan for the first time, you must select Refresh with selected current data.
This option refreshes historical data, imports sales orders, and advances the plan start date to align
with the current date.

b. In the Scope Options section, select the options that you want for the plan run.
c. For demand and supply plan types: In the Demand Plan Run Options section, select the appropriate

demand plan run options, including the forecasting profiles that you want to include as part of the plan
run.

d. For unconstrained supply plans: In the Supply Plan Run Options section, select the options that you want
for the plan run.

3. If you selected Batch in the Supply Plan Run Options section, or for constrained supply plans, click the Schedule
tab to set up the frequency parameters:

a. To run the plan immediately, select As soon as possible.
b. To run the plan in the background at a set time, select Using a schedule and then select a Frequency,

such as Daily or Weekly.
4. Click OK to run the plan.
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Publish Plan Data  
You can publish data for a plan in the Demand Management, Demand and Supply Planning, Planning Central,
Replenishment Planning, Sales and Operations Planning, or Supply Planning work area to a compressed file.

You can then use the file for data integration between your Supply Chain Planning application and other Oracle or
external applications.

By submitting a scheduled process from your Supply Chain Planning work area or the Scheduled Processes work area,
you can publish the data in a pivot table within your plan to a file on the content server of Oracle WebCenter Content.

Using APIs of Oracle's ERP integration service for automating the data integration between your Supply Chain Planning
Application and an external application, you can submit the scheduled process, check its status, and get the details of
the published document.

The file name is in the <plan name>_<pivot table name>.zip format.

Publish Plan Data from a Supply Chain Planning Work Area
Here's how you can publish data for your plan from your Supply Chain Planning work area:

1. Do one of the following to open the Publish Data dialog box:

◦ On the Manage Plans page, select the plan and click Actions > Publish Data.
The Publish Data dialog box opens.

◦ Open your plan and click Actions > Publish Data.
The Publish Data dialog box opens.

2. Optionally, enter submission notes for your scheduled process.
3. On the Parameters tab, optionally, select the Append request number to output file name check box.

Selecting this check box results in the request number being appended to the file name, which enables
easy identification of the file on the content server. The resulting file name (<plan name>_<pivot table
name>_<request number>) is also used as the document title.
If you don't select this check box, the document title is PUBLISHPLANDATA.

4. In Table Name, select the pivot table of your plan for which you want to publish data.
The available tables are enabled for the work area of the plan, and you have the required access to these tables.

5. In Source System, select the source system that's specified on the Scope tab of the Plan Options page for the
plan.

6. On the Schedule tab, specify whether you want to run the process as soon as possible or according to a
schedule.
If you publish the file according to a schedule, you can specify the frequency and start and end dates for the
process.

7. Click Submit.
The Status dialog box opens and displays the request number. Make a note of this number and then click OK.
You can use this number to search for the result of your request in the Scheduled Processes work area.
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If you appended this number to the compressed file's name, you can use this number to search for the file in
the File Import and Export work area. You can then download and check the file.

Publish Plan Data from the Scheduled Processes Work Area
Here's how you can publish data for your plan from the Scheduled Processes work area:

1. On the Overview page, click the Schedule New Process button.

The Schedule New Process dialog box opens.
2. In Name, select the Publish Plan job, and click OK.

The Process Details dialog box opens.
3. To be notified when the process ends regardless of the result, select the Notify me when this process ends

check box.
4. Optionally, enter submission notes for your scheduled process.
5. On the Parameters tab, in Plan Name, select your plan.
6. Optionally, select the Append request number to output file name check box.

Selecting this check box results in the request number being appended to the file name, which enables
easy identification of the file on the content server. The resulting file name (<plan name>_<pivot table
name>_<request number>) is also used as the document title.

If you don't select this check box, the document title is PUBLISHPLANDATA.
7. In Table Name, select the pivot table of your plan for which you want to publish data.

The available tables are enabled for the work area of the plan, and you have the required access to these tables.
8. In Source System, select the source system that's specified on the Scope tab of the Plan Options page for the

plan.
9. To set a schedule for your request and notify other users about the result, click the Advanced button.

The Schedule and Notification tabs are displayed.

◦ On the Schedule tab, specify whether you want to run the process as soon as possible or according to a
schedule.

If you publish the file according to a schedule, you can specify the frequency and start and end dates for
the process.

◦ On the Notification tab, specify the recipients to whom result notifications should be sent and the
conditions under which the notifications are sent.

10. Click Submit.

The Confirmation dialog box opens and displays the process number. Make a note of this number, and click OK.

You can use this number to search for the result of your request in the Scheduled Processes work area.

If you appended this number to the compressed file's name, you can use this number to search for the file in
the File Import and Export work area. You can then download and check the file.
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Supply Planning Concepts  

Daily Buckets in Supply Planning  
The planning process always plans in daily buckets because it considers that demands are due at the end of the day.
The planning process doesn't plan demands and supplies at weekly, period, or monthly level.

Demands and supplies are balanced at the end of the day. The shortages or excess in demand and supplies are carried
over to the next day. However, tables and graphs can aggregate daily planning results into weekly, period, or monthly
level.

Demands and supplies don't have time stamps. The planning process considers that the capacity during the day can be
used for resource or supplier requirements scheduled for the same day. If a planned work order can be completed in less
than a day, it's scheduled on the same day as the demand due date. Also, if the work order is less than a day, the start
date and the end date are same.

The planning process supports three calendars for aggregation in the planning output:

• Manufacturing calendars: Supports aggregation by week and period.

• Fiscal calendars: Supports aggregation by week and period in the tables.

• Gregorian calendars: Supports daily bucketing and aggregation by calendar month. The Gregorian calendar
doesn't support bucketing by week.

Requirements Explosion for Make Items  
When you run a supply plan or a supply and demand plan, one of the processes that take place is requirements
explosion for make items.

The supply planning process reviews the supply chain item structure to ensure that there is enough supply on hand
and on order to meet demand. The shortage of one item creates a demand for the items one level below it in the
supply chain item structure. This process of analyzing the demand of individual components that make up an item and
creating a demand for those components is known as requirements explosion.

The planning process uses the work definition of make order items to determine component requirements. The
planning process makes suggestions accordingly to replenish the components that are in low supply to make the supply
of the make order item easier.

Settings that Affect Requirements Explosion for Make Items
Supply planning respects component effective dates. The planning process determines a new date for the planned
make order after it takes into consideration the following:

• The components that are part of the work definition

• The operations that are part of the work definition

• The component effective dates for the make item on or before the order start date of the planned order

• The operation effective dates for the make item on or before the order start date of the planned order
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Note:  Requirements explosion is performed only for make items. If you mark a make item as a buy item, the planning
process does not suggest replenishing any of its components.

How Requirements Explosion for Make Items is Calculated
Consider the following scenario:

• Item A is a make order for which there is a sales order of 100.

• It takes two of item B and three of item C to make one of item A.

The planning process explodes the demand to a component level and creates a demand of 200 for item B and 300
of item C. The demand quantity on an item is the shortage of its parent item multiplied by the usage of the child
component in the parent item.

Related Topics
• How Resource Scheduling Is Done

How Resource Scheduling Is Done  
Resource scheduling can be calculated when you know the planned make order duration. The planning process uses
lead times, both fixed and variable, to calculate planned make order duration. For existing work orders, the lead time is
the duration of the work order.

The planning process does not change the duration of the work order. You can also manually set fixed and manual lead
times.

Tip:  If you manually configure the lead times, then set larger values for a conservative planning result. Set smaller
values for an aggressive planning result.

For example, suppose the fixed lead time = 1

Variable lead time = 0.2.

The planned order size = 10 units

Make planned order lead time = fixed + variable multiplied by order size = 1 + 0.2 multiplied by 10 = 1 + 2 = 3 days

Demand due date = Day 5

Make planned order: Suggested start date = Day 2; Suggested due date = Day 5

The calculation assumes that day 5 ends at 23:59 and so one full day of lead time pushes the start date to day 4 at 23:59.
So in the example, the 3-day lead time pushes the start date to day 2.

The following calculations are used to calculate planned make order duration, routing resource duration, operation
duration, and resource duration"

• Planned make order duration: The planned make order quantity is determined by total quantity of demands
and order modifiers. Total make order lead time (days) = fixed lead time + quantity multiplied with variable lead
time.
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• Routing resource duration: Resource requirement (in hours) is calculated for item-based resource usages.
Resource requirement = Quantity multiplied by Usage hours. Operation duration (in hours) is calculated by
adding each resource requirement adjusted for any simultaneous resources. Total Routing Duration = Sum of
the operation duration (hours).

• The operation duration and resource duration calculations are shown in the following illustrations. Each
operation and resource requirement is spread over the total make lead time.

The following figure illustrates the calculation for operation duration.

The following figure illustrates the calculation for resource duration.

For a planned make order, the planning process performs the following task:

• Calculates duration based on fixed and variable lead times.

• Calculates required resource hours from the work definition.

• Spreads the required resource hours evenly across the calculated work order duration. If the work order has
multiple operations, the duration for each operation is calculated and the resource hours are spread out within
the operations for assigned resources.

Rescheduling Existing Work Order
For an existing work order, you can either continue with the existing schedule or change the schedule and assign new
dates. If the work order is not rescheduled, then the planning process:

• Does not change the work order start and end dates

• Does not change the operation and resource requirement start and end dates

• Spreads each resource usage evenly over the days of the resource requirement

For example, if the resource requirement start date is Day 5 and end date is Day 6, and resource usage is 14 hours, then
the planning process allocates 7 hours on Day 5 and 7 hours on Day 6. If you reschedule a work order, the job duration is
preserved and does not change. The lead time for each operation and for each resource requirement remain the same.
Only the start and end dates change.

Planning calculations follow these guidelines while rescheduling a work order:

• Allocate the same number of days for work order start and end dates. For example, if the end date is moved by
two days, then move the start date by two days.

• Allocate the same number of days to each operation and resource requirement date. Using the previous
example, move each operation and resource requirement date by two days.

• Spread each resource usage evenly over the days of the resource requirement. For example, if the resource
requirement start date is Day 5 and end date is Day 6, and resource usage is 14 hours, then allocate 7 hours on
Day 5 and 7 hours on Day 6.
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• Adjust for days on and days off by increasing or decreasing the job, operation, and resource dates. Depending
on whether days off are included or removed from the work order, the relative working days remain the same
before and after the move. For example, the work order duration is 5 days, starting on Friday and ending on
Tuesday including two nonworking weekend days. If the work order is rescheduled to start on Monday, the new
end date becomes Wednesday. If any adjusted dates for the work order are pushed into the past, then place
the dates on Day 1 of the plan. If a part of the work order is completed, then only the open quantity of the work
order is scheduled. If some components and resources are consumed by the work order, then only the open
component requirements and open resource usages are planned in the planning process.

Related Topics
• How Resource Efficiency and Resource Utilization Are Calculated

• How Backward Scheduling and Order Dates Are Calculated

How Resource Efficiency and Resource Utilization Are Calculated  
While scheduling resources, the planning process uses resource efficiency and utilization that you specify at the
resource level. Resource efficiency is a measure (expressed in percentage) of the actual output to the standard output
expected.

Resource efficiency determines the time that a resource takes to complete a task.

For example, if you expect a resource having an efficiency of 100% to complete a task in 12 hours, the resource having
an efficiency of 50% would take 24 hours to complete the task. Effective usage of a resource is the ratio of resource
hours as specified in routing (theoretical usage) to efficiency.

The following figure illustrates the calculation used for actual resource usage.

Resource utilization is a measure (expressed in percentage) of how intensively a resource is used. For example,
a resource may take frequent breaks or you may assign maintenance tasks to the resource. This indicates that a
percentage of the resource time isn't available for the task. The actual usage is the ratio of the resource hours as
specified in routing to the product of efficiency and utilization. For example, a routing has a resource requirement for 2
hours. The efficiency and utilization of the resource is expected to be 90% and 75%, respectively. Therefore, the actual
resource usage is calculated as 2.96 hours.

Actual Resource usage = (1 each multiplied by 2 hours per resource) divided by (90% multiplied by 75%) = 2 hours
divided by 0.675 = 2.96 hours

For a Make Order to manufacture 50 units, using the same routing as described in the previous example, you have:

Actual Resource usage= (50 each multiplied by 2 hours per resource) divided by (90% multiplied by 75%) = 100 hours
divided by 0.675 = 148.15 hour

Considering the actual resource efficiency and utilization, the planning process generates a plan. If an additional
resource usage is required to satisfy a demand, the planning process recommends inflating the resource usage.
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Configure the Precision of Resource Usage Calculations
You can configure the level of decimal precision to which resource usage calculations are rounded to accurately
calculate resource requirements in supply planning. Use the Decimal Precision for Resource Usage profile option to
set the decimal precision to up to 9 digits.

Related Topics
• How Resource Scheduling Is Done

• Manage Planning Profile Options

Sourcing Allocation Splits  
The planning process creates supplies based on the sourcing splits (rank one only). Supply planning uses split
percentages that can be specified on sourcing rules.

You can rank the sources of supply that are named in the rules and bills, giving one priority over another when the
planning process generates recommendations. You can also assign sourcing percentages to these sources, which lets
you to allocate a portion of the total orders to each source. Sourcing allocation considers all supply sources: buy, make,
and transfer.

If there are no order modifiers, then when supplies are required on a day, the planned orders for the day are split into as
many planned orders as required to meet the rank one sourcing allocation splits. If there are item-attribute or supplier-
order modifiers, the supply is created for the highest allocation split percent source (rank one) respecting the order
modifiers. Then a supply is created for the next source, again respecting the order modifiers. The supply sources are
used in allocation percent order. As each order is created, the next lower allocation percentage source is considered.
If all rank one sources are used, then an order is created for the remaining top allocation percent source again and so
forth through the top rank sources. This is repeated until enough supply is created.

The calculation attempts to balance supply sources over the plan horizon to meet the rank one allocation percents. If
supplies don't respect the split due to existing purchase orders or order modifiers, then the planning process select
sources each day to bring the plan horizon supplies into alignment with the sourcing splits. You have to create supply
on the source that leads to the lowest deviation of the cumulative sourcing split from the split percentages specified in
the sourcing rule. The planning process doesn't consider historical receipts when calculating sourcing splits. Only open
purchase orders, transfer orders, and make orders are considered.

The following formula is used to calculate the sourcing split each day:

If Total Supply multiplied by Source A allocation percentage > Supply for Source A, then create a new planned order for
Source A (respecting order modifiers) so that supply for Source A > or = Source A allocation percentage multiplied by
Total Supply, until Total Supply > or = Total Demand.

Sourcing allocation and effective dates: If a sourcing rule becomes effective on a certain date, then the planning process
respects the allocation percentages from the effective date and after. The planning process doesn't consider allocation
that has happened before the effective date.

For example, a plan runs on March 1st and the sourcing rule is:

• Effective January 1st until May 31st: 40 % Acme, 60 % Business World

• Effective June 1st: 50 % Acme, 50 % Consolidated
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Starting June 1st, the allocation process splits 50/50 between Acme and Consolidated. The allocation process ignores
the history before the effective date. The allocation process doesn't consider whether Acme has 40% or 60% of the
orders before June 1st.

Reservations in Supply Chain Planning  
You can collect information about all reservations that are created by the inventory processes and view them in one of
the Supply Chain Planning work areas. You can view the amount of supply that is pegged to order fulfillment lines.

Oracle Fusion Cloud Supply Chain Planning doesn't create reservations; it just displays all the reservations that are
created by the inventory processes. You cannot edit the quantity or kind of supply that is reserved to a sales order in the
configurable planners' workbench.

The following types of supply can be reserved to a sales order in the inventory:

• On hand inventory

• Work orders

• Purchase orders

• Transfer orders

Multiple sources and quantities of supply can be reserved to a single sales order fulfillment line.

There are two ways by which sales orders are pegged to supplies:

• Multiple sales orders can be pegged to a single source of supply: In this case, the pegged quantity does not
exceed the total supply quantity. This type of reservation is done when a single source of supply is adequate
enough to fulfill many sales orders.

For example, there are 50 sales orders for item A. Each sales order is for a single unit of A. You have defined one
of your supply sources as an inter-organization transfer that supplies 100 units of A. Therefore, 50 units out of
the 100 units from the transfer supply can be pegged to the different sales order fulfillment lines.

• Multiple sources of supply can be pegged to a single sales order: In this case, the pegged quantity does not
exceed the total demand quantity. This type of reservation is done when a single supply source is not adequate
to fulfill a sales order which demands a large quantity of supply for an item.

If a sales order is recorded for an item that has a high demand, multiple sources of supply can be pegged in
varied quantities to that single sales order. For example, you have defined two supply sources A and B as the
following: A is an inter-organization transfer and B is a purchase from an external supplier. If a sales order of
800 units for this item is recorded, a part of the supply from A and a part of the supply from B will be reserved.
Those reserved quantities are then pegged to the single order fulfillment line.

Supply planning respects a demand reservation to a lot without regard to the lot expiration dates. A lot that expires on
day 6 can be reserved to a demand that is due on day 10. Supply Chain Planning collects this reservation as it is and
reflects all reservations on the Supplies and Demands page. You can only view reservations in a Supply Chain Planning
work area, but you cannot modify them.

Related Topics
• View Pegging for Reservations

• How FIFO Pegging Is Used in Supply Chain Planning
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View Pegging for Reservations  
You can view all of the reservations that the inventory process creates. To view the sales order fulfillment lines that are
pegged to different supplies and the amount of supply reserved against each sales order, follow these steps:

1. Open a plan:

a. In the Navigator, click a Supply Chain Planning work area.
b. Click the Plans drawer.
c. Expand Plans, and select the plan of your choice.
d. Click the Action menu and select Open.

2. Open the Supplies and Demands table and search for all sales orders. You can search by defining one or more
attributes in the search criteria, such as Item, Organization, or Order Type.

3. In the Search Results area, click View and then select Manage Columns.
4. In the Manage Columns dialog box, move Reserved Quantity and Reservation Type from the Hidden Columns

section to the Visible Columns section.
5. Optionally, use the Move selected items to the top of list button to move these two columns to the beginning

of the row. This enables you to view all information related to reservations at once.
6. Click OK to return to the Supplies and Demands table.

Tip:  You can also enhance your search by setting an Advanced search criteria such as Reserved Quantity > 0. This
will display only those sales orders that have some amount of reserved supply pegged to them.

Related Topics
• Reservations in Supply Chain Planning

How You View Model Forecast and Sales Order Together  
In the configure-to-order process, the execution system transacts the configured item using a unique item identifier
that's different from the model item identifier. To make effective planning decisions, you need to view the model
forecast, and the supply and demand orders together.

You can view the model forecast and the sales order together in the Material Plan table.

By viewing the model forecast and sales order together, you can analyze and make effective supply and demand
decisions in a configure-to-order environment.

Enable the Measure for a Combined View of the Model Forecast and Sales Order
To view the model forecast and the sales order together, you must enable the Configured Item Sales Orders measure.
Before you enable the measure, add the measure to the measure catalog. To view the measure, assign a category to the
model.

Follow these steps to enable the measure:

1. From your Supply Chain Planning work area, open a plan, and click Open > Full Pane.
2. From the Open Table, Graph, or Tile Set page, search and open the Material Plan.
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3. From the Material Plan table, click the Selector Tool View Table Configuration  icon from the material plan
tool bar.

4. In the Measures tab, move the Configured Item Sales Orders measure from the Available Measures column to
the Selected Measures column.

5. Click Save and Close.

Considerations for Changing the Organization for a Sales Order  
You can change the organization for a drop ship sales order or a regular sales order, depending on the associated
supplier or supplier site. The following situations summarize how the drop ship or regular sales order is affected when
you change the organization.

Drop ship sales order for an outsourced manufacturing organization
You can change the current organization to any other organization. Consider the following points when you change the
organization:

• If you change the current organization to another organization that has an associated supplier or supplier site,
the sales order remains a drop ship sales order. The supplier and supplier site on the sales order will reflect the
value associated with the new organization on the sales order.

• If you change the current organization to a drop ship validation organization, you have to manually provide a
supplier or supplier site. List of values for the supplier or supplier site includes only those suppliers or supplier
sites that are not associated with any organization.

• If you change the current organization to an internal organization, the supplier and supplier site are set to blank
values. The drop ship sales order becomes a regular sales order.

You cannot make line edits to the supplier or supplier site in the drop ship sales order on the Supplies and Demand
page.

Drop ship sales order for a drop ship validation organization
You can change your current organization to any other organization. Consider the following points when you change the
organization:

• If you change the current organization to an organization that has an associated supplier or supplier site, then
the supplier and supplier site on the drop ship sales order gets changed to reflect the ones associated with the
new organization. The sales order still remains a drop ship sales order.

• If you change the current organization to an internal organization, the supplier and supplier site are set to blank
values. The drop ship sales order becomes a regular sales order.

You can make line edits to the supplier or supplier site in the drop ship sales order on the Supplies and Demands page.
List of values for the supplier or supplier site includes only those suppliers or supplier sites that are not associated with
any organization.
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Regular sales order for an internal organization
You can change your current organization to any other organization. Consider the following points when you change the
organization:

• If you change the current organization to an organization that has an associated supplier or supplier site, the
regular sales order is converted into a drop ship sales order. The supplier or supplier site in the newly converted
drop ship sales order reflects the supplier or supplier site associated with the new organization.

• If you change the current organization to the drop ship validation organization, you have to manually provide
a supplier or supplier site. List of values for a supplier or supplier site includes only those suppliers or supplier
sites that are not associated with any organization.

• If you change the current organization to another internal organization, the sales order still remains an internal
sales order.

Regular sales order for an outsourced manufacturing organization
You cannot make any changes to the organization, or to the supplier or supplier site.

How You Plan and Collaborate with Drop Ship Manufacturers  
Using supply planning, you can plan and collaborate with your contract manufacturers in a configure-to-order
environment. You can plan and collaborate with your contract manufacturers to drop ship customer orders directly from
contract manufacturers to customers.

Add each contract manufacturer as an organization in the Product Information Management work area so that you can
plan and collaborate with the contract manufacturers. You can add the contract manufacturers as item organizations,
if you do not plan to enable transactions at these organizations. After you add the contract manufacturers as an
organization, you can share the model and option forecast with your contract manufacturers and plan to fulfill the
orders.

Using demand management, you can forecast demands for models and options at contract manufacturing locations.
The planning percentages for an option can vary according to the top model, where the option is a part of the model.
The planning percentages for an option can also vary by the demand class of the forecast.

You can consume forecasts for models and options in supply planning using the drop ship sales orders that the contract
manufacturers fulfill. Supply planning also generates planned orders to fulfill the demand for models and options at
contract manufacturing organizations. You can publish the planned order as an order forecast to Oracle Supply Chain
Collaboration. You can collaborate with your contract manufacturers to receive supply commits for models and options.

Plan Demands from Maintenance Work Orders  
You can plan supplies for components required by maintenance work orders, such as the components created to
maintain production equipment and transportation fleets.

Before you can use this functionality for constrained or unconstrained supply planning, your enterprise must opt in to
the Plan Demands from Maintenance Work Orders feature. For more information and detailed instructions on opting in
to new features for your offering, refer to the Using Functional Setup Manager guide.
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With this feature, you can plan demands from maintenance work orders in your constrained or unconstrained supply
plans. This functionality ensures that you have the right components on hand to minimize the downtime of your assets
and return them to service as quickly as possible.

For example, an international chemical manufacturer uses modular spectrometers in their production operations.
These spectrometers require regular and timely maintenance to ensure progress of manufacturing operations with
minimal downtime. To ensure that all of the required components are available at the time of scheduled maintenance,
the maintenance planner creates maintenance work orders a month earlier than the scheduled maintenance. The
planner ensures that the work order scheduled dates conform to the scheduled maintenance dates. The planner uses
supply planning to collect maintenance work orders and suggest planned orders for the materials required in these
maintenance work orders.

Only asset items that are planned items based on the Product Information Management Planning Method attribute are
collected:

• All collected assets are available in the plan.

• Asset items are planned as normal.

• All item attributes of these asset items are collected and you can edit the editable attributes in the plan.

You can view the maintenance work orders and maintenance work order demands in the Supplies and Demands table.
The table also displays the asset name for the maintenance work orders and maintenance work order demand, but the
Asset column is blank for all other supply order types.

The planning process collects the maintenance work orders as firm work orders, and you can't edit the Firm Status
attribute. This means that you can't edit the date or quantity of the maintenance work order in the Supplies and
Demands table. Also, the maintenance work orders aren't included in the Work Order measure.

The maintenance work order of collected assets are available in the plan. The maintenance work order demands are
planned; however, the resources used to maintain the asset item aren't planned. Also, the maintenance work order:

• Can't be edited.

• Has an Action attribute of None, and it can't be released.

• Isn't considered as a valid supply and the planning process pegs it to excess.

Checklist to Set Up Plan Demands from Maintenance Work Orders
Before you can use the Plan Demands from Maintenance Work Orders feature, you must set up your system.

Set up step Comments

Opt in to the feature
 

Your enterprise must first opt in to the Plan Demands from Maintenance Work Orders feature. Refer to
the Using Functional Setup Manager guide for more information about opting in to features.
 

Collect planning data for work order
supplies
 

In the Collect Planning Data dialog box, Supply Planning Data tab, select Work Order Supplies to
collect all work orders, including maintenance work orders.
 

Select a Planning Method
 

In the Product Information Management work area, select a planning method on the Manage Item
page, Specifications tab, in the Planning section.
 
The asset item is planned if it's a planned item, based on the planning method attribute:
 

• If the planning method is anything but Not Planned (for example, MRP Planning or MPS
Planning), the asset item will be collected.
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Set up step Comments

• If the planning method is Not Planned, then the asset item won't be collected.

Select the Include in Planning check box
 

To select the Include in Planning check box to collect and plan maintenance work order components:
 

1. In the Maintenance Management work area, select the Manage Maintenance Work Orders task.
2. On the Maintenance Work Order page, select the work order.
3. On the Edit Work Order page, Operations tab, click on the item.
4. In the Edit Operation Items dialog box, select the Include in Planning check box.

Plan Items with Only Transfer Order Demand  
You can plan for item and organization combinations that have no demand other than transfer order demand from a
downstream organization, such as a distribution center.

For example, ABC Enterprises has multiple distribution centers where it receives sales orders from different customers.
It replenishes the distribution centers either by transferring existing supplies or by manufacturing the supplies in
manufacturing organizations based on demand from distribution centers. ABC Enterprises can focus on planning only
manufacturing organizations in a supply plan with transfer order demands from distribution organizations without
running the supply plan with all planned items.

To plan items with only transfer order demands in an organization, select one of the following from the Supply Planned
Items drop-down list on the Scope tab in plan options:

• All planned items

• Demand plan items and all sales orders

• Demand plan items, WIP components, and all sales orders

You can plan items with only transfer order demand from a Supply Planning or Demand and Supply Planning work area
for constrained and unconstrained supply plans.

If your plan includes both transfer order demands and sales orders, you can modify a setting to plan only the transfer
order demands. To plan only transfer order demands but not sales orders, deselect the Enable Netting check box for
sales orders in Demand and Supply Netting dialog box in plan options.

To deselect the Enable Netting check box for sales orders:

1. In the Supply Planning work area, open the Manage Plans page.
2. Create a plan or edit plan options for an existing plan.
3. Click the Supply tab in Plan Options and navigate to the Organizations and Schedules subtab.
4. Select an organization and then click the Select button in the Demand and Supply Netting column.
5. In the Demand and Supply Netting dialog box, deselect the Enable Netting check box for sales orders.
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Related Topics
• Why can't I select Supply Planned Items?

• Plan Items with Safety Stock Targets with No Demand

• Define Scope Plan Options

• Supply Plan Options for Organizations and Schedules

Telescoping Time Buckets  

Overview of Telescoping Time Buckets  
With telescoping time buckets, you determine the low-level time bucket for the near term of your planning horizon. And
if you want, you can also determine a different time bucket for the remainder of the planning horizon.

Filtering, graphing, conditional formatting, and setting exception message thresholds all play a part in facilitating plan
management by exception. And certainly, the time dimension levels that you select for your tables and graphs help. For
example, if you don't need to see plan output in days, then select weeks, periods, or months for your plan output.

You can also use telescoping time buckets to handle information overload. For example, instead of your plan calculating
and planning in 100 daily buckets for a 100-day plan, the horizon can be telescoped as follows: The first 1.5 months in 45
daily buckets, and the remaining 2 months in 8 weekly buckets.

Telescoping a plan's planning time buckets reduces granularity of calculation and the number of data points in your
plan. By selecting a larger planning time bucket, you eliminate unnecessary plan precision and detail for the entire plan,
or just the portion of the horizon beyond the near term. The plan consolidates output into larger time buckets that you
determine, such as weekly instead of daily, monthly instead of weekly or daily, and so on. The result is an improved plan
runtime performance and visibility further out into the plan without having to scroll as much.

Keep in mind that telescoping does affect the available levels for you to view and edit measure data in a supply plan.
In our 45 daily plus 8 weekly buckets planning horizon, if you look beyond day 45 of the supply plan, daily viewing and
editing is no longer possible. However, if you view data in a demand and supply plan, you can drill down to the daily
level, even if you use telescoping time buckets. This is because demand planning allocates demand measures down to
the day level.

Configure Telescoping Buckets in a Supply Plan  
You can configure your supply plan to use telescoping buckets. You can set your planning horizon to include only days,
weeks, periods, or months. Or you can set your supply planning buckets at two levels of granularity.

For two levels, select a planning horizon that's a combination of daily time buckets and less granular time buckets
such as week, period, or month. The planning process calculates detailed plan information for the shorter time horizon
(days), and plans the later part of the planning horizon with less granularity. You improve your plan run time by
eliminating unneeded precision and detail for the later parts of the planning horizon.

Before you use telescoping time buckets, think about how many daily time buckets and less granular time buckets you
want to use.
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To use telescoping buckets, configure the plan parameters for your supply plan.

1. In a Supply Planning, Planning Central, or Demand and Supply Planning work area, open a plan and navigate to
the Plan Options page, Scope tab.

2. In the Plan Parameters section on the Scope tab, select a supply planning calendar.
3. Next, select your supply planning buckets. The list of values for the bucket types is determined by the calendar

that you specify.

You can base your planning horizon on days, weeks, periods, or months. Or, you can specify a combination of
daily time buckets and then specify less granular time buckets such as weeks, periods, or months. If you use
two bucket types, the first bucket type must be Day or Week.

4. Specify the number of buckets for each supply planning bucket.
5. Select Don't create partial buckets to create additional daily buckets in the plan to avoid partial buckets.

Select this option to ensure that a week, month, or period always starts on the first defined day for that
particular week, month, or period. For example, a weekly bucket starts on a Monday when you designate
Monday as the week start date. A monthly bucket starts on the first day of the month.

If you don't select this option, the plan doesn't add any additional daily buckets. Instead, the planning process
creates a partial bucket and counts that partial bucket as the first week, period, or month, as specified in the
plan options.

This option is disabled if you select Week-Period combination in Supply Planning Buckets.

Related Topics
• Define Scope Plan Options

How Demands and Supplies Are Impacted in Supply Plans That
Use Telescoping Time Buckets  
When you configure your supply plan to use telescoping time buckets, you can set your planning horizon to include only
days, weeks, periods, or months.

Or you can use telescoping buckets to plan in a combination of daily time buckets and more aggregate time buckets,
such as weeks, months, or periods.

Let's say that you have a plan with time buckets larger than days.

• The net forecast quantities that remain after forecast spreading and forecast consumption are aggregated up
to the planning time bucket level.

• These net forecast quantities are placed on the last working day of the planning time bucket.

• The supply planning process considers each combination of item, organization, demand schedule, demand
class, customer, and customer site.

For example, suppose the net forecast quantity is 10 units per working day per combination of item, organization,
and demand class in a plan with all daily buckets. Your organization is set up for 5 working days per week. The same
plan with weekly buckets displays an aggregated net forecast for a quantity of 50 units for each demand class. This
aggregated forecast has a suggested due date of the last working day of each weekly bucket.
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These are other ways that demands and supplies are impacted when you use weekly, monthly, or period time buckets.

• All supply and demand orders and all resource requirement dates are subject to bucketing logic. In other words,
for time buckets larger than days, dates calculated on supply and demand orders are bucketed to the last
working day of the bucket. The working days specification is based on the supply planning calendar that you
select on the Plan Options page, Scope tab, not the organization calendar.

• When you release make or transfer planned orders created in planning time buckets larger than days, the
orders have a suggested due date that corresponds to the last working day of the time bucket. Buy planned
orders also have a suggested due date that corresponds to the last calendar day of the bucket. However, the
implement date is set as the first calendar day of the bucket. This implement date ensures that the supplier
delivers the material in time to meet the entire planning time bucket's demand for the item.

• Firm dates, implement dates, and dates in the input data such as requested ship date or scheduled ship dates
aren't subject to the bucketing logic. For example, you can firm a planned order that was previously bucketed
to the last working day of the month to any day, regardless of whether day is the last day of the supply planning
bucket or even a working day.

• When generating planned orders in aggregate buckets, all order modifiers are honored except for fixed days of
supply.

Related Topics
• Order Modifier Options

How Safety Stock is Calculated for Supply Plans That Use
Telescoping Time Buckets  
If you use days of cover for your safety stock calculation method, then the calculation method factors in the telescoping
time buckets. If you don't use days of cover, then telescoping buckets has no impact on how safety stock is calculated.

For days of cover based safety stock calculations, the planning process prorates demand in the supply planning buckets
based on the specified demand period.

Let's suppose you have an item with the safety stock planning method of Days of Cover. The Demand Period and Days
of Cover values are set to 4 days. Additionally, the organization calendar has 7 working days.
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Calculating Safety Stock for Day 1 (Daily Buckets)
Safety stock in the daily buckets sums the demands over the demand period. Next, that sum is divided by the demand
period and multiplied by the days of cover.

In our example, the demand for Days 1 through 4 adds up to 70. This number is divided by 4 (demand period) and then
multiplied by 4 (days of cover). So, the safety stock for Day 1 is 70.

Calculating Safety Stock for Day 5 (Daily and Weekly Buckets)
When the demand straddles the daily and weekly buckets, the demand in the weekly bucket is prorated.

In our example, Days 5 through 7 are daily buckets and Day 8 is in the weekly bucket. These steps show you how to
calculate safety stock for Day 5.

1. Add the demand for Days 5 through 7, which is 20 (5+5+10).
2. The next portion of the time bucket is weekly, so to get the demand for Day 8, you must prorate the week. The

prorated demand for Day 8 is 10 (1/7th of 70).
3. Add the demand for the daily and prorated weekly buckets to determine the calculated safety stock for Day 5,

which is 30 (20+10).

Calculating Safety Stock for Weekly Buckets
When the demand is in the weekly buckets, the safety stock is the prorated daily demand multiplied by the days of
cover.

In our example, Week 2 demand is 90 units. The prorated daily demand is 12.85 (4/7th of 90) that you multiply by 4
(days of cover), which calculates to 51.4 for your safety stock for Day 9.
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How Exceptions are Calculated in Supply Plans That Use
Telescoping Time Buckets  
When you use telescoping buckets in your supply plan, the planning process handles exception messages based on
what you specify for Planning Time Buckets in plan options.

This table explains how the planning process calculates exceptions when you use time buckets larger than days.

Exception Type Calculation Logic

• Orders To Be Rescheduled In

• Orders To Be Rescheduled Out

The planning process generates reschedule exceptions only if the supply orders get rescheduled
across planning time buckets.
 
Any reschedules of the order due dates within a planning time bucket doesn't trigger reschedule
exceptions.
 

• Late Supply Pegged to Sales Order

• Late Supply Pegged to Forecast

• Late Replenishment for Sales Order

• Late Replenishment for Forecast

The planning process generates late supply or late replenishment exceptions only if the supply and
demand dates are in different planning time buckets.
 
For example, a sales order suggested due date is in the middle of a week. The suggested due date of
the supply is the last working day of the week. In this case, the planning process doesn't generate a
Late Supply Pegged to Sales Order or Late Replenishment for Sales Order exception.
 
However, suppose you have a sales order suggested due date in the middle of a week. The suggested
due date of the supply is the first working day of the following week. In this case, the planning process
generates an exception.
 

• Items with a Shortage

• Items Below Safety Stock

The planning process creates an exception only if the available quantity is less than the required
quantity at the planning time bucket level. The planning process evaluates item shortages by using the
projected available balance on the last day of the planning time bucket.
 
The planning process ignores daily fluctuations within a planning time bucket.
 

• Items with Excess Inventory The planning process creates an exception only if the available quantity is greater than the required
quantity at the planning time bucket level. The planning process evaluates item excesses by using the
projected available balance on the last day of the planning time bucket.
 
The planning process ignores daily fluctuations within a planning time bucket.
 

• Resource Overloaded

• Supplier Capacity Overloaded

The planning process creates an exception only if the available capacity is less than the required
capacity at the planning time bucket level.
 
For example, in a weekly bucket, a resource can have some overloads within the week on a few days. As
long as the available capacity at the week level is more than the required capacity, the planning process
doesn't generate a resource overload exception.
 
The planning process ignores daily fluctuations within a planning time bucket.
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Guidelines to View and Edit Measure Data in Tables for Supply
Plans That Use Telescoping Buckets  
When you use telescoping buckets in your supply plan, there are some things to understand before you view plan
output or edit measure data in tables.

If you use a table to view the plan output in a supply plan that includes the time dimension, the time hierarchy selected
in this table must be the Supply Planning Calendar. Use this time hierarchy to ensure consistency between the level at
which planning is performed and the level at which you view the plan output.

When you use telescoping buckets in a supply plan, you can't edit measure data in a table at a level lower than the
supply planning bucket. For example, you can't edit data at the day level if your data in the table is at a weekly bucket.
However, you can view and edit the measure data at or above the planning time bucket level.

Note:  If you view data in a demand and supply plan, you can drill down to the daily level, even if you use telescoping
time buckets. This is because demand planning allocates demand measures down to the day level.

Let's walk through how viewing and editing measure data in tables works in a bit more detail.

If you're viewing the portion of the plan
horizon that's planned in:

Measure data that you can view or edit in tables

Daily Buckets
 

You can view or edit the measure values in either daily, weekly, period, or monthly levels in the table.
 

Weekly Buckets
 

• You can view or edit the measure values in either weekly or period levels in the table.

• You can't view the data at the daily granularity, even though the planning process allocates some
measure data down to the day level.

• You can't drill down from the week to the day level.

• Any edit that you make at the period level is allocated to the last day of each of the underlying
weeks within that period.

Period Buckets
 

• You can only view or edit the measure at the period granularity.

• You can't drill down from the period to the week or day level.

• Any edit that you make at the period level is allocated to the last day of the period.

Monthly Buckets
 
 

• You can only view or edit the measure at the monthly granularity.

• You can't drill down from the month to the day level.

• Any edit that you make at the monthly level is allocated to the last day of the month.

These four measures work differently when you edit them.

• Gross Forecast

• Net Forecast

• Manual Demand
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• Planned Orders

You can view the portion of the plan horizon that's planned in weekly buckets. Any edit that you make at the week level
is allocated to the last day of the week for these four measures. After you save your plan, the supply planning process
updates or creates demands and supplies. These demands and supplies have a suggested due date that's the last
working day of the supply planning bucket.

Modeling a Supply Chain  

How Phantom Assemblies Are Used in Supply Chain Planning  
A phantom assembly, also known as phantom bill, is a nonstocked assembly that lets you group materials required
to produce a subassembly. When you create a bill of material for a parent item, you can specify a component as a
phantom.

One bill of material can represent a phantom subassembly for one parent item, and a stocked subassembly for another
parent item. A phantom bill of material enables you to manufacture and stock the assembly when necessary. For
example, you can use phantoms to build and stock occasional spares for field service requirements. The planning
process explodes through a phantom subassembly to the components.

Settings That Affect Phantom Assembly
The planning process ignores phantom assembly routing when you define a job or repetitive schedule. To avoid any
additional lead time offset for components, you set the lead time of the phantom to zero.

How Phantoms Are Used in Planning
When model bills or option class bills are components to another bill of material, the component supply type is
a phantom. Instead of passing the parent's planned orders to the phantom, netting the phantom, and passing
requirements to the phantom's components, the planning process blows through the phantom to create component
planned orders. For the organization parameter, you have only the Material Only option for Phantom Operation
Sequence Inheritance. The planning process ignores order modifiers for items that have a phantom supply type. The
planning process plans the phantom subassembly using the lot-for-lot lot-sizing technique.

Typically, phantom assemblies act as normal assemblies when they represent a top-level assembly, such as when you
master schedule them or manufacture them using a discrete job. As a subassembly, however, they lose their identity
as distinct assemblies and are a collection of their components. The components of the phantom subassembly are
included on the job and in the planned supplies, but not the phantom itself. Using the bill of material to determine
phantoms, has two advantages: it allows for more flexibility (because a component can be a phantom in one bill and not
another), and treatment of phantoms in the planning process is consistent with Oracle WIP.

How FIFO Pegging Is Used in Supply Chain Planning  
Pegging is a process that the planning calculations use to link the supply with the demand, and the demand with the
supply. FIFO is first in, first out. In FIFO pegging, demands are linked to supplies on a day-by-day basis.

The planning processes sort demands by day, demand type, and supply quantity in ascending order. The planning
processes sort supplies by day, supply type, and supply quantity in ascending order.
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For all reserved demands and supplies, the planning processes first pegs demands with reservations (existing or
recommended) to the reserved supply without regard to the demand type, the supply type, and dates. Pegging always
respects reservations. For unreserved demands and supplies, the planning processes sort demands day by day in the
following sort order:

• Past due sales orders

• All sales orders

• Manual demands

For all other demands, including forecasts and dependents demands, the planning processes sort supplies day by day in
the following sort order:

• On hand

• Past-due supplies (firm by definition)

• Existing firm supplies

• Existing non-firm supplies

• Planned orders

During demand and supply netting in planning calculations, if safety stock levels are specified for an item organization,
then the netting is performed considering the daily safety stock level. The planning calculations do not use the notion
of safety stock demand. As there is no concept of safety stock demand, there is no pegging of a supply to a safety stock
demand. The planning calculations do not peg some or all of a supply to anything when some or all of the supply is
used to meet the required safety stock level. A supply, which meets a safety stock level, pegs to either future demand or
is not pegged. Excess supplies because of order modifiers can peg to nothing at the end of the planning horizons.

How Shrinkage Is Calculated  
The planned quantities of products sometimes decrease or shrink as they move through the production process.
Shrinkage rate is an item-organization attribute, which determines the expected scrap and other losses in inventory.

To overcome the inventory shrinkage, the planning process begins with production quantities greater than the required
quantity to meet the demand. The planning process considers the value that you specify for shrinkage and uses it to
plan for shrinkage of an item in an organization. The planning process plans for demand by starting with a quantity
that considers shrinkage and then arrives at the required order quantity. The order quantity is the quantity after the
shrinkage is applied. The planning process uses the shrinkage rate and the required order quantity to determine the
start quantity. The planned order needs the start quantity to account for the shrinkage.

The planning process derives the start quantity based on the following equation:

Start Quantity = Order Quantity / (1 - Shrinkage)

For example, consider an item that has a shrinkage of 10%. For a demand of 100, the planning process starts with a
quantity that will shrink by 10% to arrive at 100.

Start Quantity = 100 / (1 - 10%) = 111.11

If the Apply Order Modifier to Start Quantity item attribute is set to Yes, then the start quantity will be adjusted to
conform to the applicable order modifier and the order quantity will be calculated based on the following equation:

Order Quantity = Start Quantity * (1 – Shrinkage)
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For example, consider an item that has a shrinkage of 10% and a fixed order quantity of 100. For a demand of 100, the
planning process first creates a planned order with a start quantity of 100 (which conforms to the Fixed Order Quantity
order modifier) and an order quantity of 90 (due to 10% shrinkage). Because 10 more are needed to fulfill the demand,
a second planned order is created with a start quantity of 100 (which conforms to the Fixed Order Quantity order
modifier) and an order quantity of 90, of which 10 are needed to meet the demand and 80 are available for another
demand or go unused.

Shrinkage is also applied when collecting data from an external source system. When uploading purchase requisitions,
purchase orders, or work orders using the file-based data import (FBDI) template, the planning process applies any
specified shrinkage rate and reduces the order quantity. For example, if an item has a shrinkage of 10% and the order
quantity in the .csv file for a purchase requisition is 100, then the order quantity is reduced to 90 when the purchase
requisition is uploaded.

The supply planning process considers shrinkage for both planned orders and existing supplies.

Firming Supplies
When you firm a supply order, you can select either the start quantity or the order quantity as the firm quantity on the
Supplies and Demands table. You can update either the Firm Quantity or the Firm Start Quantity column to a different
value.

When you firm a planned order, the planning process updates the Firm Quantity column with the value in the Order
Quantity column. You can also edit the Firm Quantity column based on your planning needs. Alternatively, you can
specify the Firm Start Quantity column on a firm planned order. When you enter a value in the Firm Start Quantity
column, the planning process clears the value from the Firm Quantity column.

When you rerun the plan in a simulation mode, you can see the following data:

• For the planned order with Firm Start Quantity specified, the Start Quantity column displays the Firm Start
Quantity value. The Order Quantity column displays a value based on the following calculations:

Order Quantity = Firm Start Quantity * (1 - Shrinkage)

• For the planned order with Firm Quantity specified, the Order Quantity column displays the Firm Quantity
value. The Start Quantity column displays a value based on the following calculation:

Start Quantity = Firm Quantity / (1 - Shrinkage)

Calculating Shrinkage for Work Orders
A work order can be fully complete or partially complete during collections. When you collect a work order, the collected
quantity represents the start quantity. The planning process calculates the new order quantity based on the current
state of completion and the expected scrap.

Because work orders can be incomplete at the time of planning, you can track the status of the work order from the
Supplies and Demands table in your Supply Chain Planning work area. You can review the following attributes to track
the status of the work order:

• Start Quantity

• Completed Quantity

• Scrapped Quantity

• Remaining Quantity

• Expected Scrap Quantity
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• Order Quantity

During collections, the planning process collects the start quantity from the execution systems. When you release a
planned order, the planning process releases the start quantity back to the execution systems.

Measures to View Start Quantity
The following three predefined measures let you view the start quantity and the start dates:

• Supply Start Quantity

• Reserved Supply on Start Date

• Reserved Supply Value on Start Date

Work with Supply Plans  

How Purchase Orders Are Scheduled  
Purchase orders, also known as buy orders, enable you to accurately measure the transit time from the supplier to the
organization. The following fields are included on the purchase order schedule:

• Requested Ship Date

• Promised Ship Date

• Requested Delivery Date

• Promised Delivery Date

• Buyer-managed Transportation Indicator

• Shipping Method

Buyer-managed Transportation specifies that the buying company is responsible for arranging the transportation,
from picking up the requested goods to delivering to ship-to locations specified in the order. When the Buyer-managed
Transportation indicator is not selected, delivery dates are populated on the purchase order and ship dates are not
populated on the purchase order. When it is selected, the ship dates are populated on the purchase order and delivery
dates may be populated on the purchase order.

When Buyer-managed Transportation is selected, the buyer communicates a requested ship date on Purchase Orders
and the supplier provides a promised ship date in response. When not selected, delivery dates are communicated
between buyer and supplier. In both cases, the purchase order also contains shipping method at the line level. Transit
times can be defined between a supplier site and organization location for shipping methods. The planning process can
consider transit times for purchase orders.

When the planning process creates planned purchase orders, the planning process uses the shipping method from
the sourcing rule to calculate the transit time. The total lead time from planned purchase order start date to dock date
includes both processing lead time and transit lead time.

When you release a planned purchase order from a Supply Chain Planning work area, the following information is sent
to purchasing:

• Shipping method
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• Requested ship date and requested delivery date. If Buyer-managed Purchasing is selected, then both ship and
delivery dates are populated on the purchase order. If Buyer-managed Purchasing is not selected, then only the
delivery dates are populated on the purchase order.

Purchase orders are scheduled backward from the order due date. Scheduling purchase order respects all valid
shipping, receiving, transit, manufacturing, and supplier capacity calendars. In supply chain planning, if any dates are in
the past, then the dates are set to the plan start date. The planning process issues reschedule recommendations for the
following conditions:

• When the purchase order Buyer-managed Transportation indicator is selected and the old ship date is
different from the new ship date calculated by planning.

• When the purchase order Buyer-managed Transportation indicator is not selected and the old delivery date is
different from the new dock date calculated by planning.

Example of Backward Scheduling Calculations
Consider that the suggested due date is Day 10, where postprocessing = 1 day, transit time = 2 days, processing = 4 days,
and preprocessing = 2 days. The following calculations are used for backward scheduling:

• Suggested Due Date = Day 10

• Suggested Dock Date = Day 9 (Dock Date = Due Date minus Postprocessing Lead Time)

• Suggested Ship Date = Day 7 (Ship date = Dock Date minus Transit Lead Time)

• Suggested Start Date = Day 3 (Start Date = Ship Date minus Processing Lead Time)

• Suggested Order Date = Day 1 (Start Date = Preprocessing Lead Time)

Related Topics
• How Backward Scheduling and Order Dates Are Calculated

How Backward Scheduling and Order Dates Are Calculated  
Backward scheduling is the process by which lead time is applied to supply orders. When the planning mode is
unconstrained, backward scheduling is performed by the planning process.

When you run a supply plan, the planning process reports constraint violations as capacity overloads and lead time
exceptions so that you're alerted to supply problems. The supply for your sales order becomes due on the end demand
date.

Settings That Affect Backward Scheduling and Order Dates
When supply is just in time for a demand, the supply completion date is the demand date. The supply is then scheduled
backward to arrive at the start dates for each operation that must be completed and due dates for supply of lower-level
components that make up the final supply.

Note:  If the operation consuming a component doesn’t have any scheduled resources, then the supply is scheduled
to arrive on the order (not operation) start date.

During backward scheduling of dates, if the plan start date is crossed, then all earlier dates are bucketed to the plan
start date. This process is referred to as compression.
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Backward scheduling affects order due dates in the following ways for different types of items:

• For make items, compression begins at preprocessing lead time. The first operation and each successive
operation are then compressed to zero duration until there is sufficient lead time for the remaining operations
to complete using the resource duration.

• For transfer and buy items, the preprocessing lead time is compressed first. The processing lead time is then
compressed and if insufficient lead time remains, postprocessing lead time is compressed.

Note:  The processing time for a buy item is independent of item quantity.

You can set organization and customer receiving and shipping schedules and carrier transit schedules in the Manage
Transportation Schedules section in Logistics. The only valid dates that planning calculations use for backward
scheduling are the working days on the manufacturing and shipping calendars. Calendar defaulting rules are used by
planning to determine order dates calculations. The defaulting rules are:

• Valid Supplier Capacity Calendar: Either the Supplier Site Capacity Calendar is used or a fully open calendar of
7 days, 24 hours. If the Supplier Site Capacity Calendar in the Approved Supplier List is blank, then the Supplier
Site Calendar from the Supply Network Model is used.

• Valid Supplier Shipping Calendar: The Carrier, or Supplier, or Supplier Site Calendar, the Supplier, or Supplier
Site Shipping Calendar, the Carrier, or Supplier Calendar, the Supplier Shipping Calendar, or a fully open
calendar of 7 days, 24 hours is used.

• Valid Organization Receiving Calendar: Either the Carrier or Organization Calendar is used, or the Organization
Receiving Calendar, or the Organization Manufacturing Calendar.

Note:  The defaulting rules are also applied to determine different calendars, such as Valid Organization
Manufacturing Calendar, Valid Organization Shipping Calendar, Valid Customer Shipping Calendar, and Valid Transit
Calendar.

How Backward Scheduling Is Calculated
Backward scheduling is calculated based on the following:

• Planned Make Order: If your order is for a make item, the component due date is the start date for the operation
that requires it and supply is scheduled backward. The work definition provides the information about the
component and resource requirements for such an order. The new order due date becomes the date of the end
demand.

Note:  A make planned order exists only as a planned order in supply chain planning, and isn't part of
manufacturing yet.

• Work Order: If your order is for an item that already exists as a work order, the component and resource
requirements are collected from the work order. The planning process can shift the work order to a new set of
dates without making alterations to the relationship of dates in the work order. The component due dates for
that end item are collected from manufacturing.

For example, take the following scenario:

• A is an end item with two components B and C that have different start dates.

• C is a make item with two components D and E that also have different start dates.
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Components D and E are in the lower level of the work definition for item C and they're needed for the assembly of the
make planned order C. Similarly, components B and C are in the lower level of the work definition for item A and they're
needed for the assembly of the work order A.

The following figure illustrates the relationship between components A, B, C, D, and E that are used to make an end
item.

The planned make order rescheduled dates are determined by total quantity of demands and order modifiers. Total
make order lead time (days) = fixed lead time + quantity multiplied by variable lead time.

The work order rescheduled dates are determined by component requirement start dates and end dates. If the end date
is moved by 3 days, the start date is also moved by 3 days.

Related Topics
• How Purchase Orders Are Scheduled

Rework and Transform Work Orders  
Rework and transform work orders are collected during the data collections process and they are shown as nonstandard
work orders in Planning Central, Supply Planning, and Demand and Supply Planning work areas.

You create rework work orders in Oracle Manufacturing to perform rework activities on items that have issues or
defects. The objective of rework is to make those items usable to satisfy customer demand.

You create transform work orders in Oracle Manufacturing to enhance or upgrade existing items by adding or removing
selective components from existing items. The objective of transform work orders is to transform the existing item into
a new item.

The rework and transform activities can result in the removal of components from the item being reworked or
transformed. You can use the removed components to satisfy future demands. Data collection collects the removed
components and you can search for the removed components when you select the order type as nonstandard work
order by-product in the Supplies and Demands table. The data collection process filters out all work order demands for
an item, when the item itself is manufactured by the rework work order.
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The planning process considers all nonstandard work orders as firm orders. Like other firm orders, nonstandard work
orders will be included in the calculation of the natural time fence for an item.

How Supply Planning Considers Additional Work Order Status  
Oracle Supply Planning considers the scheduling status, completion status, and specific attributes of work orders to
make informed decisions about how to allocate resources, coordinate tasks, and fulfill demand efficiently.

Undercompleted Work Orders
Oracle Supply Planning treats a work order as complete and doesn't expect further supplies if a work order is defined as
Undercompleted in Oracle Fusion Cloud Manufacturing.

When creating a supply plan, the status of work orders is assessed to determine the remaining work and resources
needed to complete them. In your manufacturing environment, you may want to complete work orders even if the
output quantity from the manufacturing process is less than the original quantity specified. You can define the
undercompletion tolerance value in Oracle Manufacturing. The supply plan automatically sets the work order to the
complete status if the work order is defined as undercompleted. If a work order status is set to complete based on the
undercompletion tolerance value, you still can continue to complete any further product quantity. If there are no more
supplies expected from a work order, select Undercomplete in Review Dispatch List in Oracle Manufacturing.

If a work order is undercompleted, the supply plan considers its status as complete and doesn’t expect any further
supplies from the work order. In Plan Inputs, the order quantity is zero for such work orders.

Note:  Both unconstrained and constrained supply plans support undercompleted work orders. The undercompletion
tolerance is supported for standard and nonstandard work orders. It is not supported for maintenance, rework, and
transform work orders.

You can view the undercompleted status on the Supplies and Demands page in Plan Inputs.

For discrete work orders:

• The undercompletion tolerance is applied on the product quantity.

• If a work order is defined as undercompleted, based on the undercompletion tolerance value, you cannot
complete any further product quantity.

• If a work order is undercompleted, you still can continue to issue input materials and the supply plan continues
to plan for the remaining input materials (to-be-issued to the work order) until it is closed.

For process work orders:

• The undercompletion tolerance is applied on the batch quantity and not on the output quantities.

• If a work order is defined as undercompleted, you still can continue to complete output items (primary output,
co-product, and by-products) and the supply plan will continue to consider the output quantity as supply from
the work order until it is closed.

For example, a process work order has started with the original batch quantity equal to 500, and the planned
primary output quantity equal to 200. If the work order is undercompleted with batch quantity equal to 400,
you still can complete the primary output quantity 200 or until the work order is closed.
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Work Orders in Pending Approval Status
Supply Planning considers a work order in Pending Approval status as available supply and plans work orders
accordingly.

You might be required to keep detailed records of product manufacturing processes on electronic records and
signatures. Oracle E-Signatures and E-Records is a configurable framework for securely capturing, storing, retrieving,
and printing electronic records and signatures. You can enforce generation of an e-record and capture e-signatures
when a work order is initially changed to the Released status in Oracle Manufacturing. Using a deferred approval
process with notifications, the work order is held in a Pending Approval status until the approvals are obtained. This
status means that no changes can be made to the quantity or schedule.

Supply planning considers work orders that come from Oracle Manufacturing in Pending Approval status as available
supply.

These work orders are planned as non-firm work orders unless explicitly firmed in Oracle Manufacturing or in Supply
Planning by a planner. Supply Planning can issue a reschedule or cancel recommendation on such work orders by virtue
of them being not firm.

Note:  Both unconstrained and constrained supply plans support work orders in Pending Approval status.

The work orders in Pending Approval status remain locked in Oracle Manufacturing for all updates and transactions.
Oracle Manufacturing won’t process any update or cancel recommendation for such work orders when they are released
from Supply Planning. An applicable message is displayed in Oracle Manufacturing if any recommendation isn’t
processed.

In such cases, you need to release the work order again in the next planning cycle (assuming by that time the work
order status is changed depending on the outcome of approval process). To avoid this, check the work order status in
Oracle Manufacturing before releasing the work orders in organizations configured for e-signature.

Manually Scheduled Work Orders
You might want to change the schedule of a work order in the execution system owing to your business requirements.
For example, you might update the work order start and completion dates, update work order operation, or resource
start and completion dates. In Oracle Manufacturing, select the User or External scheduling method. The Firm check
box is automatically selected. You then can schedule a work order manually by updating the work order, operation, and
resource dates in Oracle Manufacturing.

Supply Planning respects the manually scheduled work order and doesn’t consider it for automated rescheduling by
virtue of it being firm.

Optionally, you can deselect the Firm option for a work order in Oracle Manufacturing for the User or External
scheduling methods. In this case, since the work order is not firm, Supply Planning will plan it as a regular non-firmed
work order and recommends a reschedule or cancellation. On releasing such work orders, Oracle Manufacturing will
honor Supply Planning's recommendation.

You can also change the firm status of a manually scheduled work order to Not firm in Supply Planning. In this case
also, Supply Planning will plan the work order as a regular non-firm work order and can recommend a reschedule or
cancellation. On releasing these work orders, Oracle Manufacturing will honor the Supply Planning's recommendation.

Note:  Both unconstrained and constrained supply plans support manually scheduled work orders.
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How Plan Recommendations Are Processed  
Supply chain planning can generate plan recommendations. These are suggestions to take actions that can create a
balance between supply and demand. You can view these suggestions in the Supplies and Demands table.

The planning process can release two primary kinds of plan recommendations.

• It can suggest new planned orders: The planning process suggests that you order some new supply to meet
the demand for a certain product. All of these supply suggestions are released by planning to Oracle Supply
Chain Orchestration in the form of new planned orders. This new supply can be in the form of a manufacturing
job, in which case the planned order is released to manufacturing. If the new supply suggestion is a purchase
requisition, Supply Chain Orchestration releases the planned order to purchasing. If the new supply suggestion
is a transfer, Supply Chain Orchestration releases the planned order to logistics.

• It can suggest rescheduling or cancellation of existing supplies: The planning process suggests that you
reschedule or cancel a current supply because the total supply for a product might be in excess compared to
the demand for it. You can cancel current planned orders that exist as discrete jobs or as purchase orders or
transfer orders. Similarly, planning can also suggest that you reschedule some of the existing supply to meet
future demand. The rescheduling is done for supplies that exist as discrete manufacturing jobs, purchase
orders or transfer orders.

If the planning process suggests new supply, and the planner releases the planned order, the released planned order is
sent to Supply Chain Orchestration. The planned order has the following details specified in it:

• Item

• Organization

• Start date, dock date and if applicable, ship date

• Source

◦ If it's a make item, the organization remains the same.

◦ If it's a transfer item, the source organization must be specified.

◦ If it's a buy item, the supplier and supplier site must be specified.

You can open the Supplies and Demands table to view individual planned orders. You can also open the material plan
to view the aggregate total supply for your plan.

You can't view rescheduled plan recommendations in the material plan. The material plan accepts the
recommendations from supply chain planning and uses the rescheduled dates when aggregating supply. The planning
calculations assume that the rescheduled recommendations are already incorporated within the aggregate supply
calculations and use the rescheduled dates.

Related Topics
• How Plan Recommendations Are Released
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How Plan Recommendations Are Released  
One of the key execution capabilities that supply chain planning offers is that you can release plan recommendations to
implement standard plan-to-produce business flows. You can release plan recommendations either from a supply plan
or from a demand and supply plan.

You can either manually review and release each supply chain planning recommendation or automatically approve and
release them.

The following table illustrates the plan recommendations that either the planning processes can release automatically
for different order types, or you can manually release the orders:

Order Type Updates Suggested by Planning Calculations Actions You Can Take

Purchase Orders
 

Quantity, Delivery Date, Firm Status
 

Reschedule, Cancel
 

Purchase Requisitions
 

Cancellation
 

Cancel
 

Work Orders
 

Start Date, Completion Date, Firm Status
 

Reschedule, Cancel
 

Transfer Orders
 

Start Date, Arrival Date, Shipping Method
 

Reschedule, Cancel
 

Sales Orders
 

Scheduled Arrival Date, Scheduled Ship Date,
 Shipping Method
 

Reschedule
 

Note:   In all cases, cancellation entails releasing an order quantity of zero.

For purchase orders and transfer orders, you can manually change the input values for the updates suggested by the
plan recommendations. You can do this in the planners' workbench.

The following recommendations are released by supply chain planning to Oracle Supply Chain Orchestration:

• New planned orders for make, buy, and transfer of supplies

• Reschedules of existing make, buy, and transfer supplies

Supply Chain Orchestration processes these recommendations and sends both new releases and reschedules to
manufacturing, purchasing, and logistics depending on the type of supply.

The following recommendations are released by supply chain planning to Oracle Order Management:

• Reschedules of sales orders

• New planned orders for drop shipments

349



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 11
Supply Plans

Related Topics
• How Plan Recommendations Are Processed

• Manually Release Plan Recommendations

• Automatic Release Options

• Release Recommendation Options

Manually Release Plan Recommendations  
You can review the plan recommendations generated by the planning process and then manually release them for
execution. You can either release new planned orders as supply or you can release reschedule recommendations for
existing supplies, such as work orders, transfer orders, and purchase orders.

To review and release plan recommendations:

1. Open the Supplies and Demands table and search for your orders.
2. Select one or multiple rows that show the orders that you want to release for execution.
3. At the order level, click Actions and then select Mark for Release.

Note:  The Release Status field is updated to the appropriate status (for example, Marked for release or
Marked for reschedule) for each of the selected rows.

4. Save your changes.
5. At the page level, click Actions and then select Release. This action initiates the release plan process.

A dialog box displays the status of the process. You can monitor the process or close the dialog box and resume
other activities. If you close the dialog box, the plan action continues.

6. You can also verify the status of this process by navigating to the Scheduled Processes page. Follow these steps
to verify release results on the Scheduled Process page:

a. Use the Hierarchy view. The top-level process name is Release Plan.
b. Drill down to Release Planning Recommendations and select Load Interface Tables.
c. Check the log file of each table to confirm the release. Also, check the submission notes for each process.

The notes identify the type of release.
After you release the plan recommendations, all new, rescheduled, or canceled orders are sent to Oracle Supply Chain
Orchestration. Navigate to the Supply Chain Orchestration work area to view requests that weren't processed and check
why these exceptions were created.

Release Planned Make Orders
After you mark a planned make order for release, you can specify a work order number to use when the planned make
order is released. In the Implement Work Order Number column, the number that you enter must be valid based on
your source system. No validation is performed in the Supplies and Demands UI. For example, if you're using an Oracle
Fusion source system, the number that you enter must be unique within the organization. Release planned make orders
with duplicate work order numbers appear in Oracle Supply Chain Orchestration with an error.

Release Planned Buy Orders
After you mark a planned buy order for release, you can specify a deliver-to location to use when the planned buy order
is released. If you leave the Implement Location field blank, then the default location associated with the organization
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is used as the deliver-to location. Optionally, you can specify a different location to be used as the deliver-to location.
Only the locations that have been associated with the organization can be selected for the implement location.

Note:  Changing the Implement Location field doesn't cause any of the other implement fields, such as Implement
Shipping Method or Implement Ship Date, to be reevaluated.

Related Topics
• How Plan Recommendations Are Released

• How Plan Recommendations Are Processed

Release Plan Recommendations to an External Execution System  
You can release plan recommendations or planned orders from Oracle Fusion Cloud SCM Applications to an external
execution system. When you release a planned order, the planning process generates a CSV file for the planned order.

The planning process attaches the generated CSV file to the scheduled process called Release Planning
Recommendations: Release to External Source Systems. You can download the CSV file from the scheduled processes.
The planning process also saves the CSV file in a .zip file format in the Universal Content Manager. The name of the .zip
file is ReleasetoExternal.zip.

Prerequisite
Before you can release planned orders from Oracle Fusion Cloud SCM Applications to an external execution system, you
must do the following:

1. Assign your organization as an external source system.
2. Run collections from the external source system.

After you successfully run collections, you can plan your orders and release them to the external source system. The
release process is same for an Oracle Fusion source system and an external source system.

Release Planned Orders
Follow these steps to release the planned orders:

1. From your Supply Chain Planning work area, click the Tasks panel.
2. Click Manage Plans and then search your plan.
3. Open the plan, mark the orders for release, and then click Actions > Release.

The planning process exports the plan in the CSV format and attaches the CSV file to the scheduled process. Also, the
planning process saves the CSV file in a .zip file format in the Universal Content Manager. You can download the .zip file
from the File Import and Export link in the Navigator.

For more information, see Releasing Plan Recommendations to External Systems (Doc ID 2305394.1) on My Oracle
Support at https://support.oracle.com.
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Create and Release Manual Planned Orders  
You can create manual planned orders for buy, make, and transfer order types. For each planned order type, you can
select your source specifications.

After you create the manual planned orders, you can then release the orders to the relevant source application. Creating
and releasing manual planned orders enables you to respond quickly to issues by creating supplies in the source
applications. You can create and release manually created planned orders from the Planning Central, Supply Planning,
Demand and Supply Planning, or Replenishment Planning work area.

To create a manual planned order from the Supplies and Demands page, click the Create icon. The Create Order dialog
box opens. In the Create Order dialog box, select the source type. The source type that you select enables additional
parameters for the supply source.

Source Type Additional Parameters

Buy
 

• Supplier

• Supplier Site

• Shipping Method

Make
 
(Not relevant to Oracle Fusion
Replenishment Planning)
 

• Item Structure Name

• Work Definition

Transfer
 

• Source Organization

• Shipping Method

After you create the manual planned orders, optionally rerun your plan to determine if the new planned orders can be
executed. You can then mark the manually created planned orders for release on the Supplies and Demands page. Next,
run the release process and the planning process releases your manually created planned orders.

How to Prevent Creating Planned Orders in a Supply Plan  
In some business cases, you might want to prevent the creation of planned orders for particular items. You can use the
Create Supply attribute to manage scenarios such as end-of-life items or phasing out of components.

The Create Supply attribute also applies to end items. If set to No for an end item, all remaining demands for the end
item are marked as unmet demands after using up all on-hand inventory and on-order inventory.

This topic describes how to prevent the creation of planned orders. If you instead want only to delay the creation of
planned orders until after a specified date, see the How to Create New Supplies Only After a Specified Date topic in this
guide.

You can use the Create Supply attribute in both constrained and unconstrained supply plans, with a few minor
differences, which are noted in this topic.
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To prevent creating planned orders in a supply plan:

1. Set the Create Supply attribute to No for an item-organization.
2. (Constrained Plans Only) Select your decision rules in the plan options. This step is required only if you defined

substitutes or alternates in your plan and want the supply plan to use existing supplies or recommend planned
orders on them.

CAUTION:  Set the Create Supply attribute to No only on required items for which you don't want to create any new
supplies. Setting the attribute on the wrong items can lead to unmet demands.

Set the Create Supply Attribute
To prevent the planning process from creating planned orders for a particular item, set the Create Supply attribute to
No for an item-organization. To set this attribute, from the Product Information Management work area, navigate to the
Items page, Specifications tab. You can also set the Create Supply attribute in the Item simulation set that's available in
Supply Chain Planning.

This table describes how the planning process manages supplies when the Create Supply indicator is set to No.

Applies to plan types: When Create Supply indicator is set
to No for:

The planning process does this:

Constrained and
Unconstrained
 

End items
 

All on-hand inventory and on-order inventory is used up to satisfy
demands. All remaining demands for the end item are marked as unmet
demands.
 

Constrained and
Unconstrained
 

Primary components
 

All demands for end items whose item structure includes this component
is unmet after on-hand and existing supplies are used up to satisfy
demands.
 

Constrained
 

Primary components that have
substitute components defined in Item
Structures
 

A substitute component is used to satisfy the demand of an end item. The
Use substitute components decision rule must be selected on the Plan
Options page, Supply tab, Constraints and Decisions Rules subtab.
 

Constrained
 

A component in a primary bill of
material that has alternate bill of
materials defined
 

An alternate item structure that doesn't have this component is used. The
Use alternate item structure and work definitions decision rule must be
selected on the Plan Options page, Supply tab, Constraints and Decisions
Rules subtab.
 

For information on how to configure decision rules for constrained plans, see the Configure Constraints and Decision
Rules topic in this guide.

How to Create New Supplies Only After a Specified Date  
In some business cases, you might want to delay the creation of planned orders until after a specified date. For example,
if there's a temporary product recall, you might want to allow new orders to be placed, but only after a certain date.

The Create Supply After attribute lets you prevent the creation of new supply order recommendations until after a date
you specify. It allows you to configure each product's earliest supply creation date.

353

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20070400
https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20070400


Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 11
Supply Plans

The Create Supply After attribute must be used in conjunction with the Create Supply attribute. The Create Supply
attribute specifies whether the plan can create a new supply for the item. The Create Supply After field is enabled only if
the Create Supply attribute is first set to Yes.

To set these attributes, from the Product Information Management work area, navigate to the Items page, Specifications
tab. These attributes can also be modified in a plan and in a simulation set, in the Items table.

To delay creating a planned order until after a specified date:

1. Set Create Supply to Yes.
2. Enter a date in the Create Supply After field.

These attributes control the creation of new make and buy planned orders. They don't control the creation of new
transfer planned orders or reschedules of existing orders, because the intent is to limit new orders while utilizing all
possible existing inventory in the supply chain.

Planning ensures that the Suggested Due Date of any new make or buy supply is after the Create Supply After date.
However, the other dates, such as Suggested Dock Date, can be prior to the Create Supply After date based on lead
times. In aggregate planning buckets, the due dates are always at the end of the bucket, but the dates released to the
source system are at the beginning of the bucket. So, in such cases, the released date could fall prior to the Create
Supply After date.

Note that if a demand is satisfied late due to the Create Supply After date constraint, then the Late Supply Pegged to
Sales Order (or Forecast) exception is generated.

The Create Supply and Create Supply After attributes can be used in either constrained or unconstrained supply plans.

Related Topics
• How to Prevent Creating Planned Orders in a Supply Plan

Circular Transfer Orders  
Use circular transfer orders to rebalance your inventory at both the source and destination organizations. In Oracle
Planning Central and Oracle Supply Planning, supply planning can process a transfer order that is a circular order in the
plan.

The supply plan considers the circular transfer order and treats it as a supply at the destination organization. The supply
planning process marks both the transfer order supply and the transfer order demand as firm. This means that the plan
won't recommend reschedules or cancellations for the circular transfer order, which can generate late supply exceptions
or excess inventory exceptions.

For example, your sourcing rule is set to transfer supply from source organization ORG1 to destination organization
ORG2. You discover that you have excess inventory in ORG2 due to a canceled sales order. You decide that you want
to transfer supply from ORG2 back to ORG1, so you manually create a transfer order to move the excess inventory. The
planning process includes your circular transfer order in the plan as a supply to ORG1 and is marked as a firm supply in
the plan.

The planning process pegs the circular transfer demand to an existing supply. In our example scenario, the excess
inventory is pegged to the transfer order demand in destination organization ORG2. The transfer supply is pegged to
some demand in source organization ORG1. If there is no demand in the source organization, then the transfer order
supply doesn't peg to anything.
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The transfer order supply in the destination organization can be early, on time, or late for some demand. However, it
can't be rescheduled by the planning process.

If the transfer order is inside the planning time fence, it can cause these supply exceptions because new supplies cannot
be created:

• Late Supply Pegged to Forecast

• Late Supply Pegged to Sales Order

If the transfer order is outside the planning time fence, it can cause supply exceptions because the transfer is firm. The
Items with Excess Inventory exception is generated when the Projected Available Balance on a particular day exceeds
the Safety Stock Level quantity.

If the transfer order is in the past, it causes the Past Due Orders exception.

Note:  If you create a transfer order in error, there may not be supply in the ship-from organization to use for the
transfer. Circular pegging occurs in this case, with the transfer demand pegging to the transfer supply. In this
situation, you should cancel the circular transfer.

How You Publish Order Forecasts  
You publish order forecast for your suppliers. The suppliers can view the forecast and send their commits to you as a
supplier capacity. You don't have to save the plan to the database before publishing the order forecast.

You can publish order forecast from the following pages in the Supply Planning, Demand and Supply Planning, or
Planning Central work area:

• Items

• Supplies and Demands

• Manage Plans or individual plan

When you select Publish Order Forecast from the Actions menu, the planning process submits a job in Scheduled
Processes. The planning process deselects all additional parameters that are available in the Publish Order Forecast
job and submits the job. If you want to select various additional parameters that are available for the Publish Order
Forecast scheduled process, you must submit the job manually from the Scheduled Processes work area and select your
parameters.

Points to Remember
Consider the following points before you publish the order forecast:

• When you publish the order forecast from the Manage Plans page, you publish the order forecast for all the
valid suppliers within the plan.

• When you're in the Items table or the Supplies and Demand table, you can publish order forecast that belongs
to one Item-Organization at a time. You can't publish two rows of items with different Item-Organization
combinations.

• The Publish Order Forecast job also launches the Supply Planning Collaboration Decomposition job. You don't
have to run the decomposition job separately.
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How You Publish Supply Order Details  
One of the important aspects of collaborating with suppliers is to provide them an insight into the open supply orders.
Collaborating with suppliers on open supply orders enables you and your suppliers to plan supply chain activities more
efficiently.

Supply orders are of four types: purchase order, purchase requisition, shipment in receiving, and in-transit shipment.

You can publish supply orders along with planned orders to Oracle Supply Chain Collaboration using the Publish Order
Forecast scheduled process. Use the Navigator to access the Scheduled Processes page where you can select the
Publish Order Forecast scheduled process. In the Process Details dialog box for the Publish Order Forecast scheduled
process, you can select the following check boxes:

• Include purchase orders in order forecast: Includes purchase orders within the order forecast. All the open
purchase orders for an item on a day are added to the planned orders on that day and published as order
forecast at the supplier or supplier site level.

• Include requisitions in order forecast: Includes purchase requisitions within the order forecast. All the open
purchase requisitions for an item on a day are added to the planned orders on that day and published as order
forecast at the supplier or supplier site level.

• Run the Supply Planning Collaboration Decomposition job: Runs the Supply Planning Collaboration
Decomposition scheduled process along with the Publish Order Forecast scheduled process.

• Publish order details: Publishes all four types of supply orders along with the planned orders.
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12  Analyze Supply Plans

Supplies and Demands View  

Filter Supplies and Demands Based On Conditions  
You can narrow your search in the Supplies and Demands table by selecting a condition from the search filter.
Conditions are a group of supply-related attributes with a specific value. A condition can have one or more attributes.

From an open plan, open the Supplies and Demands table and click the Manage Conditions button in the Search region.
When you open the Manage Conditions dialog box, you can create and manage conditions. When you create conditions,
you specify attributes for your conditions and provide a value to those attributes. The value could be a specific date or
you can specify the number of days relative to another date for a given attribute.

The relative comparison options are available only for date-based attributes, such as Requested Ship Date or Actual
Arrival Date. The values for relative comparison options are enabled when you select one of the following operators:

• Before

• After

• On or before

• On or after

For example, consider a scenario where you make the following selections for a condition:

Condition Values

Attribute
 

Suggested Start Date
 

Operator
 

On or before
 

Relative Date
 

Scheduled Ship Date
 

Number of Days
 

10
 

In this case, the condition would consider the Suggested Start Date as 10 days on or before the Scheduled Ship Date. If
the Scheduled Ship Date is 10-January-2020, then the condition would filter all orders whose Suggested Start Date is on
or before 01-January-2020.

Use Comma-Separated Values with the In Operator
When using the In operator, you can either enter values individually for items, organizations, or order numbers or you
can enter a list of comma-separated values.

If you select the item or organization attribute and the In operator, then the Insert List of Comma-Separated Values tab
appears, which enables you to insert a list of comma-separated values. When you click the Insert button, then planning
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validates the individual entries in the list. If all values are valid, then the list of items or organizations is inserted into the
condition.

If you select the order number attribute and the In operator, then you can enter a list of comma-separated values.
Planning doesn't validate the order numbers that you enter.

Supplies and Demands View Modes  
The Supplies and Demands table has two modes to view supplies and demands data: pegging mode and plain table
mode (also called flat file mode). Click the Show Table icon on the table toolbar to toggle between the two modes.

When you're in the pegging mode, the Supplies and Demands view includes pegging details and the child rows tied to
each root node. For example, if you search for Forecast order types, the Supplies and Demands view shows order types
that are pegged to the forecast.

When you're in plain table mode, the Show Table icon is blue and the Supplies and Demands table only displays the root
node data. The table doesn't display the nested, or pegged data.

Planned Order Dates  
The Supplies and Demands view displays many dates, such as Suggested Due Date and Suggested Order Date. This
topic discusses the different dates used for planned orders, how the dates are calculated, and the calendars used by the
planning process for the calculations.

Note:  Refer to the Calendars Used to Calculate Dates in the Supplies and Demands View topic for information about
the different calendars and the calendar selection hierarchy used by the planning process to calculate dates.

Buy Item
This section discusses the different dates used for buy items, how the dates are calculated, and the calendars used by
the planning process to calculate dates.

Date Calculation Calendar Used

Suggested Due Date
 

Demand Date
 

Organization Manufacturing Calendar (OMC)
 

Suggested Dock Date
 

Due Date minus Postprocessing Lead Time
 

Organization Receiving Calendar (ORC)
 

Suggested Shipment Date
 

Dock Date minus Transit Lead Time
 

Supplier Shipping Calendar (SSC)
 

Suggested Start Date
 

Shipment Date minus Processing Lead Time
 

Supplier Capacity Calendar (SCC) from the
Approved Suppliers List (ASL)
 

Suggested Order Date
 

Start Date minus Preprocessing Lead Time
 

Manufacturing Organization Calendar (not from
the SSC)
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Date Calculation Calendar Used

 

If there is no sourcing rule, then the following applies:

• Suggested Shipment Date is the Dock Date.

• Suggested Start Date is the Shipment Date minus the item's Processing Lead Time.

Make Item
This section discusses the different dates used for make items, how the dates are calculated, and the calendars used by
the planning process to calculate dates.

Date Calculation Calendar Used

Suggested Due Date
 

Demand Date
 

Organization Manufacturing Calendar (OMC)
 

Suggested Dock Date
 

Due Date minus Postprocessing Lead Time
 

Organization Manufacturing Calendar (OMC)
 

Suggested Start Date
 

Dock Date minus Processing Lead Time
 

Organization Manufacturing Calendar (OMC)
 

Suggested Order Date
 

Start Date minus Preprocessing Lead Time
 

Organization Manufacturing Calendar (OMC)
 

Processing Lead Time equals Item attribute Fixed Lead Time plus (quantity multiplied by item attribute Variable Lead
Times).

Transfer Item
This section discusses the different dates used for transfer items, how the dates are calculated, and the calendars used
by the planning process to calculate dates.

Date Calculation Calendar Used

Suggested Due Date
 

Demand Date
 

Valid date on the Destination Organization
Manufacturing Calendar
 

Suggested Dock Date
 

Suggested Due Date minus Postprocessing
Lead Time
 

Valid date on the Destination Organization
Receiving Calendar
 

Suggested Shipment Date
 

Suggested Dock Date minus Transit Lead Time
 

Valid date on the Source Organization Shipping
Calendar
 

Suggested Start Date
 

Suggested Shipment Date
 

Valid date on the Source Organization
Manufacturing Calendar
 

Suggested Order Date
 

Start Date minus Preprocessing Lead Time at
the destination organization

Valid date on the Destination Organization
Manufacturing Calendar
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Date Calculation Calendar Used

  

When calculating Suggested Start Date, the planning process uses the Suggested Shipment Date, which is calculated
using the Source Organization Shipping Calendar. The planning process checks to see if that date is a valid working
day on the Source Organization Manufacturing Calendar. If the date is a working day per the Source Organization
Manufacturing Calendar, then the Suggested Start Date is equal to the Suggested Shipment Date. If it's not a working
day per the Source Organization Manufacturing Calendar, then the Suggested Start Date is moved ahead to the first
working day in the Source Organization Manufacturing Calendar.

Additional Information About Planned Order Dates
When you mark an order for release, the Implement Date is defaulted from the Firm Date or Suggested Due Date. If you
need to account for postprocessing lead time, then you must manually update the Implement Dock Date.

If a make or buy planned order is pegged to multiple demands, the Need by Date on the planned order is the Earliest
Pegged Demand Date.

Related Topics
• Calendars Used to Calculate Dates in the Supplies and Demands View

Calendars Used to Calculate Dates  
In the Supplies and Demands view, there are different calendars used to calculate the various dates. This topic discusses
the different calendars and the calendar selection hierarchy used by the planning process to calculate dates.

For each calendar hierarchy listed in this topic, the planning process searches for an associated calendar. When an
associated calendar is found, the planning process stops and the other levels in the hierarchy aren't checked.

For example, to calculate the start date of purchase supplies, the planning process first looks for the Supplier Site
Capacity Calendar in the Approved Supplier List (ASL). If the planning process doesn't find a Supplier Site Capacity
Calendar, then the process defaults to a 24 hour, 7 days a week calendar to calculate the start date of purchase supplies.

The following lists the calendars and the calendar hierarchy the planning process uses to calculate dates. In cases where
the calendar association appears in the Review Planning Calendar Associations UI, the applicable calendar type and
assignment type is listed.

• Supplier Capacity Calendar (SCC): Calendar used to calculate the start date of purchase supplies.

Hierarchy of Calendar Selection Calendar Type Assignment Type

1. SSC = Supplier Site Capacity Calendar in
the ASL
 

N/A
 

N/A
 

2. 24 Hours, 7 Days a Week N/A N/A
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Hierarchy of Calendar Selection Calendar Type Assignment Type

   

View the Supplier Capacity Calendar in the Suppliers UI. When copying supplier item records into the plan and
the Supplier Capacity Calendar isn't found, the Supplier Site Calendar from the Supply Network Model is copied
into the Supplier Capacity Calendar.

• Supplier Shipping Calendar (SSC) : Calendar used to calculate the shipment date of purchase supplies.

Hierarchy of Calendar Selection Calendar Type Assignment Type

1. SSC = Carrier/Supplier/Supplier Site
Calendar
 

Carrier
 

10 - Carrier and Supplier Site
 

2. Supplier/Supplier Site Shipping Calendar
 

Shipping
 

5 - Supplier Site
 

3. Carrier/Supplier Calendar
 

Carrier
 

7 - Carrier and Supplier
 

4. Supplier Shipping Calendar
 

Shipping
 

1 - Supplier
 

5. 24 Hours, 7 Days a Week
 

N/A
 

N/A
 

• Organization Receiving Calendar (ORC): Calendar used to calculate the dock date at destination and receiving
organization.

Hierarchy of Calendar Selection Calendar Type Assignment Type

1. ORC = Carrier/Organization Calendar
 

Carrier
 

9 - Carrier and Organization
 

2. Organization Receiving Calendar
 

Receiving
 

3 - Organization
 

3. Organization Manufacturing Calendar
(OMC)
 

N/A
 

N/A
 

5. 24 Hours, 7 Days a Week
 

N/A
 

N/A
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• Organization Manufacturing Calendar (OMC): Calendar used to calculate the order date and due date of
purchase supplies. This calendar is used to calculate all dates of make supplies. You can view the Organization
Manufacturing Calendar in the Supply Network Model UI.

Hierarchy of Calendar Selection Calendar Type Assignment Type

1. OMC = Organization Manufacturing
Calendar
 

N/A
 

N/A
 

2. 24 Hours, 7 Days a Week
 

N/A
 

N/A
 

• Organization Shipping Calendar (OSC): Calendar used to calculate the ship date at the source and shipping
organization for transfer orders.

Hierarchy of Calendar Selection Calendar Type Assignment Type

1. OSC = Carrier/Organization Calendar
 

Carrier
 

9 - Carrier and Organization
 

2. Organization Shipping Calendar
 

Shipping
 

3 - Organization
 

3. Organization Manufacturing Calendar
(OMC)
 

N/A
 

N/A
 

5. 24 Hours, 7 Days a Week
 

N/A
 

N/A
 

• Customer Receiving Calendar (CRC): Calendar used to calculate the arrival date on end demands (sales
orders).

Hierarchy of Calendar Selection Calendar Type Assignment Type

1. CRC = Carrier/Customer/Customer Site
Calendar
 

Carrier
 

11 - Carrier and Customer Site
 

2. Customer/Customer Site Receiving
Calendar
 

Receiving
 

6 - Customer Site
 

3. Carrier/Customer Calendar
 

Carrier
 

8 - Carrier and Customer
 

4. Customer Receiving Calendar
 

Receiving
 

2 - Customer
 

5. 24 Hours, 7 Days a Week N/A N/A
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Hierarchy of Calendar Selection Calendar Type Assignment Type

   

• Valid Transit Calendar (VTC): Calendar used to calculate transit days on demands and supplies.

Hierarchy of Calendar Selection Calendar Type Assignment Type

1. VTC = Carrier Transit Calendar
 

Carrier
 

4 - Carrier
 

2. 24 Hours, 7 Days a Week
 

N/A
 

N/A
 

Related Topics
• Planned Order Dates in the Supplies and Demands View

Use Calendar Details View to Analyze Supply Dates  
When you analyze a plan, it’s important for you to have insight into how supply dates were generated.

The View Calendar Details action displays a Gantt chart that shows the schedule details of a specific supply, such as lead
times and calendar constraints. The View Calendar Details action is available from the Supplies and Demands page.

You can use the View Calendar Details action to readily gain insight into information such as:

• The calendar used in calculating a specific supply date, as well as the associated calendar’s nonworking days

• The lead times used in calculating a supply date

• Other related attributes that factor into calculating supply dates, such as the planning time fence date of an
item or the time zones of the related entities

The View Calendar Details action can help you troubleshoot supply dates when there are questions.

To use the View Calendar Details action:

1. From the Supplies and Demands page, select a single supply that is not an on-hand supply.
2. Select View Calendar Details from the Actions menu.

The Calendar Details window opens and displays a Gantt chart with a timeline that specifies the details of the calendars
used.

Note:  The View Calendar Details action is not available in Replenishment Planning.
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Calendar Details Overview
The Calendar Details window displays the attributes that factored into the calculation of supply dates. Based on order
type, these attributes might vary.

• For example, the Supplier and Supplier Site fields are applicable only for purchase orders, purchase requisitions,
and planned buy orders. Therefore these fields aren't displayed when viewing calendar details for a transfer
order or work order.

• Other fields, such as Supply Planning Calendar and Plan Start Date, are always displayed, regardless of order
type.

• Earliest Start Date and Latest Start Date are specific to constrained planning and, therefore, these fields appear
only when a supply in a constrained plan is displayed.

• The rows that are displayed in the Gantt chart vary based on order type. For example, the Suggested Ship Date
and the Transit Lead Time rows aren't displayed when viewing a work order or a planned make order because
these rows aren’t applicable for make orders.

The View menu can be used to hide or show columns in the Gantt chart. For example, you might choose to hide the
Time Zone column if all supply dates are in the same time zone.

Within the Gantt chart, a vertical red line represents the plan start date. For interpreting other icons, refer to the legend
below the Gantt chart.

Hover over any milestone or bar within the Gantt chart to display the applicable start and end dates. When milestone
dates overlap, the suggested date is always displayed on top in the Gantt chart. If you hover over the milestone, you can
see if there are any overlapping dates. Dates that have a potential to overlap are also displayed in the header fields of
the Calendar Details window. For example, the Need-by Date might be hidden by the suggested due date, so the Need-
by Date is displayed in the header section of the window.

When viewing the Calendar Details window, you should be aware of how lead times are calculated for this view. When
displaying lead time duration, the Calendar Details window uses the applicable suggested date and time that is output
by the planning process as the end date and then calculates the start date. All supply dates, after they are saved to the
database, have an end-of-day time stamp of 23:59:00. As a result, the start date as calculated for this window might
appear to be off by a day.

For example, let’s say during plan run, the planning process calculated a Suggested Dock Date of September 14, 12 p.m.
Assuming transit lead time is 1.75 days, the planning process would calculate a Suggested Ship Date of September 12, 6
p.m. When the supply dates are written to the database, the actual times are replaced with an end-of-day time stamp of
23:59:00. The Calendar Details window uses the Suggested Dock Date of September 14, 11:59 p.m. as the end date of the
Transit Lead Time Gantt bar. It then subtracts 1.75 days of transit lead time to get the start date for the Transit Lead Time
Gantt bar, which would be September 13, 5:59 a.m. Because the Calendar Details window is using the end-of-day time
stamp, there’s a gap between the Suggested Ship Date, which is September 12, and the calculated start of the Transit
Lead Time, which is September 13. This is just something to be aware of when viewing the Calendar Details window.

View Calendar Details Example: Planned Buy Order  
This example describes the calendar details of a planned buy order in an unconstrained plan.

You can tell it’s a buy order because the Supplier, Supplier Site, and Supplier Site Time Zone fields are displayed in
the header section. This is an unconstrained plan. If this were a constrained plan, there would be two additional fields
displayed in the header section: Earliest Start Date and Latest Start Date.
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For planned buy orders, all lead times and suggested dates are applicable, so all available rows are shown in the Gantt
chart.

Planning uses backward scheduling to calculate supply dates, so we’ll analyze the dates starting from the Suggested
Due Date (the last row).

Date or Lead Time Row Value Explanation

Suggested Due Date February 4 In this example, the Suggested Due Date is the same as the Need-by Date. Because
unconstrained planning schedules supplies based on Need-by Date, it’s common that both
dates are the same.
 
When milestone dates overlap, the suggested date is always displayed on top in the Gantt
chart. If you hover over the Suggested Due Date milestone, you can see that both the Need-
by Date and Suggested Due Date are on February 4. The Need-by Date is also displayed in
the header section for quick reference without having to hover.
 
If needed, planning will move the Suggested Due Date out so that it’s on or after the
Planning Time Fence Date. In this case, the Planning Time Fence Date is January 7, so there’s
no need to move the Suggested Due Date out.
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Date or Lead Time Row Value Explanation

 
The calendar used in calculating the Suggested Due Date is the Organization Manufacturing
Calendar. In this example, the calendar used is APS Calendar, which has Saturdays and
Sundays as nonworking days, represented by gray bars in the Gantt chart.
 
Planning always ensures that the Suggested Due Date is on a working day, however, a
planner may firm the order on a nonworking day. If the order is firmed, the Gantt chart will
display the Suggested Due Date using the firm date icon (a blue circle), in place of the regular
green diamond icon.
 
The planning bucket type for this date and all other dates is day. This lets you know that the
Suggested Due Date didn’t get moved to the last working day of the planning bucket, which
is what happens when planning in aggregate planning buckets.
 

Postprocessing Lead Time 5 days The Postprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides. In this example, there are 5 days of Postprocessing
Lead Time.
 
The same calendar used for Suggested Due Date (the Organization Manufacturing Calendar)
is also used in calculating Postprocessing Lead Time duration.
 
The end date of the Postprocessing Lead Time is set to the Suggested Due Date.
 
The start date of the Postprocessing Lead Time is calculated by subtracting the
Postprocessing Lead Time from the end date of the Postprocessing Lead Time, only
counting the working days. In this example, the Postprocessing Lead Time starts at the
beginning of the day on Tuesday, January 29, and goes through the end of the day on
Monday, February 4 (skipping Saturday and Sunday, which are nonworking days on the APS
Calendar).
 

Suggested Dock Date January 28 The Suggested Dock Date is based on the Organization Receiving Calendar.
 
Depending on your setup, the Organization Receiving Calendar might be different from the
Organization Manufacturing Calendar, which is used in calculating the Suggested Due Date
and Postprocessing Lead Time.
 
The Organization Receiving Calendar can be specific to the receiving organization, or to a
carrier and receiving organization combination.
 
In this example, the same calendar (APS Calendar) that’s used in calculating the Suggested
Due Date and Postprocessing Lead Time is also used for calculating the Suggested Dock
Date.
 
In cases where the Organization Receiving Calendar is different from the Organization
Manufacturing Calendar, the Suggested Dock Date might need to be moved earlier to
ensure that it ends up on a working day on the Organization Receiving Calendar. In this
example, APS Calendar is used as both the Organization Manufacturing Calendar and the
Organization Receiving Calendar, so there’s no need to make any adjustment because of
differences in working days between the two calendars.
 
The Suggested Dock Date of January 28 matches what we expect to see, given the
Postprocessing Lead Time.
 

Transit Lead Time 2 days The Transit Lead Time was derived based on the Shipping Method shown in the header
section, which comes from the Interlocation Shipping Methods tab of the Supply Network
Model UI.
 
The calendar used in calculating Transit Lead Time is APS Calendar1, which has different
working days from the calendar used for the Suggested Dock Date. Only Sundays through
Thursdays are working days for APS Calendar1.
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Date or Lead Time Row Value Explanation

 
The end date of the Transit Lead Time is set to the Suggested Dock Date. If the Suggested
Dock Date is not a valid working day on the transit calendar, then the Transit Lead Time
end date will be moved earlier, to a working day on the transit calendar. In this example, the
Suggested Dock Date, January 28, is a valid working day on the transit calendar, so there’s no
need to adjust the end date of the Transit Lead Time.
 
The start date of the Transit Lead Time is calculated by subtracting the Transit Lead Time
from the end date of the Transit Lead Time, only counting the working days on the transit
calendar. In this example, Transit Lead Time starts at the beginning of the day on Sunday,
 January 27, and goes through the end of the day on Monday, January 28.
 

Suggested Ship Date January 24 The Supplier Shipping Calendar is used to calculate the Suggested Ship Date of a buy order.
 
In this example, no Supplier Shipping Calendar was found, so all days are considered
working days.
 
Because all days are working days, there was no need during plan run to adjust the
Suggested Ship Date so that it ended up on a working day.
 
You might be asking why the suggested date is Thursday, January 24. Given that the start
of the Transit Lead Time shown in the window was the beginning of the day on Sunday,
 January 27, shouldn't the ship date have been Saturday, January 26? The probable cause is
that when Transit Lead Time was calculated during plan run, the end date of the Transit Lead
Time wasn't at the very end of the day, but sometime earlier that day. This would cause the
Transit Lead Time start date to be sometime during the day on Thursday, January 24 (given
that Fridays and Saturdays are nonworking days on the transit calendar). So the Suggested
Ship Date makes sense, even though there is a gap, because of the difference between the
time stamps used during plan run and the time stamp used in the Calendar Details window
to calculate lead times.
 

Processing Lead Time 1 day The Processing Lead Time’s duration in days value comes from the Approved Supplier List
(ASL), which is displayed using the Suppliers UI. If no ASL exists for the Supplier/Supplier
Site/Item combination, then the Processing Lead Time’s duration in days value comes from
the Items page and includes any simulation set overrides.
 
The Supplier Capacity Calendar is used in calculating Processing Lead Time. In this example,
 there is no Supplier Capacity Calendar, so all days are considered to be working days for the
supplier.
 
The Processing Lead Time end date is set to the Suggested Ship Date. If the Processing
Lead Time end date is a nonworking day on the Supplier Capacity Calendar, it will be moved
earlier to a working day. In this example, the Suggested Ship Date, January 24, is a valid
working day, so there’s no need to adjust the Processing Lead Time end date.
 
The start date of the Processing Lead Time is calculated by subtracting the Processing Lead
Time from the end date of the Processing Lead Time, only counting the working days. In this
example, the Processing Lead Time starts at the beginning of the day on January 24 and
goes through to the end of that same day.
 

Suggested Start Date January 23 The Supplier Capacity Calendar is used to calculate the Suggested Start Date.
 
In this example, no Supplier Capacity Calendar was found, so all days are considered working
days.
 
The Suggested Start Date of January 23 matches what we expect to see, given the
Processing Lead Time.
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Date or Lead Time Row Value Explanation

Preprocessing Lead Time 2 days The Preprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides.
 
Preprocessing Lead Time and Suggested Order Date are used to account for the time it takes
the organization to raise an order. So it's the Organization Manufacturing Calendar that is
used in calculating Preprocessing Lead Time and the Suggested Order Date. In this case, the
calendar used is APS Calendar.
 
The Preprocessing Lead Time end date is set to the Suggested Start Date. If the
Preprocessing Lead Time end date is not a valid working day on the Organization
Manufacturing Calendar, it will be moved earlier to a working day. In this example, the
Suggested Start Date, January 23, is a valid working day, so there’s no need to adjust the end
date of the Preprocessing Lead Time.
 
The start date of the Preprocessing Lead Time is calculated by subtracting the Preprocessing
Lead Time from the end date of the Preprocessing Lead Time, only counting the working
days. In this example, Preprocessing Lead Time starts at the beginning of the day on January
22 and goes through the end of the day on January 23.
 

Suggested Order Date January 21 The Organization Manufacturing Calendar is used to calculate the Suggested Order Date. In
this example, the calendar used is APS Calendar.
 
The January 21 Suggested Order Date matches what we expect to see, given the
Preprocessing Lead Time.
 
The supply dates of a purchase order or purchase requisition can be analyzed using the
View Calendar Details action in the same way that supply dates are analyzed for planned
buy orders. The only difference is that, by default, Preprocessing Lead Time is not applied to
purchase orders and purchase requisitions. After the planned order is released and an order
is created on the source system, the ordering process is complete and there’s no need for
planning to account for the time it takes to raise an order. As a result, the Preprocessing Lead
Time row isn't applied (and therefore it isn't displayed) for purchase orders and purchase
requisitions. When Preprocessing Lead Time isn't applied, the Suggested Order Date is equal
to the Suggested Start Date.
 

Related Topics
• Calendars Used to Calculate Dates in the Supplies and Demands View

View Calendar Details Example: Planned Transfer Order  
This example describes a planned transfer order in an unconstrained plan.

You can tell it’s a transfer order because Source Organization and Source Organization Time Zone fields are displayed
in the header section. This is an unconstrained plan. If this were a constrained plan, there would be two additional fields
displayed in the header section as well: Earliest Start Date and Latest Start Date.
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When looking at the Gantt chart of a transfer order, the Processing Lead Time row isn't displayed. Processing Lead Time
doesn’t factor into the scheduling of a transfer order (planned or otherwise) because the transfer order only accounts
for the transferring of the supply from the source organization to the destination organization. The processing time
required at the source organization is accounted for on the applicable buy or make order.

The red vertical line in the Gantt chart represents the plan start date, which is also shown in the header field. This line is
only visible when the plan start date is within the visible portion of the Gantt window.

Planning uses backward scheduling to calculate supply dates, so we’ll analyze the dates starting from the Suggested
Due Date (the last row).

Date or Lead Time Row Value Explanation

Suggested Due Date January 10 In this example, the Suggested Due Date is the same as the Need-by Date. Because
unconstrained planning schedules supplies based on Need-by Date, it’s common that both
dates are the same.
 
When milestone dates overlap, the suggested date is always displayed on top in the Gantt
chart. If you hover over the Suggested Due Date milestone, you can see that both the Need-
by Date and Suggested Due Date are on January 10. The Need-by Date is also displayed in
the header section for quick reference without having to hover.
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If needed, planning will move the Suggested Due Date out so that it’s on or after the
Planning Time Fence Date. In this case, the Planning Time Fence Date is January 4 (the same
as the Plan Start Date), so there's no need to move the Suggested Due Date out.
 
The calendar used in calculating the Suggested Due Date is the Destination Organization
Manufacturing Calendar. In this example, the calendar used is APS Calendar, which has
Saturdays and Sundays as nonworking days, represented by gray bars in the Gantt chart.
 
Planning always ensures that the Suggested Due Date is on a working day, however, a
planner may firm the order on a nonworking day. If the order is firmed, the Gantt chart will
display the Suggested Due Date using the firm date icon (a blue circle), in place of the regular
green diamond icon.
 
The planning bucket type for this date and all other dates is day. This lets you know that the
Suggested Due Date didn’t get moved to the last working day of the planning bucket, which
is what happens when planning in aggregate planning buckets.
 

Postprocessing Lead Time 1 day The Postprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides.
 
The same calendar used for Suggested Due Date (the Destination Organization
Manufacturing Calendar) is also used in calculating Postprocessing Lead Time duration.
 
The end date of the Postprocessing Lead Time is set to the Suggested Due Date. Because
the same calendar is being used for both dates, there's no need to make any adjustment to
the end date of the Postprocessing Lead Time to ensure it’s on a nonworking day.
 
The start date of the Postprocessing Lead Time is calculated by subtracting the
Postprocessing Lead Time from the end date of the Postprocessing Lead Time, only
counting the working days. In this example, Postprocessing Lead Time starts and ends on
Tuesday, January 8. Because the time associated with the Suggested Due Date is the end of
the day (that is, 23:59:00), the 1 day of Postprocessing Lead Time starts at the beginning of
the day and goes to the end of the same day.
 

Suggested Dock Date January 9 The calendar used in calculating the Suggested Dock Date is the Destination Organization
Receiving Calendar. In this example, the calendar used is APS Calendar.
 
Depending on your setup, the Destination Organization Receiving Calendar might be
different from the Organization Manufacturing Calendar, which is used in calculating the
Suggested Due Date and Postprocessing Lead Time.
 
The Organization Receiving Calendar can be specific to the receiving organization, or to a
carrier and receiving organization combination.
 
In this case, the same calendar used for calculating the Suggested Due Date and
Postprocessing Lead Time is also used for calculating the Suggested Dock Date. Therefore,
 there was no need to adjust the Suggested Dock Date so that it ended up on a working day.
 
The Suggested Dock Date of January 9 matches what we expect to see, given the
Postprocessing Lead Time.
 

Transit Lead Time 2 days The Transit Lead Time was derived based on the Shipping Method shown in the header
section, which comes from the Interlocation Shipping Methods tab of the Supply Network
Model UI.
 
The calendar used in calculating Transit Lead Time is APS Calendar1, which has different
working days from other calendars used. Only Sundays through Thursdays are working days
for APS Calendar1.
 
The end date of the Transit Lead Time is set to the Suggested Dock Date. If the end date of
the Transit Lead Time is not a valid working day on the transit calendar, then the Transit Lead
Time end date will be moved earlier, to a working day on the transit calendar. In this example,
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 the Suggested Dock Date, January 9, is a valid working day on the transit calendar, so there’s
no need to adjust the end date of the Transit Lead Time.
 
The start date of the Transit Lead Time is calculated by subtracting the Transit Lead Time
from the end date of the Transit Lead Time, only counting the working days on the transit
calendar. In this example, Transit Lead Time starts at the beginning of the day on Sunday,
 January 8, and goes through the end of the day on Monday, January 9.
 

Suggested Ship Date January 5 The Source Organization Shipping Calendar is used to calculate the Suggested Ship Date.
 
In this example, APS Calendar was used in calculating the Suggested Ship Date, which has
Saturdays and Sundays as nonworking days, represented by the gray bars in the Gantt chart.
 
As you can see, there’s a gap between the Suggested Ship Date and the Transit Lead Time
start date. Some of the gap is accounted for because Sunday, January 8, is a nonworking day
on the shipping calendar. Why did planning calculate a Suggested Ship Date of Thursday,
 January 5, and not Friday, January 6? The most likely answer is that the Suggested Dock
Date calculated during plan run had a time stamp that wasn’t at the end of the day, and that
caused the transit time to actually start on Thursday, January 5 (due to Friday, Saturday, and
Sunday being nonworking days).
 
Because the View Calendar Details action calculates lead times after suggested dates are
moved to the end of the day, there's a loss of precision from how the planning process
calculated suggested dates during plan run. This can result in a gap of one working day
being shown in the Calendar Details window.
 

Suggested Start Date January 5 The Source Organization Manufacturing Calendar is used to calculate the Suggested Ship
Date.
 
Because the transfer order doesn’t include Processing Lead Time, the Suggested Start Date
is set to the same date as the Suggested Ship Date.
 
If the Suggested Start Date is not a valid working day on the Source Organization
Manufacturing Calendar, it will be moved earlier to a working day.
 
In this example, the same calendar (APS calendar) was used for calculating both Suggested
Ship Date and Suggested Start Date. The Suggested Start Date, January 5, is a valid working
day on the Source Organization Manufacturing Calendar, so there's no need to adjust the
date.
 

Preprocessing Lead Time 1 day The Preprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides.
 
Preprocessing Lead Time and Suggested Order Date are used to account for the time it takes
the destination organization to raise an order.
 
The Destination Organization Manufacturing Calendar is used in calculating Preprocessing
Lead Time. In this case, the calendar used is APS Calendar.
 
The Preprocessing Lead Time end date is set to the Suggested Start Date. If the Suggested
Start Date is not a valid working day on the Destination Organization Manufacturing
Calendar, it will be moved earlier to a working day. In this example, the Suggested Start
Date, January 5, is a valid working day, so there’s no need to adjust the end date of the
Preprocessing Lead Time.
 
The start date of the Preprocessing Lead Time is calculated by subtracting the Preprocessing
Lead Time from the end date of the Preprocessing Lead Time, only counting the working
days. In this example, Processing Lead Time starts at the beginning of the day on January 5
and goes through the end of that same day.
 

Suggested Order Date January 4 The Destination Organization Manufacturing Calendar is used to calculate the Suggested
Order Date. In this example, the calendar used is APS Calendar.
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The January 4 Suggested Order Date matches what we expect to see, given the
Preprocessing Lead Time.
 
In this example, the Suggested Order Date just happens to be the same day as the plan start
date. This was not a case where the Preprocessing Lead Time needed to be compressed
because the plan start date was reached.
 
The supply dates of a transfer order can be analyzed using the View Calendar Details action
in the same way that supply dates are analyzed for a planned transfer order. The only
difference is that, by default, Preprocessing Lead Time is not applied to transfer orders. After
the planned order is released and an order is created on the source system, the ordering
process is complete so there’s no need for planning to account for the time it takes to raise
an order. As a result, the Preprocessing Lead Time row isn't applied (and therefore it isn't
displayed) for transfer orders. When Preprocessing Lead Time isn't applied, the Suggested
Order Date is equal to the Suggested Start Date.
 

Related Topics
• Calendars Used to Calculate Dates in the Supplies and Demands View

View Calendar Details Example: Planned Make Order  
This example describes a planned make order in an unconstrained plan.

You can tell it’s a make order because the Supplier and Source Organization fields aren’t displayed in the header section.
This is an unconstrained plan. If this were a constrained plan, there would be two additional fields displayed in the
header section: Earliest Start Date and Latest Start Date.

When looking at the Gantt chart of a make order, the Transit Lead Time and Suggested Ship Date rows aren’t displayed.
Make orders aren’t shipped or received, so these dates don’t factor into the scheduling of a make order (planned or
otherwise).

The Organization Manufacturing Calendar is used in calculating all suggested dates and lead times of a make order.

The red vertical line in the Gantt chart represents the plan start date, which is also shown in the header field. This line is
only visible when the plan start date is within the visible portion of the Gantt window.
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Planning uses backward scheduling to calculate supply dates, so we’ll analyze the dates starting from the Suggested
Due Date (the last row).

Date or Lead Time Row Value Explanation

Suggested Due Date January 14 In this example, the Suggested Due Date is the same as the Need-by Date. Because
unconstrained planning schedules supplies based on Need-by Date, it’s common that both
dates are the same.
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When milestone dates overlap, the suggested date is always displayed on top in the Gantt
chart. If you hover over the Suggested Due Date milestone, you can see that both Need-by
Date and Suggested Due Date are on January 14. The Need-by Date is also displayed in the
header section for quick reference without having to hover.
 
If needed, planning will move the Suggested Due Date out so that it’s on or after the
Planning Time Fence Date. In this case, the Planning Time Fence Date is January 4 (the same
day as the Plan Start Date), so there's no need to move the Suggested Due Date out.
 
In this example, the Planning Time Fence Date is the same day as the Plan Start Date, even
though the value of the Planning Time Fence Days is 2. This is because the planning time
fence control plan option is not checked, so the Planning Time Fence Date defaults to the
Plan Start Date.
 
The calendar used in calculating the Suggested Due Date, as well as all other suggested
dates, is the Organization Manufacturing Calendar. In this example, the calendar used is APS
Calendar, which has Saturdays and Sundays as nonworking days, represented by gray bars in
the Gantt chart.
 
Planning always ensures that the Suggested Due Date is on a working day, however a
planner may firm the order on a nonworking day. If the order is firmed, the Gantt chart will
display the Suggested Due Date using the firm date icon (a blue circle), in place of the regular
green diamond icon.
 
The planning bucket type for this date and all other dates is day. This lets you know that the
Suggested Due Date didn’t get moved to the last working day of the planning bucket, which
is what happens when planning in aggregate planning buckets.
 

Postprocessing Lead Time 4 days The Postprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides.
 
The end date of the Postprocessing Lead Time is set to the Suggested Due Date.
 
The start date of the Postprocessing Lead Time is calculated by subtracting the
Postprocessing Lead Time from the end date of the Postprocessing Lead Time, counting
only the working days. In this example, the Postprocessing Lead Time starts at the beginning
of the day on Wednesday, January 9, and goes through the end of the day on Monday,
 January 14 (skipping Saturday and Sunday, which are nonworking days).
 

Suggested Dock Date January 8 The Suggested Dock Date of January 8 matches what we expect to see, given the
Postprocessing Lead Time.

Manufacturing Lead Time 4 days The Manufacturing Lead Time’s duration in days value is calculated using the item’s fixed
and variable lead time and includes any simulation set overrides, where Manufacturing Lead
Time = Fixed Lead Time + (Start Quantity * Variable Lead Time).
 
The Manufacturing Lead Time end date is set to the Suggested Dock Date.
 
The start date of the Manufacturing Lead Time is calculated by subtracting the
Manufacturing Lead Time from the end date of the Manufacturing Lead Time, counting only
the working days. In this example, the Manufacturing Lead Time was compressed because
the plan start date was reached. The Manufacturing Lead Time starts at the beginning of the
day on January 4, which is the plan start date, and goes through the end of day on January
8, which accounts for only 3 of the 4 required manufacturing days.
 

Suggested Start Date January 4 Because the plan start date has been reached, the Suggested Start Date is set to the plan
start date. Planning will not schedule a suggested date that is earlier than plan start date.
 
During backward scheduling, when the plan start date is reached, the Suggested Start Date
will be set to the plan start date, even if the plan start date is a nonworking day.
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Preprocessing Lead Time 3 days The Preprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides.
 
Because the plan start date has already been reached, the Preprocessing Lead Time is
compressed to the first day of the plan.
 

Suggested Order Date January 4 In this example, planning has already reached the plan start date so the Suggested Order
Date is placed on the first day of the plan (regardless of whether the first working day of the
plan is a working day or not).
 
The scheduling of a work order works differently from a planned make order. Refer to the
work order example in this chapter to understand how planning calculates suggested dates
on work orders.
 

Related Topics
• Calendars Used to Calculate Dates in the Supplies and Demands View

View Calendar Details Example: Work Order  
This example describes a work order that has been rescheduled in, meaning the Suggested Due Date is earlier than the
old due date.

Collected work orders are scheduled differently from the other order types. If planning didn't reschedule the work order,
then the suggested dates seen in the Calendar Details window are the ones that were collected from the source system.

Looking at the order in the Supplies and Demands page, we can see the old dates (before rescheduling) as well as
the new suggested dates. The Reschedule Days column displays the number of working days on the Organization
Manufacturing Calendar that the work order was scheduled in or out. When the work order is rescheduled in, meaning
the Suggested Due Date is earlier than the old due date, Reschedule Days will be a negative number. In this example, the
work order has been rescheduled in by 7 working days on the Organization Manufacturing Calendar.

When looking at the Gantt chart of a work order, the Transit Lead Time and Suggested Ship Date rows aren't displayed.
Make orders aren’t shipped or received, so these dates don’t factor into the scheduling of a make order (planned or
otherwise). Because this an existing work order collected from the source system, Preprocessing Lead Time is not
applied, so this row is also hidden.

The Organization Manufacturing Calendar is used in calculating all suggested dates and lead times of a work order.
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The red vertical line in the Gantt chart represents the plan start date, which is also shown in the header field. This line is
only visible when the plan start date is within the visible portion of the Gantt window.

When rescheduling a work order, planning doesn’t recalculate suggested dates by subtracting lead times. Instead,
planning will adjust the suggested dates by subtracting the Reschedule Days from the collected dates, as described in
the following table.

Date or Lead Time Row Value Explanation

Suggested Due Date January 14 In this example, planning has rescheduled the work order in by 7 days to meet the Need-by
Date. So the Suggested Due Date is the same as the Need-by Date, which is January 14.
 
When milestone dates overlap, the suggested date is always displayed on top in the Gantt
chart. If you hover over the Suggested Due Date milestone, you can see that both the Need-
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by Date and Suggested Due Date are on January 14. The Need-by Date is also displayed in
the header section for quick reference without having to hover.
 
The calendar used in calculating the Suggested Due Date, as well as all other suggested
dates, is the Organization Manufacturing Calendar. In this example, the calendar used is APS
Calendar, which has Saturdays and Sundays as nonworking days, represented by gray bars in
the Gantt chart.
 
The planning bucket type for this date and all other dates is day. This lets you know that the
Suggested Due Date didn’t get moved to the last working day of the planning bucket, which
is what happens when planning in aggregate planning buckets.
 

Postprocessing Lead Time 0 days The Postprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides.
 
In this case there’s no Postprocessing Lead Time defined, so there’s no bar in the Gantt chart
that represents Postprocessing Lead Time.
 

Suggested Dock Date January 14 Instead of calculating a Suggested Dock Date using the item’s Postprocessing Lead Time,
 planning calculates a Suggested Dock Date by adjusting the old (also known as collected)
dock date to be 7 working days earlier on the Organization Manufacturing Calendar.

Manufacturing Lead Time 1 day The Manufacturing Lead Time’s duration in days value is calculated using the item’s fixed
and variable lead time and includes any simulation set overrides, where Manufacturing Lead
Time = Fixed Lead Time + (Start Quantity * Variable Lead Time).
 
The Manufacturing Lead Time end date is set to the Suggested Dock Date.
 
The start date of the Manufacturing Lead Time is calculated by subtracting the
Manufacturing Lead Time from the end date of the Manufacturing Lead Time, counting only
the working days. In this example, the Manufacturing Lead Time starts at the beginning of
the day on Monday, January 14, and goes through to the end of that same day.
 

Suggested Start Date January 8 The start date is Tuesday, January 8, which appears to be earlier than needed, given the
Manufacturing Lead Time shown in the Calendar Details window.
 
Instead of calculating a Suggested Start Date using the item's Manufacturing Lead Time,
 planning calculates a Suggested Start Date by adjusting the old (also known as collected)
start date to be 7 working days earlier on the Organization Manufacturing Calendar.
 
The work order start date established by the manufacturing execution source system
considers various constraints, which unconstrained planning doesn't. So unconstrained
planning tries to honor those constraints, as best as it can, by keeping the same number of
working days between the supply dates.
 

Suggested Order Date January 8 Because Preprocessing Lead Time isn’t applied to work orders, the Suggested Order Date is
set to the Suggested Start Date.
 

Related Topics
• Calendars Used to Calculate Dates in the Supplies and Demands View

View Calendar Details Example: Aggregate Planning Buckets  
This example describes a planned make order in a constrained plan, using aggregate planning buckets.
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The Earliest Start Date and Latest Start Date are displayed in the header section. These fields are displayed only in a
constrained plan. These dates are also plotted in the Gantt chart, if the dates fall within the Gantt window.

In this example, the supply planning bucket type for each suggested date is week. Depending on your plan options, it's
possible for some suggested dates to have a different bucket type than others. For example, some dates might fall into a
daily bucket while other dates for the same supply might fall into a weekly bucket.

When planning in aggregate time buckets, meaning a time bucket that is higher than a day, the suggested dates are
moved to the last working day of the supply planning bucket during plan run. A yellow diamond on the Gantt chart
indicates a suggested date that has been moved to the last working day of the supply planning bucket.

Date or Lead Time Row Value Explanation

Suggested Due Date January 18 In this example, the Suggested Due Date is later than the Need-by Date. This is a constrained
plan, so there was some constraint that caused the Suggested Due Date to be after the
Need-by Date.
 
If needed, planning will move the Suggested Due Date out so that it’s on or after the
Planning Time Fence Date. In this case, the Planning Time Fence Date is January 4 (the same
day as Plan Start Date and Need-by Date), so it had no impact on the Suggested Due Date.
 
Because this is a planned make order, the calendar used in calculating the Suggested Due
Date, as well as all other suggested dates, is the Organization Manufacturing Calendar.
In this example, the calendar used is APS Calendar, which has Saturdays and Sundays as
nonworking days.
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Planning always ensures that the Suggested Due Date is on a working day, however, a
planner may firm the order on a nonworking day. If the order is firmed, the Gantt chart will
display the Suggested Due Date using the firm date icon (a blue circle), in place of the regular
green diamond icon.
 
The planning bucket type for this date and all other dates is week. This tells you that the
Suggested Due Date was moved to the last working day of the planning bucket, which is
what happens when planning in aggregate time buckets.
 

Postprocessing Lead Time 0 days The Postprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides.
 
In this example, the Postprocessing Lead Time is zero, so there’s no need to calculate
Postprocessing Lead Time start and end date.
 
If Postprocessing Lead Time wasn’t zero, it would be calculated as follows:
 

• The Postprocessing Lead Time end date is set to the Suggested Due Date.

• The start date of the Postprocessing Lead Time is calculated by subtracting the
Postprocessing Lead Time from the end date of the Postprocessing Lead Time, only
counting the working days.

• The calculations of Postprocessing Lead Time start and end dates are performed
when the UI is displayed, after planning has moved the Suggested Due Date to the
last working day of the planning bucket. As a result, the postprocessing start and end
dates might not match the dates that were calculated during plan run (which is done
before moving the Suggested Due Date to the end of the planning bucket). This loss
of precision is expected when displaying calendar details of a supply that was planned
using aggregate time buckets.

Suggested Dock Date January 18 Given that the Postprocessing Lead Time is zero, a Suggested Dock Date that is the same as
the Suggested Due Date is expected.

Processing Lead Time 4 days The Processing Lead Time’s duration in days value comes from the Items page and includes
any simulation set overrides.
 
The Processing Lead Time end date is set to the Suggested Dock Date.
 
The start date of the Processing Lead Time is calculated by subtracting the Processing Lead
Time from the end date of the Processing Lead Time, only counting the working days. In this
example, the Processing Lead Time starts at the beginning of the day on Tuesday, January
15, and goes through the end of the day on Friday, January 18.
 
The calculation of Processing Lead Time start and end dates is performed when the UI is
displayed, after planning has moved the Suggested Dock Date to the last working day of
the planning bucket. As a result, the processing start and end dates might not match the
dates that were calculated during plan run (which is done before moving the Suggested Dock
Date to the end of the planning bucket). This loss of precision is expected when displaying
calendar details of a supply that was planned using aggregate time buckets.
 

Suggested Start Date January 18 The Suggested Start Date was moved to the last working day of the supply planning bucket,
 so it ended up being the same date as the Suggested Dock Date. This is because both dates
(after accounting for Processing Lead Time) fell into the same supply planning bucket.

Preprocessing Lead Time 2 days The Preprocessing Lead Time’s duration in days value comes from the Items page and
includes any simulation set overrides.
 
The Preprocessing Lead Time end date is set to the Suggested Start Date.
 
The start date of the Preprocessing Lead Time is calculated by subtracting the Preprocessing
Lead Time from the end date of the Preprocessing Lead Time, only counting the working
days. In this example, Processing Lead Time starts at the beginning of the day on Thursday,
 January 17, and goes through the end of the day on Friday, January 18.
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The calculation of Preprocessing Lead Time start and end dates is performed when the UI
is displayed, after planning has moved the Suggested Start Date to the last working day of
the planning bucket. As a result, the preprocessing start and end dates might not match the
dates that were calculated during plan run (which is done before moving the Suggested Start
Date to the end of the planning bucket).
 
When suggested dates are moved to the last working day of the supply planning bucket, it's
common to see that lead times overlap in the Calendar Details window. In this example, we
see that Preprocessing and Processing Lead Times are overlapping.
 
This loss of precision is expected when displaying calendar details of a supply that was
planned using aggregate time buckets.
 

Suggested Order Date January 11 While not obvious at first, it makes sense that the Suggested Order Date is Friday, January
11. When calculating the Suggested Order Date, planning had to account for 4 days of
Processing Lead Time and 2 days of Preprocessing Lead Time, without any overlap. This
caused the Suggested Order Date to fall into the prior planning bucket (before the Suggested
Order Date was then bucketed to the last working day of the planning bucket).

Related Topics
• Calendars Used to Calculate Dates in the Supplies and Demands View

Export Supplies and Demands Data  
You can export supplies and demands data into a Microsoft Excel spreadsheet. However, what data gets exported
depends on how and where you initiate the export process.

• If you export data from the Supplies and Demands pegging mode, your spreadsheet includes child rows tied to
each root node that's exported. The two options to export are:

◦ Include All Child Rows: Export all child rows, even if they aren't expanded in the table.

◦ Include Child Rows if Expanded: Export the child rows only if you have expanded them in the table.

In pegging mode, the export process checks the FND_EXPORT_ROWLIMIT profile option. If a maximum row
limit isn't defined, then the default is 20,000 rows. Also, you can only export up to 500 root nodes. If the export
process reaches the row limit when exporting child rows, the process adds a line at the bottom of the exported
worksheet stating that not all rows were exported.

• If you export data from the Supplies and Demands plain table mode (also called flat file mode), the exported
data includes only the records retrieved by your search, but doesn't include pegged data.

The export process exports all rows that match your criteria until it reaches the maximum allowed by Microsoft
Excel. If the export process reaches the row limit, the process adds a line at the bottom of the exported
worksheet that not all rows were exported.

Related Topics
• Supplies and Demands View Modes
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Forecast Consumption View  
Use the Forecast Consumption table to quickly understand the misalignments between the forecast and actual sales at
different levels such as item, organization, customer, and demand class. The Forecast Consumption table, which you
drill to from the Supplies and Demands or Material plan table, enables you to analyze the sales orders or transfer order
demands that consumed a particular forecast. You can also determine the portion of the plan horizon for which the
forecast consumption details must be calculated.

The Forecast Consumption table displays the details for your plan based on the forecast consumption parameters,
including the Consumption Detail Cutoff Days plan option. Configure these parameters on the Plan Options page,
Supply tab, Forecast Allocation and Consumption subtab. After you configure the forecast allocation and consumption
parameters, run your plan. The planning process calculates forecast consumption for the entire plan based on the
forecast consumption parameters. Use the Consumption Detail Cutoff Days parameter to limit the number of days in
which to view the forecast consumption details.

After you run the plan, navigate to the Supplies and Demands or the Material Plan table. In the Supplies and
Demand table, select a sales order, forecast, or transfer order and then drill to the Forecast Consumption table. In the
Material Plan table, select either a sales order, transfer order, or a net forecast measure and then drill to the Forecast
Consumption table. Review the forecast consumption details in the context of the table that you drilled from, which can
include the following information:

• Multiple sales orders or transfer orders for a forecast entry. A forecast entry can be consumed by multiple sales
orders or transfer orders.

• Multiple forecast entries for a sales order or transfer order. A sales order or transfer order can consume multiple
forecasts.

• The original item of the sales order consuming the forecast where the sales order item has been changed to a
substitute item.

This table describes the various columns in the Forecast Consumption table:

Column Description

Consumption Sequence Sequence of forecast consumed by sales orders or transfer order demand for an item.

Consumed Item Forecast of the item for which consumption occurred. This item can be the same item that’s available in
the sales order, and can be a requested item for an end item substitution.

Organization Inventory organization in which the sales order or transfer order demand consumed the forecast.

Forecast Customer Name of the customer in the forecast.

Forecast Customer Site Name of the customer site in the forecast.

Demand Schedule Name of the demand schedule from which forecast was consumed by the sales order or transfer order
demand.

Ship-to Consumption Level Consumption level used by the forecast consumption process in the plan to consume forecasts.

Consumption Date Date on which the forecast was consumed.

Forecast Quantity Original quantity of the forecast before consumption.

Consumed Quantity Consumed quantity of the forecast by a sales order or transfer order demand.
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Column Description

Sales or Transfer Order Number Sales order or transfer order demand number that consumed the forecast.

Sales or Transfer Order Line Specific sales order line or transfer order demand line number that consumed the forecast.

Sales Order or Transfer Order Item Item in the sales order or transfer order demand that consumed the forecast.

Sales Order or Transfer Order Original Ship
Date

Original ship date of the sales order line or transfer order demand line that consumed the forecast.

Sales or Transfer Order Quantity Quantity of the sales order line or transfer order demand line.

Order Type Order type, which is either sales order or transfer order.

Sales Order Customer Customer name on the sales order.

Sales Order Customer Site Customer site name on the sales order.

Demand Class Name of the demand class on the sales order.

The Forecast Consumption table is sorted by the Consumption Sequence column by default. You can change the default
setting and sort the table by other columns. Use the Manage Columns actions on the View menu to configure which
columns are visible. The layout persists across sessions until changed.

The Forecast Consumption table is available in the Supply Planning, Demand and Supply Planning, and Planning Central
work areas for constrained and unconstrained supply plans.

You can add the Forecast Consumption table as a link to drill to from the context of a new forecast measure in any user-
defined table.

Related Topics
• Forecast Processing

• Forecast Consumption

• Supplies and Demands View Modes

• Material Plan View

• Review and Improve Your Demand Fulfillment

Material Plan View  
The Material Plan is a predefined table in Supply Chain Planning. The Material Plan table is a time-phased view of the
demands, supplies, and daily balances across the plan horizon for any item and organization combination.

The item, organization, and measures are displayed for the row headings, while the time periods are displayed for the
column headings. Access the Material Plan table from the Planning Central or Supply Planning work area.

CAUTION:  If you open the predefined Material Plan table without using any filters, it can take a long time to display
the results. Oracle recommends that you create a copy of the Material Plan and add filters to reduce the item count
and horizon of the material plan.
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You can edit the measures at aggregate levels and allocate the measures to lower levels. For example, you can edit the
manual demand measure by organization, item, and period, and then allocate that measure down to the day.

You can edit a measure's value inline by clicking in a cell and changing the value. Or, you can use mass editing
capabilities that are available to adjust several cells at the same time. For example, you can increase the forecast of item
X for the next three months by 30 percent.

You can also display the material plan as a graph. Each measure is plotted along the x-axis, which is the time dimension.

From the Material Plan table, you can drill down to the following tables:

• Item Exceptions

• Items

• Supplies and Demands

• Supply Chain Bill

Although you cannot modify the layout of the material plan, you can copy the material plan and configure the new
layout in the following ways:

• Add or remove members and measures

• Filter members, such as items or categories

• Add conditional formatting, such as font, background color, and status icons

• Add user-defined drill-to actions

Demand Fulfillment View  

Review and Improve Your Demand Fulfillment  
To improve the demand fulfillment of your plan, use the Demand Fulfillment table to review the at-risk demands in your
plan and their related recommendations. You can take actions to accept recommendations from this page.

In the Demand Fulfillment UI, you can:

• View prioritized at-risk demands based on order values weighted by the number of associated
recommendations.

• Take actions to accept or mark recommendations as complete.

• Review summary information provided for the current demand fulfillment position of your plan to analyze the
potential for improvement based on selected at-risk demands. The information also provides an understanding
of the expected demand fulfillment position based on accepted and completed recommendations.

To review and improve your demand fulfillment:

1. In a Supply Planning, Planning Central, or Demand and Supply work area, select the Manage Plans task.
2. On the Manage Plans page, search for and open your plan.
3. In the Page Layout list, select Plan Summary.

Note that the tiles in the Plan Summary layout include a Demand at Risk in thousands tile.
4. In the Demand at Risk in thousands tile, click the Select Tile bar to review the Demand at Risk Summary data.
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You can review the demand at risk data through a treemap view or a table view, the treemap view is the default.
To switch to the table view, click the Show Table icon.

5. To review the demand at risk data:

◦ Using the treemap: Click an area in the treemap. Typically, you want to start with the area that has the
highest demand at risk value. From the Drill To actions, click Demand Fulfillment.

◦ Using the table: Click the Show Table icon. In the Demand at Risk Summary table, click a cell. Typically,
you want to start with the cell that has the highest demand at risk value. From the Drill To actions, click
Demand Fulfillment.

6. The Demand Fulfillment UI shows the individual orders that are at-risk and their related recommendations.

Tip:  You can open the Demand Fulfillment table directly without drilling from the Plan Summary. After you
open a plan, click the Open button at the page level. In the Open Table, Graph, or Tile Set dialog box, search
for and select the Demand Fulfillment table. In the Demand Fulfillment UI, you can search for at-risk demands
by using the filter fields in the search panel.

Review the At-Risk Demand section and the Recommendations section, and then take further actions.

How You Filter Recommendation Summaries  
The recommendation summary information available on the Demand Fulfillment page can assist you in selecting at-risk
demands to work on. You have a summary graph, a summary table, and a cumulative at-risk demand value slider for
filtering the information to analyze the recommendations.

Recommendation Summary Graph
The recommendation summary graph shows the cumulative at-risk demand value and the related number of
recommendations associated with that value. To maximize effort, aim for a low number of recommendations with the
associated at-risk demand value substantial enough to make a difference in demand fulfillment percentage. Use the
slider to filter by top n, the cumulative demand value.

For example, move the slider to the marker most closely matching $500,000 and click Go or arrow button to the right
of the slider. After moving the slider to the left, the graph shows the at-risk demands that make up the top n of at-risk
demand value.

Recommendation Summary Table
In addition to the recommendation summary graph, demand fulfillment also provides a summary table that shows you
information about demand fulfillment position.

Column Name Description

Actual
 

Indicates the demand fulfillment position based on selection criteria coming from the search panel.
This column is not impacted when you move the cumulative at-risk demand value slider.
 

Potential
 

Indicates the demand fulfillment position for a product category if all the selected at-risk demands
were no longer at risk. Moving the slider to the left selects only the top n cumulative at-risk demands
that meet the selection criteria coming from the search panel, thereby applying an additional filter on
top of the selection criteria.
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Column Name Description

 

Accepted
 

Indicates the demand fulfillment position when the recommendations are accepted or completed. The
values in this column change when you accept or complete the recommendations.
 

Considerations for Resolving Demand Fulfillment
Recommendations  
You take actions on the demand fulfillment recommendations by accepting recommendations. Five types of
recommendations are associated with an at-risk demand. They are displayed in tabs under the Recommendations
section on the Demand Fulfillment page.

Following are the recommendation tabs:

• Expedite Buy Orders

• Expedite Make Orders

• Expedite Transfer Orders

• Add Resource Availability

• Add Supplier Capacity

You can choose to view all recommendations associated with all at-risk demands, or choose to view the
recommendations associated with the demands that you have selected.

Expedite Recommendations
You can review and accept three types of expedite recommendations:

• Expedite buy orders: This includes purchase orders, requisitions, and planned buy orders.

• Expedite make orders: This includes work orders and planned make orders.

• Expedite transfer orders: This includes transfer orders and planned transfer orders.

Expedite recommendations show when the supply is needed (expedite date) and how many days earlier (expedite days)
the supply is required than currently planned.

Regardless of the type of expedite recommendation, many columns of an expedite recommendation are the same. For
example, organization, item, order, expedite date, and expedite days are common to all expedite recommendations.
However, some columns are specific to certain types of expedite recommendations. For example, processing lead time
is specific to the make order recommendation tab.

When you accept an expedite recommendation, the order is firmed using the expedite date as the firm date. When the
plan is run after accepting the recommendation, the planning process assumes the supply is available on the firm date.

Add Resource Availability Recommendation
The add resource availability and add supplier capacity recommendations are handled in similar ways. The add resource
availability recommendation indicates how many hours a resource is overloaded. To resolve an add resource availability
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recommendation, you must increase the available hours through Oracle Fusion Cloud Manufacturing applications and
then recollect the data.

If you have increased the available hours, but have not run collections yet, you can mark the recommendation as
complete to indicate that you have taken action against the recommendation.

Add Supplier Capacity Recommendation
The add supplier capacity recommendation indicates how many additional units of capacity are required. To resolve an
add supplier capacity recommendation, you must increase the supplier capacity. Use the CSV file method to upload an
increased supplier capacity for the item.

If you have increased the capacity, but have not run collections yet, you can mark the recommendation as complete to
indicate that you have taken action against the recommendation.
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13  Supply Network Model

How You Maintain Your Supply Network Model  
Use the Maintain Supply Network Model page to view your collected data that includes details of organizations,
customers, suppliers, carriers, and interlocation shipping networks.

To open the Maintain Network Model page, navigate to a Supply Chain Planning work area. Click the Tasks panel tab
and then select the Maintain Supply Network Model link.

You use organizations to represent your business facilities or functions. Typically, if your business has a single physical
facility that performs two different functions, then you model it as two organizations. For example, you have one facility
that's a manufacturing plant and a distribution center. You can model them as two separate organizations. Additionally,
if your business has one function located in two separate physical facilities, you can model those as one organization. If
you modeled your facilities as one organization, you can create separate subinventories to represent inventory for each
facility.

Review the Collected Data
Based on your search results, use the Organization tab to do the following:

• Review organizations, including the time zones associated with the organizations, for all source systems.

• Create customer and supplier associations to organizations. This is used when creating the buy-sell transfers.

• Select the drop ship validation organization. For each source system, you can select only one organization as
the drop ship validation organization. You can also assign a calendar to a drop ship validation organization.

• Set past due parameters for each organization, which include:

◦ Past due forecast days

◦ Past due sales order days

◦ Past due supply days

• Set up organizations for subinventory-level replenishment planning by selecting Yes under Plan
Subinventories.

Use the Customers and Supplier tabs to review collected data and assign time zones to customer sites and supplier
sites. If the customer site or supplier site doesn't have an associated time zone, then the customer site or supplier site is
assumed to be in the same time zone as the organization that's associated with the demand or supply.

Use the Carriers and Interlocation Shipping Networks tabs to review collected data on carriers, shipping methods, and
transit times.

Manage Organization Groups
Click the Manage Organization Groups button on the Organizations tab to create and manage organization groups.
Organization groups are managed within the source systems and are used to:

• Limit the net change data collection from a source system to specific organizations.
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• Load planning data from files for a specific organization group when collection type is Targeted.

Enable Inventory Organization Tracking by Project
This parameter appears on the Maintain Supply Network Model page only when your organization is enabled for
project-specific supply planning.

The Project Enabled parameter governs whether your inventory organization is enabled for inventory tracking by
project. The value for this parameter can be Yes or No for an organization.

When the parameter value is Yes for an organization, the data collection process collects project-and-task-specific
supplies and demands, and the project-specific planning releases planned orders to the organization. The value for this
parameter is No for a supplier-modeled organization or a contract manufacturing organization.

Buy and Sell Transfers
You can conduct material transfers between two organizations in a single Oracle Fusion source system by using the
purchase order and sales order documents. The sales order at the source organization is used to ship the transfer. The
purchase order at the destination organization is used to receive the transfer.

In the supply network model for the purchase order supply at the receiver organization:

• Define the supplier to source organization relationship and for the sales order demand at the shipping
organization.

• Define the customer to destination organization relationship.

To model an organization as a supplier, update the Supplier and Supplier Site columns of the associated organization.

To model an organization as a customer, update Customer and Customer Site columns of the associated organization.

Forecast and Consume Internal Orders
To forecast and consume internal orders, assign a customer and customer site to the organization that's the destination
of the transfers. Use a customer name that makes sense for the destination organization, such as M1 Transfers. After
you assign a customer and customer site on the Organizations tab, select the Use Customer and Customer Site for
Interorganization Transfers check box for the organization.

Note:  To complete the setup to forecast and consume internal orders, you must also do the following:
• On the Collect Planning Data page, Parameters tab, Demand Planning Data subtab, select the Organization -

Consumption Inventory Transactions to Include check box.

• In the plan options for your plan, select the Include transfer orders check box in the Demand: Advanced
Options dialog box. This check box is only available from a Demand Management, Planning Central, or Demand
and Supply Planning work area.
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Related Topics
• Overview of Data Collections for Supply Chain Planning

• How You Collect Different Data Types for Supply Chain Planning

• How You Load Planning Data from Files

• How You Define the Approved Supplier List for Supply Chain Planning

• Set Up Forecast Consumption for Transfer Orders

Publish Order Forecasts to Suppliers  
You publish order forecasts to your suppliers to enable them to commit supply and indicate their ability to meet the
demand. Collaborating with suppliers by publishing an order forecast enables:

• Suppliers to send supply commits to the Original Equipment Manufacturer (OEM)

• OEMs to receive supply commits as supplier capacity

Collaboration enables suppliers to get an insight into the demand that the OEMs forecast and plan supply chain
activities to meet the demand. Additionally, collaboration with suppliers enables OEMs to plan their downstream
activities in the supply chain more efficiently.

Use the Collaboration Basis column in the Suppliers tab on the Maintain Supply Network Model page to indicate the
basis on which you want to publish the order forecast to your suppliers. You can choose to publish the order forecast at
the supplier and supplier site levels based on one of the following dates:

• Start date: Suppliers use the start date to know when they need to start manufacturing an order to fulfill the
order on time

• Dock date: Suppliers use the dock date to know the date by which they need to fulfill the order

How You Define the Approved Supplier List for Supply
Chain Planning  
An approved supplier list (ASL) is a repository of information that links items to the suppliers and supplier sites that
provide them to either a specific ship-to organization or the entire enterprise.

An ASL can be global or specific to an organization; however, supply planning only recognizes global ASLs.

To determine the supplier and supplier sites for items, the planning process collects ASLs from the CSV file upload,
Oracle Fusion Cloud Procurement, or both.

• Use the Load Planning Data from Flat Files process to load data directly into the planning ASL by using the
Approved Supplier List CSV template (ScpApprovedSupplierListImportTemplate.xlsm).

• You can also define some ASL attributes in Oracle Procurement and then upload a CSV file that defines
the attributes that you want supply planning to use. For example, define the following item-to-supplier
relationships and order modifiers in Oracle Procurement:

◦ Supplier
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◦ Supplier site

◦ Minimum order quantity

◦ Fixed lot multiple

To upload additional attributes for supply planning to use, you can create and collect the ASL from purchasing. You can
then use the CSV file upload to define additional attributes such as the following:

• Item-supplier lead time

• Supplier capacity calendar

• Daily supplier capacity

Oracle Fusion Cloud Supply Planning supports the approved supplier list for a base model. However, approved supplier
lists aren't supported for configured items and won't be copied into a supply plan.

Related Topics
• Supplier Capacity Options

• How You Maintain Your Supply Network Model

Associate Calendars with Supplier Sites  
Use a supplier site calendar to measure processing lead times for purchases from a supplier site. You can associate a
Supply Chain Planning calendar with a supplier site to use for all items sourced from that supplier site.

The calendar is in the collected planning data.

You can associate a calendar with supplier sites to use if there is no calendar defined through the Approved Supplier List
upload for a supplier site-item combination. From a Supply Chain Planning work area, navigate to the Maintain Supply
Network Model page, Suppliers tab. In the Supplier Site Calendar column for a supplier, select a calendar name from
the list of collected calendars. You can only edit this field if the supplier row contains a supplier site.

When you run the plan, the planning process uses the selected calendar on the Maintain Supply Network Mode page
if the approved supplier list calendar for the supplier site-item is blank. If the approved supplier list calendar for the
supplier site-item is blank, and you do not associate a calendar with a supplier site on the Maintain Supply Network
Model page, then the planning process uses the 24/7 calendar.

Related Topics
• How You Define the Approved Supplier List for Supply Chain Planning

Assignment Sets, Sourcing Rules, and Bills of
Distribution  
You use assignment sets in a Supply Chain Planning work area to link sourcing rules and bills of distribution to items.
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Using sourcing rules, bills of distribution, and assignment sets together, you can specify how material is supplied,
manufactured, and transferred across a supply chain.

Note:  This topic is applicable to only the Planning Central, Sales and Operations Planning, Supply Planning, Demand
and Supply Planning, and Replenishment Planning work areas.

When you create sourcing rules and bills of distribution, you create descriptions of the means by which you can
replenish items. However, items aren't specified anywhere on the definition forms, and so a defined sourcing rule or
bill of distribution can later be assigned to any item or group of items. Use assignment sets to associate specific items,
categories, or organizations with the sourcing rules and bills of distribution.

You must use sourcing to describe the supply chain to the planning process. Use the following three structures to do so:

• Sourcing rules

• Bills of distribution

• Assignment sets

Sourcing Rules
Sourcing rules and bills of distribution determine the movement of material between organizations. These
organizations include supplier, manufacturing, and distribution facilities. You can navigate to a Supply Chain Planning
work area and click Manage Sourcing Rules from the Tasks drawer to create or search for an existing sourcing rule.

The three types of sources are:

• Transfer From: Interorganization shipping functionality accomplishes the transfer between internal
organizations. Enter the source organization in the Organization column.

• Make At: The item is manufactured at this internal organization. Enter the manufacturing organization in the
Organization column.

Oracle Fusion Replenishment Planning doesn't support make at sourcing rules.

• Buy From: Purchase the item from an external enterprise. Data entry in the Supplier and Supplier Site columns
is enabled, and the Organization column is disabled.

Allocation Percent and Rank: The total allocation percentage for all sources within a rank must add up to 100 percent.
The sources with the highest rank (lowest numeric value) get the highest priority in allocations. Unconstrained supply
planning and Replenishment Planning only consider sources of rank one. Replenishment Planning also doesn't support
sourcing splits.

Bills of Distribution
When material flows through three or more organizations, bills of distribution describe supply chain links more
efficiently than sourcing rules. However, any relationship that can be described by bills of distribution can also be
described by a set of sourcing rules. Typically, most users use sourcing rules rather than bills of distribution. You can
navigate to a Supply Chain Planning work area and click Manage Bills of Distribution from the Tasks drawer to create
or search for existing bills of distribution.

Replenishment Planning supports bills of distribution of only rank one and doesn't support split bills of distribution.

Sales and Operations Planning doesn't support bills of distribution.
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Note:  Despite the name, bills of distribution don't describe an outward bound or push type of sourcing relationship.
Both sourcing rules and bills of distribution are used only to pull material from sources to destinations.

Assignment Sets
You use assignment sets to link sourcing rules and bills of distribution to items. In other words, you use assignment
sets to link sourcing rules, items and supply nodes. The assignment set creates the sourcing and transfer links between
organizations for each item involved in a supply chain plan. Alternative supply chains can be modeled by creating
alternative assignment sets. You can navigate to a Supply Chain Planning work area and click Manage Assignment
Sets from the Tasks drawer to create or search for existing assignment sets.

For more information, see Create an Assignment Set.

Sourcing Assignment Hierarchy
The planning process uses a sourcing assignment hierarchy to determine the actual source of a specific item. You can
assign replenishment sources at the following levels. Specific sourcing assignments override general assignment levels.
If the planning process doesn't find any sourcing assignment, then the make or buy item attribute is used to determine
sourcing.

The following table lists the supply sourcing hierarchy.

Rank Item or Category Applies to

1
 

Item - Organization
 

1. Sourcing rule

2
 

Category - Organization
 

1. Sourcing rule

3
 

Item
 

1. Bill of distribution
2. Global sourcing rule

4
 

Category
 

1. Bill of distribution
2. Global sourcing rule

5
 

Organization
 

1. Global sourcing rule

6
 

Global
 

1. Bill of distribution
2. Global sourcing rule

When entering sourcing assignments at the category level, the catalog associated with the assignment set is used to
determine the list of available categories.

When you source supplies for sales orders and forecasts (independent demands), then order promising and planning
use a more detailed hierarchy. This hierarchy includes the demand class, customer, and customer site which are
dimensions of independent demand.

The following table lists the demand sourcing hierarchy.
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Rank Item or Category

1
 

Item - Customer / customer site
 

2
 

Item - Customer
 

3
 

Item - Demand Class
 

4
 

Item - Region
 

5
 

Category - Customer / customer site
 

6
 

Category - Customer
 

7
 

Category - Demand Class
 

8
 

Item
 

9
 

Category - Region
 

10
 

Category
 

11
 

Customer / customer site
 

12
 

Customer
 

13
 

Demand Class
 

14
 

Region
 

15
 

Global
 

Using the demand sourcing hierarchy, if a demand line includes a value for demand class, then if no sourcing rule exists
for Item - Customer / customer site or Item - Customer, but a rule exists for Item-Demand Class, then that rule is used
to determine supply sources for the demand line.

When using the sourcing hierarchy, if two rules conflict, the more granular rule is used. To verify which source is
used for an assignment set, from within the set, click the View Sourcing button after entering the following required
parameters:

• Assignment set

• Organization

• Item

• Date
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The dialog box displays which assignments apply to the item-organization-date that you selected. If multiple rules
apply, then the Active Rule is marked in the form.

Related Topics
• Item Attributes and Order Modifiers for Supply Planning

• Support for Sourcing Rules and Bills of Distribution in Oracle Replenishment Planning

Create an Assignment Set  
Learn how to create an assignment set.

Assume you sell the AS54888 Computer. You're releasing a new version of it, AS54888.1 to all your customers, but you
want to make sure your highest valued customer, Computer Service and Rentals, gets first dibs on it.

Here's your supply chain.
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Note

• You are in the Vision Operations organization.

• You fulfill all computers that you have in the Computers category from:

• ◦ Vision Distribution Center 1 (DC1)

◦ Vision Distribution Center 2 (DC2)

◦ Superfly Supply (S1)

You will create one sourcing rule to meet this need:

• You fulfill the AS54888.1 only from Distribution Center 1 and Distribution Center 2.
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You will create a second sourcing rule to meet this need:

• You fulfill sales orders from Computer Service and Rentals that have the AS54888.1 only from Distribution
Center 1.

You will create a third sourcing rule to meet this need:

• You fulfill all items that are in the Computers category from Distribution Center 1, Distribution Center 2, or
Superfly.

So you need to implement this set up.

Sourcing Rule Item Category Item Fulfillment Source

1 Computers - Vision Distribution Center 1 (DC1)
 
Vision Distribution Center 2 (DC2)
 
Superfly Supply (S1)
 

2 - AS54888.1 Vision Distribution Center 1 (DC1)
 
Vision Distribution Center 2 (DC2)
 

3 - AS54888.1 Vision Distribution Center 1 (DC1)

Summary of the Setup

1. Create your sourcing rules.
2. Assign your sourcing rules.

Create Your Sourcing Rules
1. Go to the Global Order Promising work area, then click Tasks > Manage Sourcing Rules.
2. Create your first sourcing rule.

◦ On the Manage Sourcing Rules page, click Actions > Create.

◦ On the Create Sourcing Rules page, set the values.

Attribute Value

Name Transfer Computers From D1, D2, and S1

Description Sourcing rule to transfer supply for all items that are in the Computers category from our
distribution centers and from Superfly Supply.

Organization Assignment Type Global

◦ In the Sourcing Rule Effective Dates, click Actions > Add Row, then set the Start Date to today's date. You
want this rule to last forever, so leave the End Date attribute empty.

If you ever need to stop using this rule, you can always come back and set the end date.

◦ In the Sources area, use Actions > Add Row 3 times to add these rows.
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Type Organization Allocation Percent Rank

Transfer From D1 100 1

Transfer From D2 100 1

Buy From S1 100 1

3. Create your second sourcing rule.

◦ Repeat step 2, but with these values.

Attribute Value

Name Transfer Computers from D1 and D2

Description Sourcing rule to transfer supply for the AS54888.1 item from our distribution centers.

Organization Assignment Type Global

◦ Add these sources.

Type Organization Allocation Percent Rank

Transfer From D1 60 1

Transfer From D2 40 1

4. Create your third sourcing rule.

◦ Repeat step 2, but with these values.

Attribute Value

Name Transfer Computers from D1

Description Sourcing rule to transfer supply for the AS54888.1 item from our D1 distribution center.

Organization Assignment Type Global

◦ Add this source.

Type Organization Allocation Percent Rank

Transfer From D1 100 1

5. Click Save and Close.
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Assign Your Sourcing Rules
Now you create a set of assignments to assign your sourcing rules. Your set will have three assignments.

1. Click Tasks > Manage Assignment Sets.
2. On the Manage Assignment Sets page, click Actions > Create.
3. On the Create Assignment Set page, set the values.

Attribute Value

Name Assign My Computers

Description Assign the sourcing rules that we're using to source all of our computers.

Catalog GOP_Catalog
 
For details about catalogs and categories, see How Catalogs Work Together.
 

4. Click Actions > Add Row, then assign your first sourcing rule.

Attribute Value

Assignment Level Category

Category Computers

Sourcing Rule or Bill of Distribution Transfer Computers From D1, D2, and S1

5. Click Actions > Add Row, then assign your second sourcing rule.

Attribute Value

Assignment Level Item

Item AS54888.1

Sourcing Rule or Bill of Distribution Transfer Computers from D1 and D2

6. Click Actions > Add Row, then assign your third sourcing rule.

Attribute Value

Assignment Level Item and Customer

Item and Customer Computer Service and Rentals

Item AS54888.1

Sourcing Rule or Bill of Distribution Transfer Computers from D1
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7. Click Save and Close.

Another Example of Creating an Assignment Set
Create an assignment set that Promising can use when your first choice for supply can't fulfill the demand.

Consider this supply chain.

Assume:

• You're in the Vision Operations organization.

• You sell the AS54888 Computer item, and its in the Vision Pro category of computers.

• The Western Warehouse and the Eastern Warehouse are each an organization in Vision Corporation.
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• You want to ship from Western first.

• If Western can't fulfill demand in time to meet the requested delivery date, then ship from Eastern.

• If Eastern can't fulfill demand in time to meet the requested delivery date, then use Superfly Supply to fulfill
demand. Superfly is your 3rd party supplier. You use the acronym SFS to identify the Superfly organization.

• You need 10 days lead time to fulfill the item.

Summary of the Setup

1. Create your sourcing rules.
2. Assign your sourcing rules.
3. Create your ATP rules.

Create Your Sourcing Rules

1. Create your first sourcing rule.

◦ Go to the Global Order Promising work area, then click Tasks > Manage Sourcing Rules.

◦ Create a new sourcing rule.

Attribute Value

Name Sourcing Rule for Vision Pro Computers

Description We use this sourcing rule to source all items in a category from our Western Warehouse. If
Western can't fulfill the item in time, then it sources from Eastern Warehouse.

Organization Assignment Type Global

◦ Set the start date to today's date. Don't enter an end date.

◦ Add your sources.

Type Organization Allocation Percent Rank

Transfer From Western Warehouse 100 1

Transfer From Eastern Warehouse 100 2

2. Create your second sourcing rule.

Attribute Value

Name Sourcing Rule for a Vision Pro Item

Description We use this sourcing rule to source an item from our Western Warehouse. If Western can't fulfill
the item in time, then it sources from Eastern Warehouse.

Organization Assignment Type Global

◦ Set the start date to today's date. Don't enter an end date.

◦ Add your sources.
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Type Organization Allocation Percent Rank

Transfer From Western Warehouse 100 1

Transfer From Eastern Warehouse 100 2

3. Create your third sourcing rule.

Attribute Value

Name Sourcing Rule for Superfly Supply

Description We use this sourcing rule to source an item from our Superfly Supply supplier.

Organization Assignment Type Local

Organization SFS

◦ Set the start date to today's date. Don't enter an end date.

◦ Add your source.

Type Organization Allocation Percent Rank

Buy From Superfly Supply 100 1

Assign Your Sourcing Rules

1. Click Tasks > Manage Assignment Sets.
2. On the Manage Assignment Sets page, click Actions > Create.
3. On the Create Assignment Set page, set the values.

Attribute Value

Name Assign My Vision Pro Computers

Description Assign the sourcing rules that we're using to source all of our computers in the Vision Pro
category.

Catalog GOP_Catalog
 

4. Click Actions > Add Row, then assign your first sourcing rule.

Attribute Value

Assignment Level Category

Category Vision Pro
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Attribute Value

Sourcing Rule or Bill of Distribution Sourcing Rule for Vision Pro Computers

5. Click Actions > Add Row, then assign your second sourcing rule.

Attribute Value

Assignment Level Item

Item AS54888

Sourcing Rule or Bill of Distribution Sourcing Rule for a Vision Pro Item

6. Click Actions > Add Row, then assign your third sourcing rule.

Attribute Value

Assignment Level Organization

Organization SFS

Sourcing Type Sourcing Rule

Sourcing Rule or Bill of Distribution Sourcing Rule for Superfly Supply

7. Click Save and Close.

Create Your ATP Rules

1. Click Tasks > Manage ATP Rules.
2. Create your first ATP rule.

Click Actions > Create, then set the values.

Attribute Value

Name ATP Rule for the AS54888

Description ATP rule that we're using to promise the AS54888 item.

Promising Mode Lead-Time Based

Lead Time Considered User-Defined Lead Time

User-Defined Lead Time in Days 10

Assignment Basis Item

Assigned-to Item AS54888

3. Create your second ATP rule.
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Click Actions > Create, then set the values.

Attribute Value

Name ATP Rule for the Vision Pro Category

Description ATP rule that we're using to promise items that are in the Vision Pro category.

Promising Mode Lead-Time Based

Lead Time Considered User-Defined Lead Time

User-Defined Lead Time in Days 10

Assignment Basis Category

Assigned-to Item Category Vision Pro

Specify Catalogs for Assignment Sets  
A catalog is a group of categories that you can use to classify an item. Use it to organize your item into a hierarchy.

A catalog can have a flat or a one level structure of categories. You can also have a hierarchical structure of categories.

You must specify a catalog for each assignment set when you create the set. You associate the set with a catalog to:

• Use categories associated to that catalog in your assignment set.

• Link the sourcing assignments to the categories.

Use the Manage Assignment Sets task in the Global Order Promising work areas to create an assignment set and specify
the catalog. Don't use assignment sets in the Demand Management work area.

If you don't specify a catalog, then the assignment set uses the Catalog for Sourcing Assignments
(MSC_SRC_ASSIGNMENT_CATALOG) profile option as the catalog. To modify it, see Manage Promising Profiles.

A catalog is a collection of categories that you can use to classify your item. For example, you can assign the Floral Dress
item to the Summer category in the Ladies Wear catalog. For details about catalogs and categories, including how to
create a catalog and add categories and items to it, see Assign Catalogs and Categories Using Item Rules.

Create a Sourcing Rule  
Learn how to create a sourcing rule.

1. Collect the reference data that you need to create your sourcing rule, such as organizations, items, and so on.
Make sure the collected data is up to date on the server.

For details, see Collect Data for Global Order Promising.
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2. Go to the Global Order Promising work area, then click Tasks > Manage Sourcing Rules.
3. On the Manage Sourcing Rules page, click Actions > Create.
4. On the Create Sourcing Rule page, enter a name and description.
5. Set the Organization Assignment Type attribute to Global or Local.

If you set it to Local, then set a value in the Organization attribute. Select the one organization that you will
apply this sourcing rule to.

6. In the Sourcing Rule Effective Dates section, click Actions > Add Row, then set the dates when you want the
sourcing rule to be in effect.

7. In the Sources section, click Actions > Add Row, then set the values.

Attribute Value

Type Choose one:
 

◦ Transfer From

◦ Make At

◦ Buy From

8. Set other attribute values depending on the type that you selected. The page will help you. It will make some
attributes available depending on the type.

9. Click Save and Close.

Related Topics
• How You Collect Different Data Types for Supply Chain Planning

• Support for Sourcing Rules and Bills of Distribution in Oracle Replenishment Planning

Export Planning Data to CSV Files  
You can replicate sourcing rules and assignment set data from your Oracle Fusion Cloud Supply Planning instance to
another instance. When exporting data to CSV files, you can export a subset of the measures that are listed in a plan's
measure catalog.

Replicate Sourcing Rules and Assignment Set Data
You can replicate sourcing rules and assignment set data from your Oracle Fusion Cloud Supply Planning instance to
another instance or application without manually reentering data. For example, you can replicate the sourcing rules in
your Oracle Supply Chain Planning production instance into a reporting system or a test instance.

Use the Export Supply Chain Planning Data scheduled process job to extract sourcing rules and assignment set data
into a comma-delimited values (CSV) file format. The generated file is in the standard file-based import (FBDI) file
format that you can then use to do the following:

• Check for missing or incorrect sourcing rules or sourcing assignments. For example, does a particular item-
organization have a valid sourcing assignment?

• Replicate and then modify existing sourcing rules and assignment sets in a spreadsheet. You can then upload
the new setups into another instance or application to create new sourcing rule and assignment set setups.
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• Copy the sourcing rule and assignment set setups from one instance to another instance or application, such as
from a test instance to a production instance.

The format of the CSV files, including the header content, is the same as the format of the corresponding files in the
source instance. This enables you to import the same data directly into another production or test instance. Use the
Load Planning Data from Files process to upload your imported files to staging tables.

The following steps show you how to export sourcing rules and assignment set data to a CSV file:

1. In the Scheduled Processes work area, click the Schedule New Process button on the Overview page.
2. In the Schedule New Process dialog box, search for and select Export Supply Chain Planning Data and then

click OK.
3. In the Process Details dialog box, Basic Options section, select Sourcing Rules and Assignment Sets from the

Entities to Export drop down list.
4. Optionally, click the Filter button to filter your export with specific assignment sets. If you don't select any

filters, then the process exports all sourcing rules and assignment sets.
5. In the Process Details dialog box, click the Submit button to submit the scheduled process job.

After you submit your job, you will receive a confirmation with a confirmation number. The planning process
appends the confirmation number to the extracted CSV file names, such as AssignmentSets_65960.csv and
SourcingRules_65960.csv, where 65960 is the confirmation number.

Export Measures Along With Planning Data
While exporting planning data, you can include a subset of measures that are part of a plan's measure catalog.

You can assign a measure catalog other than a plan’s extract measure catalog defined in Plan options, in the Manage
Plans UI. This improves the versatility and quality of data extracts required for planning.

Depending on your planning cycle and data needs, extract only those measures that are most relevant for the planning
activity. For example, for a given plan you can export demand related measures early in a planning cycle and supply
related measures later in the cycle.

You can also assign a measure catalog when running the Prepare Planning Data for Export scheduled process.

Item Attributes and Order Modifiers for Supply Planning  
Items represent the material that you use in manufacturing and distribution processes and store in inventory. Item
attributes specify properties of each item. You set the item attributes for supply planning through the Product
Information Management work area.

Use these steps to set item organization attributes for supply planning:

1. Navigate to the Product Information Management work area and open the Manage Items task from the Tasks
drawer.

2. Search for your items.
3. Select an item and edit attributes on the specification tab. You can locate the Planning attributes under the

planning section.
This table lists the attributes related to supply planning.

405



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 13
Supply Network Model

Item Attribute Item Structure

Item Overview
 

Unit of Measure
 

Manufacturing
 

Structure Item Type
 

Manufacturing
 

Base Model
 

Manufacturing
 

Autocreated Configuration
 

Manufacturing
 

Assemble to Order
 

Manufacturing
 

Build in WIP
 

Manufacturing
 

Supply Type
 

Inventory
 

Inventory Item
 

Inventory
 

Stockable
 

Inventory
 

Transactable
 

Order Management
 

Customer Orders Enabled
 

Order Management
 

Transfer Orders Enabled
 

Planning
 

Make or Buy
 

Planning
 

Safety Stock Method
 

Planning
 

Planner Code
 

Planning
 

Planning Method
 

Planning
 

Forecast Control
 

Planning
 

Time Fences: Demand
 

Planning
 

Time Fences: Release
 

Planning
 

Time Fences: Planning
 

Planning
 

Cost
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Item Attribute Item Structure

Planning
 

Carrying Percentage
 

Planning
 

Shrinkage Rate
 

Planning
 

Acceptable Early Days
 

Planning
 

Lead Times: Processing
 

Planning
 

Lead Times: Preprocessing
 

Planning
 

Lead Times: Postprocessing
 

Planning
 

Lead Times: Fixed
 

Planning
 

Lead Times: Variable
 

Planning
 

Minimum Order Quantity
 

Planning
 

Maximum Order Quantity
 

Planning
 

Fixed Order Quantity
 

Planning
 

Fixed Lot Multiplier
 

Planning
 

Fixed Days Supply
 

Planning
 

Rounding
 

Purchasing
 

Purchasable
 

Purchasing
 

Approved Supplier List
 

You can use these attributes for specific purposes:

• Make or Buy: This attribute is used by default if no sourcing rule is present.

• Planning Method: Use either MRP planned or MPS planned as the planning method.

• Time Fences: All are used by planning.

• Buy items use the processing lead times. Make items use fixed and variable.

• Make, buy, transfer all use preprocessing lead time. Buy and transfer use post processing lead time.

• Acceptable Early Days is used if you need to reschedule existing supplies. If the supply due date is within the
acceptable early days, then no reschedule out recommendation is issued.
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Order Modifiers
You use order modifiers to obtain planned orders that you're more likely to use in your environment. For example, you
may purchase an item from a supplier who only provides it on pallets of quantity 100. If you're short in some quantity,
say 72, you can set the planned order quantity to 100 instead of 72 to support your requirement. You can't apply order
modifiers to phantoms and back-to-back items.

These are the order modifiers that you can use:

• Minimum Order Quantity

• Maximum Order Quantity

• Fixed Order Quantity

• Fixed Lot Multiplier

• Fixed Days Supply

• Rounding

Material planning uses a priority sequence (precedence) of order modifiers. It applies certain order modifiers before
others and rules out certain order modifiers based on it using certain other order modifiers. The order modifier
precedence is:

1. Fixed Days Supply: One planned order for this item must cover all the shortages for the number of days
specified in the value. For example, if the net requirements are 50 on Monday, 100 on Wednesday, 70 on
Thursday, and you've set Fixed Days Supply to 5, the planning process creates one planned order, with a
quantity of 220 (50 + 100 + 70) and due on Monday. The period start dates aren't fixed. In the example, the
next period of 5 days would not always start on the following Monday but would start on the next day after
Friday that has net requirements. You can adjust the Fixed Days Supply value using the other order modifiers.
Therefore, the next period of 5 days could be the following Wednesday through the second Tuesday.

Note:  In Supply Planning, if there's a Fixed Days Supply, then the application doesn't split supplies based on
sourcing rule percentages.

2. Fixed Order Quantity: You must always set the planned order quantity with this value. For example, if the net
requirements are 1 and you've set Fixed Order Quantity to 200, the planning process creates one planned order
with a quantity of 200. If set, the planning process skips to the Rounding order modifier.

3. Fixed Lot Multiplier: You must always have the planned order quantity with this value. For example, if the net
requirements are 400 and you've set Fixed Lot Multiplier to 150, the planning process creates one planned
order with a quantity of 450.

4. Minimum Order Quantity: The planned order quantity may never be less than this value. For example, if the net
requirements are 100 and you've set Minimum Order Quantity to 150, the planning process creates one planned
order with a quantity of 150. If set, the planning process skips to the Rounding order modifier.

5. Maximum Order Quantity: One planned order for this item may not have a quantity more than this value. For
example, if the net requirements are 200 and you've set Maximum Order Quantity to 150, the planning process
creates two planned orders, one with a quantity of 150 and the other with a quantity of 50.

6. Rounding: The planned order quantity must always be a whole number; the planning process always rounds
fractional quantities up to the next highest whole number. For example, if the net requirements are 99.2 and
you've selected Rounding, the planning process creates one planned order with a quantity of 100.
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Drop Shipment  

Drop Shipments in Supply Planning  
Drop shipments are direct shipments of material from a supplier to a customer. It's an order fulfillment strategy where
the seller doesn't keep products in inventory.

Instead, the seller relies on suppliers or contract manufacturers to build, store, and then ship orders directly to
customers. The internal organization manages the process but never handles the material. In a drop shipment flow,
there is one sales order to one supplier purchase order. Customer information is shared with the supplier. The internal
organization bills the customer and pays the supplier.

To properly plan for drop shipments in Supply Planning, you must define the drop shipment supply chain network.

• Define drop shipment sourcing rules that determine which supplier sites support drop shipments.

• Define transit times between supplier and customer sites.

• Set up a drop ship validation organization.

• Enable the Drop Ship Validation item organization for collections.

How Drop Shipments Are Processed in Supply Planning  
Supply planning recommends new planned orders for drop shipments and manages drop shipment purchase orders.

The planning process pegs supply to a sales order when both of the following conditions are met:

• A sales order line is marked as a drop shipment.

• There's an existing purchase order that's shipped directly to the customer site on the sales order.

Although not actually a reservation, the supply planning process treats the drop shipment purchase order as a
reservation. In this case, the drop shipment purchase order can't be used for any other demand.

Set Up a Drop Shipment Validation Organization  
The supply planning process uses a special organization called drop shipment organization for drop ship demands and
supplies.

Use the drop shipment validation organization to get various item organization attributes, such as lead times and time
fences, for drop ship items. You must specify a drop shipment validation organization for each source system that
supports drop shipments. Specify the drop shipment validation organization value on the Manage Organizations page
in the Maintain Supply Network Model task.

CAUTION:  Supply Planning sources all demands against the drop shipment validation organization with drop
shipment planned orders. For this reason, the drop shipment validation organization should not be a standard
inventory organization with transactions, as there could be unexpected results.
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Use the drop shipment validation organization for the following purposes:

• As the source for organization-item attributes when creating drop shipment planned orders.

• As a proxy for the organization for drop shipment forecasts and manual demands.

• As a proxy for the organization during the collections of drop shipment sales orders and drop shipment history.

Specify the drop shipment validation organization when you generate a forecast or create a manual demand. Drop
shipment sales order bookings and shipments history are collected with the drop shipment validation organization
when items are shipped from the warehouse. Demand forecasting can create forecasts for the drop shipment validation
organization and release the forecasts for planning supplies. The drop shipment validation organization can be the item
master for a source system, but it's not required.

The drop ship validation organization can be the item master for a source system, but it's not required.

Note:  The drop shipment validation organization must be an item organization. When you set up the drop shipment
validation organization, if the item master holds any transactions, create a new drop shipment validation organization.

To set up a drop shipment validation organization:

1. Define an item organization in the Product Information Management work area.
2. Enable the new item organization for collection from the Oracle Fusion source system.
3. Run collections to collect organization entities.
4. Perform the following steps in a Supply Chain Planning work area to complete the drop shipment sourcing

setup:

a. Navigate to a Supply Chain Planning work area.
b. Click the Tasks panel tab.
c. In the Tasks panel, click Maintain Supply Network Model.

Note:  You can enable only one organization for each source system as the drop shipment validation
organization.

d. In the Organizations region, select the Drop Ship Validation Organization option.

You have completed the drop shipment validation organization setup.

Set Up Drop Shipment Sourcing Rules  
To properly plan for drop shipments, you must first define the drop shipment sourcing rules that determine which
supplier sites support drop shipments.

These are sourcing rules with a buy from supplier and supplier site source. When defined, you can assign the drop
shipment sourcing rule to various aggregate levels of item and customer location. Valid item levels are item and
category. Valid customer location levels are customer site, region/zone, and all locations. When you assign a drop
shipment sourcing rule, you determine which supplier sites can drop ship to which customer sites.

You can apply drop shipment sourcing rules only to the independent demands. The demand sourcing hierarchy is
applied for drop ship cases. If a level 1 rule is found for an item and customer or customer site, then that rule is used.
Otherwise, if the highest level rule is assigned to a category-customer level, then that rule is used.

The following table lists the ranking of various demand sourcing hierarchies:

410



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 13
Supply Network Model

Rank Demand Sourcing Hierarchy

1
 

Item - Customer or Customer Site
 

2
 

Item - Customer
 

3
 

Item-Demand Class
 

4
 

Item - Region
 

5
 

Category - Customer or Customer Site
 

6
 

Category - Customer
 

7
 

Category - Demand Class
 

8
 

Item
 

9
 

Category - Region
 

10
 

Category
 

11
 

Customer or Customer Site
 

12
 

Customer
 

13
 

Demand Class
 

14
 

Region
 

15
 

Global
 

If an assignment set contains drop shipment rules that are already assigned to an item or a category, then you
must define organization-specific rules for an item or category that's both drop shipped and also shipped to an
inventory organization. If the sourcing rule for the drop ship demand includes a transfer from source or a make at,
the transfer from source and make at is ignored. If there are multiple buy from sources, then the buy from sources are
reapportioned to equal 100%.

Create Drop Shipment Sourcing Rules
To create drop shipment sourcing rules:

1. Define a global sourcing rule and specify a buy from supplier, supplier site, and supplier source system.
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2. In the assignment set, assign the global sourcing rule to an assignment level that includes an item or a
category. Assign the global sourcing rule to a customer or a zone as required, but you can't assign the rule to an
organization.

Define Transit Times Between Supplier and Customer Sites for
Drop Shipment  
After you create your drop shipment sourcing rules, you must define transit times between supplier and customer sites.
There are multiple ways to define transit times between a specific supplier and a specific customer, all created in the
Define Transit Times page.

Constraint-based supply planning supports the following transit time lane combinations for drop shipments:

• External location to external location

• External location to region/zone

• Region/zone to region/zone

Set Up a Drop Shipment Plan  
When you set up a plan for drop shipment, you can include both drop shipment sales order and standard sales orders
(forecasts and supplies) from a direct shipment organization in the same plan.

To set up your plan for drop shipment:

1. From a Supply Chain Planning work area, open your supply plan or demand and supply plan.
2. From your plan, click Actions  > Edit Plan Options.
3. On the Edit Plan Options page, click the Supply tab and then click Select Advanced Options.
4. On the Supply: Advanced Options page, select Include drop ship demands and supplies.
5. Optionally, you can include other direct shipment organizations.
6. Set the other plan parameters, as needed.

For example, select Create time fence to apply time fences to drop shipment forecasts.
7. Save the plan.
8. Run the plan to include the drop shipments in the plan output.

Note:  In your drop shipment plan, search for supplies and demand in the drop shipment validation
organization. Note that the customer information appears on the purchase order and the supplier
information appears on the sales order.

Drop Shipment Forecast  
Create a drop shipment forecast based on the drop shipment shipping history or booking history. You can also create
plans using drop shipment forecasts to see the projected drop shipment planned orders.
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To enable the drop shipment history, the collections process sets the ship from organization value of drop ship
shipments and bookings history to the drop ship validation organization.

Drop shipment history has an organization reference to the drop shipment validation organization. Collecting and
using the history facilitates creating a forecast for future drop ship shipments or bookings. The forecast uses the drop
shipment validation organization. You can use this forecast as a demand schedule for a supply plan that includes drop
shipments.

Back-to-Back Fulfillment  

Promise Sales Orders In Your Back-To-Back Flow  
Back-to-back is a supply chain management technique where you receive supply at a warehouse then ship it directly to
your customer. You can use Global Order Promising to help fulfill a back-to-back order.

You typically use back-to-back fulfillment to fulfill a high cost or a slow moving item. You usually don't stock the item in
inventory but instead build it in reply to demand.

Here's the general flow:

• You create a sales order and submit it to fulfillment.

• Promising creates and schedules supply for the order.

• You procure and receive supply in your warehouse.

• Supply Chain Orchestration reserves supply, then Inventory Management manages it in inventory during
shipping.

You set up your implementation to automatically do this work, including selecting the source, reserving supply until its
fulfilled, and automatically adjusting fulfillment when supply or demand changes.

For details, see Overview of Back-to-Back Fulfillment.

How Back-to-Back Fulfillment Is Processed in Supply Planning  
Use back-to-back fulfillment to improve revenues and margins by increasing on time fill rates while reducing your
inventory levels. Back-to-back ordering is a special type of ordering that matches each supply order with each sales
order on a one-for-one basis.

Typically, back-to-back is a purchase order matched to a sales order and cross-docked at the warehouse. Order
Promising recommends a supply source and the recommendation is sent to Supply Chain Orchestration. Supply Chain
Orchestration creates the supply and always creates a reservation between the supply and the sales order line.

Supply planning collects back-to-back demands and supplies, and respects the reservations between them. The
planning process generates exceptions if back-to-back supplies fall short of demands or cause resource or supplier
capacity overloads. Constrained supply planning generates planned supply for back-to-back orders that are missing
supplies, but these planned orders can't be released from the plan. You can notify Order Management to check
the order line and use Order Promising to promise the line and send the supply recommendation to Supply Chain
Orchestration.
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To properly plan for back-to-back orders in Supply Planning, you must define the back-to-back supply chain network.

• Set the item-organization attribute Back-to-Back Enabled to Yes in the Product Information Management
work area.

• Set the item-organization attribute Planning Method to either MRP Planned or MPS Planned.

• Specify sourcing rules for the item, which tells supply planning how to:

◦ Determine the ship from organization for sales orders.

◦ Determine the supply sources for bringing material in to the ship from organization.

• Add the sourcing rules to the Order Promising assignment set.

• Set up your supply plan to plan for drop shipments.

◦ In the Advanced Plan Options dialog box, set the Include drop ship demands and supplies attribute to
Yes.

◦ Optionally, select a demand schedule that represents a drop shipment forecast.
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14  Archive Plans

Overview of Plan Archival  
Supply Chain Planning provides two archival types, one that a planner can run for a plan and another archive type that
only an administrator with proper security privileges can set up for MAPE statistics.

For a planner, plan archival enables you to archive measures in a plan with plan context and save multiple versions of a
plan's archived measures over time. When you archive a plan, you archive a set of measures contained in the measure
catalog that you chose as the archive measure catalog for the plan.

Note:  You can create archives for demand, supply, integrated demand and supply, and sales and operations plans.
Archival isn't available for Oracle Planning Central.

Plan Archives
Plan archival enables you to save multiple versions of the plan where you archive the key measures at a point in time.
The Waterfall Analysis and Trend Analysis tables and graphs use the plan archive to compare the current plan's data
to past versions of the plan. When viewing past versions of the plan, you can see the impact of strategic and tactical
changes made to the plan. You can also compare the individual archives to the plan by selecting Compare > Archive
from the Actions menu in a plan.

For example, you archive a plan in May and then market conditions in September cause adjustments to be made to
the plan. You can analyze the impact of the adjustments on the plan by viewing the changes in the key performance
indicators between the plan version archived in May and the current plan.

A supply chain planner can run the archiving process from an open plan by selecting the Archive option from the
Actions menu. A planner can also run the archiving process by selecting the Archive plan check box on the Run Plan
page. Alternatively, you can run the archive process independently of running the plan by selecting the Archive option
from the Actions menu on the Manage Plans page.

Before you can archive a plan, you must enable the plan for archiving and set up the archiving parameters. The
parameters that you configure determine the time hierarchy, time level, and the measure catalog to use for the archives.
Set up the archiving parameters in the Scope: Advanced Options dialog box, which you navigate to from the Plan
Options page, Scope tab.

It's good practice to back up your archive data by making a full copy of your plan that includes archives. You can access
the backup plan data in the event of any temporary issue with the plan of record. On the other hand, if you want to
create a standalone plan to simulate a business scenario, you probably don't need to include archived measures.

MAPE Archives
An administrator with the correct security privileges can create an archive for MAPE statistics by running the Build
Plan Archive scheduled process from the Tools work area. Generally, a supply chain planner doesn't have the privileges
to create a MAPE archive. However, an administrator with the required privileges can see the Enable for MAPE
calculations check box in the Build Archive dialog box. The administrator can create archives at weekly, monthly, or
quarterly time levels. The archive level pertains to the planning time level, so the administrator would archive a quarter-
level plan at the quarter level.
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Note:  To calculate predefined measures for demand plans and sales and operations plans that use archived data, you
must use a MAPE archive. The statistics calculated for the MAPE archive are used to generate the Waterfall Analysis
and Trend Analysis tables and graphs.

Related Topics
• Configure Archiving Parameters

• Copy a Plan

Configure Archiving Parameters  
Before you can archive plans, you must enable the archiving options.

Note:  You can create archives for demand, supply, demand and supply, and sales and operations plans. Archival isn't
available in Oracle Planning Central.

To configure the archiving plan options:

1. In a work area for Oracle Fusion Cloud Supply Chain Planning, open a plan and then select Edit Plan Options
from the Actions menu.

2. On the Plan Options page, Scope tab, click the Select Advanced Options button.
3. In the Scope: Advanced Options dialog box, Archive Options section, review and make changes to the archive

parameters for the plan.

Parameter Description

Enable for archiving
 

Select to set parameters used to archive measure data for your plan. When selected, the
archiving options are enabled.
 

Archive Time Hierarchy
 

Select the time hierarchy to use to archive the measure data for the plan, such as Gregorian
calendar.
 
For a demand plan that uses a hybrid time hierarchy, the field value is defaulted to the hybrid
time hierarchy that you selected as the planning calendar and can't be changed.
 

Archive Time Level
 

Select the time level to archive measure data for the plan, such as day or week. The time level is
based on the selection made for the archive time hierarchy.
 
For a demand plan that uses a hybrid time hierarchy, the field value is defaulted to the Hybrid
time level corresponding to the hybrid time hierarchy that you selected as the planning
calendar and can't be changed.
 

Measure Catalog for Archival
 

Select the measure catalog to use for archiving.
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Parameter Description

Note:
Oracle recommends that you create a measure catalog containing only measures that
provide insight to the plan's changes instead of archiving every measure in the plan.
 

Do not delete archives
 

Select if you don't want to delete any archives for the plan.
 

Delete archives automatically
 

Select to automatically delete archives when the archives are older than the Most Recent Days
to Keep parameter.
 

Most Recent Days to Keep
 

Enter the number of days for which to retain archives. Archives older than this number of days
are automatically deleted.
 

4. Click Done.

Related Topics
• Overview of Plan Archival in Supply Chain Planning

Overview of Archival for Calculating MAPE Statistics  
A Supply Chain Planning administrator with the Manage Rolling Archives security privilege can create archives for the
calculation of the MAPE statistics at a week or month level.

These archives are used to calculate predefined measures for demand plans and sales and operations plans that use
archived data. The administrator runs the Build Plan Archive scheduled process from the Tools work area.

Shipments or bookings measures are required in the archive for MAPE statistics calculations, based on the measure
used to create the forecast. If your plan forecasts shipments data, then only the shipments forecast measures are
needed. If your plan forecasts bookings data, then only the bookings measures are needed. The following shipments or
bookings measures are required:

• Final Shipments Forecast

• Final Shipments Forecast 3 Months Ago

• Final Shipments Forecast 3 Months Ago Latest Archive

• Final Bookings Forecast

• Final Bookings Forecast 3 Months Ago

• Final Bookings Forecast 3 Months Ago Latest Archive

To use the archives in a waterfall or trend analysis, select the Use MAPE calculations check box in the Selector Tool
Comparison Options tab.

MAPE archives created on a rolling basis can be referenced in a user-defined measure expression that uses the Archive
function. The archive type is a parameter of this function. The valid values for archive type are "Rolling" and "Adhoc."
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Related Topics
• Archival for Calculating MAPE Statistics

Archival for Calculating MAPE Statistics  
A Supply Chain Planning administrator with the Manage Rolling Archives security privilege can create archives for the
calculation of the MAPE statistics at a week or month level.

Perform the following steps to run the Build Plan Archive schedule process:

1. In the Navigator, under the Tools section, click the Scheduled Processes link to access the Scheduled
Processes page.

2. Access the Process Details page for the Build Plan Archive process:

a. On the Schedule Processes page, click the Schedule New Process button.
b. In the Schedule New Process dialog box, click the Name list, and then click the Search link.
c. In the Search and Select: Name dialog box, enter Build Plan Archive and click Search.
d. Select Build Plan Archive and click OK to return to the Schedule New Process dialog box.
e. In the Schedule New Process dialog box, click OK.

3. In the Process Details dialog box, select the plan to archive and then click the Advanced button.
4. On the Parameters tab, select Do not delete archives or Delete archives automatically.

If you select to delete archives automatically, enter a number in the Most Recent Days to Keep field. The archive
process automatically deletes older archives based on this parameter.

5. Select the Enable for MAPE calculations check box and enter or select the following parameters:

a. Archive Time Hierarchy: Select the calendar to use for the archive.
b. Archive Time Level: Select the time level to use for the archive.
c. Measure Catalog for Archival: Select the measure catalog to use when archiving.

Note:  Oracle recommends that you create a measure catalog for archived measures instead of
archiving every measure in the plan.

d. Use default archive name: Select to use the default archive name.
e. Use user-defined archive name: Select to overwrite the default name with a user-defined name.

6. Click the Schedule tab to set up the frequency parameters.

◦ To run the plan immediately, select As soon as possible.

◦ To run the plan in the background at a set time, select Using a schedule. Next, select a Frequency, such
as Monthly or Weekly, to create MAPE rolling archives for use in waterfall and trend analyses.

7. Click Submit.

Related Topics
• Overview of Archival for Calculating MAPE Statistics
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Delete Archives  
A planner can automatically delete plan archives by setting parameters in the Scope: Advanced Options dialog box,
accessed from the Plan Options page, Scope tab.

Only a Supply Chain Planning administrator with the Manage Rolling Archives security privilege can delete MAPE
archives. In the Tools work area, the administrator can use the Delete Plan Archive schedule process to clean up
unwanted archived data versions. You can delete the archives of a plan based on an archive version, a time range, or all
archives for a plan.

Note:  When you use the Delete Plan action, the process not only deletes the plan, but it also deletes all of the archive
versions associated with that plan.

Perform the following steps to run the Delete Plan Archive schedule process:

1. In the Navigator, under the Tools section, click the Scheduled Processes link to access the Scheduled
Processes page.

2. Access the Process Details page for the Delete Plan Archive process:

a. On the Schedule Processes page, click the Schedule New Process button.
b. In the Schedule New Process dialog box, click the Name list, and then click the Search link.
c. In the Search and Select: Name dialog box, enter Delete Plan Archive and click Search.
d. Select Delete Plan Archive and click OK to return to the Schedule New Process dialog box.
e. In the Schedule New Process dialog box, click OK.

3. In the Process Details dialog box, select the plan that you want to delete the archives for and then click the
Advanced button.

4. On the Parameters tab, in the Plan section, select one of the following options, which are only available to
administrators with the Manage Rolling Archives security privilege:

a. Include MAPE archives
b. Delete MAPE archives only

5. On the Parameters tab, in the Archive Parameters section, configure the following parameters:

a. Archives to delete
b. Delete archives with time range

The Delete Plan Archive process filters the selected archive parameters by which MAPE archiving option you
selected in the Plan section.

6. Click the Schedule tab to set up the frequency parameters.

a. To run the plan immediately, select As soon as possible.
b. To run the plan in the background at a set time, select Using a schedule and then select a frequency,

such as Monthly or Weekly.
7. Click Submit.
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15  Extract Plan Data

Overview of Planning Measure Data Extractions from
Plan Output  
Planning information is an important component of supply chain analytics. It's important to extract planning measure
data from any plan to build offline reports or integrate with any external system.

Planners can use the Export Plan Data action from the Manage Plans page to run the Prepare Supply Chain Planning
Data for Export scheduled process. You can also run the process or schedule as a job from the Scheduled Processes
page under the Tools menu in the Navigator.

When analyzing a plan, you can extract detail supply chain planning multidimensional plan output data, including
measures and hierarchies. The extract is based on the measure catalog and dimension catalog assigned to the plan.
The Prepare Supply Chain Planning Data for Export scheduled process extracts plan output data into a set of files for
external reporting and analysis.

The extract process exports plan data to WebCenter Content in the comma-separated value (CSV) data format. This
extract includes measure data, including any measures that you configured that are either stored or calculated. For
calculated measures, the planning process extracts the data after evaluating the measure expressions. The extract is
based on the measure catalog and dimension catalog assigned to the plan and includes user-defined hierarchies and
levels. Supporting information such as hierarchies for multidimensional analysis is also exported.

Before you can run the Prepare Supply Chain Planning Data for Export scheduled process for a plan, you must:

1. As a one-time setup, create an application integration with login credentials.

a. Navigate to the Setup and Maintenance work area and select the Manage Setup Content task.
b. On the Manage Integration of Additional Applications page, set up the following:

- Application Name: SCP_BICC_REST_CREDENTIALS
- Full URL: Enter the host name of the application. For example: https://

example.fa.app.oraclecloud.com
- Partner Name: SCP_BICC_REST_CREDENTIALS
- Security Policy: oracle/wss_username_token_over_ssl_client_policy

2. Ensure that the user running the extract has access to the Upload and Download Data from On-Premise System
to Cloud System role (OBIA_EXTRACTTRANSFORMLOAD_RWD).

3. Configure the extract options for your plan. Navigate to the Plan Options page, Scope tab and click the
Advanced Options button. In the Scope: Advanced options dialog box, in the Extract Options section, configure
the extract parameters.

4. Navigate to the Manage Plans page and select a plan. Select Export Plan Data to run the Prepare Supply Chain
Planning Data for Export scheduled process.

You can extract data at the lowest level from any of these plan types:

• Demand plan

• Demand and Supply plan

• Replenishment plan
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• Sales and Operations plan

• Supply plan

Configure Plan Extract Parameters  
Before you can select the Export Plan Data action from the Manage Plans page, you must configure the extract options
for your plan.

1. Navigate to the Plan Options page, Scope tab and click the Select Advanced Options button.
2. In the Scope: Advanced options dialog box, in the Extract Options section, select the Enable for extract check

box to enable plan data to be extracted.
3. Configure the extract parameters for the plan.

Dimension Catalog for Extract
Select a dimension catalog to use for the extract process. The list of values includes all dimension catalogs valid for
the plan type. The list of hierarchies included in this list must be a subset of the hierarchies available in the dimension
catalog associated with the plan. The list of hierarchies includes preconfigured and user-defined hierarchies. Note the
following:

• The maximum number of levels per hierarchy is limited to 10 levels.

• The maximum number of hierarchies in the segment dimension is limited to two hierarchies.

Measure Catalog for Extract
Select a measure catalog to use for the extract process. The list of values includes all measure catalogs valid for this
plan type. The measure catalog must contain only the measures that are part of the measure catalog for the plan. The
planning process evaluates measures with expressions and includes the results in the extract.

Extract Time Hierarchy
Select a time hierarchy to use for the extract process. Data extraction is done only at the lowest level for all dimensions
except for the time dimension. You can have only one time hierarchy per plan and it must be part of the dimension
catalog used for the extract process. If it contains other time hierarchies, the extract process ignores them for extract.

The extract time hierarchy depends on the plan type, the planning calendar associated with the plan, and the planning
time level. Validation rules apply for the Extract Time Hierarchy field, based on the type of plan.
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For a demand plan that uses a hybrid time hierarchy, the value in the Extract Time Hierarchy field is automatically set
to the hybrid time hierarchy that you selected as the planning calendar and can't be changed.

Extract Time Level
Select a specific time level to extract. The list of values includes all levels based on the plan type and your selection in
the Extract Time Hierarchy field. The valid values and defaults are as follows:

• Manufacturing calendar: Week, Period (Default is Week)

• Fiscal Calendar: Month, Quarter (Default is Month)

• Gregorian Calendar: Month, Year (Default is Month)

The extract time level depends on the plan type, the planning calendar associated with the plan, and the planning time
level. The Extract Time Level selection is subject to validation for each plan type.

Plan Type Rule

Supply plan
 

Largest supply planning bucket or above. For example:
 

• If Supply Planning Buckets are 0 days, 52 weeks, then the Extract Time Level can be Week or
Period.

• If Supply Planning Buckets are 365 days, 13 Periods, then the Extract Time Level can only be
Period.

Demand plan
 

Planning time level of the plan or above.
 

Demand and Supply plan
 

Largest supply planning bucket or above. For example:
 

• If Supply Planning Buckets are 0 days, 52 weeks, then the Extract Time Level can be Week or
Period.

• If Supply Planning Buckets are 365 days, 13 Periods, then the Extract Time Level can only be
Period.

Sales and Operations plans
 

Planning time level of the plan or above.
 

Replenishment plan
 

Planning time level of the plan or above.
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For a demand plan that uses a hybrid time hierarchy, in the Extract Time Level field, you can select a parent of the
Hybrid time level for the hybrid time hierarchy that you selected as the planning calendar. For a manufacturing hybrid
hierarchy, you can select the Week or Period level. For a Gregorian hybrid hierarchy, you can select the Month, Quarter,
or Year level. For a fiscal hybrid hierarchy, you can select the Month, Quarter, or Year level.

Files Created by the Plan Extract Process  
The plan extract process generates a set of files. Some files have file names that begin with DATA and have a .csv.gz file
extension. These files are compressed, comma-separated value (CSV) files.

The extract process also generates a set of files with file names that begin with META and have a .mdcsv.gz extension
for its internal use. You can ignore the META files.

Every plan extract results in the following DATA files:

File generated Description of file

Dimension Data
 

The plan extract process generates one dimension data file for each dimension selected for the extract
process. This file contains all of the level members with their associated relationships for all hierarchies
in that dimension.
 

Dimension Definition
 

The plan extract process generates one dimension definition file for each extract and contains the
names of the hierarchies and levels.
 

Measure Data
 

The plan extract process generates one measure data file for each set of measures that share the same
dimensionality. This file contains the measure values by the different dimensions.
 

Measure Definition
 

The plan extract process generates one measure definition file for each extract and contains the
names, data types, expressions, granularity, and aggregation rules of the measure.
 

The extract process generates the dimension definition and measure definition files to help you understand the
content of the data files, but they aren't essential for reporting or analysis. These files contain translatable strings in the
language of the planner performing the extract.

Naming Conventions for Extracted DATA Files
In addition to the DATA prefix and .csv.gz file extension, the data file names follow a specific naming pattern. You can
search the content server for this name pattern to get the required files for download.

• Dimension file name patterns

◦ Dimension data file:

◦ Dimension definition file:
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Dimension file name parts Description

jobID
 

The job ID of the extract scheduled process.
 

planID
 

The ID of the plan. This name is available in log files.
 

Dimension code
 

The dimension code that the hierarchies in the file belong to. Used in the dimension data file,
 but not the dimension definition file.
 

BICCJobID
 

The job ID of the extract scheduled job of the BI Cloud Connector (BICC) tool.
 

DateTime
 

Date and time the extract scheduled process began.
 

• Measure file name patterns

◦ Measure data file:

◦ Measure definition file:

Measure file name parts Description

jobID
 

The job ID of the extract scheduled process.
 

planID
 

The ID of the plan. This name is available in log files.
 

Dimensionality group code
 

Name of the dimensionality group code. Used in the measure data file, but not the measure
definition file.
 

BICCJobID
 

The job ID of the extract scheduled job of the BI Cloud Connector (BICC) tool.
 

DateTime
 

Date and time the extract scheduled process began.
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Dimension Data Files Created by the Plan Extract Process
 
The plan extract process generates one dimension data file for each dimension and contains all of the hierarchies in
that dimension. Each dimension file contains information for all of the selected hierarchies.

For example, if the planner selects two product hierarchies, an item appears twice--once for each hierarchy.

Column name Content

HIERARCHY_ID
 

Internal hierarchy identifier
 

[dimension]_LVL_MEMBER_ID
 

ID of the lowest-level member. Each dimension file contains its own lowest level member. For example:
 

• PRD_LVL_MEMBER_ID

• ORG_LVL_MEMBER_ID

BASE_MBR_NAME
 

Name of the lowest level member
 

L2-MBR_ID
 

Level 2 member ID
 

L2_MBR_NAME
 

Level 2 member name
 

L3-MBR_ID
 

Level 3 member ID
 

L3_MBR_NAME
 

Level 3 member name
 

L4-MBR_ID
 

Level 4 member ID
 

L4_MBR_NAME
 

Level 4 member name
 

L5-MBR_ID
 

Level 5 member ID
 

L5_MBR_NAME
 

Level 5 member name
 

L6-MBR_ID
 

Level 6 member ID
 

L6_MBR_NAME
 

Level 6 member name
 

L7-MBR_ID
 

Level 7 member ID
 

L7_MBR_NAME Level 7 member name
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Column name Content

  

L8-MBR_ID
 

Level 8 member ID
 

L8_MBR_NAME
 

Level 8 member name
 

L9-MBR_ID
 

Level 9 member ID
 

L9_MBR_NAME
 

Level 9 member name
 

L10-MBR_ID
 

Level 10 member ID
 

L10_MBR_NAME
 

Level 10 member name
 

SR_BASE_MBR_ID
 

Internal use only
 

Dimension Definition Files Created by the Plan Extract
Process  
The dimension definition file contains information for all of the dimensions and hierarchies specified in the dimension
catalog for extract. The plan extract process creates only one file per extract.

Column name Description

DIMENSION_ID
 

Unique ID of the dimension
 

HIERARCHY_ID
 

Unique ID of the hierarchy
 

BASE_LEVEL_ID
 

Lowest level (Level 1) ID
 

LEVEL_2_ID
 

Level 2 ID
 

LEVEL_3_ID
 

Level 3 ID
 

LEVEL_4_ID
 

Level 4 ID
 

LEVEL_5_ID
 

Level 5 ID
 

LEVEL_6_ID Level 6 ID
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Column name Description

  

LEVEL_7_ID
 

Level 7 ID
 

LEVEL_8_ID
 

Level 8 ID
 

LEVEL_9_ID
 

Level 9 ID
 

LEVEL_10_ID
 

Level 10 ID
 

DIMENSION_CODE
 

Unique code for the dimension
 

DIMENSION_NAME
 

Dimension name
 

HIERARCHY_NAME
 

Hierarchy name
 

BASE_LEVEL_NAME
 

Base level name
 

LEVEL_2_NAME
 

Level 2 name
 

LEVEL_3_NAME
 

Level 3 name
 

LEVEL_4_NAME
 

Level 4 name
 

LEVEL_5_NAME
 

Level 5 name
 

LEVEL_6_NAME
 

Level 6 name
 

LEVEL_7_NAME
 

Level 7 name
 

LEVEL_8_NAME
 

Level 8 name
 

LEVEL_9_NAME
 

Level 9 name
 

LEVEL_10_NAME
 

Level 10 name
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Measure Data Files Created by the Plan Extract Process  
The plan extract process generates one measure data file for each set of measures that share the same dimensionality
or granularity. Use the measure definition file to obtain more details about the measure, including its full name,
description, aggregation methods, and so on.

The following table is an example measure data file for a specific dimensionality with a selected list of measures. The
actual format depends on the dimensionality and the measures selected by users for extract.

Column name Description

PLAN_ID
 

ID of the plan
 

PRD_LVL_MEMBER_ID
 

Product dimension lowest level member ID
 

ORG_LVL_MEMBER_ID
 

Organization dimension lowest level member ID
 

TIM_LVL_MEMBER_ID
 

Time dimension lowest level member ID
 

FACT_DATE
 

Date
 

AVG_DAILY_DMD
 

Value of this measure
 

GROSS_MARGIN_PCT
 

Value of this measure
 

IN_TRANSIT
 

Value of this measure
 

INV_TURNS
 

Value of this measure
 

ITEM_STD_COST
 

Value of this measure
 

ONHAND
 

Value of this measure
 

PAB
 

Value of this measure
 

PAB_VALUE
 

Value of this measure
 

PO_QTY
 

Value of this measure
 

PR_QTY
 

Value of this measure
 

PROJECTED_ONHAND Value of this measure
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Column name Description

  

SCHED_RCPT
 

Value of this measure
 

SS
 

Value of this measure
 

TF_QTY
 

Value of this measure
 

TOTAL_DEMAND
 

Value of this measure
 

TOTAL_DEMAND_VALUE
 

Value of this measure
 

TOTAL_SUPPLY
 

Value of this measure
 

TTL_END_ITEM_CST
 

Value of this measure
 

GROSS_MARGIN
 

Value of this measure
 

The extract process generates one measure data file for each set of measures that share the same dimensionality or
granularity. The measure data files contain information for all measures that share that same dimensionality. A list
of predefined dimensionality groups is listed in the Dimensionality Group Codes Used by the Plan Extract Process
topic. The lowest level of each of these dimensions appears in each file. They will be different for each dimensionality,
based on the dimensions that are part of that group. Each measure column name is a measure code from the measure
definition file. Use the measure definition file to obtain more details about the measure, including its full name,
description, aggregation, and so on.

Measure Definition Files Created by the Plan Extract
Process  
The measure definition file contains information for all of the measures specified in the measure catalog for extract. The
plan extract process creates only one file per extract.

Column name Description

GRANULARITY_ID
 

Dimensionality group ID
 

POSITION
 

Internal use only
 

MEASURE_CODE
 

Used as the column name in measure data files
 

430



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 15
Extract Plan Data

Column name Description

MEASURE_ID
 

ID that uniquely identifies a measure
 

NAME
 

Name of the measure
 

DESCRIPTION
 

Brief description of the measure
 

DATA_TYPE
 

Data type
 

EXPRESSION
 

Internal use only
 

AGGR_ORDER
 

Aggregation rule:
 
1 = Calculate, then aggregate
 
2 = Aggregate, then calculate
 

AGGR_METHOD_OTHER
 

Aggregation method on dimensions other than the Time dimension
 

AGGR_METHOD_TIME
 

Aggregation method on the Time dimension
 

WEIGHTED_BY
 

ID of the measure to be used when aggregation method is WAVG (weighted average)
 

The MEASURE_CODE column in this file contains all the measure codes for all measures. The actual measure data
files use this measure code as data column name. Using this code, you can look up additional information about the
measure in the definition file. Note that the expression indicated is only for internal use and is already evaluated before
the extract. Aggregation methods (Sum, Latest, Average, Weighted Average, and so on) can be used to configure your
analytics to aggregate these measures across various dimensions.

Dimension Codes Used by the Plan Extract Process  
The plan extract process uses preconfigured dimension codes related to a list of valid dimension.

Code Dimension name

tim
 

Time
 

res
 

Resource
 

cus
 

Customer
 

prd Product
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Code Dimension name

  

org
 

Organization
 

dcs
 

Demand Class
 

sup
 

Supplier
 

fcm
 

Forecasting Method
 

cto
 

Configure to Order
 

src
 

Source
 

exp
 

Exception Type
 

ord
 

Order Type
 

cig
 

Decomposition Method
 

seg
 

Segment
 

Dimensionality Group Codes Used by the Plan Extract
Process  
The extracted files use codes related to a list of valid dimensionality groups. Dimensionality group codes shown in this
topic list all of the valid preconfigured dimension groups.

For example, code 125 is for all measures that are dimensioned only by the Organization, Product, and Time dimensions.
The measure data file for that dimensionality contains all measures extracted for that dimensionality.

Dimensionality Group Code Dimensionality Group

10
 

org, prd, tim, cus, cto
 

15
 

org, prd
 

20
 

org, res, tim
 

25 tim
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Dimensionality Group Code Dimensionality Group

  

35
 

org, prd, tim, cus
 

40
 

org, prd, res, tim, cus, sup, exp
 

45
 

org, prd, tim, sup
 

50
 

org, prd, tim, cus, sup, src
 

55
 

org, prd, tim, cus, dcs, ord
 

60
 

org, prd, tim, ord
 

65
 

org, prd, tim, cus, sup, dcs, ord
 

70
 

org, prd, tim, sup, ord
 

75
 

org, prd, dcs
 

95
 

org, prd, cus, dcs, fcm, clg, tim, cto
 

100
 

org, prd, tim, cus, dcs, cto
 

105
 

org, prd, cus
 

110
 

org, prd, cus, dcs
 

125
 

org, prd, tim
 

130
 

org, prd, tim, cus
 

135
 

org, prd, tim, cus, dcs
 

145
 

prd, tim, cus
 

150
 

prd, tim, cus, dcs
 

155
 

org, prd, tim, cus, sup, dcs
 

160
 

prd, cus
 

165 org, prd, tim, exp

433



Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 15
Extract Plan Data

Dimensionality Group Code Dimensionality Group

  

170
 

org, tim
 

175
 

prd
 

180
 

org, prd, tim, cus, dcs, fcm, clg
 

185
 

org, prd, cus, dcs, fcm, clg
 

190
 

org, prd, cus, fcm, clg
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16  Simulation Sets

Overview of Simulation Sets  
Simulation sets provide a way to override key parameters coming from plan inputs. A simulation set enables you to
modify item-organization attributes for testing purposes.

Use a simulation set to quickly change item-attribute values without having to recollect items. For example, you can test
planning results by changing item lead times or order modifiers.

You can open a simulation set and use the Items table to modify some item attributes.

Item Type Editable Item Attributes

Lead times
 

Fixed Lead Times, Postprocessing Lead Time, Preprocessing Lead Time, Processing Lead Time,
 Variable Lead Times
 

Order modifiers
 

Fixed Days of Supply, Fixed Lot Multiplier, Fixed Order Quantity, Maximum Order Quantity, Minimum
Order Quantity
 

Time fences
 

Demand Time Fence Type, Demand Time Fence Days, Planning Time Fence Type, Planning Time Fence
Days, Release Time Fence Type, Release Time Fence Days
 

Safety stock
 

Days of Cover, Safety Stock Planning Method, and several other attributes used for safety stock level
calculation
 

Other
 

Acceptable Early Days, Excess Horizon, Obsolescence Date, Planning Method, Selling Price, Standard
Cost
 

Related Topics
• Simulate Demand and Supply Changes

• Create a Simulation Set

• Edit a Simulation Set

Create a Simulation Set  
Perform the following steps to create a simulation set from the Plan Inputs work area:

1. In the Navigator, click the Plan Inputs work area link.
2. On the Plan Inputs page, click the Open button.
3. In the Open Table, Graph, or Tile Set dialog box, do the following:
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a. In the Search drop-down list, select: Name.
b. In the Search text box, enter the name of a table, such as Items or Resources.
c. Click the Search icon button.
d. Select the Items (or Research) table and click OK.

4. On the Plan Inputs page, Items tab (or Resources tab), click the Search button.
5. In the Search Results region, select one or more rows and do the following:

a. Click Actions and then select Add to Simulation Set.
b. In the Add to Simulation Set dialog box, click the Search: Simulation Set down arrow for a list of values,

and then click Create Simulation Set.
c. In the Create Simulation Set dialog box, in the Simulation Set field, enter the name of the simulation set

you want to create.
d. Click Save and Close.
e. In the Add to Simulation Set dialog box, click Save and Close.

Related Topics
• Overview of Simulation Sets

• Edit a Simulation Set

• Simulations in Supply Planning

• Copy Data to Simulation Sets in Supply Planning

• Add Data from Plan Inputs to Simulation Sets

Edit a Simulation Set  
Perform the following steps to edit a simulation set from the Plan Inputs work area:

1. In the Navigator, click the Plan Inputs work area link.
2. On the Plan Inputs page, click the Plans panel tab.
3. In the Plans panel drawer, do the following:

a. Expand the list of Simulation Sets.
b. Select a simulation set, right-click on it and select Open.

4. On the Simulation Set page, click Open and then select Full Pane.
5. In the Open Table, Graph, or Tile Set dialog box, select a table, such as Resources or Items, and then click OK.

On the Simulation Set page, a new tab opens for the table that you selected, such as the Resources tab or the
Items tab.

6. In the Search region, click Search.
7. In the Search Results region, select one or more rows. Click Actions and then select Edit from the drop-down

list.

8. In the edit dialog box, you can edit some of the attributes and drill down to additional tables, depending on the
table that you accessed. For example:

◦ For the Resources table, you can change the Bottleneck value. You can also drill down to the Resource
Availability table.

436

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20059450
https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20060971
https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20060972


Oracle Fusion Cloud SCM
Using Supply Chain Planning Common Features

Chapter 16
Simulation Sets

◦ For the Items table, you can change the Processing Lead Time value. You can also drill down to the
Suppliers table.

9. When done, click OK to return to the Simulation Set page. Changed rows and fields are marked with small
colored dots.

Related Topics
• Overview of Simulation Sets

• Simulate Demand and Supply Changes

• Create a Simulation Set

• Edit a Simulation Set from a Spreadsheet

Edit a Simulation Set from a Spreadsheet  
You can download simulation set data into a spreadsheet, make edits, including certain updates, additions, and
deletions, and then upload it back to the simulation set.

In the Plan Inputs work area, while working with the Items or Supplies and Demands table in a simulation set, use the
Edit in Spreadsheet option in the Actions menu to download the table rows into a Microsoft Excel file.

Note:  Before working with spreadsheets, you must download and install the desktop integration installer that is
available under Navigator > Tools. Otherwise, you can't download information into or upload information from
spreadsheets.

To edit the data in the Items or Supplies and Demands table of the simulation set in a Microsoft Excel spreadsheet,
follow these steps:

1. In the Plan Inputs work area, click the Plans panel tab.

Note:  The simulation set can also be edited from the Planning Central, Sales and Operations Planning, and
Supply Planning work areas. However, the Supplies and Demands table is available in the simulation set only
when it is edited in the Supply Planning work area.

2. In the Plans panel drawer, do the following:

a. Expand the list of simulation sets.
b. Select the simulation set that you want to edit, right-click, and click Open. The simulation set opens.

3. In the Open menu, select Full Pane. The Open Table, Graph, or Tile Set dialog box opens.
4. Select the Items or Supplies and Demands table, and click OK. The table opens in a page in the simulation set.
5. Perform a search for the table rows in the simulation set.
6. In the Actions menu for the table, click Edit in Spreadsheet. A dialog box opens and prompts you to save or

open a Microsoft Excel file.
7. Open the spreadsheet. The Connect dialog box opens and prompts you to connect to the URL for the

application.
8. Click Yes. A dialog box opens and prompts you to type your credentials.
9. Sign in with your credentials for the Oracle Fusion Cloud Applications Suite. The spreadsheet is refreshed with

the data in the simulation set.
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10. Edit the data.

Task Steps

To add an item to the Items table of the
simulation set
 

Click the Add Item icon in the Items menu of the spreadsheet, and provide values in the Add
Item dialog box that opens. You can add an existing item or create an item that is based on an
existing item.
 

To create an order in the Supplies and
Demands table of the simulation set
 

Click the Create Order icon in the Supplies and Demands menu of the spreadsheet, and
provide values in the Create Order dialog box that opens. (Not applicable to sales and
operations planning.)
 

To edit a row
 

Modify the values in the row cells that are not grayed out. A symbol appears in the cell under
the Changed column for the row.
 

To delete a row
 

Click the corresponding cell in the Mark for Deletion column. A symbol appears in the cell to
mark the table row for deletion. To deselect the row, click the cell again.
 

11. Click the Upload icon in the Items or Supplies and Demands menu. In the Upload Options dialog box that
appears, select the check boxes for the options that you want to use, and click OK. The data is uploaded to the
simulation set.

12. Save the simulation set. The changes are displayed and marked with colored symbols.
13. Save and close the spreadsheet.

Simulate Demand and Supply Changes  
Planning Central enables you to simulate the effects of demand and supply changes on a plan.

Item Simulation Sets
You can use item simulation sets to edit item-organization parameters within the Planning Central work area and then
run a plan using the edited values. You can quickly simulate demand and supply changes, and analyze plan output with
the changes.

Open the Supplies and Demands table in a plan to make these changes:

• Add demands: Create a manual demand and firm the date and quantity.

• Cancel demands: Firm the demand and change the firm date.

• Reschedule demands: Firm the demand and change the firm date.

• Add new planned orders: Create a planned order and set the firm date and quantity.

• Cancel supplies and planned orders: Firm the supply and set the firm quantity to zero.

• Reschedule supplies: Firm the supply and change the firm date.
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Run the plan with the Do not refresh with current data option selected to see the results of your demand and supply
changes.

Note:  If you’re making changes to a planned order, set the Overwrite Firm Planned Orders to None.

Order Types You Can Copy to Simulation Set
Here’s the list of supply and demand order types that you can copy to a simulation set:

Supply Order Types

• Planned order

• Purchase order

• Purchase requisition

• Transfer order

• On hand supplies

Demand Order Types

• Sales order

• Manual demand

Related Topics
• Overview of Simulation Sets

• Create a Simulation Set

• Edit a Simulation Set
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17  Troubleshooting

Resolve Error MSC-2806379  
This topic guides you on how you can resolve error MSC-2806379 that may be displayed when you view a table or
graph.

The error is displayed when you view a table or graph that you don't own for your Oracle Fusion Cloud Supply Chain
Planning product, and the table or graph contains too much data.

The error text is as follows: "You can't view this table or graph because the underlying data or analysis produces too
much data. (MSC-2806379)

"To resolve this issue, make a copy of the table or graph because you aren't the owner of it, change configurations to
reduce the data set, and try again. For example, limit the use of measures with different dimensionalities, reduce the
number of measures with complex expressions, such as lead or lag functions, or check measure filter configuration.
Refer to Incident ID <number> on <server name> server."

Follow these steps to resolve the error:

1. If the table or graph is open, in the toolbar, click Actions > Save Table As or Actions > Save Graph As.
Otherwise, do the following:

a. Click Actions > Manage Tables, Graphs, and Analysis Sets.
b. In the Manage Tables, Graphs, and Analysis Sets dialog box, search for your table or graph, and select it.
c. Click Actions > Duplicate.

2. In the dialog box, provide the name and description for the copied table or graph.
Provide other details for the copied table or graph.

3. Click Save and Edit.
4. In the Configure Table or Configure Graph dialog box, do the following:

◦ On the Measures tab, on the Selected Measures pane, select the measures that you can remove from the
table or graph, and move them to the Available Measures pane.

For example, limit the use of measures with complex expressions.

◦ On the Members tab, on the Selected Members pane, select the members that you can remove from the
table or graph, and move them to the Available Members pane.

For example, on the Selected Members pane, retain only one organization or a few products according to
your business requirements. You can use the Advanced Filter dialog box to reduce the number of members
that are displayed by the table or graph.

◦ On the Measure Filters tab, add filters to reduce the amount of data returned by your table or graph.

◦ On the Layout tab, add filters to your table or graph.

For example, if your table includes the Organization level, you can use the level as a filter that restricts the
returned data to the selected member.

5. Click Save and Close.
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Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Use Advanced Options in the Selector Tool

• Configure Filters for Graphs

Resolve Error MSC-2806380  
This topic guides you on how you can resolve error MSC-2806380 that may be displayed when you view a table or
graph.

The error is displayed when you view a table or graph that you own for your Oracle Fusion Cloud Supply Chain Planning
product, and the table or graph contains too much data.

The error text is as follows: "You can't view this table or graph because the underlying data or analysis produces too
much data. (MSC-2806380)

"To resolve this issue change configurations to reduce the data set, and try again. For example, limit the use of
measures with different dimensionalities, reduce the number of measures with complex expressions, such as lead or lag
functions, or check measure filter configuration. Refer to Incident ID <number> on <server name> server."

Follow these steps to resolve the error:

1. If the table or graph is open, in the toolbar, click Actions > Configure Table or Actions > Configure Graph.
Otherwise, do the following:

a. Click Actions > Manage Tables, Graphs, and Analysis Sets.
b. In the Manage Tables, Graphs, and Analysis Sets dialog box, search for your table or graph, and select it.
c. Click Actions > Edit.

2. In the Selector Tool, do the following:

◦ On the Measures tab, on the Selected Measures pane, select the measures that you can remove from the
table or graph, and move them to the Available Measures pane.

For example, limit the use of measures with complex expressions.

◦ On the Members tab, on the Selected Members pane, select the members that you can remove from the
table or graph, and move them to the Available Members pane.

For example, on the Selected Members pane, retain only one organization or a few products according to
your business requirements. You can use the Advanced Filter dialog box to reduce the number of members
that are displayed by the table or graph.

◦ On the Measure Filters tab, add filters to reduce the amount of data returned by your table or graph.

◦ On the Layout tab, add filters to your table or graph.

For example, if your table includes the Organization level, you can use the level as a filter that restricts the
returned data to the selected member.

3. Click Save and Close.
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Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Use Advanced Options in the Selector Tool

• Configure Filters for Graphs
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